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CHAPTER 1 Types of Utilities

SAP® Adaptive Server® Enterprise (SAP ASE) provides utility programs of various types.

Threaded Versions of Utilities

SAP includes the _r versions of some of the utilities for use with threaded drivers.

These utilities have threaded _r versions:

* bcp

* cobpre

* cpre

* defncopy
e dscp

* isql

See also

e bcpon page 14

e cobpreon page 34

e cpreon page 34

e defncopy on page 64
e dscpon page 69

* /sg/on page 78

Installation or Configuration Utilities

SAP ASE® includes various utilities for installation and configuration.

Use these to install or configure databases:

* auditinit — allows you to install an audit system.
e dataserver — allows you to build a new SAP ASE server.

» dscp —allows you to view and edit server entries in the interfaces file from the command
line.

» dsedit — allows you to view and edit server entries in the interfaces file using a GUI.

In Windows, allows you to create and modify network connection information in the
interfaces file.
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CHAPTER 1: Types of Utilities

preupgrade — performs tests on an installation or database to determine its readiness for
upgrade, and reports problems found.

sglupgrade — upgrades your currently installed release of SAP ASE to the newest release.
sglupgraderes — upgrades your currently installed release of SAP ASE to the newest
release using resource files in UNIX platforms.

srvbuild — creates a new SAP ASE server, Backup Server, or XP Server with default or
user-specified values for key configuration attributes using a graphical user interface.
srvbuildres — creates a new SAP ASE server, Backup Server, or XP Server, using resource
files to specify values for key configuration attributes in UNIX platforms.

See also

aataserveron page 35
dscp on page 69

dsediton page 71
preupgrade on page 102
sqlupgrade on page 132
sqlupgraderes on page 133
srvbuild on page 134
srvbuildres on page 136
updatease on page 163

Utilities for Languages, Character Sets, and Sort Orders

SAP ASE includes various utilities to set languages, character sets and sort orders.

charset — loads the character sets and sort order files in Windows.

langinstall — installs a new language on an SAP ASE server.

sglloc — installs and modifies languages, character sets, and sort order defaults for SAP
ASE.

sqllocres — installs and modifies languages, character sets, and sort order defaults for SAP
ASE, using a resource file in UNIX platforms.

See also

charseton page 33
langinstall on page 94
sqlloc on page 124
sqllocres on page 125
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Utilities to Start Servers

SAP ASE includes various utilities to start servers manually.

backupserver — starts the Backup Server executable. To start Backup Server manually,
use:

¢ (UNIX) startserver

e (Windows) srvmgr

dataserver — starts the SAP ASE executable. Use startserver instead of this utility to start
SAP ASE manually.

sqlsrvr — starts the SAP ASE executable in Windows . Use the services manager utility
instead of this utility to start SAP ASE manually.

srvmgr — starts, pauses, and stops the SAP ASE server, Backup Server, and Adaptive
Server Monitor™ as Windows services.

startserver — starts an the SAP ASE server and a Backup Server in UNIX platforms.

See also

Startserveron page 138
backupserveron page 10
aataserveron page 35
sqlsrvron page 127

Database Creation and Manipulation Utilities

SAP ASE includes various utilities to create and manipulate databases.

bcp — copies a database table to or from an operating system file in a user-specified format.
ddlgen — generates data definition language for server- and database-level objects in SAP
ASE.

defncopy — copies definitions for specified views, rules, defaults, triggers, or procedures
from a database to an operating system file or from an operating system file to a database.

extractjava—copies aretained JAR and the classes it contains from an SAP ASE servertoa
client file.

installjava — installs a JAR from a client file into an SAP ASE database.
isgl — interactive SQL parser to the SAP ASE server.
optdiag — displays optimizer statistics or loads updated statistics into system table.

See also

bcp on page 14
adlgen on page 42
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e defncopy on page 64
e extractjavaon page 71
» installjavaon page 74
e jsgl/on page 78

Utilities to Gather Information

SAP ASE includes various utilities to gather information:

« showserver —shows the SAP ASE servers and Backup Servers that are currently running
on the local machine in UNIX platforms.

» sybdiag — collects comprehensive SAP ASE configuration and environment data to help
SAP Product Support diagnose server issues.

» wdllvers — provides information about the SAP ASE-related DLLs (dynamic link
libraries) that are loaded into memory in Windows.

See also
e showserveron page 117
» sybdiag on page 145

Tuning Utility

gptune enables you to fix missing statistics and identify the best query plan, optimization
goal, or other configuration settings, and apply them at the query or server level.

Utility to Manage a Cluster

(Cluster Edition only) Use the sybcluster utility to manage an SAP ASE shared-disk cluster.
sybcluster provides a set of interactive, command line options for creating and managing a
cluster.
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CHAPTER 2

Utility Commands Reference

Reference pages for the SAP ASE utility program commands.

In UNIX, you enter a utility program command at the system prompt in a UNIX shell.

In Windows, if a utility:

e Hasanicon in the Sybase® for Windows or Sybase for the Windows program group,
double-click the icon to launch the utility program.

« Does not have an icon in the program group, enter the utility program command at the
Windows command prompt to launch the utility program.

Place characters with special meaning to the shell (the command prompt in Windows), such as
the backslash (\), asterisk (*), slash (/), and spaces, in quotes. Precede some special
characters with the backslash (\) to “escape” them to prevent the shell (command prompt)
from interpreting the special characters.

The utility programs available with SAP ASE are:

Utility Description

auditinit Install an audit system using the executable form of the auditinit program.

backupserver | The executable form of the Backup Server program.

bcp Copies rows in a database table to or from an operating system file in a user-speci-
fied format.

buildmaster See dataserver.

certauth This utility is deprecated.

certpk12 This utility is deprecated.

certreq This utility is deprecated.

charset (UNIX only) Loads the character sets and sort order files.

cobpre A precompiler for COBOL.

cpre A precompiler for C.

dataserver (UNIX only) An executable form of the SAP ASE program.
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CHAPTER 2: Utility Commands Reference

Utility Description

ddigen A Java-based tool that generates data definition language for server- and database-
level objects in an SAP ASE server.

defncopy Copies definitions for specified views, rules, defaults, triggers, procedures, or re-
ports from a database to an operating system file or from an operating system file to
a database.

dscp (UNIX only) Allows you to view and edit server entries in the interfaces file in
command-line mode.

dsedit Allows you to view and edit server entries in the interfaces file using a graphical
user interface.

extractjava Copies a retained JAR from an SAP ASE server to a client file.

installjava Installs a JAR from a client file into an SAP ASE server.

isql Interactive SQL parser to the SAP ASE server.

langinstall Installs a new language on the SAP ASE server.

optdiag Displays optimizer statistics or loads updated statistics into system tables.

preupgrade Performs tests on an installation or database to determine its readiness for upgrade.

pwdcrypt Creates and prints an encrypted LDAP password in the libtcl.cfg file.

grmutil (Cluster Edition only) allows you to back up, restore, and reconfigure the quorum
device.

gptune Enables you to fix missing statistics and identify the best query plan, optimization
goal, or other configuration settings, and apply them at the query or server level.

showserver Shows SAP ASE servers and Backup Servers that are currently running on the local
machine.

sqldbgr Debugs stored procedures and triggers.

sqlloc Installs and modifies languages, character sets, and sort order defaults for the SAP
ASE server in GUI mode.

sqllocres Installs and modifies languages, character sets, and sort order defaults for the SAP
ASE server in command-line mode.

sqlsrvr An executable form of the SAP ASE program.
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Utility Description
sglupgrade Upgrades your currently installed release of SAP ASE to the newest release in GUI
mode.

sqlupgraderes | Upgrades your currently installed release of SAP ASE to the newest release in
command-line mode.

srvbuild Creates a new SAP ASE server, Backup Server, or XP Server in GUI mode with
default or user-specified values for key configuration attributes.

srvbuildres (UNIX only) Creates a new SAP ASE server, Backup Server, or XP Server in
command-line mode with default or user-specified values for key configuration
attributes.

startserver (UNIX only) Starts an SAP ASE server or a Backup Server.

sybatch (Windows only) Creates a new SAP ASE server, Backup Server, or XP Server with

default or user-specified values for key configuration attributes, as well as installs
and modifies languages, character sets, and sort order defaults for SAP ASE.

sybcluster Manages a shared-disk cluster.

syconfig (Windows only) A GUI version of sybatch.

sybdiag A Java-based tool that collects comprehensive configuration and environment data
for the SAP ASE server.

sybmigrate Enables you to migrate database from a server using 2K logical pages to a server

using 4, 8, or 16K logical pages.

sybrestore Enables you restore an SAP ASE database to the time of failure from the most
current full database backup dump files.

sybtsmpasswd | Records or changes the user password and creates the Tivoli Storage Manager
(TSM) encrypted password file, TSM. PWD, on the TSM client machine.

updatease Reinstalls scripts and updates system stored procedures and messages after a minor
upgrade.
xpserver Starts XP Server manually.

Note: These utility programs may allow you to use a -P parameter to enter your password. If
security is an issue, do not use -P to specify your password; another user may have an
opportunity to see it. Instead, log in as usual without the -P parameter, and let the SAP ASE
server prompt you for your password.
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See also

e auditiniton page 9

e backupserveron page 10
e bcpon page 14

e buildmasteron page 32
e certauthon page 32

* certpk12on page 32

e certregon page 33

* charseton page 33

e cobpreon page 34

e cpreon page 34

e dataserveron page 35

* ddlgenon page 42

e defncopy on page 64

e dscpon page 69

e dsedjton page 71

* extractjavaon page 71
 installjavaon page 74

e Jsqlon page 78

» langinstall on page 94

e optdiag on page 96

e preupgrade on page 102
e pwdcrypton page 106

e gptune on page 107

e grmutil/on page 113

e showserveron page 117
e sqgldbgron page 118

e sgllocon page 124

o sgllocreson page 125

* sglsrvron page 127

» sqlupgrade on page 132
» sqlupgraderes on page 133
e srvbuild on page 134

e srvbuildres on page 136
e Startserveron page 138
e Sybatchon page 140

e sybclusteron page 141
e syconfigon page 144

* sybdiag on page 145
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e sybmigrate on page 156

e Sybrestore on page 161

* sybtsmpasswd on page 163
e updatease on page 163

e xpserveron page 165

auditinit

Install an audit system using the executable form of the auditinit program.

The auditinit executable file is located here:

* (UNIX) $SYBASE/$SYBASE ASE/bin
+ (Windows) $SYBASE$\%SYBASE ASE%\bin as auditinit.exe

Syntax
uditinit [-v ] [-h ]
al

a
[-
[-c charset]

[-el

[-D user data directory ]
[-1 language]

[-log log file]

[-r resource file]

[-s release dlrectory]

Parameters

e -v —prints the version string and exits.

e -h —prints the help information and syntax usage and exits.

» -a—validates an audit resource file.

* -C—sets the character set.

* -e—writes the environment to the log file and exits.

» -D —when specified, auditinit will read or write user data files (for example: interfaces,
RUN_server, and so on) from or to this directory. Use this option when you specify at the
time that you install SAP ASE, that another user could configure the server. If you do not
use -D, the SAP ASE server uses $SYBASE (%SYBASE% on Windows) as the default.

* -l —specifies the language you want to use for the SAP ASE server.

* -log —indicates a user-defined log file where the output is stored.

» -r —specifies the name and location of the resources file for the SAP ASE server.

» -s—specifies the name and location of the SAP ASE directory.
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Examples

« Examplel-Starts the interactive auditinit utility. Use the utility to install an audit system,
or modify devices in the current audit system:auditinit

AUDITINIT
1. Release directory: /usr/u/sybase
2. Configure a Server product

* Example 2 —Writes the environment to the auditinit log file.auditinit -e

The log file for this session is 'C:\Sybase\ASE-16 0\init\logs
\10g1120.007".

* Example 3 — Validates the specified audit resource file:auditinit -a -r
auditResource.rs

Usage
To install an audit system, enter auditinit without any parameters to start the interactive utility.

Using the parameters, you can retrieve information about the current audit system.

Permissions

The system security officer manages the audit system.

See also
e Chapter 2, Utility Commands Reference on page 5

backupserver

The executable form of the Backup Server program.
The utility is located in:

+ (UNIX) $SYBASE/$SYBASE ASE/bin.
*  (Windows) $SYBASE%$\$SYBASE ASE%\Dbin, as bcksrvr.exe.

Syntax

backupserver
[-C server connections]
S b servername]
I interfaces file]
e error log file]
M sybmultbuf binary]
-N network connections]
T trace value]
L Sybase language name]
J Sybase character set name]
c tape config file]

10
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[-D n]

[-A pathname]

[-P active service threads]
[-V level number]

[-p nl]

[-m max shared memory]

backupserver -v

Parameters

-C server_connections —specifies the number of server connections for the
Backup Server, which requires:

« Two connections for each dump session
< One connection for each load session
« One connection for volume change messages

Allow a maximum of three times the number of expected concurrent dump and load
sessions. The default value is 30 server connections.

-S b_servername —specifies the name of the Backup Server to start. The default is
SYB_BACKUP. This entry must specify the name of a Backup Server in the interfaces
file.

-1 interfaces_file—specifiesthe nameand location of the interfaces file to search
when connecting to Backup Server. If - T is omitted, backupserver looks for a file named
interfaces in the directory pointed to by your SYBASE environment variable.

-v — prints the version number and copyright message of the backupserver software and
then exits.

-e error_log_file-specifiesthe name and location of the Backup Server error log
file used to report SAP® Open Server™ internal errors, sybmultbuf errors, errors that halt
the Backup Server, and errors for disconnected sessions. All other errors are sent to the
notify destination specified in the dump database, dump transaction, load database, and
load transaction commands.

-M sybmultbuf_ binary-—specifiesthe full path name of the sybmultbuf executable.
Use this parameter only when starting Backup Server from a directory other thanthe bin
directory of the Sybase installation directory, or when using a diagnostic version of
sybmultbuf.

-N network connections —specifies the number of total network connections
(DBPROCESSes) that the master Backup Server can originate. The default value is 25.
-T trace_value—interprets frace_valueas a bitmask (base-2 number). The 1 bits in
trace_valuecorrespond to Open Server Trace flags to turn on. If you specify more than one
-T parameter on the command line, the final - T value overrides the values from earlier - T
parameters. The trace _value must be a positive integer.

-L Sybase_language name —specifies the default language for Backup Server. If
not specified, Backup Server uses the locale specified by the LC_ALL or LANG
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environment variables. If these variables are not set, Backup Server searches for the
“default” entry in locales.dat.

Note: The -L parameter does not override the value set in the LANG environment variable.
-J Sybase character_set_name—specifies the default character set for Backup
Server.

-c tape_config file —specifies the name and location of the tape configuration
file to search for tape device configuration information before doing a dump database or a
dump transaction. If you do not specify -c, the default path name for the tape
configuration file is $SYBASE/backup tape.cfg.

-D n-—specifies the bitmap (base 10 number) of the diagnostic flags used within Backup
Server.

-A pathname —specifies the pathname to the directory of the Archive API dynamically
loadable library.

-P active_service_ threads —allows you to increase the number of stripes
during multiple dump/load operations (with a maximum of 12,286 stripes per single
operation).

-V level number —limits the messages that are printed to the Backup Server error
log. The fevel_numbervariable determines the degree of error verbosity (-V) for Backup
Server:

o -v4 —displays all -v0 messages except “Connection from Server” messages printed
for each connection event.
« —-v3-displays only completion messages from a normal dump or load command and
these types of messages:
< Error messages from Backup Server and sybmultbuf
e Other sybmultbuf messages
* \olume change messages
» Open Server™ messages
» Trace print messages
« Informational messages from the System & Tape Auto Config modules
e -v2 —displays:
e All-v3 messages plus
« File creation and file mount messages
o -V1 —displays:
e All -v2 messages plus
e Phase messages
e -VO0 (default) — displays all messages, including backup progress

This limitation does not involve the messages that are sent to the client or console as
determined by the NOTIFY= parameter in a dump or load command.

This option also does not affect logging for these message types:

12

Adaptive Server Enterprise



CHAPTER 2: Utility Commands Reference

¢ Open Server messages

« Trace printing messages from bs_traceprint

* sybmultbuf messages

-p n-—specifies the TDS packet size in bytes that the local Backup Server requests from
the remoteBackup Server during network dumps. The actual packet size used is limited to
the —p parameter value of the remote Backup Server. If you do not specify —p, the default
is 2048 bytes. The packet size should be an integer greater than, or equal to 256.

-m max_shared memory — specifies the maximum amount of shared memory in
megabytes that Backup Server can use for all of its dump or load sessions.

Usage

In SAP ASE version 15.5 and later, both the SAP ASE server and Backup Server can

bypass the operating system buffer cache when you enable the directio parameter for the

device using disk init, disk reinit, or sp_deviceattr. the SAP ASE server passes the device

options to Backup Server, which enables Backup Server to access the database device with

the appropriate directio option.

Backup Server versions 15.0.3 and earlier do not work with SAP ASE 15.5 and later.

Start Backup Server with the startserver command rather than by directly executing the

backupserver program.

» To change default values in UNIX, edit the RUN_servername file in your Sybase
installation directory. See the startserver reference page for details.

« To change default values in Windows, use Server Config to change the command line
parameters of the Backup Server. See the SAP ASE configuration guide for details.

Make sure that the device driver options you include with the dump command are accurate.

Backupserver does not verify any device driver options you include during a dump

command. For example, if you include a option that forces Backupserver to rewind a tape

before use, it will always rewind the tape to the beginning instead of reading the tape from

the point of the dump.

If you do not specify a Backup Server name with the —S parameter, and you have not set the

environment variable DSLISTEN, backupserver uses the default Backup Server name

SYB_BACKUP in UNIX.

(Windows) beksrvr uses the default Backup Server name server name BS. Thevalue

of the DSLISTEN environment variable overrides this default value, and the -S parameter

overrides both the default and the value specified in DSLISTEN.

Whenever possible, the Backup Server and any SAP ASE servers that dump or load

directly through the Backup Server should share the same interfaces file (sgl.ini in

UNIX). The interfaces file that Backup Server uses must contain entries for:

« Backup Server

* Any other Backup Servers with which this Backup Server communicates

Trace flags cause the Backup Server to print information regarding its operation while it is

running, for debugging problems in the Backup Server.
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bcp

» Backup Server provides multithread support needed for Tivoli Storage Manager (TSM)
options such as LAN-FREE.
To enabled multithread support for TSM options, use the -D8192 option during Backup
Server startup. For example:

$ {BACKUPSERVER} -SSYB BACKUP -ISSYBASE/interfaces -M${SYBMULTBUF}
-D8192s&

This feature is not enabled by default.

« IfBackup Server cannot findthe 1ocales and charsets directories specified by the -L
and -J parameters, or if these parameters specify an incorrect language and character set
combination, Backup Server issues an error message and uses the default language and
character set. Backup Server does not support use of the Open Server-defined SRV_TR
symbols for -T.

« Backup Server cannot perform loads or dumps between servers that use different logical
page sizes. For example, load a 4K logical page sized database dump into another server
using a 4K logical page size. But Backup Server does not support dumping a 4K logical
page sized database and loading it into a database that uses 16K logical page size.

See also Open Server Server-Library/C Reference Manual for more details on trace flags.

Permissions

Anyone with execute permission on the binary, and who has read/write access to all the files.

See also

» Chapter 2, Utility Command’s Reference on page 5
»  Ulilities to Start Servers on page 3

* Startserveron page 138

Copies a database table to or from an operating system file in a user-specified format.

bep provides a convenient and high-speed method for transferring data between a database
table or view and an operating system file. bcp can read or write files in a wide variety of
formats. When copying in from a file, bcp inserts data into an existing database table; when
copying out to a file, bcp overwrites any previous contents of the file.

The utility is located in:

* (UNIX) $SYBASE/$SYBASE OCS/bin.
* (Windows) $SYBASE%$\%$SYBASE OCS%\bin, as bcp.exe.

Note: For parallel bcp, on:

14
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e UNIX platforms — use bcp_r. The executable is in the same directory as the standard bcp

command.

« Windows — use the standard bcp.exe utility.

Syntax

bcp

[[database name.]owner.]table name [: partition id |

slice number

[partition partition name] {in | out} [datafile]
a display charset]

A packet size]

b batch_51ze]

c]

C]

d discardfileprefix]

e errfile]

E]

f formatfile]

F firstrow]

g id start value]

i input file]

I interfaces file]

J client character set]

K keytab file]

L lastrow]

m maxerrors]

MLabelName LabelValue] [-labeled]

output file]
password]

row terminator]

remote server principall]
server]

field terminator]

text or image size]
username]

[security options]]

trusted.txt file]

lternate home directory]

~—

anguage]
security mechanism]
colpasswd [[[db name. [owner].]table name.]
column name [password]]]
[--keypasswd [[db name.[owner].]key name [password]]]
[--hide-vcc]
[--initstring "TSQL command"]
[--maxconn maximum connections]
[
[

(-
(-
[-
(-
(-
(-
[-
(-
(-
(-
[-
(-
(-
(-
[-
(-
(-
(-
[-
(-
(-
(-
[-
(-
(-
(-
[-
(-
(-
(-
[-
(-
(-
(-
[-
(-
(-
(-
[-

INN >—<'~< .’><>< E}<<GH<‘1’UJ’;UHIO"UO Z‘J

—-—-show-£fi]
--skiprows nSkipRows]
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Parameters

database_name —is optional if the table being copied is in your default database or in
master. Otherwise, specify a database name.

owner—isoptional if you or the database owner owns the table being copied. If you do not
specify an owner, bcp looks first for a table of that name that you own, then looks for one
owned by the database owner. If another user owns the table, specify the owner name or the
command fails.

table_name —specifies the name of the database table to copy. The table name cannot
be a Transact-SQL ™ reserved word.

partition_id - specifies the partition number into which data is to be copied.
Supported only for bep in, partition_id is the equivalent of slice_numberin SAP ASE
12.5.x.

slice number—specifies the number of the slice of the database table into which data
is to be copied. Supported only for bep in and only for round-robin partitioned tables in
SAP ASE 15.0 and later.

partition partition_name—specifies the name of the partition in the SAP ASE
server. For multiple partitions, use a comma-separated list of partition names.

in | out —specifies the direction of the copy. in indicates a copy from a file into the
database table; out indicates a copy to a file from the database table or view.

Note: bep raises an error and stops if the number of rows to be copied in or out exceeds
2147483647.

datafile—specifies the full path name of an operating system file. The path name can
be 1 to 255 characters long. For multiple files, use a comma-separated list of file names. If
you enter more than one data file and partition name, the number of files and partitions
must be the same.

-a display_ charset—allowsyoutorunbcp fromaterminal where the character set
differs from that of the machine on which bcp is running. Using —a in conjunction with -J
specifies the character set translation file (. x1t file) required for the conversion. Use -a
without - J only if the client character set is the same as the default character set.

You see this error message if the character translation file named with the —a parameter is
missing, or you mistype the name:

Error in attempting to determine the size of a pair of
translation tables. : 'stat' utility failed.

-A packet_size —specifies the network packet size to use for this bep session. For
example, set the packet size to 4096 bytes for the current bcp session, use:
bcp pubs2..titles out table out -A 4096

packet_size must be:

e Between the values of the default network packet size and maximum
network packet size configuration variables,

16
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* A multiple of 512.

To improve the performance of large bulk-copy operations, use network packet sizes that
are larger than the default value.

* -b batchsize—specifiesthe number of rows per batch of data copied. By default, bcp
in copies /7rows in one batch, where r7is equal to the batch size. Batch size applies only
when you are bulk copying in; it has no effect on bulk copying out. The smallest number
bep accepts for batchsizeis 1. The largest number bep accepts for batchsize is
2147483647L.

Note: Set the batch size to 1 for the SAP ASE server to allocate one data page to one row
copied in. This option applies only to fast bcp, and is useful only in locating corrupt rows
of data. Use -b1 with care—doing so causes a new page to be allocated for each row, and
is an inefficient use of space.

» —c—performs the copy operation using the cha r datatype as the default. This option does
not prompt for each field; it uses char as the default storage type, no prefixes, \ t (tab) as
the default field terminator, and \n (newline) as the default row terminator.

» —-C-—supports bulk copy of encrypted columns if the SAP ASE server supports encrypted
columns. —C enables the ciphertext option before initiating the bulk copy operation.

* -d discardfileprefix—logs the rejected rows into a dedicated discard file. The
discard file has the same format as the host file and is created by appending the input file
name to the discard file prefix supplied. You can correct the rows in this file and use the file
to reload the corrected rows.

* Youcanuse-d discardfileprefixwith-e errorfiletohelpidentifyand
diagnose the problem rows logged in the discard file.

» Specifying the —d option applies only when bulk copying in; itis silently ignored when
used in bulk copying out.

« If there are no rejected rows, no discard file is created.

« Ifyou use multiple input files, one discard file is created for every input file that has an
erroneous row. If there are no rejected rows, no discard file is created.

« If bcp reaches the maximum errors allowed and stops the operation, all the rows, from
the beginning of the batch until the failed row are logged.

* -e errfile-—specifiesthe full path name of an error file where bcp stores any rows that
it was unable to transfer from the file to the database. Error messages from bcp appear on
your terminal. bep creates an error file only when you specify this parameter.

We recommend thatyouuse —e errorfilewith-d discardfileprefixtohelp
identify and diagnose the problem rows logged in the discard file.
e -E —explicitly specifies the value of a table’s IDENTITY column.

By default, when you bulk copy data into a table with an IDENTITY column, bcp assigns
each row atemporary IDENTITY column value of 0. This is effective only when copying
datainto atable. bcp reads the value of the ID column from the data file, but does not send it
to the server. Instead, as bcp inserts each row into the table, the server assigns the row a

Utility Guide 17



CHAPTER 2: Utility Commands Reference

unique, sequential IDENTITY column value, beginning with the value 1. If you specify
the —E flag when copying data into a table, bcp reads the value from the data file and sends
it to the server, which inserts the value into the table. If the number of inserted rows
exceeds the maximum possible ITDENTITY column value, the SAP ASE server returns an
error.

By default, when you bulk copy data from a table with an IDENTITY column, bcp
excludes all information about the column from the output file. If you specify the -E flag,
bcp copies the existing IDENTITY column values into the output file.

The —-E parameter has no effect when you are bulk copying data out. the SAP ASE server
copies the TD column to the data file, unless you use the —N parameter.

You cannot use the -E and -g flags together.

-f formatfile —specifies the full path name of a file with stored responses from a
previous use of bcp on the same table. After you answer bep’s format questions, it prompts
you to save your answers in a format file. Creation of the format file is optional. The default
filenameisbcp. fmt. The interactive bcp program can refer to a format file when you are
copying data so that you do not have to duplicate your previous format responses. Use the
- £ parameter only if you previously created a format file that you now want to use for a
copy in or copy out operation. If you do not specify this parameter, bcp interactively
queries you for format information.

-F firstrow—specifiesthe number of the first row to copy (default is the first row). If
you use multiple files, this option applies to each file.

Do not use - F when performing heavy-duty, multiprocess copying, as doing so causes bcp
to generally spend more effort to run, and does not provide you with a faster process.
Instead, use —F for single-process, ad hoc copying.

Note: You cannot use -F with -—skiprows.

-g id_start_value —specifies the value of the IDENTITY column to use as a
starting point for copying data in.

Note: You cannot use the —-g and -E flags together.

-i input_file—specifies the name of the input file. Standard input (stdin) is used
as the default.

-1 interfaces_file—specifiesthe nameand location of the interfaces file to search
when connecting to the SAP ASE server. If you do not specify - T, bcp looks for an
interfaces file (sql.ini in Windows) in the SYBASE release directory.

-J client_charset—specifies the character set to use on the client. bcp uses afilter
to convert input between client _charsetand the SAP ASE character set.

-J client charset requests that the SAP ASE server convert to and from
client_charset, the character set used on the client.

18
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-J with no argument disables character set conversion. No conversion takes place. Use
this if the client and server use the same character set.

Omitting - J sets the character set to a default for the platform, which may not necessarily
be the character set that the client is using. For more information about character sets and
associated flags, see the Adaptive Server Enterprise System Administration Guide.

* -K keytab file—(Used only with Kerberos security) Specifies a Kerberos keytab
file that contains the security key for the user name specified with the —U option. To create
a keytab, see your Kerberos documentation.

If you do not supply the -K option, the bcp user must be logged in to Kerberos with the
same user name as specified with the —-U option.

* -L lastrow-—specifies the number of the last row to copy from an input file (default is
the last row). If you use multiple files, this option applies to each file.

* -labeled-—(secure SAP ASE only) indicates that the data you are importing already has
labels in the first field of every record.

For exporting data, this option indicates that you want the sensitivity label of every row to
be copied out as the first field.

* -m maxerrors—specifies the maximum number of errors permitted before bcp aborts
the copy. bcp discards each row that it cannot insert (due to a data conversion error, or an
attempt to insert a null value into a column that does not allow them), counting each
rejected row as one error. If you do not include this option, bcp uses a default value of
10.

If you use multiple partitions, the same number of maxerrors is used for every file.
* -M LabelName LabelValue —(Secure SAP ASE only) enables multilevel users to
set the session labels for the bulk copy. Values for Labe/Name are:

e curread (current reading level) —is the initial level of data that you can read during
this session, curread must dominate curwrite.

* curwrite (current write level) — is the initial sensitivity level that is applied to any
data that you write during this session.

* maxread (maximum read level) — is the maximum level at which you can read data.
This is the upper bound to which you as a multilevel user can set your curread during
the session. maxread must dominate maxwrite.

e maxwrite (maximum write level) — is the maximum level at which you can write
data. This is the upper bound to which you as a multilevel user can setyour curwrite
during a session. maxwrite must dominate minwrite and curwrite.

* minwrite (minimumwrite level)—isthe minimum level at which you can write data.
This is the lower bound to which you as a multilevel user can set curwrite during a
session. minwrite must be dominated by maxwrite and curwrite.
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LabelValueis the actual value of the label, expressed in the human-readable format used
on your system (for example, “Company Confidential Personnel”).

-n —performs the copy operation using native (operating system) formats. Specifying the
-n parameter means bcp does not prompt for each field. Files in native data format are not
human-readable.

Warning! Do not use:

* bcp in native format for data recovery or salvage or to resolve an emergency situation.

* bcp in native format to transport data between different hardware platforms, different
operating systems, or different major releases of SAP ASE.

* Field terminators (-t) or row terminators (-r) with bcp in native format.

Results are unpredictable and data may become corrupted.

Using bep in native format can create flat files that cannot be reloaded into the SAP ASE
server and it may be impossible to recover the data. If you cannot re-run bcp in character
format (for example, a table was truncated or dropped, hardware damage occurred, a
database was dropped, and so on) the data is unrecoverable.

-N—skips the IDENTITY column. Use this option when copying data in if your host data
file does not include a placeholder for the IDENTITY column values, or when copying
data out, if you do not want to include the TDENTITY column information in the host
file.

You cannot use both -N and -E parameters when copying data in.

-o output_file—specifiesthe name of the output file. Standard output (stdout) is
used as the default.

-P password—specifiesan SAP ASE password. If you do not specify - P, bcp prompts
for a password. Omit the —P flag if your password is NULL.

-Q—provides backward compatibility with bep for copying operations involving nullable
columns.

-r row_terminator —specifies the row terminator.

Warning! Do not use —t or —r parameters with bcp in native format. Results are
unpredictable and data may become corrupted.

When specifying terminators from the command line with the -t or —r parameter, you
must escape characters that have special significance to the UNIX operating system (or the
command prompt shell for Windows). See the examples for bcp for more information.
Either place a backslash in front of the special character or enclose it in quotes. This is not
necessary when bcp prompts you (interactive mode).

-R remote_server principal —specifies the principal name for the server. By
default, a server’s principal name matches the server’s network name (which is specified
with the —s option or the DSQUERY environment variable). Use the -R option when the
server’s principal name and network name are not the same.
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* -8 server—specifies the name of the SAP ASE server to connect to. If you specify -S
with no argument, bep uses the server specified by the DSQUERY environment variable.

* -t field_terminator —specifies the default field terminator.

* -T text_or_ image_size—allows you to specify, in bytes, the maximum length of
text or image data that the SAP ASE server sends. The default is 32K. Ifa text oran
image field is larger than the value of - T or the default, bcp does not send the overflow.

* -U username-—specifiesan SAP ASE login name. If you do not specify this option, bcp
uses the current user’s operating system login name.

» —v —displays the version number of bcp and a copyright message and returns to the
operating system.

SDK binaries like bcp have the same names in both the 32-bit and 64-bit products.
Installing SAP ASE, the SDK, or Open Server 64-bit products with other 32-bit products
overwrites the 32-bit binaries. Starting with SAP ASE 15.0.2 and SDK/Open Server 15.0
ESD #9, the 64-bit binaries have been replaced with 32-bit binaries on all 64-bit UNIX
platforms. Since 32-bit binaries are included in the 64-bit EBF, the —v option of bcp is no
longer a valid way to check the EBF number for 64-bit products. Instead, use the UNIX
strings and grep commands to confirm the EBF numbers for SAP ASE.

For example, to find the string containing the EBF number in the libsybct64.a library,
enter:

strings -a libsybct64.a | grep Sybase

This returns a string similar to:

Sybase Client-Library/15.5/P/DRV.15.5.0/SPARC/Solaris
8/BUILD1550-001/64bit/0OPT/Mon Aug 10 23:04:17 2009

To find the string containing the EBF number in the libsybsrv64.a library, enter:
strings -a libsybsrv64.a | grep Sybase

This returns a string similar to:

Sybase Server-Library/15.5/P/DRV.15.5.0/SPARC/Solaris
8/BUILD1550-001/64bit/OPT/Mon Aug 10 23:06:27 2009

* -V security_options —specifies network-based user authentication. With this
option, the user must log in to the network’s security system before running the utility.
Users must supply their network user name with the -U option; any password supplied
with the - P option is ignored.

To enable additional security services, follow -v with a security options string of key-
letter options:

* ¢ —enables data confidentiality service.

e i —enables data integrity service.

* m - enables mutual authentication for connection establishment.
* o —enables data origin stamping service.
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e r —enables data replay detection.
e g - enables out-of-sequence detection.
-W —specifies that if the server to which bcp is attempting to connect supports neither

normal password encryption nor extended password encryption, plain text password
retries are disabled.

If you use this option, the CS_SEC_NON_ENCRYPTION_RETRY connection property
is set to CS_FALSE, and plain text (unencrypted) passwords are used, the connection is
not retried.

-x trusted. txt_ file —specifies an alternate frusted.ixtfile.

-X —specifies that, in this connection to the server, the application initiates the login with
client-side password encryption. bep (the client) specifies to the server that password
encryption is desired. The server sends back an encryption key, which bcp uses to encrypt
your password, and the server uses the key to authenticate your password when it arrives.

This option results in normal or extended password encryption, depending on connection
property settings at the server. If CS_SEC_ENCRYPTION is set to CS_TRUE, normal
password encryption is used. If CS_SEC_EXTENDED_ENCRYPTION is set to
CS_TRUE, extended password encryption is used. If both CS_SEC_ENCRYPTION and
CS_SEC_EXTENDED_ENCRYPTION are set to CS_TRUE, extended password
encryption is used as the first preference.

If bep fails, the system creates a core file that contains your password. If you did not use the
encryption option, the password appears in plain text in the file. If you used the encryption
option, your password is not readable.

-y alternate_home_directory —sets an alternate Sybase home directory.

-Y — specifies that character-set conversion is disabled in the server, and is instead
performed by bcp on the client side when using bcp out

Note: A client-side Unicode conversion is supported only for SAP ASE 15.0 and later.

During bep out, all character-set conversion is done in the server.

-z language —is the official name of an alternate language the server uses to display
bcp prompts and messages. Without the -z flag, bcp uses the server’s default language.

Add languages to an SAP ASE server during installation or afterwards, using either the
langinstall utility (langinst in Windows) or the sp_addlanguage system procedure.

If an incorrect or unrecognized language is named with the -z parameter, you see this
error message:

Unrecognized localization object. Using default value
'us_english'.

Starting copy...

=> warning.

-Z security mechanism—specifies the name of a security mechanism to use on the
connection.
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Security mechanism names are defined in the SSYBASE/install/libtcl.cfg
configuration file. The default mechanism is used if you do not supply
security mechanism name.

e --colpasswd [[database name
[owner] .] table_name.]column _name [password]]] —setsthe passwords
for encrypted columns by sending set encryption passwd password for
column column name tothe SAP ASE server. This does not automatically apply
passwords to other encrypted columns, even if the second column is encrypted with the
same key. Supply the password a second time to access the second column.

e -—-hide-vcc —instructs bcp not to copy virtual computed columns (VCC) either to or
from a data file. When you use this option in bcp out, the data file contains no data for
VCC. When you use it in bep in, the data file may contain no data for a VCC.

If you use this option, the SAP ASE server does not calculate or send virtual computed
column data.

* --initstring "Transact-SQL command" —sends Transact-SQL commandsto
the SAP ASE server before data is transferred.

Result sets issued by the initialization string are silently ignored, unless an error occurs. If
the SAP ASE server returns an error, bcp stops before data is transferred, and displays an
error message.

« --keypasswd [[database name.[owner].]key name [password]]]
— sets passwords for all columns accessed by a key by sending set encryption
passwd password for key key name tothe SAP ASE server.

* --maxconn maximum_connections —isthe maximum number of parallel
connections permitted for each bulk copy operation. You must use bcp_r, the threaded
version of the bep utility, to copy multiple files in parallel. For example, the following
example sets the maximum number of parallel connection permitted for each operation to
2:

bcp r --maxconn 2

If you do not include this option, bcp uses the default value of 10.

* --show-£i —instructs bcp to copy functional indexes, while using either bcp in or bep
out. If you do not specify this option, the SAP ASE server generates the value for the
functional index.

» --skiprows nSkipRows — instructs bcp to skip a specified number of rows before
starting to copy from an input file. The valid range for --skiprows is between 0 and the
actual number of rows in the input file. If you provide an invalid value, you see an error
message.

Note: You cannot use --skiprows with the —F option.
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Examples

Character datatype (-c) — The —-c option copies data out of the publishers table in
character format (using char forall fields). The -t field terminatoroptionends
each field with a comma, and the ~r row terminator option ends each line with a
Return. bcp prompts only for a password. The first backslash before the final “r” escapes
the second so that only one backslash prints.

In UNIX:
bcp pubs2..publishers out pub out -c -t , -r \\r

In Windows:
bcp pubs2..publishers out pub out -c -t , -r \r

Encrypted columns (-C) — The —C parameter copies data out of the publishers table
(with encrypted columns) in cipher-text format instead of plain text. Press Return to accept
the defaults specified by the prompts. The same prompts appear when copying data into
the publishers table:

bcp pubs2..publishers out pub_ out -C

Password:

Enter the file storage type of field pub_id [char]:
Enter prefix length of field pub id [0]:

Enter length of field pub id [4]:

Enter field terminator [none]:

Enter the file storage type of field pub name [char]:
Enter prefix length of field pub name [1]:

Enter length of field pub name [40]:

Enter field terminator [none]:

Enter the file storage type of field city [char]:
Enter prefix length of field city [1]:

Enter length of field city [20]:

Enter field terminator [none]:

Enter the file storage type of field state [char]:
Enter prefix length of field state [1]:

Enter length of field state [2]:

Enter field terminator [none]:

In UNIX, you are then asked:
Do you want to save this format information in a
file? [Y-n] y
Host filename [bcp.fmt]: pub form
Starting copy...
3 rows copied.
Clock Time (ms.): total = 1 Avg = 0 (3000.00 rows per sec.)
Copy out to a file— Copies data from the publishers table to a file named pub_out for
later reloading into the SAP ASE server. Press Return to accept the defaults that the
prompts specify. The same prompts appear when copying data into the publishers table:

bcp pubs2..publishers out pub out

Password
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Enter the file storage type of field pub_ id [char]:
Enter prefix length of field pub id [0]:

Enter length of field pub id [4]:

Enter field terminator [none]:

Enter the file storage type of field pub name [char]:
Enter prefix length of field pub name [1]:

Enter length of field pub name [40]:

Enter field terminator [none]:

Enter the file storage type of field city [char]:
Enter prefix length of field city [1]:

Enter length of field city [20]:

Enter field terminator [none]

Enter the file storage type of field state [char]:
Enter prefix length of field state [1]:

Enter length of field state [2]:

Enter field terminator [none]:

You are then asked:

Do you want to save this format information in a
file? [Y-n]

Host filename [bcp.fmt]: pub form

Starting copy...

3 rows copied.

Clock time (ms.): total = 1 Avg = 0 (3000.00 rows per

sec.)

* Copy in — Copies data back into the SAP ASE server using the saved format file,

pub_ form:

bcp pubs2..publishers in pub out -f pub form

* Client character set (-J) —Copies a data file created with the iso_1 character set into the
pubs2. .publishers table. The -z flag displays bcp messages in French:
bcp pubs2..publishers in datafile -J iso 1 -z french

e Partitions— Copies data out of partition p1 of table t1 to the mypart.dat file in the
current directory:
bcp tl partition pl out mypart.dat

To copy in:
bcp tl partition pl in mypart.dat

Tocopyfilesdata.first,data.lastanddata.other intopartitionspl,p2,and
p3, respectively:

bcp tl partition pl, p2, p3 in data.first, data.last,
data.other

To copy partitionpl, p2,and p3 tofiles a, b, and c respectively, into the \work2\data
directory:

bcp tl partition pl, p2, p3 out \work2\data\l,
\work2\data\b, \work2\data\c
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Setting limits (--initstring) — Limits this to the current session, disabling replication for
the bcp connection during the transfer of data from titles. txt datainto
pubs2..titles.

bcp pubs2..titles in titles.txt —--initstring 'set replication off'

You need not explicitly reset the configuration option after bep is finished. If the SAP ASE
server returns an error, bep stops the data transfer and displays an error message.

Passwor d (-P) — Sets the password to pwd1 for the encrypted column col1:

bcp mydb. .mytable out myfile -U uuu -P ppp —-colpasswd
db..tbl.coll pwdl

Passwor d prompts— Sets a prompt to enter the password for encrypted column col1:

bcp mydb. .mytable out myfile -U uuu -P ppp —-colpasswd
db..tbl.coll

Enter column db..tbl.coll’s password: ***?

External file password — Reads the password for encrypted column col11 from an

external OS file named “passwordfile™:

bcp mydb. .mytable out myfile -U uuu -P ppp —-colpasswd
db..tbl.coll < passwordfile

Encrypted key password — Sets password pwd1 for encryption key key1:

bcp mydb. .mytable in myfile -U uuu -p ppp —-keypasswd
db..keyl pwdl

Discard file (-d) — Creates the discard file reject titlesfile.txt:

bcp pubs2..titles in titlesfile.txt -d reject

Security (-V) —For MIT Kerberos, requests credential delegation and forwards the client

credentials to MY_GATEWAY:
bcp -Vd -SMY GATEWAY

Skip rows (--skiprows) —bcp ignores the first two rows of the input file titles. txt,
and starts to copy from the third row:
bcp pubs2..titles in titles.txt -U username -P password
--skiprows 2
Alternate directories (-y) — Sets an alternate Sybase home directory:
bcp tempdb..T1l out Tl.out -y/work/NewSybase -Uuserl
-Psecret -SMYSERVER
Text and image sizes (-T) — Specifies that the SAP ASE server send 40K of text or
image data using a packet size of 4096 bytes:

bcp pubs2..publishers out -T 40960 -A 4096
Maximum number of connections (--maxconn) — Sets 2 as the maximum number of
parallel connections permitted for each operation.

bcp r --maxconn 2
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* Materialized computed columns— Copies out database db_ 1, which includes table t 1
with materialized computed column c1:
bcp db 1..tl out db 1.dat -Usa -P -S big db -I./interfaces -f ./
bcp. fmt
The following then copies in the data file (db_1.dat) containing table t1 with
materialized computed column c1:
becp db 1..tl in db 1.dat -Usa -P -S big db -I./interfaces -f ./
bcp. fmt

* Fast logging—Enables fast-logged bcp when you transferthe t i t 1es . txt datainto the
pubs2..titles table:

bcp pubs2..titles in titles.txt --initstring 'set logbulkcopy on'

Permissions

You must have an SAP ASE account and the appropriate permissions on the database tables or
views, as well as the operating system files to use in the transfer to use bcp.

« To copy data into a table, you must have insert permission on the table.
« To copy a table to an operating system file, you must have select permission on these
tables:
» The table to copy
e sysobjects
¢ syscolumns
¢ sysindexes

Auditing
Values in event and extrainfo columns are:
Eve [Auditop- |Command or | Information in extrainfo
nt tion access audi-
ted
4 bep bep in e Roles— Current active roles
*  Keywords or options— NULL
*  Previous value— NULL
e Current value— NULL
e Other information— NULL
*  Proxyinformation- Original login name, if set proxy
in effect
Tables used

sysaudits 01 - sysaudits 08
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See also

Chapter 3, Using bcp to Transfer Data to and from SAP ASE on page 169
Bulk Copying Encrypted Data on page 186

Threaded Versions of Utilities on page 1

Chapter 2, Utility Commands Reference on page 5

Database Creation and Manipulation Utilities on page 3

Usage for bcp

There are a number of considerations when using bcp.

bcp_ris a threaded version of bep.

You cannot use named pipes to copy files in or out.

Using --hide-vcc improves performance because the SAP ASE server does not transfer
and calculate data from virtual computed columns.

Although you can use any Transact-SQL command with --initstring as an initialization
string for bep, reset possible permanent changes to the server configuration after running
bep. You can, for example, reset changes in a separate isql session.

slice_numberis included for backward compatibility with SAP ASE 12.5.x and earlier,
and can be used only with round-robin partitioned tables.

Specify either partition_id or partition_name, but not both.

If you provide no partition name, bcp copies to the entire table.

You can specify multiple partitions and data files. Separate each partition name or data file
with commas.

bep provides a convenient and high-speed method for transferring data between a database
table or view and an operating system file. bcp can read or write files in a wide variety of
formats. When copying in from a file, bcp inserts data into an existing database table;
when copying out to a file, bcp overwrites any previous contents of the file.

Upon completion, bcp informs you of the number of rows of data successfully copied, the
total time the copy took, the average amount of time in milliseconds that it took to copy one
row, and the number of rows copied per second.

bcp does not insert any row that contains an entry exceeding the character length of the
corresponding target table column. For example, bcp does not insert a row with a field of
300 bytes into a table with a character-column length of 256 bytes. Instead, bcp reports a
conversion error and skips the row. bcp does not insert truncated data into the table. The
conversion error is as follows:

cs_convert: cslib user api layer: common library
error: The result is truncated because the
conversion/operation resulted in overflow

To keep track of data that violates length requirements, run bcp with the -e log-file name
option. bep records the row and the column number of the rejected data, the error message,
and the data in the log file you specify.
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To restrict the functionality of bcp to that of a previous version, set the CS_BEHAVIOR
property in the [bcp] section of the ocs . cfg file:

[bep]
CS_BEHAVIOR = CS_BEHAVIOR 100

If CS_BEHAVIOR is not set to CS_BEHAVIOR_100, you can use functionality for bcp
11.1 and later.

e If bep is invoked and no value is supplied for the -c, -f, or -n parameters, a bcp prompt
requests the file storage type. The file storage type can be any valid SAP ASE datatype.
Storage types for the bigdatetime and bigtime SAP ASE datatypes are specified

as:
Storage Type Table Datatype
A bigdatetime
B bigtime

* You can specify these datatypes for a bcp format file using the bigdatetime or
bigtime datatypes:

Storage Format SAP ASE Datatype
SYBBIGDATETIME bigdatetime
SYBBIGTIME bigtime

» Use bep to copy encrypted data in and out of the server.

* bcp versions 15.7 and later allow you to copy data into tables that contain nonmaterialized
columns.

« Error message format is different than in versions of bcp earlier than 15.7. If you have
scripts that perform routines based on the values of these messages you may need to
rewrite them, for example:

The display message that indicates the number of rows

transferred has been changed. During a session, this

version of bcp periodically reports a running total

of rows transferred. This message replaces the "1000

rows transferred" message displayed by the previous

bcp.

* When using bcp out:

o If partition_name and datafile are both specified, then either datafile must specify a
single data file, or specify a one-to-one mapping between partition names and data
files.

« If datafile is not specified, data from each partition is copied to a file named for the
named partition with a.dat extension. For example, if the partition name isptn1, the
datafileisptnl.dat.

* You may use initstring to run any Transact-SQL command, but you must reset any
permanent changes to the server initstring causes after bcp finishes. For instance, as in the
example for the password (-p) parameter, if the SAP ASE account does not have the

Utility Guide 29



CHAPTER 2: Utility Commands Reference

appropriate permissions, the SAP ASE server returns an error message for the
initialization string. bep displays the server error message and stops before any data is
transferred.
Result sets issued by the initialization string are silently ignored unless an error occurs.
* When using bep in, if partition_name is specified, datafile must specify a corresponding
number of data files
» If you see a message similar to the following, the character translation file specified with
the -q parameter is missing, or you mistyped the name:

Error in attempting to load a view of translation tables.
See also:

»  Open Client™ and Open Server™ Configuration Guide — the description for
libtcl.cfg for security mechanism names

e Performance and Tuning Guide— on how changing certain parameters can affect bcp for
large batches

*  Reference Manual: Commands — insert

» Reference Manual: Procedures — sp_audit, sp_dboption, sp_displayaudit

«  System Administration Guide — character sets and associated flags

Copying Tables with Indexes or Triggers Using bcp

bcp is optimized to load data into tables that do not have associated indexes or triggers. It loads
data into tables without indexes or triggers at the fastest possible speed, with a minimum of
logging. Page allocations are logged, but row insertions are not.

When you copy data into a table that has one or more indexes or triggers, a slower version of
bep is automatically used, which logs row inserts. This includes indexes that are implicitly

created using the unique integrity constraint of a create table command. However, bcp does
not enforce the other integrity constraints defined for a table.

Since the fast version of bcp inserts data without logging it, the system administrator or
database owner must first set the sp_dboption procedure:

sp_dboption dbname, "select into/bulkcopy", true
If the option is not true and you try to copy data into a table that has no indexes or triggers, the

SAP ASE server generates an error message. You need not set this option to copy data out to a
file or into a table that contains indexes or triggers.

Note: Because bep logs inserts into a table that has indexes or triggers, the log can grow very
large. You can truncate the log with dump transaction to truncate the log after the bulk copy
completes, and after you have backed up your database with dump database.

While the select into/bulkcopy option is on, you cannot dump the transaction log. Issuing
dump transaction produces an error message instructing you to use dump database instead.
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Warning! Ensure that you dump your database before you turn off the select into/bulkcopy
flag. You cannot recover your data if you have inserted unlogged data into your database and
you then perform dump transaction before performing dump database.

Unlogged bcep runs slowly while a dump database is taking place.

Table 1. Comparing fast and slow bcp

select into/bulkcopy on | select into/bulkcopy off

Fast bcp — no indexes or trig- | Yes—dump transaction prohibi- | No — the SAP ASE server forces
gers on target table ted slow bep

Slow bcp — one or more in- | Yes—dump transaction prohibi- | Yes — dump transaction OK
dexes or triggers ted

By default, the select into/bulkcopy option is off in newly created databases. To change the
default, turn the option on in the mode1 database.

Note: The performance penalty for copying data into a table that has indexes or triggers can be
severe. If you are copying in a large number of rows, it may be faster to:

1. Use drop index (or alter table for indexes) and drop trigger to drop all the indexes and
triggers

Set the database option.

Copy the data into the table.

Re-create the indexes and triggers.

Dump the database.

S A

However, you must allocate extra disk space for the construction of indexes and triggers—
about 2.2 times the amount of space needed for the data.

Using bcp with Compressed Data

Pages in a compressed table may have a combination of row-, page-, or uncompressed rows.
Tables and partitions listed as not compressed may contain a mixture of rows in different
states of compression because you may have created them when the table’s compression level
was different.

* bcp out:
» Decompresses compressed rows and returns them to the client, either in native or
character form.

e Supports IDENTITY, encrypted columns, and so on.
» Returns text data as uncompressed.

* bcp in compresses uncompressed data received from the client according to the table or
partition’s compression level.
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Using bep to copy data out and then bep it back in to a table that is configured for compression
results in compressed data, even if the data was originally uncompressed.

buildmaster

SAP ASE does not use the buildmaster binary to build the master device. Instead, it has
incorporated the buildmaster functionality in the dataserver binary.

See also
e Chapter 4, Using dataserver Build Servers on page 215
e Chapter 2, Utility Commands Reference on page 5

certauth

This utility is deprecated. As a replacement, SAP ASE includes the openssl open source
utility.

The openssi utility is located in:

* (UNIX) $SYBASE/$SYBASE OCS/bin.
* (Windows) $SYBASE%$\$SYBASE OCS%\bin.

See the OpenSSL Web site for details.

See also
» Chapter 2, Utility Command’s Reference on page 5

certpkl?

This utility is deprecated. As areplacement, SAP ASE includes the openssl open source utility

The openssi utility is located in:

* (UNIX) $SYBASE/$SYBASE OCS/bin.
* (Windows) $SYBASE%$\$SYBASE OCS%\bin.

See the OpenSSL Web site for details.

See also
e Chapter 2, Utility Commands Reference on page 5
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certreg

This utility is deprecated. As a replacement, SAP ASE includes the openssl open source
utility

The openssl utility is located in:

* (UNIX) $SYBASE/$SYBASE OCS/bin.
* (Windows) $SYBASE%\%SYBASE 0OCS%\bin.

See the OpenSSL Web site for details.

See also
o Chapter 2, Utility Commands Reference on page 5

charset
(UNIX only) Loads the character sets and sort order files in the SAP ASE server.

The utility is located in $SYBASE/$SYBASE ASE/bin.

Syntax

charset
[-Ppassword]
[-Sserver]
[-Iinterface]
sort order
[ charset ]

Or

charset -v

Parameters

* -P password-—specifies your password. If you do not specify - P, charset prompts for
your password.

* -8 server —specifies the name of the server on which to change the character set and
sort order.

* -I interface —specifies the network interface used by the server.

* sort_order —specifies the name of the sort order file the SAP ASE server will use.

* charset —specifies the character set the SAP ASE server will use.

» —v —displays the version number and copyright message for charset.
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Usage

Before using charset, set your SYBASE environment variable to point to the current release
directory.

See also set command in Reference Manual: Commands.

Permissions

You must be a system administrator to use charset.

See also
e Chapter 2, Utility Commands Reference on page 5
o Ulilities for Languages, Character Sets, and Sort Orders on page 2

cobpre

Precompiler for COBOL.
The utility is located in:

+ (UNIX) $SYBASE/$SYBASE OCS/bin.
+ (Windows) $SYBASES\%SYBASE 0OCS%\bin.

For a full description of cobpre, see the Open Client and Open Server Programmer's
Supplement.

See also
e Threaded Versions of Utilities on page 1
o Chapter 2, Utility Commands Reference on page 5

cpre

Precompiler for C.
The utility is located in:

* (UNIX) $SYBASE/$SYBASE OCS/bin.

* (Windows) $SYBASE%\$SYBASE OCS%\bin.

For a full description of cpre, see the Open Client and Open Server Programmer's
Supplement.

See also
e Threaded Versions of Utilities on page 1
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e Chapter 2, Utility Commands Reference on page 5

dataserver

(UNIX only) The executable form of the SAP ASE program, located in $SYBASE/
$SYBASE ASE/bin.

Syntax

dataserver [-f] [-g] [-G] [-h] [-H] [-m] [-q] [-v] [-X]
[-A system role

a path to CAPs directive file]

b master device size [k | K | m | M | g | G | t | T] ]

c config file for server]

d device name]

D default db size]

e path to error log]

i interfaces file directory]

K keytab file]

L config file name for connectivity]

M shared memory repository directory]

N licinstant]

n

P

r

s

T

u

w

y

z

Z

system privileges

sa login name]
mirror disk name]

server name]

trace flag]

sa/sso_name]

master | model database]
[password] ]

page size [ k | K] ]
initial master db size]

Syntax for the Cluster Edition:

dataserver

-u, --admin-name=sa/sso_name
—--buildgquorum=[ force]

-a, --caps-file=filename

-F, --cluster-input=filename
--cluster-takeover

-L, --conn-config-file=[filename]
--create-cluster-id [=quorum]

-D, --default-db-size=size spec

-e, -—-error-log=[filename]

-G, —--event-log-server=logserv name

-f, —--forcebuild

-H, --ha-server

-h, --help=[{0|112|3}[,display width]]
--instance=instance name

-y, ——key-password=[key password]
-K, --keytab-file=filename
-N, --license-prop-file=filename
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-z,
_Z,
_d,
_b,

-r,
-m,
—9y
-n,
_QI
-d,
-w,
-A,
—by
_k,
-M,
-X,
-T,

Or

--logical-page-size=page size
--master-db-size=size spec
--master-dev=master device name
--master-dev-size=[size spec]
--master key password [=password]
--master-mirror=filename
-—-masterrecover

--no-event-logging
--permission-login=system privilege
-—quorum-dev=quorum dev
--recover—-gquiesced
--rewrite-db=database name
--role-logins=system role
--sa-name={SS0O_login account | sso_role | sa role}
--server-principal=s principal
--shared-mem-dir=directory name
-—-sybmon

-—trace=trace flag

--version

dataserver -v

Parameters

-A system_role—when enable granular permissions is set to 0, and all users are
unable to log into the SAP ASE server, provides the server administrator with a login
account with sso_role.

-a path to CAPs directive_ file —specifies the path to the CAPs directive
file.

-b master device size [ k | K | m | M| g | G| t | T]-
specifies the size of the master device or database you want to build. The server calculates
the sizes, so you can use “K”, “M”, “G”, and “T” instead of exact byte numbers.

-c config file for server—specifies the full path name of an SAP ASE
configuration file. Use this parameter to start the SAP ASE server with the configuration
values in the specified configuration file. If you specify a configuration file with the
dataserver -c parameter, make sure all the parameters in this configuration file are
compatible before you boot the server. If some of the configuration parameters are
incompatible, the server may not boot. To avoid this, do not specify a configuration file
when you build the master device. The build phase uses all default settings when you do
not specify a configuration file.For more information, see the System Administration
Guide.

-D default_db_size—declares how large the model database should be when
creating a new installation. This sets the size of the smallest permitted database. Syntax is
identical to the -b s1ize parameter. -D is only valid when used in conjunction with -b.
Default varies by server page size, because the smallest acceptable size is 1024 logical
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pages: 2 Mb on a 2k page, 4 Mb on an 8k page, and so on. If the flag provides a size smaller
than the minimum, the server adjusts it up to the minimum.

* -d device_name —is the full path name of the device for the master database. The
master database device must be writable by the user who starts the SAP ASE server. If you
do not use the -d parameter, the default master database device name is d master.

* -e errorlogfile—is the full path name of the error log file for SAP ASE system-
level error messages.

» —f —forces initialization of a device or database. - £ is valid only when used with -b
and/or —w. The server fails to boot if you use - £ without either -b or —-w. —f forces the
server in different ways, depending whether —w is present.

* -G logserv_name —specifies the name of the event log server.

* —g—turns off event-logging.

» -H-starts the high availability (HA) server, if you have the HA feature installed on your
SAP ASE server.

* -h —prints this help message, then exists.

* -i interfaces_file directory —specifies the directory location of the
interfaces file to search when connecting SAP ASE. If - T is omitted, dataserver looks for
a file named interfaces in the directory pointed to by your SYBASE environment
variable.

* -K keytab file-—specifiesthe path to the keytab file used for authentication in DCE.

* -k, --server-principal=s_principal —specifies the server principal name.

* -L config file name for connectivity —specifies the name the
configuration file for connectivity.

* -M sharedmem directory —places shared memory files in the specified directory
instead of in the default location, $SYBASE. If sharedmem_directory starts with “/”, the
directory name is assumed to be absolute. Otherwise, the directory name is interpreted
relative to SSYBASE.

* --master_key password [=password] —specifies the master key password
when you provide the password on the command line or prompts for a master key
password during SAP ASE startup. The password characters are not displayed, and the
password is not validated until later in the SAP ASE startup sequence.

If you include the password on the command line, it is visible until the memory is read and
used.

e —m - starts the SAP ASE server in single-user mode.

* -N licinstant —specifies a nondefault directory location for the license cache file.
The default location is $SYBASE/$SYBASE ASE/sysam/
server name.properties.

* -n system privileges—whenenablegranular permissionsissetto 1, and all users
are unable to log into the SAP ASE server, provides the server administrator with a login
account with change password privilege.
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-p sso_login_name —specifies the login name of a system security officer when
starting the SAP ASE server, for the purposes of getting a new password for that account.
SAP ASE generates a random password, displays it, encrypts it, and saves it in
master..syslogins as that account’s new password.

Because SAP ASE passwords are encrypted, you cannot recover forgotten passwords. If
all system security officers lose their passwords, the —-p parameter generates a new
password for a system security officer account. Start the SAP ASE server with -p,
immediately log in to the SAP ASE server with the new random password, and execute
sp_password to reset your password to a more secure one.

-q —treats quiesced databases as “in recovery.”

-r mastermirror—starts the mirror of the master device. Use this parameter to start
the SAP ASE server if the master device has been damaged.

-s servername —specifies the name of the SAP ASE server to start.

If you do not specify an SAP ASE name with the —s parameter, and you have not set the
DSLISTEN environment variable, dataserver uses the default SAP ASE name SYBASE.
The value of the DSLISTEN environment variable overrides this default value, and the -s
parameter overrides both the default and the DSLISTEN environment variable.

-T trace_flag-specifies a trace flag number.

-u sa/sso_name —specifies the system administrator or system security officer’s
name you want to unlock.

-v — prints the version number and copyright message for dataserver, then exits.

-w [master | model] —specifies whether you want to write amaster or model
database.

When you use the —w parameter, dataserver uses the ascii-8 character set instead of the
iso_1 character set. If you require the iso_8 character set for master, load adump of the
master database or change the character set with sqlloc (sglloc requires the
sybsystemprocs database.)

-X —starts this server as sybmon, not dataserver.

-y [password] —allowsyou to assign a password for the encrypted private key, so that
the server prompts the user for a password. This password should match the password you
used to encrypt the private key when it was created. You cannot use this parameter when
you are running the server in the background.

Note: Although you can set a password with -y, for security reasons Sybase strongly
discourages you from doing so.

A private key is included with your server’s digital certificate. By default, the certificate
file located at /usr/local/sybase/certificates/<servername>.crt.

The location of the certificate file changes if you invoke the sp_ssladmin addcert
command.
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* -Z [initial master db size] —declares how large the master database
should be when creating a new installation, setting the size of the smallest permitted
database. Syntax is identical to the -b size parameter. -D is only valid when used in
conjunction with -b. Default varies by server page size, because the smallest acceptable
size is 3072 logical pages: 6MB on a 2K page, 12MB on an 8K page, and so on. If the flag
provides a size smaller than the minimum, the server adjusts it up to the minimum.

* -z page size [ k | K ] —specifies the page size of the server. Use b and ~w to
use this flag, and name an even power of two between 2K and 16K, or else the server does
not boot.

Examples
e Createnew installation — Creates a new installation with a 100MB master device and a
4K page:

dataserver -d my master device -z 4k -b 100.02M

The spaces between options and their following arguments are optional and acceptable.
This example specifies “100.02M” for a 100MB master device because the server requires
16K of overhead for its configuration area.

* Rewrite database — Rewrites a corrupt mode1 database:

dataserver -d d master -w model -s server name

* Rewrite database with device size — Rewrites a corrupt ma s ter database, specifying
device size:

dataserver -d my master device -w master -z 4k

* Rewrite database with device and page sizes— Rewrites a corrupt master database,
specifying device and page sizes, forcing the server to accept these values in preference to
what it may find in the config block:
dataserver -d my master device -w master -z 4k -b

100.02M -£

* Rewritedatabase with nonmatching page size (gener ates error) — Rewrites a corrupt
master database, specifying a page size that does not match what the server finds in its
config block. This produces a failure:

dataserver -d my master device -w master -z 8k

00:00000:00000:2001/01/19 12:01:26.94 server The
configured server page size does not match that
specified on the command line. To use the configured
size, omit the command line size; to use the command
line size, specify 'force' (-f).
* Rewrite database with incorrect page size (generates error) — Rewrites a corrupt
master database, specifying an incorrect page size, even in a normal restart. This
produces a failure:

dataserver -d my master device -z4000
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dataserver: the 'z' flag may not be used without 'b' or
'w'. dataserver: server will ignore the 'z' flag.
dataserver: the 'z' flag contained an invalid page size.
dataserver: the page size must be an even power of two
between 2048 and 16384 bytes, inclusive.
» Specify principal name — Specifies the “aseprincipal@myrealm.com” principal name:
$SYBASE/SSYBASE ASE/bin/dataserver -dmaster.dat
-s secure ase -k aseprincipal@myrealm.com
e Prompt for password — Prompts for a master key password:

dataserver --master key passwd -dd master -eerrorlog

* List with role— List account names with role sso_role:
$SYBASE/$SYBASE ASE/bin/dataserver
-d master.dat
-S serveriname
-A sso role
(Cluster Edition) To list account names with role login for sso_role:

$SYBASE/$SYBASE ASE/bin/dataserver
-d master.dat
=S serveriname
--role-logins sso_role
* List with change password privilege — List account names with privilege change
password:

$SYBASE/$SYBASE ASE/bin/dataserver

-d master.dat

-S server_name

-n "change password"

(Cluster Edition) To list account names with permission logins change password:

$SYBASE/$SYBASE7ASE/bin/dataserver

-d master.dat

-s server name

--permission-logins "change password"

Permissions
Anyone with execute permission on the binary, and who has read/write access to all the files.

After you have finished running the SAP ASE installation program, set the file permissions on
the dataserver executable to limit who can execute it.

See also

» Dependencies and Conditions of dataserver -b and -w Optfons on page 41

» Potential Issues of Using dataserver -f and -w Options Togetheron page 42
» Chapter 4, Using dataserver Build Servers on page 215

* startserveron page 138

» Chapter 2, Utility Commands Reference on page 5
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Installation or Configuration Ulilities on page 1
Utilities to Start Servers on page 3

Usage for dataserver

There are additional considerations when using dataserver.

dataserver allows you to create devices and databases that are up to 32GB in size,
depending on the limitation of your operating system. For more information on size limits,
see the installation guide for your platform.

Start the SAP ASE server with the startserver command rather than by directly executing
the dataserver program. If you need to change any of the default values, edit the
RUN_servernane file in your Sybase installation directory.

Automatic login lockouts can cause a site to end up in a situation in which all accounts
capable of unlocking logins (system administrators and system security officers) are
locked. If this occurs, use the dataserver utility with the —u parameter to check the
specified login for system administrator or system security officer authorization, unlock
the account, and reset the value of the current failed logins counter to zero.

See also:

Reference Manual: Commands— disk mirror, disk remirror, disk unmirror
Reference Manual: Procedures — sp_ssladmin, addcert

See also

Startserveron page 138

Dependencies and Conditions of dataserver -b and -w Options

The effect of -b changes depending on whether -w is present.

-b without -w creates a new master device as named by -d (the default is d master)and
with the page size as specified by -z (the default is 2048). If the named device:
« Already exists as an OS file — the attempt fails, and you see a message such as:

File already exists. You must remove the existing
file before attempting to create a new one using
the server's -b option.

Unable to create master device.

« Names an existing raw partition — the attempt fails unless you include the-f flag. This
reinitializes the raw partition as a server master device.

-b with -w master tells dataserver to use the size specified in -z for the master device

when re-creating the master database. It implies nothing about creating a new device.

—-w may or may not require additional flags if you use:

-wmodel —the -z and -b flags are accepted but ignored.
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* -wmaster for new installations — -z and -b are not required because the device size
information is stored in the config block.

* -wmaster to upgrade older installations:
» The server requires -b and/or -z if the config block does not contain a valid entry

for the associated size(s). The command fails if it cannot get valid data for the page size
or device size.

* Provide -b and/or -z when the config block contains valid entries for the sizes
they represent. However if the sizes do not match whatisinthe config block,add
-f to force your new size preferences.

Potential Issues of Using dataserver -f and -w Options Together
Be particularly careful when using the -f and -w options together.

When rewriting master database using the -w option, the server requires that the
configuration block page size and device size are correct. If you do not provide them on the
command line they must agree. The server refits the master device, and puts master and all
other included databases back in their proper places.

When you use the -f option to force initialization, your page size and master device size
override those in the configuration block. In addition, -f assigns all other unknown spaces—
allocation blocks that are either unused or are corrupted—to the master database.

ddigen

A Java-based tool that generates definitions for server- and database-level objects in an SAP
ASE server.

The command-line version of ddlgen is located in:

* (UNIX) $SYBASE/$SYBASE ASE/bin.
e (Windows) $SYBASE%\%SYBASE ASE%\bin.

Syntax

ddlgen
-Ulogin
-Ppassword
-S[[ssl:]server | host name : port number]
[-I interfaces file]
[-Tobject type]
[-Nobject name]
[-Ddbname]
[-Cproperty name=property value]
[-Xextended object type]
[-Ooutput file]
[-Eerror file]
[-Lprogress log file]
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[-Jclient charset]

[-LC -N logical cluster name

-F[ % | SGM | GRP | USR | R | D | UDD | U | V |
P | XP | I | RI | KC | TR | PC ]

Or
ddlgen -v
Parameters

* -U login—specifies alogin name, and is case-sensitive.
* -P password — specifies your password.

If you do not include the —P parameter in your ddlgen statement, ddigen prompts you to
specify a password.

* -S [[ssl:] server | host _name : port number] —specifiesthe name of
the SAP ASE server. ddigen looks this name up in the interfaces file or LDAP
configuration file. If you specify:

* [ssl:] —allows you to generate DDL for objects in SSL-enabled servers. This
parameter is optional.
* -S[host name:port number] —ddlgen uses the fost_nameand port_number
provided, and neither interfaces nor LDAP configuration files are read or parsed.
* -S[server] -I-ddlgen parsesthe interfaces file specified at the user location for
the server name (see the —I parameter description).
e -S[server] —without specifying an interfaces file, ddigen does:
1. ddigen first tries to read the LDAP configuration file from the standard location
2. If the LDAP file does not exist, or exists but does not contain an SAP ASE entry,
then the interfaces file is parsed at its standard location for the server name
3. Ifthe LDAP file exists, then ddigen uses it to search the server name. The interfaces
file is not parsed, and the LDAP configuration file is parsed.

Note: You must use the —s option because ddigen does not connect to a default server.
e -I-—specifiesthe interfaces file name, and corresponds to SSYBASE/interfaces for
UNIX,and $SYBASE%\ini\sqgl.ini for Windows. Use this optional parameter with
-S.
* -Tobject_type —specifies the type of object you are creating. If you do not use - T,
ddligen generates DDL for the default database of login. The object types for —T are:

e C-—cache

e D -—default

e DB - database

e DBD - database device
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DPD — dump device
EC — execution class
EG — engine group
EK — encrypted keys
GRP —group

T —index

IT - instead of trigger for views
KC — key constraints
L — login

LK — logical key

P — stored procedure
PN — partition name

R-—rule
RI - referential integrity
RO —role

RS — remote server

SGM — segment

TR — trigger

U — table

UDD — user-defined datatype
USR — user

V — view

WS — user-defined Web service
WSC — Web service consumer
XOD — local caches

XOU — global caches

XP — extended stored procedure

-Nobject_name—specifies the fully qualified name of the object you are creating, such
as -Ndb_name.owner name.table name.object name. The -N option:

Is required if you specify any object type other than DB (database) in the —T
parameter.

Accepts wildcards with the use of %.

Generates DDL for a trigger for a table, using the -

Ndb_name.table owner.table name.trigger name format.

To generate all triggers for a table, substitute frigger_name with % using the -
Ndb_name.table owner.table name.% format.

Generates DDL for an encrypted key with -Ndb name. owner.key name.
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» Generates DDL for all items of a specific object type on your server.

« Enforces strict order in which it parses the names in the -
Ndb name.owner name.table name.object name format. If you only
provide three arguments, ddigen assumes they are owner_name, table_name, and
obfect_name, in that order. Alternatively, you can also use —
Nowner name.table name -Ddb name.ddlgen does not impose this
restriction if object_nameis an index (I).

* -Ddbname — specifies the name of the database for the object you specify in the -N
option. The default is the user’s default database.

You cannot use the -D parameter when generating DDL for all triggers of a table.

* -Cproperty name=property value —allows you to set connection properties.
You can set multiple properties; separate them with commas, such as:
-Cproperty valuel=property valuel,property nameZ=property valueZ2

* -Xextended object_type —differentiates:

« User tables (0U) from proxy tables (0D) when you specify a table as your object type
(-TU)

» Temporary databases (OD) from normal databases (OU) or archive databases (02)
when you specify database as your object type (- TDB)

e SQLJ procedures (oD) from stored procedures (0U) when you specify procedure as
your object type (-TP).

If object type (-T) is U (table) and -X is not specified, ddigen generates DDL for both
user tables and proxy tables. To generate DDL only for:

e user tables— use the OU extended object type with the -x option.

* proxy tables— use the OD extended object type with the —X option.

* in-memory databases, caches, and devices— use the OI extended object type with
the —x option.

* in-memory temporary databases — use the OIT extended object type with the -x
option.

Note: ddigen does not support schema generation for system tables.

Use extended object typeDE (-XDE), with the database object type (- TDB) to generate a
database and all of its objects in correct dependent order.

* -Ooutput_file—specifiesan output file for the generated DDL. If you do not specify
-0, the DDL you create appears in a console window.

* -Eerror_file—specifiesa log file for recording errors. If you do not specify -E, the
generated errors appear in a console window.

* -Lprogress_log file—specifiesa log file for recording the progress of ddigen. If
you do not specify -1, the progress is not recorded.

Utility Guide 45



CHAPTER 2: Utility Commands Reference

-Jclient_charset —specifies the character set to use on the client. -
Jclient charset requests that the SAP ASE server convert to and from
client_charset, the character set used on the client. A filter converts input between
client_charsetand the SAP ASE character set.

Omitting —J sets the character set to a default for the platform. The default may not
necessarily be the character set that the client is using.

Note: For HP platforms — you must use -Jiso_ 1 to specify the correct character set.
-LC —generate DDL for one or all logical clusters on a server.

-F—filters out indexes, triggers, and constraints out of table and database definitions in the
DDL of table- and database-level objects. The valid filters are:

e Fortables—[ % | I | RI | KC | TR | PC ]

* Fordatabases—[ % | SGM | GRP | USR | R | D | UDD | U | V | P
| XP | I | RI | KC | TR]

The filter options are:

« % —everything. Retrieves the schema-only definition of a database or table.
e SGM - segments

e GRP —groups

e USR-—USers

* R-rules

e D -—defaults

e UDD - uer-defined datatypes

e U -—user tables

e V-—views

e P —stored procedures

e PC — partition condition

e XP —extended stored procedures

e T —indexes

e RI —referential integrity constraints

e KC - primary- and unique-key constraints
e TR —triggers

If you use an invalid filter parameter, ddlgen generates a warning, ignores that parameter,
and continues with the rest of the valid parameters you specify.

If you specify % along with other filter parameters, ddigen ignores all other filterable
parameters, and only shows schema-only definitions. ddigen then continues to evaluate
the dependencies within the subset of the applied as the filterable parameters for the
database.
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-v —displays the version and copyright message of ddigen and returns to the operating
system.

Examples

Archive database — To generate DDL for all archive databases, use the extended filter
option “OA.”

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TDB -N% -XOA

To generate DDL for a single archive database, use the syntax for normal databases. This
example creates DDL for the archive database adb1.

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TDB -Nadbl

Caches— Generates DDL for a cache called default data cache onamachine
named HARBOR using port 1955:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TC -N"default data cache"

To generate DDL for all caches:
ddlgen -Ulogin -Ppassword -Sserver:port -TC -N%

Connection properties—

Generates DDL for a database that uses an encrypted password for its connection:

ddlgen -Usa -Psybase -Sbjrhx64:7710 -Tdb -Nmodel -
CENCRYPT PASSWORD=true

Databases—Generates DDL for a database called pubs2 on a machine named HARBOR
using port 1955:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TDB -Npubs2

If you do not specify a dbname, ddigen generates DDL for the default database of /ogir.

ddlgen -Ulogin -Ppassword —-Sserver:port

If you do not use the - T parameter, ddigen generates DDL for a default-type database:

ddlgen -Ulogin -Ppassword -Sserver:port —-Ndbname

To generate DDL for all databases:

ddlgen -Ulogin -Ppassword —-Sserver:port —-TDB -N%

Defaults— Generates DDL for a default called “phondflt” owned by jones in the pubs?2
database on a machine named HARBOR using port 1955:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TD -Njones.phonedflt -Dpubs2

Alternatively, because ddigen allows you to use a fully qualified name in the —N flag, omit
the -Ddbname and include the database name in the —N option:

ddlgen -Ulogin -Ppassword -Sserver:port -TD -
Ndbname.owner.defaul tname

To generate DDL for all defaults in a database owned by “owner”:
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ddlgen -Ulogin -Ppassword —-Sserver:port -TD -Nowner.% -Ddbname
Database devices— Generates DDL for a database device called master running on a
machine named HARBOR using port 1955:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TDBD -Nmaster

To generate DDL for all database devices:

ddlgen -Ulogin -Ppassword -Sserver:port —-TDBD -N%

Dump devices— Generates DDL for a dump device called tapedumpl running on a
machine named HARBOR using port 1955:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TDPD -Ntapedumpl

To generate DDL for all dump devices:
ddlgen -Ulogin -Ppassword -Sserver:port —-TDPD -N%
Encrypted keys—Generates DDL for all encryption keys inthe account s database ona
machine named “HARBOR” using port 1955:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TEK
-Naccounts.dbo.%

Alternatively, you use the -D option to specify the database name.

Encrypted keys— Generate DDL for an encryption key “ssn_key” in a the
SampleKeysDB database:

ddlgen -Usa -P -Sserver -TEK -NSampleKeysDB.dbo.ssn key

Add -FEKC toavoid creating DDL for key copies when generating DDL for the “ssn_key”
encryption key:

ddlgen -Usa -P -Sserver -TEK -NSampleKeysDB.dbo.ssn key -FEKC
Encrypted passwor ds— Generates system encryption passwords along with DDLs for
encryption keys when you include the extended option -X0OD. The output generates the
sp_encryption statement followed by DDL statements for all encrypted keys. This
generates DDL for the login “george” on a machine named HARBOR using port 1955:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TEK -Ngeorge -XOD

To generate DDL for all the encrypted keys in the aut ho r s database on a machine named
HARBOR using port 1955:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TEK -Nauthors.dbo.%

Enginegroups—Generates DDL for an engine group called LASTONLINE running on a
machine named HARBOR using port 1955:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TEG -NLASTONLINE

To generate DDL for all engine groups:
ddlgen -Ulogin -Ppassword -Sserver:port -TEG -N%

Execution class—Generates DDL for an execution class called EC2 running on a machine
named HARBOR using port 1955:
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ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TEC -NEC2

To generate DDL for all execution classes:

ddlgen -Ulogin -Ppassword -Sserver:port -TEC -N%
* Extended object type

The example uses the following:

create database tdb on default = '20M'

use tdb

create table test (
fid varchar (10)
)

create view View A as select * from test
create view View B as select * from View A

CREATE FUNCTION Func_C(@ID VARCHAR (10))
RETURNS varchar (8000)

AS

BEGIN

declare @Qret varchar (8000)

select @ret = (select fid from View B)

return @ret

END
go

create view View D as
select * from test where fid>dbo.Func C('111"'")

go

CREATE FUNCTION Funcinoidepend(@ID VARCHAR (10))
RETURNS varchar (8000)
AS
BEGIN
declare @ret varchar (8000)
return Qret
END

go
Issuing ddlgen returns all objects of database tdb in correct dependent order:
ddlgen -S -U —-P -TDB —-Ntdb —-XDE

Segment
Group
User
Rules
Defaults
UDDs

o g hswdE

Utility Guide 49



CHAPTER 2: Utility Commands Reference

7. Encrypted Keys
8. User Tables
9. Proxy Tables
10. Triggers
11. Functions and Views
a. All functions without any dependency
b. All views without any dependency
c. All functions and all views with any dependency on any objects
12. Instead of trigger
13. Stored Procedures
14. Extended Stored Procedures
15.PRS
16. User Defined Web Services

Extended stored procedures— Generates DDL for the xp_cmdshell extended stored
procedure in the pubs?2 database, owned by Jones and running on a machine named
HARBOR using port 1955, by using the fully qualified
dbname.owner.extendedstoredprocedure format with the -N option:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TXP -

Npubs2.jones.xp cmdshell

Alternatively, use the —D option instead of using the fully qualified name:

ddlgen -Ulogin -Ppassword -Sserver:port —-TXP
-Nowner.extendedstoredprocedure -Ddbname

To generate DDL for all extended stored procedures:

ddlgen -Ulogin -Ppassword -Sserver:port —-TXP -Ndbname.owner.%

Filters—Generates DDL for the authors table in the pubs2 database, filtering for all
indexes (1), and referential integrity constraints (RT), primary and unique key constraints
(KC), triggers (TR), and partition condition (PC) from the DDL of a table:

ddlgen -Uroy -Proyl23 -TU -Nauthors -Dpubs2 -F$%

Alternatively, specify each of the filters individually:

ddlgen -Ulogin -Ppassword —-TU -Ndbname.owner.table
-FI,RI,KC,TR

This generates the definition of table_name while filtering out foreign keys and primary-
unique keys:

ddlgen -Ulogin -Ppassword -TU -Ntable name -Ddbname
-FRI,KC

Both of these generate foreign keys for a specified user in the entire database:
ddlgen -Ulogin -Ppassword -TRI -N%.%.% —-Ddbname

Or:

50

Adaptive Server Enterprise



CHAPTER 2: Utility Commands Reference

[T}

ddlgen -Ulogin -Ppassword -TRI -Ndbname$.%.%

Both of these generate DDL for the primary and unique keys of all the tables in a database
that begin with “PK”":
ddlgen -Ulogin -Ppassword -TKC -Ndbname.%.%.PK

oe

Or:
ddlgen -Ulogin -Ppassword -TKC -N%.%.PK$ -Ddbname

This generates schema-only definition of a database:
ddlgen -Ulogin -Ppassword -Sserver:port -TF -Ndbname -F%

Alternatively, specify each of the filters individually:

ddlgen -Ulogin -Ppassword —-Sserver:port —-TDB -Ndbname
-FSGM, GRP, USR, R, D,UDD, V, P, XP, I,RI,KC, TR

This generates the database DDL skipping the compiled object:

ddlgen -Ulogin -Ppassword —-Sserver:port —-TDB -Ndbname
-FTR,D,XP,V,R

This generates database definition without a table definition:

ddlgen -Ulogin -Ppassword —-Sserver:port —-TDB -Ndbname
-FU

e Groups—Generates DDL fora group called “public” in the pubs 2 database, runningon a
machine named HARBOR using port 1955, by using the fully qualified
dbname . groupname format in the -N option:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TGRP -Npubs2.public

Alternatively, use the -D option to specify the dbname:
ddlgen -Ulogin -Ppassword -Sserver:port -TGRP -Ngroupname -Ddbname

To generate DDL for all groups:
ddlgen -Ulogin -Ppassword -Sserver:port —-TGRP -Ndbname.$%

* In-memory database — Generates DDL for an in-memory database:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TDB -Nimdb 1

Use the same syntax to generate DDL for an in-memory temporary database:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TDB -Nimdb templ

* Indexes—Generates DDL for an index called au_1name for the table authors owned
by dbo, in the pubs2 database:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TI -Ndbo.authors.au lname -
Dpubs?2
Alternatively, because ddigen allows you to use a fully qualified name in the - flag, omit
the -Ddbname and include the database name in the - option:

ddlgen -Ulogin -Ppassword —-Sserver:port
-TI -Ndbname.owner.tablename.indexname
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If you use a fully qualified name, you may omit the —D option.

To generate DDL for all indexes for a single table:

ddlgen -Ulogin -Ppassword —-Sserver:port -TI
-Ndbname.owner. tablename.%

To generate DDL for all indexes of all tables in a database:

ddlgen -Ulogin -Ppassword -Sserver:port -TI
-Ndbname.%.%.%

For example, this generates DDL for all indexes for all tables in the pubs2 database:
ddlgen -Usa -P -SHARBOR:1955 -TI -Npubs2.%.%.%

Instead of triggers— Generates one view and its (instead of) trigger, and next view
and its (instead of) trigger:

ddlgen -S -U -P -TV -Ndbname.ownername.viewname

Generates triggers only for tables:

ddlgen -S -U -P -TTR

Generates instead of triggers for views:

ddlgen -S -U -P -TIT

Keys— Both of these generate DDL for the primary and unique keys of all the tables in a
database that begin with “PK":

ddlgen -Usa -P -TKC -Ndbname.%.%.PK

Or:
ddlgen -Usa -P -TKC -N%.%.PK% -Ddbname

o\

Logical cluster — Generates DDL for “my_Icluster” on server “asel”, enter:
ddlgen -Usa -P -Sasel -TLC -Nmy lcluster

Logical cluster — Generates DDL for all logical clusters on server “asel”, enter:
ddlgen -Usa -P -Sasel -TLC -N%

Logical keys— LK generates logical keys of table defined by sp_primarykey,
sp_commonkey, sp_foreignkey statements. Since these keys do not have a name, the
name of the object in this case would be the name of the table. This example generate a
DDL for logical keys of table authors in database pubs2 running on a machine named
HARBOR using port 1955:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TLK -Npubs2.dbo.authors

To generate DDL for all logical keys in database pub2 use:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TLK -Npubs2.%.%

To filter out logical keys definition from DDL of table authors use LK in -F argument,
use:
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ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TLK -Npubs2.dbo.authors -FLK

* Logins—TL generates DDL for one or all logins. This example generates DDL for all
logins on a machine named HARBOR using port 1955
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TL -N%

Note: The password in the DDL generated for all logins is “password”.

Alternatively, specify an individual login by using -Nusername instead of -N%:
ddlgen -Ulogin -Ppassword -Sserver:port -TL -Nusername

If server-wide password complexity options have been specified for the login or logins, all
sp_addlogin and sp_loglogin DDL statements are generated first, followed by DDL
statements for the password options. This example generates DDL for the login “george”
on a machine named HARBOR using port 1955:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TL -Ngeorge

¢ Remote servers— Generates DDL for a remote server called ORANGE on a machine
named HARBOR using port 1955:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TRS -NORANGE
To generate DDL for all remote servers:
ddlgen -Ulogin -Ppassword -Sserver:port —-TRS -N%
* Roles— Generates DDL for the sa_role on a machine named HARBOR using port 1955:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TRO -Nsa role
To generate DDL for all roles:

ddlgen -Ulogin -Ppassword -Sserver:port —-TRO -N%

Note: The password in the DDL generated for all roles is “password”.

¢ Rules—Generates DDL for all rules associated with authors on a machine named
HARBOR using port 1955:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TR -Nauthors.dbo.%

The % symbol tells ddigen to create DDLs for all rules that exist on the server.

You can also give the fully qualified name of the rule:
ddlgen -Ulogin -Ppassword —-Sserver:port -TR -
Ndbname.owner.rulename
Alternatively, also use the —D parameter:
ddlgen -Ulogin -Ppassword -Sserver:port -TR -Nowner.rulename -
Ddbname

* Segments— Generates DDL using the fully qualified dbname . segmentname format
in the —N option for a segment called 1ogsegment for the pubs2 database, on a
machine named HARBOR using port 1955:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TSGM -Npubs2.logsegment
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Alternatively, specify the dbname using the -D option:

ddlgen -Ulogin -Ppassword —-Sserver:port -TSGM -Nsegmentname -
Ddbname

To generate DDL for all segments:

ddlgen -Ulogin -Ppassword -Sserver:port —-TSGM -Ndbname.$%

SQL J functions— Generates DDL for a SQLJ function named region_of owned by dbo
in database master:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TF -Nmaster.dbo.region of

Alternatively also use the —-D parameter:

ddlgen -Ulogin -Ppassword -Sserver:port —-TF -Ndbo.region of -
Dmaster

To generate DDL for all SQLJ functions in a database, use object type F:

ddlgen -Ulogin -Ppassword -Sserver:port —-TF -Ndbname.owner.%

SQL J procedures— A kind of stored procedure, you generate DDL for SQL procedures
along with DDL for stored procedures. This generates DDL for all stored procedures—
including SQLJ procedures—owned by dbo in the master database:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TP —-Nmaster.dbo.%

To generate DDL for all SQLJ procedures that are only owned by dbo in the master
database, use this, where the extended type oD refers to SQLJ procedures:

ddlgen -Ulogin -Ppassword-Sserver:port —-TP -Nmaster.dbo.% -XOD

To generate DDL for all procedures except SQLJ procedures owned by dbo in the
master database, use this, where the extended type oU refers to all stored procedures
except SQLJ procedures:

ddlgen -Ulogin -Ppassword-Sserver:port —-TP -Nmaster.dbo.% -XOU

Stored procedures—Generates DDL for the sp_monitor stored procedure for the pubs?2
database on a machine named HARBOR using port 1955, using the fully qualified
dbname. owner.procedure name format for the -N option:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TP -Npubs2.dbo.sp monitor

Alternatively, specify the dbname using the —-D option:
ddlgen -Ulogin -Ppassword -Sserver:port -TP -Nowner.procedurename
-Ddbname

To generate DDL for all stored procedures:

ddlgen -Ulogin -Ppassword -Sserver:port -TP -Ndbname.owner.%

SSL -enabled servers— Generates DDL for objects in the pubs2 database for an SSL-
enabled SAP ASE server running on a machine named HARBOR using port 1955:
ddlgen -Uroy -Proyl23 -Sssl:HARBOR:1955 -TDB -Npubs2
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» Tables— Generates DDL for all user tables in the pubs2 database owned by “dbo” and
running on a machine named HARBOR using port 1955:
ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TU -Ndbo.% -Dpubs2

You can also use the —-N parameter to give the fully qualified name of the table:
ddlgen -Ulogin -Ppassword -Sserver:port -TU
-Ndbname. tableowner. tablename
Alternatively, also use the —-D parameter to specify the database:
ddlgen -Ulogin -Ppassword -Sserver:port -TU

-Ntableowner. tablename -Ddbname

To generate DDL for all proxy tables, which uses the value 0D, use -X0D instead, where X
is the extended type, and OD denotes proxy tables:
ddlgen -Ulogin -Ppassword -Sserver:port -TU

-Ntableowner.% -Ddbname -XOD

To generate DDL for all user tables, which uses the value OU, use -XOU instead, where X is
the extended type, and OU denotes user tables:
ddlgen -Ulogin -Ppassword -Sserver:port -TU
-Ntableowner.% -Ddbname -XOU
To generate DDL for all tables, including user tables and proxy tables:

ddlgen -Ulogin -Ppassword -Sserver:port -TU -Ndbname.tableowner.%

* Temporary databases — Generates DDL for all databases, including tempdb:
ddlgen -Ulogin -Ppassword -Sserver:port —-TDB -N%

To generate DDL for all temporary databases, use the OD extended database type:
ddlgen -Ulogin -Ppassword -Sserver:port —-TDB -XOD -N%

Although you can use the 0D extended type in SAP ASE versions 12.5.0.3 and later,
versions earlier than 12.5.0.3 issue warning messages. Safely ignore this message; ddigen
continues processing the command.To generate DDL for all databases except temporary
databases, use the OU extended type:

ddlgen -Ulogin -Ppassword —-Sserver:port —-TDB -XOU -N%

This generates DDL for a temporary database named tempdb1:
ddlgen -Ulogin -Ppassword —-Sserver:port —-TDB -Ntempdbl

The output includes:

¢ A create temporary database Statement:
create temporary database tempdbl on master = 4,
asdas = 2
go
* An sp_tempdb bind statement where the isql application is bound to tempdb1:
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sp_tempdb 'bind', 'ap', 'isqgl', 'DB', 'tempdbl'
go

Note: DDL for objects such as views, stored procedures, and tables is not generated along
with DDL for a temporary database because these objects are temporary, and are re-
created when the server restarts.

When you use the —-F parameter to filter a table while generating DDL for a database
object, then indexes, referential integrity, key constraints and triggers automatically get
filtered, as they are a subset of the table object.

Triggers— Generates DDL for the trigger checksum for the pubs2 database on a
machine named HARBOR using port 1955, using the fully qualified
dbname. owner. trigger name format for the -N option:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TTR -Npubs2.dbo.checksum

Alternatively, specify the database_name using the —D option:

ddlgen -Ulogin -Ppassword -Sserver:port -TTR
-Nowner. triggername -Ddbname

You can also generate DDL for a trigger for a table, using:

-Ndb name. table owner.table name.trigger name

To generate DDL for all triggers of a database:

ddlgen -Ulogin -Ppassword -Sserver:port -TTR -Ndbname.owner.%

You can also use this format to generate DDL for all triggers of a table:
-Ndb _name.table owner.table name.%

Note: You cannot use the —D parameter when generating DDL for all triggers of a table.

User-defined datatypes— Generates DDL for the user-defined datatype “ldentype” for
the pubs2 database on a machine named HARBOR using port 1955 using the fully
qualified dbname . userdefined datatype format for the -N option:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TUDD -Npubs2.Identype

Alternatively, use the —D option to specify the dbname:
ddlgen -Ulogin -Ppassword —-Sserver:port —-TUDD
-Nuserdefined datatype -Ddbname
To generate DDL for all user-defined datatypes:
ddlgen -Ulogin -Ppassword —-Sserver:port —-TUDD -Nbname.$%
Views— Generates DDL for a view named retail owned by Miller in the pubs?2

database running on a machine named HARBOR using port 1955, by using the fully
qualified dbname . owner. viewname format with the -N option:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TV -Npubs2.miller.retail

Alternatively, use the —D option instead of using the fully qualified name:
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ddlgen -Ulogin -Ppassword -Sserver:port -TV -Nowner.viewname -
Ddbname

To generate DDL for all views:
ddlgen -Ulogin -Ppassword —-Sserver:port —-TV -Ndbname.owner.%

* User-defined Web services— Generates DDL for a named user-defined Web service,
sp_who_service, in the pubs?2 database running on a machine named HARBOR using
port 1995, by using a fully qualified dbname . username . webservice name
format with the -N and -T options:
ddlgen -Uroy -Proyl23 -SHARBOR:1995 -TWS

-Npubs2.dbo.sp who service
The syntax for generating DDL for a named user-defined Web service is:
ddlgen -Ulogin -Ppassword -Shost name:port -TWS -

Ndbname.owner.webservice name

To generate DDL for all user-defined Web services owned by all users in database
dbname.
ddlgen -Ulogin -Ppassword -Shost name:port -TWS -Ndbname.%.%

Note: An sp_webservices ‘addalias' statement is only generated if the DDL is to be
generated for all user-defined web services or for a database.

* Users— Generates DDL for a user named Smith in the pubs2 database running on a
machine named HARBOR using port 1955, by using a fully qualified
dbname . username format with the -N option:

ddlgen -Uroy -Proyl23 -SHARBOR:1955 -TUSR -Npubs2.smith

Alternatively, use both the —-N and -D options instead of using a fully qualified name in
-N:

ddlgen -Ulogin -Ppassword —-Shost name:port -TUSR -Nusername -
Ddbname

To generate DDL for all users:
ddlgen -Ulogin -Ppassword —-Sserver:port —-TUSR -Ndbname.$%

Permissions
Users must have either sa_role or sso_role to generate DDL for:

« Encryption keys
* Logins
* Roles

For all other objects, users do not need any specific permissions or roles to generate DDL.

See also
»  Hiding Passwords in ddlgen on page 59
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» Chapter 2, Utility Command’s Refference on page 5
» Database Creation and Manipulation Utilities on page 3

Usage for ddlgen

There are additional considerations when using ddlgen.

» ddligen does not identify existing sequences within views, stored procedures or triggers.
For this reason, when generating DDL for a database, first run ddigen on those views,
stored procedures and triggers that are independent, before running ddigen on those with
dependencies. For example, if view B depends on view A, first run ddigen on view A,
before running it on view B.

* The default information for ddigen is:

Op- [|Parameter Required |Default
tion
-U username Yes None
-P password Yes None
-S host_name:port_number Yes None
-T object_type No Database
See the —T parameter description for a list of valid
object types
-N object_name Yes, if ob- Default database
Ject typefor | name of user-
—-T isnot DB | name, if -Tob-
(database) Jject typeis
db orif -T is not
specified
-D database name No Default database

of username
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Op- [|Parameter Required |[Default

tion

-X extended_object type No None
Options are:

» QU - for user tables, user databases (excluding
temporary databases), and stored procedures
(excluding SQLJ procedures).

» OD - for proxy tables, temporary databases,
and SQLJ procedures.

Use only when the object typefor T is:
e U (user table)
e P (procedure)
» DB (database)

-0 output_file_name No Standard out
-E error_file_name No Standard out
-L log_file_name No None
-V version_number of ddigen No None

e At the command line, invoke ddigen using the dd1gen shell script file (dd1gen.bat
for Windows), included in your SAP ASE installation. The main class in DDLGen. jaris
com.sybase.ddlgen.DDLGenerator.

e To start ddigen in the SQL Central plug-in for Adaptive Server:

1. Right-click on the object for which you want to generate DDL.
2. Select Generate DDL.

« Inthe output DDL of create table, bind statements are generated as independent DLL
instead of dependent DLL.

e The PN type allows you to generate DDL for tables with partition names. Use partition

names and the optdiag utility to analyze optimizer behavior by creating empty partitioned
tables with simulated metadata.

To generate names for local index partitions, use:
ddlgen - TU -XPN

To generate DDL for all user tables with partition names, use:

ddlgen -TU -XPN,OU
ddlgen -TU -XOU, PN

Hiding Passwords in ddigen
When you issue the ddligen utility in a UNIX command-line environment, other users on that
UNIX machine can see your ddigen command—including its password—if they issue the ps
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process management command, which shows the status of processes that are running on that
machine.

The ddligen -P password parameter option lets you to invoke ddigen from a script so that the
password is hidden from other users.

To achieve this, set the $PSWD environment variable to point to your SAP ASE login
password, and include the string “ext” in the —-P parameter. ext acts as a pseudo password,
allowing you to supply the actual password in the next line. Set s PSWD at the command line or
a Bourne shell script, but not from the C-shell.

1. Setthe SPSWD environment variable:

setenv PSWD pass word

2. Run ddigen:
ddlgen -Ulogin -Pext -Sserver:port -Ttype -Nname << END
$PSWD
END

If you prefer to keep your password in a file, replace $PSWD with “cat filename’, where
filename is the location of your password file. For example:

ddlgen -Ulogin -Pext -Sserver:port -Ttype -Nname << END
‘cat filename®
END

Note: Enclose cat filename with a grave accent (*); ddigen returns an error if you use an
apostrophe.

ddigen and Encryption
You can use the ddlgen utility with both encrypted columns and encrypted databases.

ddlgen provides support for both encrypted databases and encrypted columns.
For databases, use ddlgen to:

« Create an encrypted database
» Create a database encryption key

ddlgen adds support for transparent database encryption with these values for the -TEK
parameter:

e -XOCE - only generate DDL from column encryption keys
e —-XOMK - only generate DDL from master key or dual master key
* -XODE - only generate DDL from database encryption keys (dek)
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ddlgen for Encrypted Columns
You can use the ddligen utility with encrypted columns.

e The ddigen utility supports pre-15.0.2 encryption. Pre-15.0.2 ddigen support includes
generating DDL for an encryption key in a database, and generating DDL to synchronize
encryption keys across servers.

If you use ddligen to generate DDL for encryption keys on SAP ASE version 15.0.2 or
later, the DDL may cause errors on a pre-15.0.2 version SAP ASE, specifically if an
encryption key is encrypted by a user specified-password or has key copies.

* Thetype EX, used for encryption key, generates the DDL to create an encryption key and to
grant permissions on it. ddigen generates encrypted column information and a grant
decrypt statement, along with the table definition.

» If you do not specify the —x0D option, and the key to be migrated has been created in the
source database using the with passwd clause, ddlgen generates a create encryption key
command with password as its explicit password.This is similar to what ddigen does for
roles and login passwords.

« The -XOD generates the create encryption key that specifies the key’s encrypted value as
represented in sysencryptkeys. Use the —XOD to synchronize encryption keys across
servers for data movement.
ddlgen -XOD generates DDL that includes a system encryption password (if it was set and
DDL is generated for a key encrypted with a system encryption password) and DDL for
keys.

Encrypted Columns and Specifying the -XOD Flag in ddigen
There are special considerations when using the ddigen -XOD option with encrypted columns.

If you do not specify the -xOD flag in ddigen, and you:

» Did not specify a password when the encryption key was created — ddlgen generates DDL
with no password.

« Specified a password when the encryption key was first created — ddigen generates the
default password of ‘password’. This is similar to what ddigen does for roles and login
passwords, and its output looks similar to:

print 'ssn key'

--The DDL is generated with a default password - 'password' as
--a password was specified when this key was created.

create encryption key SampleKeysDB.dbo.ssn key for AES
with keylength 128
passwd 'password'
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init vector random
go

When you specify the-XOD flag in ddigen, ddigen generates DDL that includes a system
encryption password (if it has been setand DDL is generated for a key encrypted with a system
encryption password) and DDL for keys.

Use this syntax to generate a system encryption password:

ddlgen -Usa -P -Sserver -TEK -NsampleKeysdb.dbo.ekl -XOD The
output would look like:

-- System Encryption Password

use SampleKeysDB
go

sp_encryption 'system encr passwd',
'0x8e050e3bb607225c60c7cb9£59124e99866ca22e677b2cdc9a4d09775850£472
iv,

NULL, 2, O

go

-- DDL for EncryptedKey 'ekl'

print '<<<<< CREATING EncryptedKey - "ekl" >>>>>!'
go

create encryption key SampleKeysDB.dbo.ekl for AES

with keylength 128

passwd 0x0000C7BC28C3020AC21401

init vector NULL

keyvalue
0xCE74DB1EO28FF15D908CD066D380AB4AD3AA88284D6F7742DFFCADCAABE4100D0
1

keystatus 32

go

Note: When migrating keys from a source to a target server using ddligen, set the system
encryption password to NULL (if it exists) in the target server if you want to run the ddigen
output (from the source server) for encryption keys generated using “~XOD” parameter.
Failure to do this results in errors when you try to execute the ddigen output against the target
Server.

ddigen Support for Key Copies
The ddligen utility also generates DDL for key copies along with the DDL for base key.

For example, this syntax would generate DDL for “ssn_key” and its key copies:

ddlgen -Usa -P -Sserver -TEK -NSampleKeysDB.dbo.ssn key
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The output from ddigen would look like:

print 'ssn key'

--The DDL is generated with a default password - 'password' as
--a password was specified when this key was created.

create encryption key SampleKeysDB.dbo.ssn key for AES
with keylength 128

passwd 'password'

init vector random

go

print 'Key Copies for ssn_key'
-- Generating DDL for Key Copies for 'ssn key'

alter encryption key 'ssn key'

with passwd 'password'

add encryption with passwd 'passwd'
for user 'dbo'.

If you include the -x0D flag, the DDL for key copy would look like:

alter encryption key SampleKeysDB.dbo.ssn key add encryption

with keyvalue
0x84A7360AA0B28801D6D4CBF2F8219F634EE641E1082F221A2C58C9BBECI9F49B50
1

passwd 0x000062DF4B8DA5709E5E01

keystatus 257

for user 'userl'

go

EKC Encryption Key Copy Filter and ddigen
The ddlgen utility supports the EKC (encryption key copy) extended type for its -F filter
argument, to suppress the generation of key copies for encryption keys.

This example uses -FEKC to avoid creating DDL for key copies when generating DDL for the
“ssn_key” encryption key:

ddlgen -Usa -P -Sserver -TEK -NSampleKeysDB.dbo.ssn key -FEKC

The output from ddigen would look like:

print 'ssn key'
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--The DDL is generated with a default password - 'password' as
--a password was specified when this key was created.

create encryption key SampleKeysDB.dbo.ssn key for AES
with keylength 128

passwd 'password'

init vector random

go

Create Table DDL
ddlgen can generate decrypt_default statements (if set for an encrypted column) along with
DDL of a table.

This example issues a ddigen command on a table called employee which has an “ssn”
column that is encrypted with encryption key “ssn_key,” and a decrypt default value that is set
to “100”:

ddlgen -Usa -P -Sserver -TU -Nemployee

The DDL output would look like:

create table employee (

ssn int not null encrypt with ssn key
decrypt default 100 ,

last name int not null ,

first name int not null

)
lock allpages
on 'default'

go

defncopy

Copies definitions for specified views, rules, defaults, triggers, or procedures from a database
to an operating-system file or from an operating-system file to a database.

The utility is located in:

* (UNIX) $SYBASE/$SYBASE OCS/bin.
* (Windows) $SYBASE%\$SYBASE OCS%\bin, as defncopy.exe.

Syntax

defncopy
[—X]
a display charset]
I interfaces file]
J [client charset]]
K keytab file]
P password]
R remote server principall]
S [server name]]
U username]

[-
(-
(-
(-
[-
(-
(-
(-
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[-V security options]
[-Z security mechanism]
[-z language]
{ in file name database name |
out file name database name [owner.]object name
[[owner.]object name...] }

Or
defncopy -v

Parameters

* -a display charset—runs defncopy from a terminal whose character set differs
from that of the machine on which defncopy is running. Use —a in conjunction with -J to
specify the character set translation file (. x1t file) required for the conversion. Use -a
without —J only if the client character set is the same as the default character set.

Note: Theascii_7 character set is compatible with all character sets. If either the SAP ASE
character set or the client character set is set to ascii_7, any 7-bit ASCII character can pass
unaltered between client and server. Other characters produce conversion errors. See the
System Administration Guide for more information on character set conversion.

* -I interfaces_file-specifiesthe nameand location of the interfaces file to search
when connecting to the SAP ASE server. If you do not specify - I, defncopy looks for a
filenamed interfaces inthedirectory specified by the SYBASE environment variable
in UNIX platforms, and sql.ini inthe ini subdirectory for your Sybase release
directory in Windows.

* -J client_charset—specifies the character set to use on the client. A filter converts
input between client_charsetand the SAP ASE character set.

-J client charset requests that the SAP ASE server convert to and from
client_charset, the client’s character set.

—J with no argument sets character set conversion to NULL. No conversion takes place.
Use this if the client and server are using the same character set.

Omitting - J sets the character set to a default for the platform. The default may not be the
character set that the client is using. For more information about character sets and their
associated flags, see the Systern Administration Guide and configuration guide for your
platform.

* -K keytab file-specifiesthe pathto the keytab file used for authentication in DCE.

* -P password—specifies your password. If you do not specify -P, defncopy prompts
for your password.

* -R remote_server principal —specifies the principal name for the server. By
default, a server’s principal name matches the server’s network name (which is specified
with the —s parameter or the DSQUERY environment variable). Use the -R parameter
when the server’s principal name and network name are not the same.
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-S server_name —specifies the name of the SAP ASE server to which to connect. If
you specify - s with no argument, defncopy looks for a server named SYBASE. If you do
not specify -s, defncopy uses the server specified by your DSQUERY environment
variable.

-U username —specifies a login name. Login names are case sensitive. If you do not
specify username, defncopy uses the current user’s operating system login name.

-v —displays the version and copyright message of defncopy and returns to the operating
system.

-V security options —specifies network-based user authentication. With this
option, the user must log in to the network’s security system before running the utility. In
this case, users must supply their network user name with the -U option; any password
supplied with the - P option is ignored.

-V can be followed by a security options string of key-letter options to enable additional
security services. These key letters are:

» ¢ - Enable data confidentiality service

e i —Enable data integrity service

» m - Enable mutual authentication for connection establishment

* o - Enable data origin stamping service

e r —Enable data replay detection

« g- Enable out-of-sequence detection

-X —initiates the login with client-side password encryption in this connection to the
server. defncopy (the client) specifies to the server that password encryption is desired.

The server sends back an encryption key, which defncopy uses to encrypt your password,
and the server uses to authenticate your password when it arrives.

If defncopy crashes, the system creates a core file which contains your password. If you
did not use the encryption option, the password appears in plain text in the file. If you used
the encryption option, your password is not readable.

-z language —is the official name of an alternate language that the server uses to
display defncopy prompts and messages. Without the -z flag, defncopy uses the server’s
default language.

Add languages to an SAP ASE at installation, or afterwards with the utility langinstall
(langinst in Windows) or the stored procedure sp_addlanguage.

-Z security_mechanism—specifies the name of a security mechanism to use on the
connection.

Security mechanism names are defined in the SSYBASE/install/libtcl.cfg
configuration file. If no security mechanism name is supplied, the default mechanism is
used. See the description of the 1ibtcl . cfq file in the Open Client and Open Server
Configuration Guide.

database_name — specifies the name of the database to copy the definitions from or to.
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» file_name - specifies the name of the operating system file destination or source for the
definition copy. The copy out overwrites any existing file.

* in | out —specifies the direction of definition copy.

* object_name — specifies names of database object for defncopy to copy out. Do not use
objectname when copying definitions in.

* owner —is optional if you or the database owner own the table being copied. If you do not
specify an owner, defncopy first looks for a table of that name that you own, and then looks
for one owned by the database owner. If another user owns the table, specify the owner
name or the command fails.

Examples

* Files—Copies definitions from the file new proc into the database stagedb on server
MERCURY. The connection with MERCURY is established with a user of name “sa” and
a NULL password:
defncopy -Usa -P -SMERCURY in new proc stagedb

* Objects— Copies definitions for objects sp_calccomp and sp_vacation from the
employees database on the SYBASE server to the file dc . out. Messages and prompts
display in french. The user is prompted for a password:

defncopy -S -z french out dc.out employees sp calccomp sp vacation

Usage

» Use this syntax for defncopy_r if you are using threaded drivers.

« Use this syntax for defncopy you are using threaded drivers in the IBM platform.

« Setthe SYBASE environment variable to the location of the current version of SAP ASE
before using defncopy.

 Invoke the defncopy program directly from the operating system. defncopy provides a
noninteractive way to copy out definitions (create statements) for views, rules, defaults,
triggers, or procedures from a database to an operating system file. Alternatively, it copies
in all the definitions from a specified file.

* Thein filenameorout filenameandthedatabase name arerequiredand mustbe
stated unambiguously. For copying out, use file names that reflect both the object’s name
and its owner.

« defncopy ends each definition that it copies out with the comment:

/* ### DEFNCOPY: END OF DEFINITION */

Definitions created as text must end with this comment so that defncopy can copy them in
successfully.

« Enclose values specified to defncopy in quotation marks, if they contain characters that
could be significant to the shell.

Utility Guide 67



CHAPTER 2: Utility Commands Reference

Warning! Long comments of more than 100 characters that are placed before a create
statement may cause defncopy to fail.

SDK binaries like defncopy use the same hames in both 32-bit and 64-bit products.
Installing SAP ASE, the SDK, or Open Server 64-bit products with other Sybase 32-bit
products overwrites the 32-bit binaries. Starting with SAP ASE 15.0.2 and SDK/Open
Server 15.0 ESD #9, the 64-bit binaries are replaced with 32-bit binaries on all 64-bit
UNIX platforms. Since 32-bit binaries are included in the 64-bit EBF, the -v option of
defncopy is no longer a valid way to check the EBF number for 64-bit products. Instead,
use the UNIX strings and grep commands to confirm the EBF numbers for both Open
Client and Open Server.

For example, to find the string containing the EBF number in the libsybct64.a library,
enter:

strings -a libsybct64.a | grep Sybase

This returns a string similar to:

Sybase Client-Library/15.5/P/DRV.15.5.0/SPARC/Solaris
8/BUILD1550-001/64bit/OPT/Mon Aug 10 23:04:17 2009

To find the string containing the EBF number in the libsybsrv64.a library, enter:
strings -a libsybsrvé64.a | grep Sybase
This returns a string similar to:

Sybase Server-Library/15.5/P/DRV.15.5.0/SPARC/Solaris
8/BUILD1550-001/64bit/OPT/Mon Aug 10 23:06:27 2009

See also:

Reference Manual: Commands — create, select
Reference Manual: Procedures— sp_addlanguage, sp_checkreswords, sp_configure,
sp_procgmode, sp_remap

Permissions

You must have select permission on the sysobjects and syscomments tables to
copy out definitions; you do not need permission on the object itself.

You may not have select permission on the text column of the syscomments table if
the system security officer has reset the allow select on syscomments.text column
parameter with the system procedure sp_configure. This reset restricts select permission
to the object owner and the system administrator. This restriction is required in order to run
SAP ASE in the evaluated configuration , as described in the installation and
configuration documentation for your platform. In this case, the object owner or a system
administrator must execute defncopy to copy out definitions.

Note: If the text has been encrypted, it may be hidden from you even if you have all the
required permissions. See “Verifying and Encrypting Source Text” in the 7ransact-SQL
User’s Guide.

You must have the appropriate create permission for the type of object you are copying in.
Obijects copied in belong to the copier. A system administrator copying in definitions on
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behalf of a user must log in as that user to give the user proper access to the reconstructed
database objects.

Tables used

syscomments, sysobjects

See also

» langinstall on page 94

e Threaded Versions of Utilities on page 1

e Chapter 2, Utility Commands Reference on page 5

» Database Creation and Manipulation Utilities on page 3

dscp

(UNIX only) A text-based utility that allows you to view and edit server entries in the
interfaces file from the command line in UNIX platforms.

The utility is located in $SYBASE/$SYBASE _OCS/bin.

Set the SYBASE environment variable to the location of the current version of SAP ASE
before using dscp.

Syntax
dscp [-p]

or:

dscp -v

To exit from dscp:
quit

or:

exit

Parameters

e —p —suppresses command-line prompts.
« —v—displays the version and copyright message of dscp and returns to the operating
system.

Examples

* Suppress command line prompt — Opens the default interfaces file for editing and
suppresses the command line prompt:
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dscp -p

Usage
You can perform various functions by entering commands at the dscp prompt:

add servername —adds server entry servernamein the current session. dscp prompts
you for information about servername. Press Return to accept the default value, which is
shown in square brackets [ ]. Enter “#done” to exit add mode.

addattr servername-addsan attribute to the server entry servernamein the current
session.

close [sess] —closes asession identified by the sessnumber. If you do not specify
sess, closes the current session.

config — displays configuration information related to your Sybase environment.
copy namel to {name2 | sess | sess namel2} —cCopiesserverentry namel
in the current session to:

e Server entry nameZ2in the current session,

e Session sess, or

e Server entry nameZ2 in session Sess.

copyall to sess — copies all server entries in the current session to session sess.
del servername — deletes server entry servername in the current session.
delete-all — deletes all server entries in the current session.

exit — exits dscp.

help, ?, h —displays the online help.

list [all] - lists the server entries for the current session. To list the names of the
entries, use the 1ist command. To list the attributes for each entry, use the 1ist all
command.

mod servername — modifies server entry servername in the current session. dscp

prompts you for information about servername. Press Return to accept the default value,
which is shown in square brackets [ ]. Enter “#done” to exit modify mode.

open [dsname] —opens asession for the specified directory service, where dsnameis
the directory service name. If you do not specify a value for dsnarme, this command opens a
session for the default directory service. To open a session, specify the value
“InterfacesDriver” for dsname.

quit — exits dscp.

read servername — displays the contents of server entry servername.
sess — lists all open sessions.

[switch] sess—makes session number sessthe current session.

See also

Chapter 5, Using dscp to Viiew and Edit Server Entries on page 221
dsediton page 71
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e Threaded Versions of Utilities on page 1
e Chapter 2, Utility Commands Reference on page 5
 Installation or Configuration Ulilities on page 1

dsedit

The dsedit utility allows you to view and edit server entries in the interfaces file using a GUI.
In Windows, dsedit creates and modifies network connection information in the interfaces
file.

The utility is located in:

* (UNIX) $SYBASE/$SYBASE OCS/bin.
* (Windows) $SYBASE%\%$SYBASE OCS%\bin, as dsedit.exe.

Syntax
dsedit

or:
dsedit -v

Parameters

« —v—displays the version and copyright message of dsedit.

Usage
» Set the SYBASE environment variable to the location of the current version of SAP ASE
before using dsedit.

« Setthe DISPLAY environment variable before invoking dsedit, unless you are only using
the —v parameter to display the version number.

See also

e Chapter 6, Using dsedit to View and Edit Server Entries on page 229
* dscpon page 69

o Chapter 2, Utility Commands Reference on page 5

 Installation or Configuration Ulilities on page 1

extractjava

Copies a retained JAR and the classes it contains from an SAP ASE server into a client file.

The utility is located in:
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(UNIX) SSYBASE/$SYBASE OCS/bin.
(Windows) $SYBASE$\$SYBASE 0OCS%\bin, as extrjava.exe.

Syntax

extractjava (extrjava in Windows)

or:

-Jj jar name
-f file name
a display charset]
D database name]

I interfaces file]
J client charset]
-P password]

S server name]

t timeout]

U user name]

v

z

language]

extractjava -v

Parameters

-a display charset —allows you to use extractjava from a machine where the
character set differs that of the server. Use —a in conjunction with —J to specify the
character set translation file (. x1t file) required for the conversion. Use -a without -J
only if the client character set is the same as the default character set.

-D database_name —specifies the name of the database in which to install the JAR. If
you omit the -D flag, or if you specify the -D flag with no parameter, the user’s default
database is used.

-f file name —specifies the name of the client file that is the target of the transfer.
-1 interfaces_file-—specifiesthe name and location of the interfaces file to search
when connecting to a SAP ASE server. If you omit the - T flag and parameter, or if you
specify the —T flag with no parameter, the interfaces file in the directory designated by
your SYBASE environment variable is used.

-j jar_name —specifies the name assigned to the retained JAR in the database that is
the source of the transfer.

-J client_charset—specifiesthe character setto use on the client. extractjava uses
a filter to convert input between client_charsetand the SAP ASE character set.

-J client charset requests that the SAP ASE server convert to and from
client_charset, the character set used on the client.

- J with no argument disables character set conversion. Use this if the client and server use
the same character set.
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Omitting - J sets the character set to a default for the platform, which may not necessarily
be the character set that the client is using. See the System Administration Guidefor more
information about character sets and associated flags.

-P password-—specifiesan SAP ASE password. If you omit the - P flag and parameter,
extractjava prompts for a password. If you specify the - P flag with no password, the null
password is used.

-S server_name —specifies the name of the server.

-t timeout—specifiesthe number of seconds before a SQL command times out. If you
do not specify a timeout, the command runs indefinitely. This affects commands issued
from within extractjava, not the connection time. The default timeout for logging into
extractjava is 60 seconds.

-U user_name —specifies an SAP ASE login name. If you omit the ~U flag and
parameter, or if you specify the —U flag with no parameter, the SAP ASE server uses the
current user’s operating system login name.

-v —prints the version number and copyright message for extractjava and then exits.
-z language —specifies the name of an alternate language for displaying extractjava
prompts and messages. Without the -z flag, extractjava uses the server’s default
language. Add languages to an SAP ASE during installation or afterward, using the
langinstall utility or the sp_addlanguage stored procedure.

Examples

Download classes — Downloads the classes associated with the employees JAR to the
client file newaddr. jar

¢ OnUNIX:
extractjava -j employees -f '/home/usera/jars/addr.jar' -new
e On Windows:

extrjava -J employees -f '\home\usera\jars\addr.jar' -new

Usage

Set the SYBASE environment variable to the location of the current version of SAP ASE
before you use extractjava.

If the target client file already exists, extractjava overwrites its contents.

You can write parameter flags -£, -3, -S, -U, -P, -D, and —I with or without a space
between the flag letter and the following parameter.

When you execute extractjava, an exclusive lock is placed on sysxtypes.
Specifying -jar places an exclusive table lock on sysjars.

See also:

Java in Adaptive Server Enterprise
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»  Reference Manual: Commands— remove java
»  Reference Manual: Procedures — sp_helpjava

Permissions

You need to be a system administrator or database owner to use extractjava.

Tables used

sysjars, sysxtypes

See also

 installjavaon page 74

* langinstall on page 94

» Chapter 2, Utility Command’s Refference on page 5

» Database Creation and Manipulation Utilities on page 3

installjava

Installs a JAR from a client file into an SAP ASE server.
The utility is located in:

e (UNIX) $SYBASE/$SYBASE OCS/bin.

* (Windows) $SYBASE$\$SYBASE OCS%\bin as instjava.exe.

Syntax

installjava

-f file name
[ -new | -update ]
[ -a display charset ]
[ -D database name ]
[ -I interfaces file ]
[ -J client charset ]
[ -J jar name ]
[ -P password ]
[ -S server name ]
[ -t timeout ]
[ -U user name ]
[ -v]
[ -z language ]

Or

installjava -v
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Parameters

-a display_ charset —allows you to use installjava from a machine where the
character set differs that of the server. Use —a in conjunction with —J to specify the
character set translation file (. x1t file) required for the conversion. Use -a without -J
only if the client character set is the same as the default character set.

-D database_name —is the name of the database in which to install the JAR. If you
omit the -D flag, or if you specify the -D flag with no parameter, the user’s default
database is used.

-f file name —is the name of the source file containing the classes to be installed in
the database.

-1 interfaces_file—isthe name and location of the interfaces file to search when
connecting to the SAP ASE server. If you omit the - T flag and parameter, or if you specify
the -1 flag with no parameter, the interfaces file in the directory designated by your
SYBASE environment variable is used.

-J client_charset—specifies the character set to use on the client. installjava uses
a filter to convert input between client _charsetand the SAP ASE character set.

-J client charset requests that the SAP ASE server convert to and from
client_charset, the character set used on the client.

- J with no argument disables character set conversion. Use this if the client and server use
the same character set.

Omitting - J sets the character set to a default for the platform, which may not necessarily
be the character set that the client is using. See the System Administration Guidefor more
information about character sets and associated flags.

-j jar_name —is the name of the JAR containing the classes to be installed in the
database. Indicates that the JAR file should be saved in the database and associated with
the classes it contains.

-new | -update —specifies whether the classes in the file already exist in the
database. If you specify:

e —new —You cannot install a class with the same name as an existing class

* -update - install a class with the same name as an existing class, and the newly
installed class replaces the existing class

-P password—isan SAP ASE password. If you omit the - P flag and parameter,

installjava prompts for a password. If you specify the - P flag with no password, the null

password is used.

-S server_name —is the name of the server.

-t timeout—specifies the number of seconds before a SQL command times out. If you
do not specify a timeout, the command runs indefinitely. This affects commands issued
from within installjava, not the connection time. The default timeout for logging into
installjava is 60 seconds.

Utility Guide 75



CHAPTER 2: Utility Commands Reference

-U user_name—isan SAP ASE login name. If you omit the - U flag and parameter, or if
you specify the -U flag with no parameter, the SAP ASE server uses the current user’s
operating system login name.

-v — prints the version number and copyright message for installjava and then exits.

-z language —is the name of an alternate language for displaying installjava prompts
and messages. Without the -z flag, installjava uses the server’s default language. Add
languages to an SAP ASE during installation or afterward, using the langinstall utility or
the sp_addlanguage stored procedure.

Examples

Install —Installs addr . jar and its classes, but does not retain the association between
the JAR and classes:

installjava -f '/home/usera/jars/addr.jar' -new

In Windows:

instjava -f '\home\usera\jars\addr.jar' -new

Reinstall — Reinstalls addr . jar and associates its classes with the employees JAR
name:

installjava -f '/home/usera/jars/addr.jar' -update -j employees

In Windows:
instjava -f '\home\usera\jars\addr.jar' -update -j employees

Permissions

You need to be a system administrator or database owner to use installjava.

Tables used

sysjars, sysxtypes

See also

extractjava on page 71

langinstall on page 94

Chapter 2, Utility Commands Reference on page 5
Database Creation and Manipulation Utilities on page 3

Usage for installjava

There are additional considerations when using installjava.

Set the SYBASE environment variable to the location of the current version of SAP ASE
before you can use installjava.
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* Any user can reference installed classes.

* Youcan write the -f, -j, -S, -U, -P, -D, and -Iparameter flags with or without a space between
the flag letter and the following parameter.

See also:

e Java in Adaptive Server Enterprise
»  Reference Manual: Commands— remove java
»  Reference Manual: Procedures — sp_helpjava

Cases When Adding New JARs Causes Exceptions
An exception is raised under some conditions.

* You use -new with the -j jar_name option and a JAR of that name already exists in the
database.

» Any classes of the same name as those in the source JAR already exist in the database, an
exception is raised.

Updating JARs and Classes

If you alter a class used as a column datatype by reinstalling a modified version of the class,
make sure that the modified class can read and use existing objects (rows) in tables using that
class as a datatype. Otherwise, you may be unable to access those objects without reinstalling
the class.

If you use -update:

e With the -j jar_name option:

« Allclasses in the database associated with the target JAR are deleted from the database
and the classes in the source JAR file installed in their place.

« Ifaclassinthe source JAR file is already installed in the database but is not attached to
aJAR, the class in the source JAR is installed in the database and the unattached class is
deleted.

« Without the -j jar_name option:

» Classes in the source JAR file replace unattached classes of the same name.

e Classes in the source JAR that do not correspond to an installed class are installed as
unattached classes in the database.

If you install a new JAR with a replacement for an installed class that is referenced by a SQLJ
procedure or function, make sure that the newly installed class has a valid signature for the
SQLJ routine. If the signature is invalid, an exception is raised when the SQLJ routine is
invoked.

Locks
Using installjava causes some locks to occur.

« When you execute installjava, an exclusive lock is placed on sysxtypes.
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e If jjar_name is specified, an exclusive table lock is placed on sys-jars.

isql

Interactive SQL parser to the SAP ASE server.
The utility is located in:

* (UNIX) $SYBASE/$SYBASE OCS/bin.
* (Windows) $SYBASE%\%SYBASE OCS%\bin, as isgl.exe.

Syntax
isgql [-b] [-e]l [-F] [-n] [-p] [-v] [-W] [-X] [-Y] [-Q]
-a display charset]

A packet size]
c cmdend]
D database]
E editor]
h header]
H hostname]
i inputfile]
I interfaces file]
J client charset]
K keytab file]
1 login timeout]
m errorlevel]
-M LabelName LabelValue]
o outputfile]
P password]
R remote server principall]
s col separator]
S server name]
t timeout]
U username] [-v]

V [security options]]

w column-width]

x trusted.txt file]

y sybase directory]

z localename]

Z security mechanism]

—-—-conceal [':?' | 'wildcard']l]

—--help]

--history [plhistory length [--history file history filename]]
—-—-retserverror]

--URP remotepassword

Parameters

* -a display_ charset—allowsyoutorunisql fromaterminal where the character set
differs from that of the machine on which isql is running. Use —a with -J to specify the
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character set translation file (. x1t file) required for the conversion. Use -a without -J
only if the client character set is the same as the default character set.

Note: Theascii_7 character set is compatible with all character sets. If either the SAP ASE
character set or the client character set is set to ascii_7, any 7-bit ASCII character can pass
unaltered between client and server. Other characters produce conversion errors. For more
information on character set conversion, see the System Administration Guide.

* -A packet_size —specifies the network packet size to use for this isql session. For
example, to set the packet size to 4096 bytes for the isqgl session, use:
isgl -A 4096

To check your network packet size, use:

select * from sysprocesses
The value appears under the network pktsz heading.

packet_size must be between the values of the default network packet size and maximum
network packet size configuration variables, and must be a multiple of 512. The default
value is 2048.

Use larger-than-default packet sizes to perform 1/0-intensive operations, such as readtext
or writetext operations. Setting or changing the SAP ASE packet size does not affect
remote procedure calls’ packet size.

* -b—disables the display of the table headers output.
* -c cmdend - changes the command terminator. By default, you terminate commands

and send them to the server by typing “go” on a line by itself. When you change the
command terminator, do not use SQL reserved words or control characters.

* -D database —selects the database in which the isqgl session begins.

e -—e —echoes input.

* -E editor —specifies an editor other than the default editor vi. To invoke the editor,
enter its name as the first word of a line in isql.

e -F —enables the FIPS flagger. When you specify the —-F parameter, the server returns a

message when it encounters a nonstandard SQL command. This option does not disable
SQL extensions. Processing completes when you issue the non-ANSI SQL command.

* -h headers —specifies the number of rows to print between column headings. The
default prints headings only once for each set of query results.

* -H hostname — sets the client host name.

* -i inputfile—specifiesthe name of the operating system file to use for input to isql.
The file must contain command terminators (the default is “go”).

« Specifying the parameter is equivalent to < inputfile:
-1 inputfile

« Ifyouuse -1 and do not specify your password on the command line, isgl prompts you
for it.
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< Ifyou use < inputfile and do not specify your password on the command line, specify
your password as the first line of the input file.

-1 interfaces_file-—specifiesthe nameand location of the interfaces file to search
when connecting to the SAP ASE server. If you do not specify -1, isql looks for a file
named interfaces in the directory specified by your SYBASE environment variable.
-J client_charset —specifies the character set to use on the client. The parameter
requests that the SAP ASE server convert to and from client _charset, the character set used
on the client. A filter converts input between client charset and the SAP ASE character
set.

-J with no argument sets character set conversion to NULL. No conversion takes place.
Use this if the client and server use the same character set.

Omitting —J sets the character set to a default for the platform. The default may not
necessarily be the character set that the client is using. For more information about
character sets and the associated flags, see Configuring Client/Server Character Set
Conversions, in the System Administration Guide, Volume One.

-K keytab file—(usedonly with Kerberos security) specifies a Kerberos keytab file
that contains the security key for the user name specified with the -U option. To create a
keytab, see your Kerberos documentation. If you do not specify the -K option, the isql user
must be logged in to Kerberos with the same user name as specified with the -U option.

-1 login_timeout—specifies the maximum timeout value allowed when connecting
to the SAP ASE server. The default is 60 seconds. This value affects only the time that isql
waits for the server to respond to a login attempt. To specify a timeout period for command
processing, use the —t t imeout parameter.

-m errorlevel — customizes error message appearance. For errors of the severity
level specified or higher, only the message number, state, and error level appear; no error
text appears. For error levels lower than the specified level, nothing appears.

-M LabelName LabelValue—(Secure SQL Serveronly)enables multilevel usersto
set the session labels for the this isqgl session. Valid values for Labe/Name are:

e curread (current read level) —is the initial level of data that you can read during this
session. curread must dominate curwrite.

* curwrite (current write level) — is the initial sensitivity level that is applied to any
data that you write during this session.

* maxread (maximum read level) — is the maximum level at which you can read data.
This is the upper bound to which you as a multilevel user can set curread during the
session. maxread must dominate maxwrite.

e maxwrite (maximum write level) — is the maximum level at which you can write
data. This is the upper bound to which you as a multilevel user can set curwrite during a
session. maxwrite must dominate minwrite and curwrite.
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* minwrite (minimumwrite level)—isthe minimum level at which you can write data.
This is the lower bound to which you as a multilevel user can set curwrite during a
session. minwrite must be dominated by maxwrite and curwrite.

LabelValue is the actual value of the label, expressed in the human-readable format used
on your system (for example, “Company Confidential Personnel”).

e —n-removes numbering and the prompt symbol (>) from the echoed input lines in the
output file when used with -e.

* -o outputfile —specifies the name of an operating system file to store the output
from isql. Specifying the parameter as -o outputfile issimilar to > outputfile

e —p —prints performance statistics.

* -P password — specifies your SAP ASE password. If you do not specify the —P flag,
isql prompts for a password. If your password is NULL, use the-P flag without any
password.

* —-Q—provides clients with failover property. See Using Sybase Failover in a High
Auvailability System.

* -R remote_server principal - specifies the principal name for the server as
defined to the security mechanism. By default, a server’s principal name matches the
server’s network name (which is specified with the -s parameter or the DSQUERY
environment variable). Use the —-R parameter when the server’s principal name and
network name are not the same.

* -s colseparator—resetsthe column separator character, which is blank by default.
To use characters that have special meaning to the operating system (for example, “|”, “;”,
“&”, “<”, “>"), enclose them in quotes or precede them with a backslash.

The column separator appears at the beginning and the end of each column of each row.

* -S server_name-—specifies the name of the SAP ASE server to which to connect. isqgl
looks this name up in the interfaces file. If you specify — S without server_name, isql looks
for a server named SYBASE. If you do not specify -, isql looks for the server specified
by your DSQUERY environment variable.

* -t timeout—specifiesthe number of seconds before a SQL command times out. If you
do not specify a timeout, the command runs indefinitely. This affects commands issued
from within isgl, not the connection time. The default timeout for logging into isql is 60
seconds.

* -U username —specifies a login name. Login names are case-sensitive.

» —v —prints the version and copyright message of isgl and then exits.

isgl is available in both 32-bit and 64-bit versions. They both reside in the same directory
and are differentiated by their executable file names (isql and isgl64). Enter isql
-vorisql64 -v tosee the detailed version string of the isgl you are using.

* -V security_options —specifies network-based user authentication. With this
option, the user must log in to the network’s security system before running the utility, and

Utility Guide 81



CHAPTER 2: Utility Commands Reference

users must supply the network user name with the —U option; any password supplied with
the - P option is ignored.

Follow -v witha security optionsstring of key-letter options to enable additional security
services. These key letters are:

* ¢ —enables data confidentiality service.

» d -—enables credential delegation and forwards the client credentials to the gateway
application.

e i —enables data integrity service.

* m - enables mutual authentication for connection establishment.

* o —enables data origin stamping servic.e

e g - enables out-of-sequence detection

e r —enables data replay detection

-W —disables both extended password and password encrypted negotiations.

-w columnwidth-—setsthe screen width for output. The default is 80 characters. When

an output line reaches its maximum screen width, it breaks into multiple lines.

-x trusted. txt_file —specifies an alternate t rusted. txt file.

-X —initiates the login connection to the server with client-side password encryption. isql

(the client) specifies to the server that password encryption is desired. The server sends

back an encryption key, which isgl uses to encrypt your password, and the server uses the
key to authenticate your password when it arrives.

This option can result in normal or extended password encryption, depending on
connection property settings atthe server. If CS_SEC_ENCRYPTION issetto CS_TRUE,
normal password encryption is used. If CS_SEC_EXTENDED_ENCRYPTION is set to
CS_TRUE, extended password encryption is used. If both CS_SEC_ENCRYPTION and
CS_SEC_EXTENDED_ENCRYPTION are set to CS_TRUE, extended password
encryption takes precedence.

If isql fails, the system creates a core file that contains your password. If you did not use the
encryption option, the password appears in plain text in the file. If you used the encryption
option, your password is not readable.

For details on encrypted passwords, see the user documentation for the Open Client
Client-Library.

-y sybase_directory —sets an alternate Sybase home directory.

-Y —tells the SAP ASE server to use chained transactions.

-z locale name —specifies the official name of an alternate language to display isql
prompts and messages. Without -z, isql uses the server’s default language. Add
languages to an SAP ASE server during installation or afterward, using the langinstall
utility (langinst in Windows) or the sp_addlanguage stored procedure.

-Z security mechanism—specifies the name of a security mechanism to use on the
connection.
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Security mechanism names are defined inthe 1ibtcl . cfg configuration file located in
the ini subdirectory below the Sybase installation directory. If no security mechanism
name is supplied, the default mechanism is used. For more information on security
mechanism names, see the description of the 1ibtcl.cfg file inthe Open Client and
Open Server Configuration Guide.

* --appname "application_name" —allows you to change the default application
name isql to the isql client application name. This simplifies:

» Testing of SAP ASE cluster routing rules for incoming client connections based on the
client application name.

» Switching between alternative settings for isql in $SYBASE/$SYBASE OCS/
config/ocs.cfg, such as between debugging and normal sessions.

 ldentification of the script that started a particular isgl session from within an SAP
ASE server.

application_name.

« Isthe client application name. You can retrieve the client application name from
sysprocesses.program name after connecting to your host server.

» Hasamaximum length of 30 characters. You must enclose the entire application name
in single quote or double quote characters if it contains any white spaces that do not use
the backslash escape character. You can set the goplication_nameto an empty string.

Note: You can also set the client application name in ocs . cfg using the CS_ APPNAME

property.

e --conceal [':?' | 'wildcard'] -hides your inputduring an isqgl session.
The --conceal option is useful when entering sensitive information, such as
passwords.

wildcard, a 32-byte variable, specifies the character string that triggers isgl to prompt you
for input during an isql session. For every wildcard that isqgl reads, isql displays a prompt
that accepts your input but does not echo the input to the screen. The default wildcard
is : 2.

Note: —--conceal is silently ignored in batch mode.

* --help-—displays a brief description of syntax and usage for the isql utility consisting of
a list of available arguments.

e --history [plhistory length [--history file
history filename] —Loads the contentsof the command history log file, if it exists,
when isql starts. By default, the command history feature is off. Use the --history
command line option to activate it.

e p—indicates command history persistence; in-memory command history is saved to
disk when isgl shuts down. If you do not use the p option, the command history log is
deleted after its contents are loaded into memory.
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» history length— this parameter, which is required if you use ——history, is the
number of commands that isql can store in the command history log. The maximum
value of Aistory lengthis 1024; if alarger value is specified, isgl silently truncates it to
1024.

* -history file history filename —indicates thatisqgl must retrieve the
command history log from history filename. If p is specified, isql also uses
history _filenameto store the current session’s command history. Aistory filenamecan
include an absolute or a relative path to the log file. A relative path is based on the
current directory. If you do not indicate a path, the history log is saved in the current
directory. When --history file isnot specified, isql uses the default log file in
SHOME/ .sybase/isgl/isglCmdHistory.log.

--retserverror —forces isqgl to terminate and return a failure code when it

encounters a server error with a severity greater than 10. When isgl encounters this type of

abnormal termination, it writes the label “Msg” together with the actual SAP ASE error
number to stderr, and returns a value of 2 to the calling program. isgl prints the full
server error message to stdout.

--URP remotepassword—enables setting the universal remote password

remotepasswordfor clients accessing an SAP ASE server.

Examples

Query edit —Opens a text editor where you can edit the query. When you write and save
the file, you are returned to isql. The query appears; type “go” on a line by itself to execute
it:

isgql -Ujoe -Pabracadabra
1> select *

2> from authors

3> where city = "Oakland"
4> vi

Clearingand quitting—reset clears the query buffer, and quit returns you to the operating
system:

isgl -Ualma

Password:

1> select *

2> from authors

3> where city = "Oakland"

4> reset

1> quit

Column separator s— Creates column separators using the “#” character in the output in
the pubs2 database for store ID 7896:

isgl -Usa -P -s#
1> use pubs2

2> go

1> select * from sales where stor id = "7896"

#stor id#ord num #date #
- fiomereeeseseseeomoo= ffomemmemeseeeeseesemeeeeoe=s #
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#7896 #124152 # Aug 14 1986 12:00AM#
#7896 #234518 # Feb 14 1991 12:00AM#

(2 rows affected)

* Credentials— (MIT Kerberos) Requests credential delegation and forwards the client
credentials to MY_GATEWAY:

isgl -vd -SMY GATEWAY
» Passwords— Changes password without displaying the password entered. This example
uses “old” and “new” as prompt labels:

$ isgl -Uguest -Pguest -Smyase --conceal
sp_password
:? old

new
Confirm new
Password correctly set.

(Return status 0)

* Hideinput — In this example of --conceal, the password is modified without
displaying the password entered. This example uses “old” and “new” as prompt labels:

$ isgl -Uguest -Pguest -Smyase --conceal
1> sp password

2> :? old

3>,

4> :?:? new

5> go

old

new

Confirm new
Password correctly set.
(return status = 0)

In this example of --conceal, the password is modified without displaying the
password entered. This example uses the default wildcard as the prompt label:

$ isgl -Uguest -Pguest -Smyase --conceal
1> sp password

2> 2

3>,

4> :?2:?

5> go

:?

:?

Confirm :?

Password correctly set.
(return status = 0)
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This example of --conceal uses a custom wildcard, and the prompt labels "role" and
"password" to activate a role for the current user:

$ isgl -UmyAccount --conceal '*'
Password:

1> set role

2> * role

3> with passwd

4> ** password

5> on

6> go

role

password

Confirm password
1>

Return server error —returns 2 to the calling shell, prints “Msg 207” to stderr, and
exits, when it encountered a server error of severity 16:

guest> isqgl -Uguest -Pguestpwd -SmyASE --retserverror
2> isqgl.stderr

1> select no column from sysobjects

2> go

Msg 207, Level 16, State 4:
Server 'myASE', Line 1:
Invalid column name 'no column'.

guest> echo $°?

2

guest> cat isqgl.stderr
Msg 207

guest >

Application name—Sets the application name to the name of the script that started the isqgl
session:

isgl --appname $0

History — Loads and saves the command history using the default log file:
isgl -Uguest -Ppassword -Smyase --history pl024

Run isgl with configuration file— This sample ocs . cfg file allows you to run isql
normally or with network debug information. Because the configuration file is read and
interpreted after the command line parameters are read and interpreted, setting
CS_APPNAME to isgl sets the application name back to isql:

;Sample ocs.cfg file
[DEFAULT]
;place holder

[isgl]
;place holder

[isgl dbg net]
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CS_DEBUG = CS_DBG_NETWORK
CS_APPNAME = "isqgl"

To run isql normally:

isgl -Uguest

To run isgl with network debug information:
isgl -Uguest --appname isql dbg net
* Load and save command history — Loads and saves the command history using the
default log file:
isgl -Uguest -Ppassword -Smyase --history pl024

* Deletelog—Deletes myaseHistory. log after loading its contents to memory. The
session’s command history is not stored.
isgl -Uguest -Ppassword -Smyase —--history 1024
--history file myaseHistory.log

* All commandsin command history — Lists all the commands stored in the command
history:
isgl -Uguest -Ppassword -Smyase --history pl024
1> h

[1] select @@version
[2] select db name ()
[3] select @@servername

1>

¢ Most recent commands — Lists the two most recent commands issued:
isgl -Uguest -Ppassword -Smyase --history pl024
1> h -2

[2] select db name ()
[3] select @@servername

1>
* Recall labeled command from history — Recalls the command labeled 1 from the
command history:
isgl -Uguest -Ppassword -Smyase --history pl024
1> 21

1> select @@version
2>

* Recall last-issued command from history —Recalls the latest issued command from the
command history:

isgl -Uguest -Ppassword -Smyase --history pl024
1> ? -1
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1> select @@servername
2>

Set directory — Sets an alternate Sybase home directory using the —y option:
isgql -y/work/NewSybase -Uuserl -Psecret -SMYSERVER

Roles— Activates a role for the current user. This example uses a custom wildcard and the
prompt labels “role” and “password”:

$ isgl -UmyAccount --conceal '*'Password:
set role

* role

with passwd

** password

on

go

role
password
Confirm password

Application name — Sets the application name to “isql Session 01"

isgl -UmyAccount -SmyServer --appname "isqgl Session 01"
Password:

1>select program name from sysprocesses

2>where spid=@Q@spid

3>go

program_name

isgl Session 01

Deleting history —DeletesmyaseHistory. log after loading its contents to memory.
The session’s command history is not stored:

isgl -Uguest -Ppassword -Smyase —--history 1024
--history file myaseHistory.log

See also

Interactive isql Commands on page 91

Command History in isq/on page 93

Chapter 7, Using Interactive isql from the Command Line on page 241
Threaded Versions of Utilities on page 1

Chapter 2, Utility Commands Reference on page 5

Database Creation and Manipulation Utilities on page 3

Usage for isql

Additional information for using isql.

If you are using threaded drivers, use the isqgl syntax for isql_r.
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« If you are using threaded drivers in the IBM platform, use the standard syntax for isql.

» Before using isql, set the SYBASE environment variable to the location of the current
version of Adaptive Server.

e The 5701 (“changed database™) server message is no longer appears after logging in or
issuing a use database command.

« Error message format differs from versions of isqgl earlier than 15.7. If you have scripts that
perform routines based on the values of these messages you may need to rewrite them.

« Whenyouinclude the -X parameter, the password-enabled connection proceeds according
to server capabilities:
 If the server can handle both extended password and password encryption, extended

password encryption negotiations are used.

« If the server can handle only password encryption, password encryption negotiations
are used.

« Ifthe server cannot handle password encryption or extended password encryption, the
first connection attempt fails and the client attempts to reconnect using a plain text
password.

« Terminate acommand by typing a line beginning with the default command terminator go
or another command terminator, if the -c parameter is used. Follow the command
terminator with an integer to specify the number of times to run the command. For
example, to execute this command 100 times, type:
select x =1
go 100
The results appear once at the end of execution.

* If you enter an option more than once on the command line, isql uses the last value. For
example, if you enter this command, “send”, the second value for —c, overrides “.”, the
first value:
isgl -c"." -csend

This enables you to override any aliases you set up.

« Execute operating system commands by starting a line with two exclamation points (! !)
followed by the command.

« To clear the existing query buffer, type reset on a line by itself. isql discards any pending
input. Press Ctrl+c anywhere on a line to cancel the current query and return to the isql
prompt.

» Read in an operating system file containing a query for execution by isql:
isql -U alma -Ppassword < input file

The file must include a command terminator. The results appear on your terminal. Read in
an operating system file containing a query and direct the results to another file:
isgl -U alma -Ppassword < input file > output file

« isql displays only six digits of f1oat or real data after the decimal point, rounding off
the remainder.
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You can include comments in a Transact-SQL statement submitted to the SAP ASE server
by isqgl. Open a comment with “/*”. Close it with “* /™, as shown in this example:
select au lname, au fname

/*retrieve authors’ last and first names*/

from authors, titles, titleauthor

where authors.au id = titleauthor.au id

and titles.title id = titleauthor.title id

/*this is a three-way join that links authors

**to the books they have written.*/

Do not comment out a go command at the beginning of a line. For example, use this to
comment out the go command:

/*

**go

=

Do not use this:

/*

go

=)

isgl defines the order of the date format as month, date, and year (mm dd yyyy hh:mmAM
(or PM)), regardless of the locale environment. To change this default order, use the
convert function.

In an isql session, the default prompt label is either the default wildcard :? or the value of
wildcard. Customize the prompt label by providing a one-word character string, with a
maximum length of 80 characters after a wildcard. If you specify a prompt label that is
more than one word, the characters after the first word are ignored.

Note: In an isqgl session, isql recognizes :?, or the value of wildcard, as wildcards only
when these characters are placed at the beginning of an isqgl line.

See also:

Reference Manual: Building Blocks— exact numeric datatypes, convert built-in
function

Reference Manual: Commands — create schema, set

Reference Manual. Procedures — xp_sendmail extended stored procedure,
sp_addlanguage, sp_addlogin, sp_addremotelogin, sp_add_resource_limit,
sp_bindexeclass, sp_configure, sp_defaultlanguage, sp_droplanguage,
sp_helplanguage, sp_processmail, sp_remoteoption, sp_serveroption,
sp_showcontrolinfo, sp_unbinexeclass, sp_volchanged

System Administration Guide: Volume 1 — default network packet size and maximum
network packet sizeconfiguration parameters
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Interactive isql Commands
To use isgl interactively, give the command isql (and any of the optional parameters) at your
operating system prompt.

The isqgl program accepts SQL commands and sends them to the SAP ASE server. The results
are formatted and printed on standard output. EXit isgl with quit or exit.

When using isql interactively:

« Read an operating system file into the command buffer using:

:r filename

Do not include a command terminator in the file; enter the terminator interactively once
you have finished editing.

« Read and display an operating system file into the command buffer using:
:R filename

« You can change the current database using:

use databasename

The commands you execute from within interactive isql are:

Command Description

:r filename Reads an operating system file into the command buffer.

Do not include the command terminator in the file; once you have finished
editing, enter the terminator interactively on a line by itself.

:R filename Reads an operating system file into the command buffer then shows the
command.

Do not include the command terminator in the file; once you have finished
editing, enter the terminator interactively on a line by itself.

use data- Changes the current database.
base name

!'! os _command | Executes an operating system command. Place at the start of a line.

> file name Redirects the output of the Transact-SQL command to file_name. This
example inserts the server version into file_name:

select @@version
go > file name
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Command

Description

>> file name

Appends the output of the Transact-SQL command to file_name.This ex-
ample appends the server version to file_name:

select @@version

go >> file name

| command

Pipes the output of the Transact-SQL command to an external command.
This example finds all instances of “sa” in the listing produced by

sp_who:

sp_who
go | grep sa

vi (UNIX) or edit

Calls the default editor.

(Windows)
reset Clears the query buffer.
quitorexit Exits isql.

isgl Session Commands

Additional commands to use within isql.

Command | Description

> Redirects command output to a file. File is overwritten if it exists.
> Redirects command output to a file. The output is appended to the file if the file already
exists.

| Pipes the output of a command to an external application.

reset Clears the query buffer.

quit or exit | EXits from isql.

Vi Calls the editor.

It command | Executes an operating system command.

:r filename | Reads an operating system file.

‘R filename | Reads and displays an operating system file.

use dbname | Changes the current database to dbname.
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Prompt Labels and Double Wildcards in an isgl Session

In an isql session, the default prompt label is either the default wildcard : 2 or the value of
wildcard. You can customize the prompt label by providing a one-word character string with a
maximum length of 80 characters, after a wildcard.

If you specify a prompt label that is more than one word, the characters after the first word are
ignored. Double wildcards such as : ? : ? specify that isql needs to prompt you twice for the
same input. The second prompt requests you to confirm your first input. If you use a double
wildcard, the second prompt label starts with Confirm.

Note: In an isql session, : ? or the value of a custom wildcard is only recognized by isql as
such, when it is the first "word" of a line.

Command History in isql
The command history feature is available in command mode.

Only commands that are issued interactively in isqgl are included in the command history.
Examples of commands that are not included in the command history are those that are
executed using the -1 command line option or as part of a redirected input, such as:
isqgl -Uguest -Ppassword -Smyase --history pl024

--history file myaseHistory.log <<EOF
exec sp X y z
go
EOF
Command history contains the most recent commands issued in an isql session. When
history lengthis reached, isgl drops the oldest command from the history and adds the newest
command issued.

If you do not specify an alternate log file, and if the $SHOME or %APPDATA% environment
variable used by the default log file is not defined, an error message appears and the command
history log is not saved.

In an isql session, use the h [n] command to display the command history. A page can
display up to 24 lines of commands. If the command history contains more than 24 lines, press

Enter to display the next set of commands or enter “a” to display all commands in one page.

Enter “g” to return to isql.

nindicates the number of commands to appear. If nis:

« Positive — the commands that appear start from the oldest command in the history.
* Negative — the 7most recent commands appear.

Usethe 2 n | 2?2 command to recall and reissue a command from the command history.

When nis positive, isgl looks for the command labeled with the number nand loads this to the
command buffer. When n is negative, isgl loads the /th most recent command issued.

?2? — recalls the latest command issued and is equivalent to ? -1.
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« Whenacommand is recalled from history, the recalled command overwrites the command
in the command buffer.
* You can edit a recalled command before resubmitting the command to the server.

langinstall

Installs a new language in an SAP ASE.
The utility is located in:

+ (UNIX) $SYBASE/$SYBASE ASE/bin.
* (Windows) $SYBASE$\$SYBASE ASE%\Dbin, as langinst.exe.

Syntax

langinstall
[-I path]
[-P password]
[-R release number]
[-S server]
[-U user]
language
character set

Or

langinstall -v

Parameters

* -I path—specifies the name and location of the interfaces file (sql. ini file in
Windows) that langinstall searches when connecting to the SAP ASE server. If you do not
specify -, langinstall uses the interfaces file in the directory specified by the SYBASE
environment variable. If it is not set, langinstall looks for the default SYBASE directory.

* -P password — specifies the system administrator’s (“sa” account) password. If you
omit —P, langinstall prompts for the “sa” account password.

* -R release_number - specifies the release number, in the format n.71.7, to use to
upgrade messagesinmaster. .sysmessages.Use —-Ronly in failure conditions, such
as if langinstall (langinst in Windows) fails, in case of user error, or when you think that
messages in sysmessages are out of date.

The -R parameter forces langinstall to collect messages from a release previous to the
current one. langinstall compares the existing messages with the ones to be installed and
replaces any that have changed.

For example, if the current version is 15.0, and the previous version was 12.5, and you
think sysmessages may not be correct, include the messages from the earlier version in
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the syslanguages.upgrade column (12.5 in this case) by specifying -R12. 5.
langinstall then installs all messages from SAP ASE 12.5.

* -S server—specifies the name of the SAP ASE server to which to connect. If you do
not specify -s, langinstall uses the server specified by your DSQUERY environment
variable. If DSQUERY is not set, langinstall attempts to connect to a server named
SYBASE.

* -U user —specifies a login name. Login names are case sensitive.

* language —is the official name of the language to be installed. You must specify a
language.

* character_set—isthe name of SAP ASE default character set, and indicates the
directory name of the localization files for the language. The common . loc and
server. loc localization files for an official language reside in the character set
directory $SYBASE/locales/language/character set in UNIX platforms,
or $SYBASE%\locales\language\character set in Windows. You must
specify a character set.

» -v —prints the version number and copyright message for langinstall and then exits.

Usage

The SAP ASE installation program runs langinstall automatically for a new installation as
well as for customers who are upgrading from an earlier version.

langinstall:

» Adds the specified language-specific information to master..syslanguages using
sp_addlanguage. If the language already exists, langinstall updates the appropriate row
in syslanguages.

« Adds to, updates, and deletes error messages as necessary from master..sysmessages.

e Updates syslanguages.update, inserting the new release number.

» Validates the entries in the localization file sections that it uses. If anything is missing,
langinstall prints an error message and does not add the language to syslanguages.

» Compares the version numbers of each localization file it uses, common . 1oc and
server. loc. If they are not the same, it prints a warning message.
syslanguages.upgrade is always set according to the version number in server. loc.

See also:
»  Reference Manual: Procedures — sp_addlanguage, sp_addlogin, sp_configure,

sp_defaultlanguage, sp_droplanguage, sp_helplanguage

Permissions

Only a system administrator using the “sa” account can run langinstall.
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Tables used

master.dbo.syslanguages,master.dbo.sysmessages

See also

e defncopy on page 64

e srvbuildon page 134

e Chapter 2, Utility Commands Reference on page 5

o Ulilities for Languages, Character Sets, and Sort Orders on page 2

optdiag

Displays optimizer statistics or loads updated statistics into system tables.
The utility is located in:

* (UNIX) $SYBASE/$SYBASE ASE/bin.
* (Windows) $SYBASE%$\$SYBASE ASE%\bin, as optidag.exe.

Syntax

optdiag [binary] [simulate] statistics
{ -1 input file | databasel.owner|.[{table|prs name}
[.column] ] 1 ]
[-o output file] }
user name]
password]
trace value]
interfaces file]
server]

]

]

language]

client character set]

[-U
[-P
[-T
[-I
[-S
[-Vv]
[-h
[-s
[-z
[=J
[-a display charset]

Parameters

* binary—extracts statistics in human-readable form and in binary form. When used with
aninputfile (-1 input file), loads binary statistics into system tables.

* simulate —specifies that optdiag display or load simulated statistics. See the
Performance and Tuning Guide.

* -i input_file—specifies the name of the operating system file to use for optdiag
input. Specifying an input file causes optdiag to update optimizer statistics for the table or
column by using the values in the specified file (also called “input mode™).
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* database —is the name of the database whose statistics you want displayed. In input
mode, optdiag uses the database name as specified in the file, and does not accept a
database name from the command line.

* owner —is the name of a table owner. In:

« Display mode - if you do not specify an owner, but do specify a table name, optdiag
displays output for all of the owners of a table.
« Input mode - optdiag ignores the table owner specified on the command line and uses
the value in the input file.
e table —is the name of the table to survey for statistics. If the command:

« Does not include an owner name or a table name — optdiag displays statistics for all
tables in the database.

 Includes an owner name, but no table name — optdiag displays all of the tables that
belong to the specified owner.

In input mode, optdiag ignores the table name specified on the command line and uses the
value from the input file.

e prs_name—indicates the name of the precomputed result set.

* column—isthe name of the colum to survey. If the command does not include a column
name, optdiag displays all statistics for a table.

In input mode, optdiag ignores the column name on the command line and uses the values
from the input file.

* -o output_file —specifies the name of an operating system file to store the output
from optdiag. If a file with the same name already exists, optdiag overwrites that file
without warning.

* -U user_name —specifies an SAP ASE login name.

* -P password —specifies your SAP ASE password. If you do not specify the - P flag,
optdiag prompts for a password.

* -T trace_value-—setstrace flags for the optdiag session. The optdiag trace flags and
their meanings are:

* 1-donotstopwith awarning if the optdiag version of SAP ASE in use does not match
the SAP ASE version in the input file.

e 2 —display status message “Next table is fable_name’ when in input mode.

« 4 —skip consistency checking for step numbers while loading histograms in input
mode.

« 6 —display lines of input file during input mode. This flag has no effect in display
mode.

* 7 —do not stop with a warning if the optdiag input file does not include sampling
percent information.

* -I interfaces_file—specifies the name and location of the interfaces file to use
when connecting to an SAP ASE server.
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If you do not use —I and specify an interfaces file name, optdiag looks for the interfaces
file (interfaces in UNIX), in the directory specified by the SYBASE environment
variable. In Windows, optdiag looks for afilenamed sql . ini inthe ini subdirectory in
the Sybase installation directory (d: \ sybase). Then, if SYBASE is not set, optdiag
looks for the file in the default $SYBASE directory (¥SYBASES in Windows).

-S server —specifies the name of the SAP ASE server to which to connect. optdiag
looks for this name in the interfaces file (sgl.ini in Windows).

If you use - without specifying a server name, optdiag looks for a server named
SYBASE.

When you do not use -, optdiag looks for the server that your DSQUERY environment
variable specifies.

-v —displays the version number of and a copyright message for optdiag and exits.

-h —displays the optdiag syntax help.

-s —includes system tables in optdiag output. By default, only user tables are included.
-z language—is the official name of an alternate language that the server uses both for
date formats and to display optdiag prompts and messages. Without the -z flag, optdiag
uses the server’s default language.

Add languages to SAP ASE either during or after installation, After SAP ASE installation,
use either the langinstall utility or the sp_addlanguage stored procedure to add a
language.

-J client_charset—specifies the character set to use on the client. A filter converts
input between client charsetand the SAP ASE character set.

Byusing -J client charset, you request that the SAP ASE server convert data to
and from client _charset, the client’s character set.

By using - J without a character set name, you specify character set conversion as NULL;
no conversion takes place. Use this —J alone when the client and server are using the same
character set.

By omitting -J, you set the character set to the default set for the platform. A filter
converts input between the default set and the SAP ASE character set. Keep in mind that
the default may not necessarily be the character set that the client is using.

For more information about character sets and their associated flags, see the System

Administration Guide.

-a display charset—runsoptdiag from aterminal with a character set that differs

from that of the machine on which optdiag is running. Use -a:

* Inconjunction with —J to specify the character set translation (. x 1 t) file required for
the conversion.

*  Without -J only if the client character set is the same as the default character set.

Note: The ascii_7 character set is compatible with all character sets. If either the SAP ASE

character set or the client character set is set to ascii_7, any 7-bit ASCII character can pass
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unaltered between client and server. Any other characters produce conversion errors. For
more on character-set conversion, see the System Administration Guide.

On some Linux platforms, the LANG environment variable might be set by default to
“en_US.UTF-8,” which can cause unnecessary LONGCHAR conversion between the
client and server. If your server and client have different charsets, we recommend that you
bypass the conversion using one of these methods:

* unsetenv LANG

* setenv LANG C

* optdiag -J

e optdiag -Jiso-1 (if your server uses iso-1)

Examples

» User tables— Displays statistics for all user tables in the pubs2 database and places the
output in the pubs?2 . opt file:
optdiag statistics pubs2 -Usa -Ppasswd -o pubs2.opt

e Table—Displays statistics for the titles table:

optdiag statistics pubs2..titles -Usa -Ppasswd
-0 titles.opt

* Precomputed Result Sets— Displays information for the precomputed result set prs1.

optdiag statistics prsdb..prsl -Usa -Ppass -Sserver

Server name: nn

Specified database: "prsdb"

Specified table owner: not specified

Specified table: "prsl"

Specified column: not specified

Table owner: "dbo"

Table name: "prsl"

Table type: "precomputed result set"
Statistics for table: "prsl"

No statistics for remaining columns: "a"

(default values used)

Optdiag succeeded.

e Character set —Displays statistics using the roman8 character set and row labels and error
messages in French:
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optdiag statistics pubs2..titles -Usa -Ppasswd
-0 titles.opt -J roman8 -z french

Binary statistics—Displays binary statistics for the price columninthe titles table:

optdiag binary statistics pubs2..titles.price
-Usa -Ppasswd -0 price.opt

Edited statistics— Loads edited statistics from the price. opt file:

optdiag statistics -i price.opt -Usa -Ppasswd

See also

ddlgen on page 42
Chapter 2, Utility Command’s Reference on page 5

Usage for optdiag

Take these into consideration when using optidag.

Set the SYBASE environment variable to the location of the current version of SAP ASE
before using optdiag.

By default, optdiag does not include the system tables when you display statistics for a
database. To include the system tables in the output, use the -s flag.

You cannot specify a particular partition on the optdiag command line; optdiag displays
statistics for all partitions of a specified table.

When you use binary mode, optdiag displays the human-readable values with comment
marks (#s) at the beginning of the lines, as shown in this example:

Statistics for column: "price"

Last update of column statistics: Jan 20 1998 7:16PM
Statistics loaded from Optdiag.

Range cell density: 0x3f8b9cfefece26bf
# Range cell density: 0.0134830400000000
Total density: 0x3f8b9cfefece26bf
# Total density: 0.0134830400000000
Range selectivity: default used (0.33)
# Range selectivity: default used (0.33)
In between selectivity: default used (0.25)
# In between selectivity: default used (0.25)

When you use optdiag with an input file to change statistics, it ignores all characters after

the “#” in a line.

Converting floating-point values may lead to rounding errors when you use files for input.

When you are loading statistics on the same hardware platform, edit the statistics using the

binary values to provide greater precision.

optdiag displays:

» The statistic sampling percent last used, which indicates that statistics are gathered
with a user-specified sampling percent.

 Statistics for each partition of a multi-partitioned table or index.
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» Global- and partition-level statistics for each column in a table with multiple partitions.

* Use ddigen partition names and the optdiag utility to analyze optimizer behavior by
creating empty partitioned tables with simulated metadata.

See also:

e Performance and Tuning Guide — for details on optidag output, and changing statistics
using optidag

»  Reference Manual: Commands - create index, delete statistics, set, update statistics

»  Reference Manual: Procedures — sp_addlogin, sp_configure, sp_defaultlanguage,
sp_droplanguage, sp_flushstats, sp_helplanguage

Byte Ordering and Binary optdiag Files
Do not use the binary mode option to move statistics between SAP ASE servers on machines
that use different byte ordering.

« Onanincompatible architecture server, always comment out binary statistics and load the
human-readable statistics.

« Onacompatible architecture server, load either binary statistics or human-readable
statistics.

optdiag Input Mode
When you use the -1 input file syntax, optdiag reads the file as named and updates
statistics in sysstatistics.

optdiag input mode changes the allow update to system tables configuration parameter by
setting the parameter to 1 at the beginning of the session, and then to 0 at the end of the
session.

During histogram input, the process checks these rules and displays error messages for any
violated rules:

e The step numbers must increase monotonically, unless the command includes the -T4
trace flag.

e The column values for the steps must increase monotonically.

» The weight for each cell must be between 0.0 and 1.0.

* The total of weights for a column must be close to 1.0.

« The first cell represents null values, and it must be present, even in columns that do not
allow null values. There must be only one cell to represent the null value.

« Two adjacent cells must not both use the < (less than) operator.
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preupgrade

Performs tests on an installation or database to determine its readiness for upgrade, and reports
found problems.

The utility is located in:

* (UNIX) $SYBASE/S$SSYBASE ASE/upgrade.
* (Windows) $SYBASE%$\$SYBASE ASE%\upgrade, as preupgrd.exe.

Syntax

preupgrade [-v] [-h] [-N]
[-p [skip sybprocs]

D database name]

I interfaces file]

P password]

-S server name]

U user name]

X option[,option]...]

Parameters

* -D database_ name —limits checking to the named database and a subset of possible
checks. Use this parameter to check newly loaded databases before bringing them online.

* -h —prints help text and then exits.

* -I interfaces_file—specifies an interfaces file for the server. The default is
$SSYBASE/interfaces.

* N -specifies preupgrade is to run in noninteractive mode. Thus, if preupgrade
determines that any database is too small, the utility exits immediately.

* -p [skip sybprocs] —specifies whether you want to skip the parsing validity test
on stored procedures.

During the upgrade process, stored procedures are automatically re-created internally
from the text source, requiring that they be parsed correctly. The valid options for
preupgrade -p are:

e —p —skips the parsing in all databases
* -p skip procs - skips parsing in sybsystemprocs while parsing the other
databases
« Not using -p — parses text everywhere. This is the default.
* -P password - specifies the password for connecting to the server. SAP recommends
that you do not use this option on the command line as the password is then visible to other
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users when they view displays of system information. Rather, wait until the SAP ASE
server prompts for a password, and enter the information then.

-S server_name—specifies the name of the server to which you want to connect. This
server must be listed in the interfaces file specified by the — T parameter. The default is
$DSQUERY.

-U user_name — specifies the user name to use when connecting to the server. The
default is “sa.” user_name must have “sa_role” privileges on the server being checked.

Note: If you use the -D option, which limits checking to a named database, and that
database is offline, enter “sa” or accept the default as the user name.

-v — prints version information and exits.

-X option[, option...] —specifiesa list of checks to be made. The default is all
checks, except when using the —D option, which uses only a subset of available checks. If
you specify the -x option more than once on the command line, preupgrade performs
only those checks in the last entered —x parameter.

When using the -X parameter with an options list, either:

« List options without a space between the comma and the next option, or
e Surround the options list with quotes.

Valid check options are:

Check
Option

Option Description
Used With
the -D
Parame-
ter

all

Performs all permitted checks. When used with the —D option, only checks
subset of options. Otherwise, all options are checked.

cache

Checks the definition of default cache size. If the definition is DEFAULT, enter
its current value in the configuration file as its actual value. This ensures that its
size does not change because the new server’s default value is different from
the current server’s default value.

config Checks the server’s configuration parameters to see if they are consistent with

new requirements, and reports discrepancies.

Discrepancies can cause errors or warnings for certain parameters:

e Errors — occur when the current value of a parameter is outside the new
server’s range, or when its value is too low for upgrade.

*  Wiarnings — occur when the current value of a parameter is between the
maximum and minimum values, but less than the default value
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Check Option Description
Option Used With
the -D
Parame-
ter
da- Performs updates to system tables, including clearing certain system table
ta mods columns that are non-zero. Applies primarily to older SAP ASE servers, and
o will make no changes to newer systems.
data- X Checks the systypes table to make sure that if existing datatypes use a
type system-defined name, type, or user type, they match what the new server
expects. Reports discrepancies and suggests remedies.
db_size Checks that certain system databases meet the minimum size requirements for
installation.
free sp| X Checks for free space in the named database or in all databases. Makes sure that
ace there is sufficient free data and log space to perform the necessary upgrade
steps.
ob- X Checks that object IDs of user-defined objects are not reserved for system
ject id objects.
e SAP ASE 15.0 and later reserves objects IDs 1 — 255.
e SAP ASE 12.5.x and earlier reserves object IDs 1 — 99.
Does not issue an error. If you receive a warning that a user object ID is
reserved, contact Technical Support for directions for changing the user object
ID after upgrade.
re- Checks that required system databases exist. Some versions of SAP ASE may
quired require specialized databases such as sybsystemdb.
dbs
sproc_t | X Checks for the existence of stored procedure text in the named database or in all
ext databases. After upgrade, the SAP ASE server must recompile stored proce-
dures from their source text. This check makes sure that all of the source text is
both available and valid.
srvclas Checks for servers classed as “generic” inmaster .dbo.sysservers.
S This class is deprecated by SAP ASE 12.0 and later.
statis- Checks for duplicate rows in sysstatistics. Duplicate rows may occur
tics when upgrading from SAP ASE 12.0to SAP ASE 15.0 and later due to schema
changesinthe sysstatistics table.
Versions of SAP ASE may occasionally change valid options for the —x parameter; use the
—h parameter to view the current set of valid options.
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Examples

» Check options(-X) — Specifies checks for the default cache size, minimum database size,
and duplicate rows in sysstatistics for the installation:
preupgrade —-X cache,db size,statistics

* Check database (-D) —Checks a newly loaded, offline database for datatypes, free space,
object IDs, and stored procedure text:
preupgrade —-Dmy db -Usa

* Noninteractive mode (-N) — Shows how the sqglupgrade utility uses preupgrade. When

used in this way, preupgrade checks all databases, runs noninteractively, and exits with a
failing status if any database is too small:

preupgrade -N

Permissions

The user login specified by the - U parameter must have system administrator privileges to run
preupgrade on the server specified by the -s parameter.

When using the -D parameter to check an offline database, preupgrade must log in as user
“sa.” The “sa_role” privilege is insufficient.

See also

* sglupgrade on page 132

» sqlupgraderes on page 133

» Chapter 2, Utility Command’s Refference on page 5
» Installation or Configuration Utilities on page 1

Usage for preupgrade
There are additional considerations when using preupgrade.

« When preupgrade finds no errors, it exits with status 0 (zero).

e preupgrade is primarily used before upgrading an installation to ensure the procedure will
run smoothly. You can also run preupgrade after loading a database created by a previous
version of Adaptive Server to check for problems that might prevent that database from
upgrading while being brought online.

» sqglupgrade calls preupgrade as part of its normal procedure.

The preupgrade -D Parameter
Use the —D parameter primarily to check newly loaded databases before bringing them online.

To do so, preupgrade must force access to offline databases, which requires that preupgrade
log in as user “sa.” The “sa_role” privilege alone is insufficient. The default is -Usa.
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When run as part of a normal upgrade, the —D parameter is optional, and you can choose a
system administrator login other than “sa.”

Unless the —D parameter is included, preupgrade checks all databases in the system, and runs
only on previous server versions.

sglupgrade always runs the full set of preupgrade checks. Correct problems and run
preupgrade to ensure that the problems are indeed corrected before letting sqlupgrade repeat
the full preupgrade procedure.

If the -D parameter is included, preupgrade:

« Checks only the named database.

« Can run be run against server of the same version number as the preupgrade utility.

« Limits checking to a subset of possible checks. See —x parameter for a list of checks that
are valid when used in conjunction with this parameter.

When running preupgrade after an upgrade to check a newly loaded but offline database, use
the —-D parameter and either specify the “sa” login or omit the —-U parameter.

When you specify the —D option, or specify a partial list of options with the —-X parameter,
preupgrade performs the specified checks and, if there are no errors, displays a list of checks
performed in the exit message.

You may want to use the -D and the —X parameters as part of the normal upgrade if
preupgrade reports warnings or errors for a particular database or area. Using these
parameters allows you to focus on problem areas without repeating unnecessary checks.

pwdcrypt

Creates and prints an encrypted LDAP password in the 1ibtcl.cfg file.
The utility is located in:

+ (UNIX) $SYBASE/SSYBASE OCS/bin.
* (Windows) $SYBASE%$\%$SYBASE OCS%\bin, as pwdcrypt.exe.

Before using pwdcrypt, set the SYBASE environment variable to the location of the current
version of SAP ASE.

Syntax
pwdcrypt

Examples

» Example of pwdcrypt —Enter pwdcrypt at the prompt to return a request to enter your
password twice, after which pwdcrypt returns the LDAP password:
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pwdcrypt
Enter password please: password
Enter password again : password

The encrypted password:
0x01312a775ab9d5c71£99£05£7712d2cded288d0aelce79268d0e8669313d1lbc
4c706

Replace the last part of the LDAP URL in 1ibtcl.cfg with this encrypted password:

ldap=libsybdldap.so

ldap://dolly:389/dc=sybase,dc=com????

bindname=cn=Manager, dc=sybase, dc=com?
0x01312a775ab9d5c71£99£05£7712d2cded288d0aelce79268d0e8669313d1lbc
4c706

An unencrypted password looks similar to:

ldap=libsybdldap.so
ldap://dolly:389/dc=sybase,dc=com????
bindname=cn=Manager, dc=sybase, dc=com?
secret

Permissions

Use file system permissions to prevent unauthorized access to this encrypted password in your
libtcl.cfgfile.

See also
» Chapter 2, Utility Command’s Refference on page 5

gptune

gptune is an SAP ASE utility written in Java/XML. It enables users to fix missing statistics
and identify the best query plan, optimization goals, or other configuration settings, and apply
them at the query or server level. This results in optimal performance of subsequent query
executions.

Syntax

gptune
[-U username]

-P password]

-S hostname:port/database]

-A action]

-M mode]

-T appTime]

-1 inputFile]

-0 outputFile]

-f fileList(,)]

-c configFile]

-1 1imit]
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-e evalField]

-d difference]

-m missingCount]
-n login]

-J charset>]

-N (noexec) ]

-g (applyOptgoal) ]
-v (verbose) ]

-s (sort)]

-h (help)]

Parameters

* -U username — specifies the database user name.
* -P password — specifies the database password.

* -S server—specifies the database server. The database server is denoted by fost. pord
gatabase.

Note: Specify the -s option while using any gptune action.
* -A action-—specifies the action to be taken. Valid actions are:

e start

e collect - the default value
e collect full

L4 compare

e fix

e start stats

e collect stats

« fix stats

e undo fix stats

* -c configFile —specifies the configuration file. The default value is
config.xml.

* -d difference —specifies the percentage and absolute value difference for
performance improvement to be considered outstanding using the format -d <di ff%
(,diff abs)>. Thedefaultvalue is 5,5. If you specify percentage but not the absolute
value, then absolute value defaults to 0.

* -e evalField-isthe evaluation field used for performance comparison. The default
value iselap.avg.

e -f fileList—compares a list of files to get the best plans; use commas to separate
filenames.

» —g-—when used along with the £ i x action, applies the default goal. The default goal is the
best optgoal setting that most queries used as the best plan using QPTune’s f£1ix action.

This option only generates plans for queries that do not currently use the server’s default
optimization goal.
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* -i inputFile —specifies the input file for the fix, fix stats, and
undo fix stats actions. You can also use -1 to apply special rules to the specified
queries for start for custom modes.

e -J charset—specifies the character set used to connect to an SAP ASE server. If you
do not specify this option, the SAP ASE server uses the server’s default character set.

Note: If the installed JRE does not support the server’s default charset encoding, you see
an error message during the login process. Use the —J option to specify a more generic
character set, such as -J utfs.

e -1 1limit—specifies a limit on the number of queries that should be analyzed and
applied with special rules.

* -M mode —specifies the optimization goal or custom mode for an application. The valid
options for modeare allrows oltp,allrows dss,allrows mix.Youmay also
define custom modes, however basic_isasystem-reserved custom mode. The default
value isallrows dss.

* -m missingCount —specifies the threshold value for missing statistics. The default
value is 5.

* -N-usedalongwith fix statsandundo fix stats, -Ngeneratesa SQL script
with update statistics or delete statistics statements. The update or delete statements are
not executed through gptune. The statements are written into a SQL script that is specified
by the —o option.

* -n login —specifies the user’s login whose query executions are collected and
analyzed.

* -0 outputFile —specifies the output file. The default value ismetrics.xml.

* -T appTime —specifies the application running time, in minutes. The default value is
0.

e —v—specifies verbose mode. Do not use —v when collecting more than 1,000 queries, as
gptune can take a long time to export all the query information on the console. Instead,
view the output XML file for query details.

Examples
» Fix stats— Fixes missing statistics, starts the utility with the start stats action:
QPTune -A start stats -S my host:4816/my database -v

Executing : QPTune -U sa -P [unshown]

-S jdbc:sybase:Tds:my host:4816/my database

-A start stats -M allrows dss -T 0 -i null

-0 metrics.xml -f null -c config.xml -1 5

-e elap avg -d 5,5 -m 5 -n null -v

You are now connected to database: my database

[INFO] Config: sp configure 'capture missing statistics', 1
[INFO] Config: sp configure 'system table', 1

[INFO] Config: delete sysstatistics where formatid =110
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* Retrievemissing information —Uses collect stats to retrieve missing statistics
information from the sysstatistics table for statistics that exceed a specified

threshold for count of missing statistics:

QPTune -A collect stats -m 1 -o missingstats.xml -v
-S my host:4816/my database

Executing QPTune -U sa -P

[unshown]

-S jdbc:sybase:Tds:my host:

4816/my database -A collect stats -M allrows dss -T 0 -i null -o

missingstats.xml -f null -c config.

-n null -v

You are now connected to database:

Now collecting missing statistics

on "Fri Sep 26 10:08:06 PDT 2008".
<?xml version="1.0" encoding="UTF-

xml -1 5 -e elap avg -d 5,5 -m 1

my database
information from sysstatistics

8" 72>

<server url="jdbc:sybase:Tds:my host:4816/my database"

file="missingstats.xml"

type="missing stats" datetime="Fri Sep 26 10:08:06 PDT 2008" >

<missingStat id="1">
<1d>1068527809</1id>
<stats>Y (y4,y2)</stats>
<count>2</count>
</missingStat>
<missingStat id="2">
<id>1068527809</id>
<stats>Y (y3)</stats>
<count>1</count>
</missingStat>
<missingStat id="3">
<id>1068527809</id>
<stats>Y(y2,yl)</stats>
<count>1</count>
</missingStat>
<missingStat id="4">
<id>1068527809</id>
<stats>Y (yl)</stats>
<count>1</count>
</missingStat>
</server>

The missing statistics information is written into XML file:

missingstats.xml

[INFO] End config: sp configure
[INFO] End config: sp configure
[INFO] End config: sp configure
[INFO] End config: sp configure

'enable metrics capture', 0
'abstract plan dump', O

'system table', 0

'capture missing statistics', O

Program has restored the data source for metrics collection.

QPTune finished executing.

¢ Updatestatistics— After collecting missing statistics information into an XML file called
missingstats.xml, updates the statistics using the fix stats action:

QPTune -A fix stats -m 1 -i missingstats.xml
-v -S my host:4816/my database

Executing QPTune -U sa -P

[unshown]

-S jdbc:sybase:Tds:my host:

4816/my database -A fix stats -M allrows dss -T 0 -i
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missingstats.xml -o metrics.xml -f null -c config.xml -1 5 -e
elap avg -d 5,5 -m 1 -n null -v

You are now connected to database: my database

Fix statistics on "Fri Sep 26 10:14:59 PDT 2008"

Fixed statistics: [Update] Y (y4,vy2)

[INFO] Fix Statement = update statistics Y (y4,y2)
Fixed statistics: [Update] Y (y3)

[INFO] Fix Statement = update statistics Y (y3)
Fixed statistics: [Update] Y(y2,yl)

[INFO] Fix Statement = update statistics Y (y2,yl)
Fixed statistics: [Update] Y(yl)

[INFO] Fix Statement = update statistics Y (yl)
————— QPTune finished executing. ------

Generates a SQL script for updating statistics, without executing the actual updates, by
using the —N option to indicate “noexec”, and the —ooption to indicate the output script
file:

QPTune -U sa -P -S my host:5000/my database
-A fix stats -m 5 -1 missingstats.xml
-N -o missingstats.sql

« Start QPTune— Starts QPTune to apply standard optimization goal settings to queries:

QPTune -S host:port/database -A start
[-M {allrows oltp, allrows dss, allrows mix}]

Start QPTune to apply custom rules to specified queries:

QPTune -S host:port/database -A start -M custom 1
-1 input.xml -1 3 [-V]

* Collect metrics— Runs your application and collect metrics into an XML file named
a2.xml:

QPTune -S host:port/database -A collect -T O
-0 aZ2.xml -v

Program has configured the data source for metrics collection.
Now collecting information from sysquerymetrics on "Tue Feb 19
22:16:04 PST 2008".

<?xml version="1.0" encoding="UTF-8"?>

<server url="jdbc:sybase:Tds:SHANGHI:5000" type="ASE"
mode="custom 1" datetime="Tue Feb 19 22:16:04 PST 2008">
<query id="1">

<gtext> select count (T.title id) from authors A, titleauthor T
where A.au_id = T.au id </gtext>

<elap avg>300</elap avg>

<bestmode> custom 1

</bestmode>

</query>

</server>

e CompareXML files—Once metrics are collected, compares different XML files to get the
best query optimization goal or criteria for each of the queries:
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QPTune -A compare -f al.xml,a2.xml -d 51,10
-0 best.xml -S my host:5000/my database

This result shows a comparison between two XML metrics files: a1 . xm1 has six queries,
and a2 . xm1 has seven queries. Comparisons can only be made between the queries that
are common to both files. There are three queries that ran faster in a2 . xm1:

Compare all the files: | al.xml, a2.xml|
Report generated on "Tue Aug 19 21:13:04 PST 2008"

File #1: [name= al.xml : mode=allrows mix]

File #2: [name= a2.xml : mode=custom 1]

Query count in File #1 : [mode=allrows mix] 6
Query count in File #2 : [mode=custom 1] 7

Query count improved in File #2: [mode=allrows mix] 3
Total performance improved [from 422 to 129]: 69 %

Following queries run better in File #2:
[mode=allrows mix]

Group l: improved by no more than 25% [0 queries]

Group 2: improved by 25% to 50% [l queries]

Query: select count(T.title id) from authors A, titleauthors T
where A.au id = T.au id

Average elapsed time (ms): File #1=100 File

#2=50 Improvement=50.0% Outstanding=No

Group 3: improved by 50% to 75% [0 queries]

Group 4: improved by 75% to 100% [2 queries]

Query: select count(*) from titlles T, titleauthors TA where
T.title id = TA.title id

Average elapsed time (ms): File #1=34 File

#2=7 Improvement=79.0% Outstanding=Yes

Query: select au lname, au fname from authors where state in
("CA", "AZ") - -

Average elapsed time (ms): File #1=9 File

#2=0 Improvement=100.0% Outstanding=No

Usage

When you use QPTune to collect a very large number of queries, you may see a message such

Exception in thread "main" java.lang.OutOfMemoryError:
Java heap space

If this occurs, increase the value of the maximum heap size of the Java Virtual Machine (JVM)
by using sp_jreconfig to set the -Xmx arguments of the PCA_JVM_ JAVA OPTIONS
directive to a size larger than the default of 1024MB. See Chapter 2, “Managing the Java
Environment” in Java in Adaptive Server Enterprise for more information about —Xmx.
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When you use QPTune to collect a large amount of queries, do not use the -v verbose option.
See also:

e Java in Adaptive Server Enterprise
e Migration Technology Guide
»  Reference Manual: Procedures — sp_jreconfig

Permissions

QPtune’s compare action may be run by any user. All other actions of QPTune may only be
run by users with sa_role and sso_role.

See also
e Chapter 2, Utility Commands Reference on page 5

qrmutil

(Cluster Edition only) grmutil allows you to back up, restore, and reconfigure the quorum
device.

The utility is located in $SYBASE/$SYBASE ASE/bin.

Syntax

--additional-run-parameters=parameter 1ist
--ase-config-extract=file name
-—ase-config-info
--ase-config-store=file name
--ase-config-version=version number

—-buildquorum=[force]--cluster-take-over

--config-file=file name

--diag={all | boot | toc | nodes | locks | config | cms}

--display={boot | nodes | heartbeat | master | cluster |
instance | config | state}

--drop-cluster=[force]
--drop-instance=instance name
--errorlog=file name
--extract-config=file name

=, ==help

-F, --cluster-input=file name
--fence-capable=device path
--installation=installation mode

-s, —-linstance=instance name
--instance-node=node name
--interfaces-dir=path to interfaces file
--max-instances=number of instances
--master-dev=master device
--membership-mode=membership mode
--primary-address=interconnect address
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--primary-port=port number
--primary-protocol=protocol

_QI

—--quorum-dev=quorum device

--register-node=node name
--secondary-address=interconnect address
--secondary-port=port number
—-—-secondary-protocol=protocol
--traceflags=traceflag list
--unregister-node=node name
--verify-node=node name

—V,

--version]

Parameters

--additional-run-parameters=parameter_ list— parameters that
Unified Agent uses to start the data server. Unlike other settings, dataserver does not read
additional run parameters. They are read by the unified agent and passed to the dataserver
command line. If you include the --instance parameter, the additional run parameters
apply to the specified instance. Otherwise, the additional run parameters apply to all
instances in the cluster.

--ase-config-extract=file name —extracts the SAP ASE configuration file
stored on the quorum device to the named file.

--ase-config-info —displays information about the SAP ASE configuration file
stored on the quorum device.

--ase-config-store=file name—stores the named file in the quorum device as
the SAP ASE configuration file.

--ase-config-version=[version number] —displays or sets the version of
the master SAP ASE configuration file stored on the quorum device.
--buildquorum[=force] —builds anew quorum device. Use =force to overwrite
an exiting file or an existing quorum device on a raw partition. You must include the —-
cluster-input parameter with -—buildquorum
--config-file=config file name —if used with -~instance, sets this path
to the SAP ASE configuration file for the specified instance. If you do not include -
instance, sets the path to the cluster-wide configuration file.

--diag={all | boot | toc | nodes | locks | config | cms} —for
internal use only.

--display={boot | nodes | heartbeat | master | cluster |
instance | config | state} —displays the current state of cluster or instance:

e boot —displays start-up information for the cluster, including the version of the
quorum device, any trace flags issued at start-up, the boot ID of the cluster, and any
messages displayed at start-up.

* nodes —displays the registered management nodes.
* heartbeat —displays heartbeat information for all nodes in the cluster.
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e master —displays master device information.
e cluster —displays the cluster configuration.

* instance —displays the instance configuration. You must include --
instance=instance name with this parameter.

e config - displays configuration for the cluster and for all instances in the cluster.
* state —displays the current state for the cluster and for all instances in the cluster.

* --drop-cluster=[force] —drops a cluster and removes the quorum device. Use
=force to force the drop if the quorum indicates the cluster is running.

Warning! --drop-cluster removes the cluster.

* --drop-instance=instance_name —do not use; internal use only.

Warning! Use the sybcluster utility to drop an instance from the cluster.

* --errorlog=log file name —full path to the error log for the specified instance.
You must include the -instance-name parameter. Takes effect at next restart of the
instance.

* --extract-config=file name —extracts the configuration area of the quorum
device to the specified file.

e -h | --help —displays the full syntax of grmutil.

* -F | cluster-input=file name —loads the cluster configuration from the
specified cluster input file.

* --fence-capable=device path —tests if specified device can be used for I/O
fencing. Returns either “Device is fence capable” or “Device is not fence capable”.
* --installation=installation mode —changes the installation mode for the

cluster. Values are:

e shared (default)
e private
* -instance=instance_name —applies grmutil parameters to a specified instance.
* --interfaces-dir=interfaces_path —the path to a directory that contains a
file named interfaces. If this parameter is used with --instance, it sets the path to the
interfaces file for the specified instance. If -—instance is not included, sets the path to
the cluster-wide interfaces file.

* --max-instances=number of _instances —Ssetsthe maximum number of
instances for the cluster configura_tion. B

* --master-dev=master_device_ name - changes the master device the cluster
uses.

* --membership-mode=membership mode — sets the membership mode. Values
are:

e native (default)
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e VCsS
--primary-address=interconnect_address —changes the primary
interconnect address for a given instance.

--primary-port=port number—changesthe starting port number for the primary
interconnect for a given instance.

--primary-protocol=protocol —changes the protocol used for the primary
cluster interconnect.

-Q | --quorum-dev=quoum_path —specifies the full path to the quorum device.
--register-node=node_name —registers a node for quorum management.
--secondary-address=inteconnect_address —changes the secondary
interconnect address for a given instance.

--secondary-port=port_number — changes the starting port number for the
secondary interconnect for a given instance.
--secondary-protocol=protocol — changes the protocol used for the
secondary cluster interconnect.

--traceflags=trace_flag, trace_flag-—changes the cluster-wide or the
instance-specific trace flags for start-up. If you do not include a list of trace flags, grmutil
clears the trace flags for the cluster instance.

--unregister-node=node name—unregisters a node from quorum management.
--verify-node=node_name —indicates that the specified node is registered on the
quorum device.

-v | --version —displays the version information for the grmutil utility.

Examples

Change path — Changes the path to the error log to /sybase/opt/cluster/
ASE-15 0O/asel.log:

grmutil --quorum dev=/dev/raw/rawlOl --instance=asel
--errorlog=/sybase/cluster/ASE-15 0/ASE-15 0/asel.log

Register node — Registers the node “blade5” for mycluster:

grmutil --quorum dev=/dev/raw/rawl0l --register-node=bladeb

Create quorum device — Creates a new quorum device for the cluster “mycluster”:
grmutil --quorum-dev=/dev/raw/rawl0l --cluster-input=/sybase/
cluster/asel.inp -buildquorum

Back up device —Backs up the quorum device to /sybase/cluster bak/
quorum.bak:

grmutil --quorum-dev=/dev/raw/rawlOl
--extract-config=/sybase/cluster bak/quorum.bak

Restore device — Restores the quorum device from the backup created in /sybase/
cluster bak/quorum.bak:
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gqrmutil --quorum-dev=/dev/raw/rawl0l --cluster-input=/sybase/
cluster bak/quorum.bak --buildquorum=force
» Display configuration — Displays the cluster configuration stored on the quorum device:

grmutil --quorum-dev=/dev/raw/rawl0l --display=config

¢ Test — Tests whether the named device can be fenced:

grmutil --quorum-dev=/dev/raw/rawl0l --fence-capable=/dev/raw/
rawl06

Usage

» grmutil is primarily a diagnostic utility. We recommend that you use sybcluster to make
configuration changes to the cluster.

« You may pass as many as 20 commands to grmutil. However, you can specify the --
instance= parameter only once.

* If you specify -—buildquorum, the quorum is built and grmutil exits without running
any commands other than --cluster-input.

e grmutil exits after it executes the -—-drop-cluster parameter.

e This is an example of using multiple commands:

grmutil --quorum-dev=/dev/raw/rawl0l --display=cluster
--register-node=bladel --unregister-node=blade2 --verify-
node=blade3

Permissions

To run grmutil, you must be the same sybase user that started the instance, with execute
priveledges on the grmutil binary, have direct access to the quorum device, and at least read
permissions on the quorum file.

See also
e Chapter 2, Utility Commands Reference on page 5

showserver

(UNIX only) Shows the SAP ASE servers and Backup Servers that are currently running on
the local machine, available only in UNIX platforms.

The utility is located in $SYBASE/$SYBASE ASE/install.

Syntax

showserver

Utility Guide 117



CHAPTER 2: Utility Commands Reference

Parameters

None—

Examples

Serversrunning — Shows the SAP ASE servers and Backup Servers that are currently
running on the local machine:

showserver
USER PID $CPU %MEM SZ RSS TT STAT START TIME COMMAND
userll4276 0.0 1.7 712 1000 2 S Apr 5514:05 dataserver

-d greensrv.dat -sgreensrv -einstall/greensrv+ errorlog

sybase 1071 0.0 1.4 408 820 2 S Mar 28895:38 /usr/local/
sybase/bin/dataserver -d/dev/rsdlf -e/install/errorlog

userl28493 0.0 0.0 3692 0?2 IW Apr 1 0:10 backupserver -
SSYB BACKUP

-e/install/backup.log -Iinterfaces -Mbin/sybmultbuf -Lus_ english

-Jiso 1

Usage

showserver displays process information about an SAP ASE server or Backup Server. If no
servers are running, only the header appears.

See also:

Reference Manual: Building Blocks— host_name
Reference Manual: Commands — startserver

See also

aataserveron page 35

Startserveron page 138

langinstall on page 94

Chapter 2, Utility Commands Reference on page 5
Utilities to Gather Information on page 4

sqldbgr

sqgldbgr is a command line utility that debugs stored procedures and triggers.

The utility is located in:

(UNIX) SSYBASE/S$SYBASE ASE/bin.
(Windows) $SYBASES$\$SYBASE ASE%\bin, as sqldbgr.exe.

As with many source-level debuggers, you can:
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» Attach sqgldbgr to a task

» Set, enable, and disable breakpoints

« Step through a task one line at a time

« Step into and out of procedures

» Detach sqldbgr from stored procedures or triggers once the debugging is complete.

Note: You do not have the ability to view sqldbgr version strings.

Syntax

sgldbgr
-U username
-P password
-S host:port

Parameters

* -U username —specifies the user name. Insert a space between -U and username.

* -P password — specifies the user password. Insert a space between -P and
password.

* -S host:port —specifies the machine name and the port number. Insert a space
between -s and Aost.port.

Examples

* Debug stored procedures and trigger s— Shows sqldbgr debugging stored procedures
and triggers on host MERCURY:

$SYBASE/$SYBASE ASE/bin/sgldbgr -U sa -P -S MERCURY:16896

(sgldbg) stop in sp who

Breakpoint moved to line 20

(sgldbg) run sp who

(sp_who::20)1if Q@trancount = 0

(sgldbg) next

(sp_who::22) set chained off

(sgqldbg) cont

fid spid status loginame origname hostname blk spid dbname cmd
block xloid

0 2 sleeping NULL NULL 0 master NETWORK HANDL

ER 3 Osleeping NULL NULL 0 master NETWORK HANDL

ER 4 Osleeping NULL NULL 0 master DEADLOCK TUNE

0 5 Osleeping NULL NULL 0 master MIRROR HANDLE

% 6 Osleeping NULL NULL 0 master ASTC HANDLER

0 7 Osleeping NULL NULL 0 master ASTC HANDLER
0

Utility Guide 119



CHAPTER 2: Utility

Commands Reference

0 8 sleeping NULL NULL 0 master CHECKPOINT SL
EEP 0
0 9 sleeping NULL NULL 0 master HOUSEKEEPER
0
0 10 running sa sa 0 master SELECT
0
0 11 sleeping sa sa
(sgqldbg) show breakpoints

1 stop in sp_who

(sgldbg)

Debug a stored procedurerunning in another task — In this example, the system

administrator first logs in to an SAP ASE server using isql, then starts sqldbgr from the

command li

SSYBASE/S
1> select
2> go

SSYBASE/S

(sqldbg)
The spid
(sgldbg)
(sgldbg)
(sgqldbg)
Breakpoin
(sgldbg)
(sgldbg)
(sp_who::

(ADHOC: :1:

(sgldbg)
(sp_who:
(sgqldbg)
(sp_who:
(sgldbg)
(sgldbg)
isgl scre
(sqldbg)

(sgldbg)

See also

ne to debug a stored procedure that is running in another task:

SYBASE 0OCS/bin/isql -U sa -P
@@spid

SYBASE ASE/bin/sqgldbgr -U sa -P -S MERCURY:16896

attach 13

is invalid
attach 12

show breakpoints
stop in sp who

t moved to line 20
/* at this point run the sp who procedure from spid 12 */
where
20::@loginname = <NULL>)
:null)
next
:22) set chained off
next
:25)set transaction isolation level 1
cont
/* at this point the sp who result will show up in the
en */
detach 12

Chapter 2, Utility Commands Reference on page 5

Usage for sqldbgr

Additional usag

The sgl com
is executed i

e instructions for sqldbgr

mand is executed in the context of debugged task, while the mysqgl command
n the context of debugger task. Setting session-specific information, such as

for set quoted_identifier on through sql does not work.
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+ By default, the SAP jConnect™ for JDBC driver uses set quoted_identifier on. Since the
sqgldbgr utility is built using jConnect arguments that need quotes, use single quotes
instead of double quotes when entering options. For example, use sp_configure
'allow update’ instead of sp configure "allow update™.

« Before running sqldbgr, set either the SYBASE_JRE or JAVA_HOME environments to
the location containing the Java run environment.

*  When you invoke sqldbgr at the command prompt, the utility starts and the prompt
changes to a sgldbgr prompt:

(sgldbgr)

Once you see the (sgldbgr) prompt, enter these sqldbgr commands to perform your

tasks:

sgldbgr commands and their descriptions are:

Command

Description

attach spid

Attaches a task to sqldbgr when you are already logged in to an SAP ASE
server.

Do not use attach spid to attach to a procedure that is not running.

sqgldbgr cannot debug multiple tasks in the same session. If you try to attach the
utility to multiple tasks, the first spidcontinues to be marked as attached. Since
you cannot attach to a spid'that is already attached, use the detach command,
and then attach to another sp/d.

run prochame

Debugs stored procedures and triggers without attaching sgldbgr to an existing
task.

If you attempt to use run procname while you are already debugging an ex-
isting task with attach spid, run procname fails and you see:

Cannot run a procedure while debugging another task

stop in procname
[at line #]

Sets a breakpoint to stop the stored procedure or trigger being debugged at the
beginning of the specified procedure name.

stop in procname at line # sets a breakpoint to stop the stored procedure or
trigger being debugged at a designated line within the specified procedure.

If you enter an invalid line number, sgldbgr moves the breakpoint to the next
valid line number, and displays:

Invalid line number

You can also use this command to set multiple breakpoints.
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Command

Description

show breakpoints

Displays the breakpoint handle in the form of a unique number, as well as the
breakpoint statements given by the user during the sqldbgr session.

If you specify a breakpoint line number that does not contain a valid SQL
statement, the SAP ASE server moves the breakpoint to the next valid line
number. However, SAP ASE does not change the command you entered. This is
why show breakpoints can return a breakpoint handle and a breakpoint state-
ment given during the sqgldbgr session that can be different.

An asterisk (*) in the breakpoint line indicates that the breakpoint is set, but
currently disabled.

use dbname

Tells sgldbgr what database to use in order to debug that database’s stored
procedures or triggers.

show variables [at lev-
el #]

Dsplays all the variables and their values in the current SQL stored procedure or
trigger.

show variables at level # — displays the variables and their values in the current
SQL stored procedure or trigger at the specified level.

Note: sqldbgr does not support Java variables.

show where

Displays the call stack of the stored procedures and triggers that exist in the task
being debugged.

step Or next

Instructs sgldbgr to move to the next statement in the current stored procedure
or trigger.

step into Instructs sqldbgr to move into a procedure if the current statement is an exe-
cute statement. If the current statement is an update, delete, or insert state-
ment, and if there are triggers in it, step into instructs sgldbgr to move into the
update, delete, or insert triggers.

step out Instructs sqldbgr to move out of the current stored procedure or trigger, and to

stop at the next line in the calling procedure.

set @varname =

Sets the value of the indicated variable to the variable value declared in the

VALUE command in the current stored procedure or trigger. The values for the variables
set using set @varname = VALUE are valid only for the current session
sqldbgr.

cont[inue] Instructs sqldbgr to continue debugging, and to stop at the next breakpoint (if

any).
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Command Description
delete # Deletes the indicated breakpoint set in the current instance of sqldbgr.
enable # Enables the indicated breakpoints, while disable # does the opposite.

sql any_sql_state-

Executes ad hoc SQL statements. Use this command to select and analyze data

ment from temp tables created by the task being debugged.
sql any_sql_statement returns a result set and any errors that occurred.
detach spid Detaches sqldbgr from the indicated sp/d, and releases the task being debug-
ged.
It deletes the breakpoints that were set for the task being debugged during the
current sgldbgr session.
help [all] Display sqldbgr commands.

Error Messages in sqldbgr

Error messages for sqldgbr.

Message

Displays When

Cannot allocate re-
source in ASE

The SAP ASE server does not have sufficient memory resources
to execute sqldbgr. Increase procedure cache size and restart
sqldbgr.

Cannot create Debug-
ger handle in ASE

The SAP ASE server does not have sufficient memory resources
to create a debugger handle. Increase procedure cache size and
restart sqldbgr.

The spid is invalid

You attempt to attach sgldbgr to an invalid spid. Double check the
Spidand try again.

You cannot debug a
task that is not
owned by you

You are attempting to debug a task that you do not own. You must
log in to the server as the owner of the task to be debugged.

Spid is already be-
ing debugged

You execute attach spid and attempt to attach to a spid'that is
already being debugged.

Spid is not debugged
currently

You execute detach spid and attempt to detach from a spid'that is
not attached to sqldbgr.

Invalid command

You enter an invalid command.
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Message Displays When
Invalid procedure You enter an invalid procedure name in stop in procname.
name

Invalid line number | You enter an invalid line number in stop in procname at line #.

Variable not found You enter an invalid variable in show @varname, show @varname
at level #, or set @varname = VALUE.

Illegal conversion You execute set @varname = VALUE and attempt to convert the
attempted variable to an invalid value.

Conversion from text | set @varname = VALUE is unsuccessful.
to datatype failed

Cannot run a proce- | You use runprocname While already debugging an existing task
dure while debugging | With attach spid.
another task

sqglloc

(

UNIX only) Installs and modifies languages, character sets, and sort order defaults for SAP

ASE using a GUI.
The utility is located in $SYBASE/$SYBASE ASE/bin.

S server]
U user]
P password]
-D data directory]
s sybase dir]
I interfaces file]
r resource file]

Or
sglloc -v
Parameters

-I interfaces file—specifiesthe nameand location ofthe interfaces file tosearch
when connecting to an SAP ASE server.

-P password — specifies the “sa” account password.

-Ddata_directory —(optional) specifies the working directory when it differs from
the default installation directory for an SAP ASE server. Use this option when you specify
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at the time that you install SAP ASE, that another user could configure the server. If you do
not use -D, the SAP ASE server uses $SYBASE as the default.

* -r resource file—executes the specified resource file.

* -S server —specifies the name of the SAP ASE server to which to connect.

* -U user —specifies a login name. Logins are case-sensitive.

* -s sybase dir-—specifies the value to use for the SYBASE environment variable.
* —v —prints the version number and copyright message for sglloc and then exits.

Usage
Set the:

« SYBASE environment variable to the location of the current version of SAP ASE before
using sqlloc.

« DISPLAY environment variable before invoking sqlloc, unless you are only using the —v
parameter to display the version number.

See also:

 Installation guide for your platform

Permissions

You must be a Sybase system administrator to use sqlloc.

See also

* langinstall on page 94

» sgllocreson page 125

» Chapter 2, Utility Command’s Refference on page 5

» Ulilities for Languages, Character Sets, and Sort Orders on page 2

sqgllocres

(UNIX only) Installs and modifies languages, character sets, and sort order defaults for an
SAP ASE server, using a resource file.

The utility is located in $SYBASE/$SYBASE OCS/bin.

Syntax

sgllocres
[-S server]
-U user]
-P password]
-D data directory]
=8

[
[
[
[ sybase dir]
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Or

[-I interfaces file]
[-r resource file]

sgllocres -v

Parameters

-I interfaces file—specifiesthe nameand location of the interfaces file to search
when connecting to an SAP ASE server.

-P password — specifies the “sa” account password.

-Ddata_directory —(optional) specifies the working directory when it differs from
the default installation directory for an SAP ASE server. Use this option when you specify
at the time that you install SAP ASE, that another user could configure the server. If you do
not use -D, the SAP ASE server uses $SYBASE as the default.

-r resource file —executes the specified resource file.

-S server —specifies the name of the SAP ASE server to which to connect.

-s sybase dir —specifies the value to use for the SYBASE environment variable.
-U user —specifies a login name.

-v —prints the version number and copyright message for sqllocres, then exits.

Usage

Set the SYBASE environment variable to the location of the current version of SAP ASE
before using sqllocres.

See also:

Installation guide for your platform

Permissions

You must be a Sybase system administrator to use the sqllocres utility.

See also

langinstall on page 94

sqlloc on page 124

Chapter 2, Utility Commands Reference on page 5

Utilities for Languages, Character Sets, and Sort Orders on page 2
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sqlsrvr

(Windows only) The executable form of the SAP ASE program.

The utility is located in $SYBASE$\$SYBASE ASE%\bin.

Syntax
sglserver [-f] [-g] [-G] [-h] [-H] [-m] [-P] [-g9] [-v] [-X]

[-a path to CAPs directive file]

-b master device size] [k | K | m | M| g | G| t | T]
-c config file for server]

-d device name]

-e path to error 1og]

-1 interfaces file directory]

-K keytab file]

-L config file name for connectivity]
--master key password [=password]

-M shared memory repository directory]
-p sa login name]

-r mirror disk name]

-s server_name]

-T trace flag]

-u sa/sso_name]

-w master | model database]

-y [password] ]

-z page size [ k | K] ]

Parameters

-a path to CAPs directive_ file —specifies the path to the CAPs directive
file.

-bmaster device size [k | K | m | M| g | G| t | T ]-specifies
the size of the master device.

-c config file for server —specifies the full path name of an SAP ASE
configuration file. Use this parameter to start an SAP ASE server with the configuration
values in the specified configuration file.If you specify a configuration file with the sqlsrvr
-c parameter, make sure all the parameters in this configuration file are compatible before
you boot the server. If some of the configuration parameters are incompatible, the server
may not start. To avoid this, do not specify a configuration file when you build the master
device. The build phase uses all default settings when you do not specify a configuration
file.For more information, see the System Administration Guide: Volume 1.
-ddevice_ name —is the full path name of the device for the master database. The
master database device must be writable by the user who starts the SAP ASE server. The
default master database device name is d master.
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-eerrorlogfile—isthe full path name of the error log file for SAP ASE system-level
error messages.

- £ —forces initialization of a device or database. You must use both -b and -w to use -
£.

-G — specifies the name of the event log server.

-g —turns off event-logging.

—H —starts the high availability (HA) server, if you have the HA feature installed on your
SAP ASE server.

-iinterfaces file directory —specifies the directory location of the
interfaces file to search when connecting an SAP ASE server. If -1 is omitted, sqlsrvr
looks for a file named interfaces in the directory pointed to by your SYBASE
environment variable.

-h — prints this help message, then exists.

-Kkeytab_file—specifies the path to the keytab file used for authentication in DCE.
-Lconfig file name for connectivity —specifies the name the
configuratioﬁ file for conne_ctivit;

-M sharedmem_directory —places shared memory files in the specified directory
instead of in the default location, $SYBASES. If sharedmem_dlirectory starts with “\”, the
directory name is assumed to be absolute. Otherwise, the directory name is interpreted
relative to $SYBASES.

-m — starts an SAP ASE server in single-user mode.

--master_key password [=password] —specifies the master key password
when you provide the password on the command line or prompts for a master key

password during SAP ASE startup. The password characters do not appear, and the
password is not validated until later in the SAP ASE startup sequence.

If you include the password on the command line, it is visible until the memory is read and
used.

-psso_login_name —specifies the login name of a system security officer when
starting an SAP ASE server, for the purposes of getting a new password for that account.
The SAP ASE server generates a random password, displays it, encrypts it, and saves it in
master..syslogins as that account’s new password.

-q —treats quiesced databases as “in recovery.”

-rmastermirror — starts the mirror of the master device. Use this parameter to start
the SAP ASE server if the master device has been damaged.

-sservername —specifies the name of the SAP ASE server to start. If —s is omitted, a
server named SYBASE is started.

-Ttrace flag-—

-usa/sso_name—specifies the system administrator or system security officer’s name
you want to unlock.
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* —v —prints the version number and copyright message for sqlsrvr and then exits.

* -w master | model database —specifies whether you want to write a master or
model database.

e -X —starts this server as sybmon, not dataserver.

* -y [password] —allowsyou to assign a password for the encrypted private key, so that
the server prompt the user for a password. This password should match the password you
used to encrypt the private key when it was created. You cannot use this parameter when
you are running the server in the background.

Note: Although you can a password with -y, for security reasons Sybase strongly
discourages you from doing so.

A private key is included with your server’s digital certificate. By default, the certificate
file located:
$SYBASE%\%$SYBASE ASE%\certificates\servername.crt

The location of the certificate file changes if you invoke the sp_ssladmin addcert
command.

* -z page size —specifies the page size of the server. Use -b and -w to use this flag,
and name an even power of two between 2k and 16k, or else the server does not boot.

Examples

* Createnewinstallation —Creates a new installation with a 100MB master device and a 4k
page:
sglsrvr -d d master -z 4k -b 100.02M

The spaces between options and their following arguments are optional and acceptable.
This example specifies “100.02M” for a 100MB master device because the server requires
16KB of overhead for its configuration area.

* Rewriteacorrupt master — Rewrites a corrupt mode 1 database:

sglsrvr -d d master -w model

To rewrite a corrupt master database specifying device size:

sglsrvr -d d master -w master -z 4k

To rewrite a corrupt master database, specifying device and page sizes, forcing the
server to accept these values in preference to what it may find in the config block:
sglsrvr -d d master -w master -z 4k -b 100.02M -f

To rewrite acorrupt ma s t er database, specifying a page size that does not match what the
server finds in its config block, which produces a failure:
sglsrvr -d d master -w master -z 8k

00:00000:00000:2001/01/19 12:01:26.94 server The
configured server page size does not match that
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specified on the command line. To use the configured
size, omit the command line size; to use the command
line size, specify 'force' (-f).

To rewrite a corruptma ster database, specifying an incorrect page size, even in anormal
boot, which produces a failure:

sglsrvr -d d master -z4000

sglsrvr: the 'z' flag may not be used without 'b' or
'w'. sglsrvr: server will ignore the 'z' flag. sglsrvr:
the 'z' flag contained an invalid page size. sqglsrvr:
the page size must be an even power of two between 2048
and 16384 bytes, inclusive.

Permissions

Anyone with execute permission on the binary, and who has read/write access to all the files.

Tables used

sysconfigures

See also

Startserveron page 138
Chapter 2, Utility Commands Reference on page 5
Utilities to Start Servers on page 3

Usage for sqlsrvr

Usage considerations for sqlsrvr.

The sqlsrvr utility is referred to as dataserver in other Sybase documents.

Start the SAP ASE server using the services manager utility rather than by executing the
sqlsrvr program directly. If you need to change any of the default parameters, edit the SAP
ASE Registry keys. See the configuration guide for your platform for details.

An SAP ASE server derives its running environment from values in the
sysconfigures system table. Run sp_configure to see the configuration values; use
sp_configure and reconfigure to change the configuration

Because SAP ASE passwords are encrypted, you cannot recover forgotten passwords. If
all system security officers lose their passwords, the -p parameter generates a new
password for a system security officer’s account. Start the SAP ASE server with -p,
immediately log in to the SAP ASE server with the new random password, and execute
sp_password to reset your password to a more secure one.

By default, the SAP ASE server logs error messages in both the local error log file and the
local Windows event log. You can disable Windows event logging by including the -g
parameter and specifying a different event-logging machine with -G machine_name. Use
standard Windows conventions when entering the machine_name. For example, to
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designate a PC named “LOGSITE”, substitute “\LOGSITE” for the machine_name. See
the configuration guide for your platform for details on logging error messages.

« After you have finished running the installer, set the file permissions on the sqlsrvr
executable to limit who can execute it.

« If you do not specify an SAP ASE name with the -s parameter, and you have not set the
DSLISTEN environment variable, sqglsrvr uses the default SAP ASE name SYBASE. The
value of the DSLISTEN environment variable overrides this default value, and the -s
parameter overrides both the default and the DSLISTEN environment variable.

» Automatic login lockouts can cause a site to end up in a situation in which all accounts
capable of unlocking logins (system administrators and system security officers) are
locked. If this occurs, use the sqlsrvr utility with the -u parameter to check the specified
login for system administrator or system security officer authorization, unlock the
account, and reset the value of the current failed logins counter to zero.

o -fisonly valid when used with -b and/or -w. The server fails to boot if you use -f without
either -b or -w. -f forces the server in different ways, depending whether -w is present. See
-b and -w below.

See also:
»  Reference Manual: Commands - disk mirror, disk remirror, reconfigure

e Reference Manual: Procedures — sp_configure, sp_password

Starting an SAP ASE Server
There are two methods to start an SAP ASE server with a specified configuration file.
Use either method to start an SAP ASE server:

» Use Server Config to configure the server to have the —c parameter. In the Configure SAP
ASE window, select the Command Line option, and in the Command Line Parameters
window, enter:

-Cconfiguration file pathname

Forexample, entering -chaze . cf£g starts the server using the haze . c£g configuration
file.
» Start SAP ASE from the command line and provide the —c parameter.

startsrvr Dependencies and Conditions with -b and -w
The effect of -b changes, depending on whether -w is present.

* -bwithout -w creates a new master device as named by -d (the default is d_master)and
with the page size as specified by -z (the default is 2048). If the named device:
» Already existsas an OS file, the attempt fails, and you must remove the existing file and
try again.
» Names an existing raw partition, the attempt fails unless you include the -f flag. This
reinitializes the raw partition as a server master device.
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e -bwith-wmaster tells dataserver to use the size specified in -z for the master device
when re-creating the master database. It implies nothing about creating a new device.

-w may or may not require additional flags. If you use:

e -wmodel —the -z and -b flags are accepted but ignored.

* -wmaster for new installations — the -z and -b parameters are not required because the
device size information is stored in the config block.
* -wmaster to upgrade older installations:

» The server requires -b and/or -z if the config block does not contain a valid entry
for the associated sizes. The command fails if it can't get valid data for the page size or
device size.

* You may provide -b and/or -z whenthe config block contains valid entries for the
sizes they represent. However if the sizes do not match what is in the
config block, add -f to force your new size preferences.

» -f may appear without either -b or -z, because -f also instructs the server to accept
damaged allocation pages as belonging to the master database. This is useful for
restoring badly corrupted databases. If you specify -wmaster -f, the server assigns to
the master database every allocation page on the named master device that does not
belong to some other database than master.

sqlupgrade

(UNIX only) Upgrades your currently installed version of SAP ASE to the newest release
using a GUI.

The utility is located in $SYBASE/$SYBASE ASE/bin.

Syntax

sglupgrade
[-s sybase dir]
[-r resource file]
[-D data directory]

Or
sglupgrade -v

Parameters

* -r resource file —executes the specified resource file.
* -s sybase dir-—specifiesthe value to use for the SYBASE environment variable.

* -Ddata_directory—(optional) specifies the working directory when it differs from
the default installation directory for the SAP ASE server. Use this option when you specify
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at the time that you install SAP ASE, that another user could configure the server. If you do
not use -D, the SAP ASE server uses $SYBASE as the default.

e —v —prints the version number and copyright message for sqlupgrade and then exits.

Usage
Set the:

« SYBASE environment variable to the location of the current version of SAP ASE before
using sqlupgrade.

e DISPLAY environment variable before invoking sglupgrade, unless you are only using
the —v parameter to display the version number.

See also:

» The installation guide for your platform

Permissions

You must be a Sybase system administrator to use sqlupgrade.

See also

e preupgrade on page 102

» sglupgraderes on page 133

e Chapter 2, Utility Commands Reference on page 5
 Installation or Configuration Ulilities on page 1

sqlupgraderes

(UNIX only) Upgrades your currently installed release of SAP ASE to the newest release
using resource files.

The utility is located in $SYBASE/$SYBASE OCS/bin.

Syntax

sgqlupgraderes
[-s sybase dir]
[-r resource file]
[-D data directory

Or

sqlupgraderes -v
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Parameters

* -r resource_ file—executes the specified resource file.
* -s sybase_ dir—specifies the value to use for the SYBASE environment variable.

* -Ddata_directory—(optional) specifies the working directory when it differs from
the default installation directory for an SAP ASE server. Use this option when you specify
at the time that you install SAP ASE, that another user could configure the server. If you do
not use -D, the SAP ASE server uses $SYBASE as the default.

e —v—prints the version number and copyright message for sglupgraderes and then exits.

Usage

Set the SYBASE environment variable to the location of the current version of SAP ASE
before using sglupgraderes.

See also:

« The installation guide for your platform
e The configuration guide for your platform — “Configuring New Servers with srvbuild”

»  System Administration Guide— "Managing Adaptive Server Logins, Database Users, and
Client Connections"

Permissions

You must be a Sybase system administrator to use sqlupgraderes.

See also

» sglupgrade on page 132

e Chapter 2, Utility Commands Reference on page 5
 Installation or Configuration Ulilities on page 1

srvbuild

(UNIX only) Creates a new SAP ASE server, Backup Server, or XP Server with default or
user-specified values for key configuration attributes. Use srvbuild in either GUI or non-GUI
mode.

The utility is located in $SYBASE/$SYBASE ASE/bin.

Syntax

srvbuild
[-s sybase dir]
[-I interfaces file]
[-r resource file]
[-D user data directory
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Or

srvbuild -v

Parameters

* -I interfaces_file-specifiesthe nameand location of the interfaces file to search
when connecting to an SAP ASE server.

* -s sybase_ dir—specifies the value to use for the SYBASE environment variable.

* -r resource_file—executes the specified resource file.

* -Duser_data_directory —(optional) specifies the working directory when it
differs from the default installation directory for an SAP ASE server. Use this option when
you specify at the time that you install SAP ASE, that another user could configure the
server. If you do not use -D, the SAP ASE server uses $SYBASE as the default.

* —v —prints the version number and copyright message for srvbuild and then exits.

Permissions

You must be a Sybase system administrator to use srvbuild.

See also

« srvbuildres on page 136

o Chapter 2, Utility Commands Reference on page 5
» Installation or Configuration Ulilities on page 1

Usage for srvbuild
Set the SYBASE environment variable.

« To the location of the current version of SAP ASE before using srvbuild.

« Before invoking srvbuild, unless you are only using the -v parameter to display the version
number.

See also:
e The installation guide for your platform
Using LDAP with srvbuild in a 64-bit Environment

When you use srvbuild to build a new server using a Lightweight Directory Access Protocol
(LDAP) service in a 64-bit environment, edit the LDAP server entry.

srvbuild is a 32-bit application and uses the LDAP server entry from the SSYBASE/
$SYBASE 0OCS/config/libtcl.cfgfile. SAP ASEisa64-bitapplicationand usesthe
LDAP server information from the $SYBASE/$SYBASE 0OCS/config/
libtclé4.cfqgfile.
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Do not include any blank spaces after the LDAP server entry inthe 1ibtcl.cfgor
libtcl64.cfqg files; these prevent srvbuild from connecting to the LDAP server.

srvbuildres

(UNIX only) Creates, using resource files, a new SAP ASE server, Backup Server, or XP
Server with default or user-specified values for key configuration attributes.

The utility is located in $SYBASE/$SYBASE ASE/bin.

Syntax

srvbuildres
[-s sybase dir]
[-I interfaces file]
[-r resource file]
[-D user data directory

Or

srvbuildres -v

Parameters

* -I interfaces file—specifiesthe nameand location of the interfaces file to search
when connecting to an SAP ASE server.

* -r resource_ file—executes the specified resource file.

* -s sybase_dir—specifies the value to use for the SYBASE environment variable.

* -Duser data directory — (optional) specifies the working directory when it
differs from the default installation directory for the SAP ASE server. Use this option when

you specify at the time that you install SAP ASE, that another user could configure the
server. If you do not use -D, SAP ASE uses $SYBASE as the default.

e —v —prints the version number and copyright message for srvbuildres and then exits.

Usage

Set the SYBASE environment variable to the location of the current version of SAP ASE
before using srvbuildres.

The $SYBASE/$SYBASE ASE/init/sample resource filesdirectorycontains
these sample resource files:

e sglloc.rs*

¢ sqglupgrade.adaptive server.rs*
¢ sglupgrade.backup server.rs*

¢ sqglupgrade.monitor server.rs*
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e srvbuild.adaptive server.rs*

e srvbuild.backup server.rs¥*

e srvbuild.job scheduler.rs*

e srvbuild.monitor server.rs*

e srvbuild.text server.rs*

e srvbuild.xp server.rs¥*

The sample resource file from an SAP ASE installation looks similar to:
sybinit.release directory: USE DEFAULT

sglsrv

sglsrv

sglsrv. |
An example sglloc resource file...
sybinit.release directory: USE DEFAULT
sglsrv.server name: PUT YOUR SERVER NAME HERE
sqlsrv.sa login: sa

sglsrv.sa password:

sglsrv.default language: french
sqlsrv.language install list: spanish,german
sglsrv.language remove list: USE DEFAULT
sglsrv.default characterset: cp437
sglsrv.characterset install list: mac,cp850
sqglsrv.characterset remove list: USE DEFAULT
sglsrv.sort order: dictionary

H= = S S S S S S H S S e

See also:

.server_ngme: PUT_YOUR_SERVER_NAME_HERE
sglsrv.
sglsrv.
sglsrv.
sglsrv.
sglsrv.
sglsrv.
sglsrv. - _ L
.characterset remove list: USE DEFAULT

sa_login: sa

sa password:

default language: USE DEFAULT

language install list: USE DEFAULT
language remove list: USE DEFAULT
default characterset: USE DEFAULT
characterset install list: USE DEFAULT

sort order: USE DEFAULT

e The installation guide for your platform

Permissions

You must be a Sybase system administrator to use srvbuildres.

See also

e srvbuildon page 134

e Chapter 2, Utility Commands Reference on page 5
 Installation or Configuration Ulilities on page 1
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startserver

(UNIX only) Starts an SAP ASE server or a Backup Server.

The utility is located in $SYBASE/$SYBASE ASE/bin.

Syntax

startserver [[-f runserverfile] [-m]]

Parameters

-f runserverfile—specifiesthe relative path name of arunserver file, which is used
as a reference each time you start an SAP ASE server or Backup Server. By default, the
runserver file is in the current directory and is named RUN_servername. If you start a
second SAP ASE server on the same machine, startserver creates a new runserver file
named RUN servername

-m —starts an SAP ASE server in single-user mode, allowing only one system
administrator to log in, and turns the allow updates to system tables
configuration parameter on. Use this mode to restore the master database. The system
administrator can use thedbo use only parameter of sp_dboption for system
administration activities that require more than one process, such as bulk copying or using
the data dictionary. startserver normally starts up only one server per node.

The -m parameter creates an m_RUNSERVER file and overwrites any existing
m_RUNSERVER file.

Examples

Start an SAP ASE server — Starts an SAP ASE server named SYBASE from the
runserver file named RUN_servername in the current directory:

startserver

Start an SAP ASE server and Backup Server — Starts an SAP ASE server named
MYSERVER and a Backup Server named SYB_BACKUP:

startserver -f RUN MYSERVER -f RUN SYB BACKUP

Start Backup Server — Starts only the Backup Server SYB_BACKUP:
startserver -f RUN_ SYB BACKUP

See also

backupserveron page 10
aataserveron page 35
Chapter 2, Utility Commands Reference on page 5
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«  Ulilities to Start Serverson page 3

Usage for startserver
Take usage information into consideration when running startserver.

» startserver uses the information in the runserver file to start an SAP ASE server or Backup
Server. The master device must be writable by the user who starts the SAP ASE server.
The startserver command creates the SAP ASE error log file (named errorlog) in the
directory where the server is started, and adds this information as part of the —e parameter
in the SAP ASE executable line in the runserver file. If a second SAP ASE server is started
on the same machine, a new error log named errorlog servername is created; this
information is added to that server’s runserver file. The user must have execute permission
on the specified runserver file.

« Start multiple servers by specifying more than one runserver file, as shown in example 2.
Specify -m after each -f runserverfile.

» The SAP ASE server derives its running environment from values inthe con £ i g file. Run
sp_configure or edit the config file to see or change configuration parameters.

« Toensure the integrity of your SAP ASE server, it is important that you apply appropriate
operating-system protections to the startserver executable and the runserver file.

See also:
*  Reference Manual: Commands— disk mirror, disk remirror, disk unmirror
The Runserver File

The runserver file, which is created by srvbuild during installation, contains the dataserver
command to start an SAP ASE server or the backupserver command to start Backup Server.

By default, the file is in the current directory and is named RUN servername. Edit the
runserver file to correct the options and parameters for the commands. This example shows
two sample runserver files.

Runserver file for server MYSERVER:

#!/bin/sh

#

# Adaptive Server Information:

# name: /MYSERVER

# master device: /remote/Masters/myserver dat

# master device size: 10752

# errorlog: /remote/serverdev/install/errorlog
# interfaces: /remote/serverdev/interfaces

#

#

/$SYBASE/SSYBASE ASE/bin/dataserver -d/remote/Masters/myserver dat
\

-sMYSERVER -e/remote/serverdev/install/MYSERVER errorlog \
-i/remote/serverdev &

Runserver file for Backup Server SYB_BACKUP:
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#!/bin/sh

#

# Backup Server Information:

# name: SYB BACKUP

# errorlog: /remote/serverdev/install/backup.log
# interfaces: /remote/serverdev/interfaces

# location of multibuf: /remote/serverdev/bin/sybmultbuf
# language: us_english

# character set: iso 1

# tape configuration file: /remote/serverdev/backup tape.cfg
#

#

/remote/serverdev/bin/backupserver -SSYB BACKUP \
-e/remote/serverdev/install/backup.log \
-I/remote/serverdev/interfaces \
-M/remote/serverdev/bin/sybmultbuf -Lus english -Jiso 1 \
-c/remote/serverdev/backup tape.cfg

sybatch

(Windows only) Creates a new SAP ASE server, Backup Server, or XP Server with default or
user-specified values for key configuration attributes, as well as installs and modifies
languages, character sets, and sort order defaults for SAP ASE.

The sybatch utility is the command-line version of the syconfig GUI utility, designed for
batch mode and driven by resource files.

The sybatch executable file is located in the $SYBASE$\$SYBASE ASES$\bin
\sybatch.exe directory.

Syntax

sybatch
[-c charset]

[-h]

[-1 language]

[-log log file]

[-s release directory]
[-Vv]

[-D user data directory]
[-I interfaces file]

=it resources_flle

Parameters

e -ccharset — Specifies the character set.

e -h —Prints help information for sybatch then quits.

¢ -l language — Specifies the language you want to use for the SAP ASE server.

* -log log_file — Specifies the name and location of the log file for sybatch.

» -srelease directory — Specifies the name and location of the SAP ASE directory.
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* -v —Prints the version number then quits.

e -Duser_data_directory — (optional) specifies the working directory when it differs from
the default installation directory for the SAP ASE server. Use this option when you specify
atthe time that you install SAP ASE, that another user could configure the server. If you do
not use -D, the SAP ASE server uses $SYBASE$ as the default.

* -linterfaces file—Specifies the name and location of the interfaces file for the SAP ASE
server.

» -rresources file—specifies the name and location of the resources file for the SAP ASE
server.

Examples
* Example 1 — Specifies a resource file called myase:

sybatch.exe -r myase.res

Usage
If you do not want to include the login and password in the resources file (for security reasons,

for example), you can set them in the SYBASE_ASE_SA_USER and SYBASE-
ASE_SA PWD environment variables.

Permissions

You must be a Sybase System Administrator or log in with the sa_role to use sybatch.

See also
e Chapter 2, Utility Commands Reference on page 5

sybcluster

Manages a Sybase shared-disk cluster. sybcluster lets you create, start, stop, and manage a
cluster or any instance in a cluster.

sybcluster is available only in a shared-disk cluster environment. For information about how
to use sybcluster, see the Clusters Users Guide.

Syntax

sybcluster
[ -C cluster name ]

[ -d discovery list ]

[ -F agent connection ]
[ -h ]

[ -I instance name ]

[ -1 input file path ]
[ -L 1]

[ -m message level ]

Utility Guide 141



CHAPTER 2: Utility Commands Reference

[ -P [ password 1]
[ -U user name ] (the default value is “uafadmin”)
[ -v ]

Parameters

-C cluster_name —is the unique name of the Sybase shared-disk cluster to be
managed. sybcluster looks up the name in the cluster directory or uses agent discovery
services.

-d discovery list—specifies the discovery services to be used to discover a
shared-disk cluster agent and the discovery order. The format is:
"method[ (method specification][,...)"]]

For example:
-d "udp(),Jjini(jinihostl;jinihost2)"

The supported discovery methods are:

e UDP () —performs a UDP broadcast and listens for a response from listening Unified
Agents. UDP discovery does not cross subnet boundaries.

* JINI(JINI spec) —specifiesthe JINI servers used to look up the locations of
nodes in the cluster. The specification form is: host-name [ : port num].
Indicate multiple JINI servers by placing a semicolon between each specification. By
default, sybcluster uses port number 4160 to attach to a JINI server.

The JINI server must be running, and the management agents (UAF) must be
registered with the JINI server. The locations of the nodes, and status of the instances
are stored on the JINI server.

* LDAP (LDAP spec) —specifies an LDAP server that will be used to look up the
locations of the nodes in the cluster. The specification form is:
host namel:port num] [?registry].

Indicate multiple LDAP servers by placing a semicolon between each specification.
By default, sybcluster uses port number 389 to attach to an LDAP server and the
LDAP directory at “cn=ua-registry,ou=ua,dc=sybase,dc=com”.

-F agent_connection —specifies the agent to be used to access the cluster. The

format is:

host namel:port num] [, host name[:port num ]]

For example:
-F "nodel, node2,node3,node4:9999"

The default port number is 9999.

-h —displays sybcluster syntax and lists supported interactive commands.

-1 instance_name —specifies the instance to be accessed. If you do not specify the
- T option when you execute sybcluster, you may need to specify it when entering certain
interactive commands. sybcluster uses this name to discover the remote host, and as a
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default when executing interactive commands. If an interactive command affects multiple
instances, the instance identified by -1, if available, is used as the priority connection.

To override the instance specified by -1, execute the use command in interactive mode.

e -i —specifies an operating system file for input to sybcluster. This file contains
sybcluster commands, one command per line. The final command in the file should be
quit.

e -L-—createsa sybcluster. log file. sybcluster writes all messages to this file
irrespective of the message level set by the —m option.

* -m message_level —specifies which sybcluster and unified agent messages are
displayed on the client console. Message levels are:

e 0 - off (no messages to log file or console)

e 1-fatal

e 2-—error

e 3 -warning

e 4 —information

e 5—debug

sybcluster displays all messages of the level you choose and all messages of greater
severity (with lower numbers). That is, if you select message level 3, sybcluster displays
messages of level 3, 2, and 1. The default level is 4.

* -P [password] —isthe management agent password for the Sybase Common Security
Infrastructure in the Unified Agent framework. The default user name after installation is
“uafadmin” with no password. This is the Simple Login Module in the Agent
configuration. The user and password can be configured to use several different
mechanisms for authentication and authorization, including using the running instance
and the operating system logins.

If you do not specify the — P option, sybcluster prompts for a password. For a blank or null
password, use the —P option without a value or enter a set of quotation marks without
content.

You can encrypt the password using the Sybase passencrypt utility. See the Clusters Users
Guide.

* -U user_name —is the management agent login name. The default login after
installation is “uafadmin.” See the -P description.

e —v —displays the sybcluster version number and other information.

Examples
e Start using direct connect — Starts sybcluster using direct connect and port numbers:

sybcluster -U uafadmin -P -C mycluster
-F "bladel:9100,blade2:9292,bladel3:9393"

To start sybcluster using direct connect and default port numbers:
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sybcluster -U uafadmin -P -C mycluster
-F "bladel,blade2,blade3"
* Usediscovery to start — You can also start sybcluster using discovery.

sybcluster -U uafadmin -P -C mycluster
-d "JINI (myjiniserver:4564)"

Usage
The recommended method for starting sybcluster and connecting to a cluster is:

sybcluster -U login name -P password -C cluster name
-F agent spec
The -C cluster name, -P password, -1 instance_name, -F
agent connection,and-d discovery 1ist parametersaredefaultvaluesthatcan

be changed using subsequent sybcluster interactive commands. If you do not specify these
values on the sybcluster command line, sybcluster prompts for them as they are required.

You can also start sybcluster and then use the interactive connect command to connect to the
cluster. For example:

sybcluster
> connect to mycluster login uafadmin password " "
agent "bladel,blade2,blade3"

See also
o Chapter 9, Interactive sybcluster Commands Reference on page 267
e Chapter 2, Utility Commands Reference on page 5

syconfig

(Windows only) A GUI version of sybatch, syconfig creates a new SAP ASE server, Backup
Server, or XP Server with default or user-specified values for key configuration attributes, as
well as installs and modifies languages, character sets, and sort order defaults for SAP ASE.

The syconfig executable file is located in the $SYBASE$\$SYBASE ASE%\bin
\syconfig.exe directory.

Syntax
See sybatch.

See also
e Chapter 2, Utility Commands Reference on page 5
e Sybatchon page 140
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sybdiag

sybdiag is a Java-based tool that collects comprehensive SAP ASE configuration and
environment data. Technical Support uses this information to diagnose server issues, thus
expediting customer cases.

Note: Run sybdiag on the same machine as the monitored SAP ASE server.

Syntax

sybdiag -U username

[-P password]
-S [server name | host:port]
-1 interfaces file]

-L log file]

-N num threads]

-0 output directory]

-R resource file]

-T feature list]

-h]

-m message level]

-D user data directory

-v]

Parameters

-1 interfaces_file—(optional) specifies the name of the interfaces file. If I is
specified, sybdiag uses the interfaces filespecified and displays an error if that file is not
found. If - T is not specified, sybdiag first checks the LDAP server for the server entry, and
if the entry is not found, sybdiag uses the default interfaces file in the directory
specified by the SYBASE environment variable.

-L log_file —(optional) specifies the name of the log file that sybdiag creates. If
log_fileis not an absolute path, the log file is created in the directory where sybdiag is
executed.

Whether you specify this parameter or not, sybdiag creates a default log file called
sybdiag.loginthe . zip output file.

-N num_threads — (optional) specifies the maximum number of parallel threads that
sybdiag executes in parallel. The default value is 5. Do not change the default value unless
you cannot execute parallel collections.

-0 output_directory—(optional) specifies the name of a local directory in which
to store sybdiag output. If not specified, sybdiag creates the output . z1ip file in the
directory where the command was executed. The output file is named “sybdiag-
<server name>-<datetime stamp>.zip”.
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-R resource_file—(optional) specifies the resource file that sybdiag uses on start-
up. Use this option only at the direction of Sybase Technical Support.

-P password —specifies your SAP ASE password. If you do not specify the -P flag,
sybdiag prompts for a password. If your password is NULL, use the-p flag without any
password.

-S server _name | host:port—server namespecifies the name of the SAP ASE
server to which sybdiag connects. sybdiag looks for this name in the interfaces file or the
LDAP directory.

If you specify - s with no argument, sybdiag looks for a server named SYBASE. If you do
not specify -3, sybdiag looks for the server specified by your DSQUERY environment
variable.

host. port specifies the machine name and the port number.
-T feature list—(optional) specifies the type of diagnostic data that sybdiag
gathers, based on these feature_list values:

* osdata — operating system data.

* asecore — SAP ASE configuration data.

e aseadd - SAP ASE monitoring data.

* keyfile - information about SAP ASE and operating system files.

All diagnostic data is collected if you do not specify -T.

-U username — specifies a case-sensitive login name.

-h — (optional) displays all help options.

-m message_level—(optional) displays different levels of error messages depending
on the value of message_/levef

¢ 0 -no messages.

e 1 -—fatal errors only.

o 2-allerrors.

e 3 -—warnings and all errors.

e 4 —informational messages, warnings, and all errors.

e 5—debug and informational messages, warnings, and all errors.

By default, the error message display level is set to 4.

-Duser_data_directory — (optional) specifies the working directory when it
differs from the default installation directory for the SAP ASE server. Use this option when
you specify at the time that you install SAP ASE, that another user could configure the
server. If you do not use -D, the SAP ASE server uses SSYBASE as the default.

-v — (optional) displays version information.
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Examples

» Example 1 - Collects all SAP ASE diagnostics from /work/ASEInstall/
ASE-15 0/bin, and creates an output file called sybdiag-
testserver-20110312024652. zip in the same directory:

sybdiag -Usa -P -Stestserver

Note: For readability, some lines have been omitted from this sample output.

Collecting data for "Adaptive Server Version" (ase version)
Completed data collection for "Adaptive Server Version"

(ase _version) .

Collecting data for "Server License" (ase license)

Completed data collection for "Server License" (ase license).
Collecting data for "Adaptive Server Configuration" (ase cfq)
Completed data collection for "Adaptive Server Configuration"
(ase cfgqg) .

Collecting data for "Adaptive Server Non-default Configuration"
(ase nondefault cfg)

Completed data collection for "Adaptive Server Non-default
Configuration" (ase nondefault cfg).

...Lines deleted...

Collecting data for "Adaptive Server LDAP Configuration File"
(ase libtcl)

Completed data collection for "Adaptive Server LDAP Configuration
File"

(ase libtcl).

Collecting data for "Adaptive Server LDAP Configuration File
(64bit) "

(ase libtcl64)

Completed data collection for "Adaptive Server LDAP Configuration

File

(64bit)" (ase_libtclé64).

Collecting data for "Virtual Memory Statistics" (os vmstat)
Collecting data for "Adaptive Server General Performance
Information"

(ase sysmon) .

Collecting data for "I/O Statistics" (os_ iostat)

Collecting data for "CPU Statistics" (os mpstat)

Completed data collection for "Virtual Memory Statistics"
(os _vmstat) .

Completed data collection for "I/O Statistics" (os _iostat).
Completed data collection for "CPU Statistics" (os mpstat).
Completed data collection for "Adaptive Server General Performance
Information" (ase sysmon) .

Data collection statistics: 43 task(s) succeeded, 0 task(s)
skipped, and

0 task(s) failed.

The collected data is stored as

/work/ASEInstall/ASE-15 0/bin/sybdiag-
testserver-20110312024652.zip

Data collection completed.
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Example 2 —Collects basic SAP ASE configuration data from /work/ASEInstall/

ASE-15 0/bin, and creates an output file called sybdiag-
smmdi 9966-20110502202909. zip in the same directory:

sybdiag -Usa -P -Ssmmdi:9%9966 -Tasecore

Collecting data for "Adaptive
Completed data collection for
(ase version) .

Collecting data for "Server License"

Completed data collection for
Collecting data for "Adaptive
Completed data collection for
(ase_cfq).

Collecting data for "Adaptive
(ase nondefault cfg)
Completed data collection for
Configuration"

(ase nondefault cfg).

Server Version" (ase version)
"Adaptive Server Version"

(ase license)

"Server License" (ase license).
Server Configuration" (ase cfq)
"Adaptive Server Configuration"

Server Non-default Configuration"

"Adaptive Server Non-default

Collecting data for "Remote Server Configuration"

(ase remote server)...
Completed data collection for
(ase _remote server).
Collecting data for "Adaptive
(ase script version)
Completed data collection for
(ase_script version).
Collecting data for "Adaptive
(ase_mon_cfg)

Completed data collection for
Monitor" (ase mon cfg).
Collecting data for "Adaptive
(ase cache cfq)

Completed data collection for
Configuration"
Collecting data for "Adaptive
(ase pool cfq)

Completed data collection for
Configuration"
Collecting data for "Adaptive
Configuration"
(ase_shmdumpconfigq)

Completed data collection for
Configuration" N
Collecting data for "Adaptive
(ase_switches)

Completed data collection for
Switches"

(ase switches) .

Data collection statistics:
skipped, and

0 task(s) failed.

(ase _pool cfg).

11 task(s)

"Remote Server Configuration"
Server Script Version"

"Adaptive Server Script Version"
Server Configuration Monitor"
"Adaptive Server Configuration
Server Cache Configuration"

"Adaptive Server Cache

(ase_cache cfqg).

Server Pool Configuration"
"Adaptive Server Pool

Server Shared Memory Dump

"Adaptive Server Shared Memory Dump
(ase shmdumpconfig) .

Server Traceflags and Switches"

"Adaptive Server Traceflags and

succeeded, 0 task(s)

The collected data is stored as /work/ASEInstall/ASE-15 0/bin/

sybdiag
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smmdi 9966-20110502202909.zip
Data collection completed.

Permissions

» To gather all SAP ASE data, you must have permission to access all datasources used by
sybdiag. In a default SAP ASE configuration, you must have sa_role andmon_role
to collect SAP ASE configuration and monitoring data. Use sp_roletograntsa role
and mon_role to the sybdiag user:

sp_role "grant", sa role, sybdiag user

go
sp_role "grant", mon role, sybdiag user

go

You may need other permissions to access database objects if your system administrator
has changed the default access restrictions. If you have insufficient permission to access
certain database objects, you see an error message that lists the database objects that you
cannot access.

« To gather all environment data, you must have authorized access to operating system and
device files.

Note: On Linux, you must have read permission to access operating system messages
in /var/log/messages.
e You must have read permissions on these files:
e SAP ASE error log
* SAP ASE configuration file
» Environment scripts such as SYBASE . csh, SYBASE. sh Of SYBASE.bat
« You must have write permissions on an output directory specified by the -0 parameter.

Note: If you do not have the required permissions on a file, sybdiag displays an error message
does not process that file.

See also
» Chapter 2, Utility Command’s Refference on page 5
»  Ulilities to Gather Information on page 4

Usage for sybdiag
sybdiag connects to an SAP ASE server and executes stored procedures such as
sp_configure, and queries to tables like monLicense. It collects operating system and
platform diagnostic information by executing commands such as ps, vmstat, and netstat.

The output of sybdiag is a compressed ZIP file containing HTML and data files that can be
uncompressed and viewed in a Web browser. The information collected includes operating

system and environment data, SAP ASE configuration and monitoring data, and SAP ASE

files and scripts.

Utility Guide 149



CHAPTER 2: Utility Commands Reference

sybdiag does not collect SAP ASE or operating system data for logins, passwords, or user
lists, and does not collect information from application database tables.

Viewing sybdiag Output

The sybdiag output is in a compressed file in this format: sybdiag-servername-
datetime stamp.zip.

To generate individual output files, uncompress the zip file. The ZIP file contains these HTML,
data, and log files:

sybdiag start.html-anHTML filewith links to diagnostic data files in the output
directory. To view sybdiag output, open this file in any Web browser.
sybdiag displays information in these categories:

Operating system information, including process status, physical and virtual memory,
interprocess communication, disk usage, 1/0O, and network information.

SAP ASE configuration data, including server version, platform and license
information, configuration values, remote server configuration data, and so on. For the
Cluster Edition, this also includes the cluster overview, cluster instances, and logical
cluster information.

SAP ASE monitoring data about processes, databases, devices, locks, and so on. For
the Cluster Edition, this also includes cluster interprocess communication protocol
information, cluster lock usage, and cluster quorum device dump information.

SAP ASE files such as errorlog, interfaces, configuration file, SySAM
properties file, and environment configuration scripts. For the Cluster Edition, a single
report may contain information from many external files for several cluster instances.

Diagnostic data files — collected SAP ASE and environment information organized under
different directories. These are the files that sybdiag start.html accesses.

Log file — by default, the ZIP file includes a log file called sybdiag. 1og that provides a
log of the activities sybdiag performed.

Configuration Options for sybdiag

To generate certain reports, you must enable corresponding configuration options using
sp_configure, or edit the server configuration file.

If configuration options are set incorrectly, sybdiag skips the related reports.

Option Value sybdiag Reports

enable monitoring 1 Adaptive Server Wait Events

Adaptive Server Locks

Adaptive Server Deadlock His-
tory

wait event timing 1 Adaptive Server Wait Events
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Option Value sybdiag Reports
deadlock pipe active 1 Adaptive Server Deadlock His-
tory
deadlock pipe max mes- | Nonzero value; must be large enough | Adaptive Server Deadlock His-
sages to capture all relevant deadlock rows | tory
sybdumptran

Use the sybdumptran utility to dump the most recent transactions when the database and the
server have suffered a catastrophic failure.

sybdumptran generates a transaction log dump from the log pages contained in operating
system files/raw devices, that were formerly used as a log device by a database inan SAP ASE
environment. sybdumptran is located in:

*  (UNIX) $SYBASE/$SYBASE ASE/bin/

e (Windows) $SYBASE%\%SYBASE ASE%\bin as sybdumptran.exe

Syntax
sybdumptran [-m file name | -g | -d database name |

-f first page num ] -o output file | -h dump history file name
or:

sybdumptran --help

Parameters

* -m file name —specifies the location of the metadata file containing information
needed by sybdumptran to dump the transaction log, including the path to the database log
devices, and the layout of the log segment relative to these devices. It also contains
sequencing information and the page number of the first page in the log. This metadata file
can be:

» Afile generated using the —g option; or,

« Preferably, the most recent full database dump or transaction log dump.
Use the most recent database dump/transaction log to ensure that the information is
current, including the location of the log segment relative to the rest of the database, the
dump sequencing information, and the location of the active log within the log
segment. If it is not possible to use the most recent backup, then use a backup that was
taken when the database had the same layout as it currently has. This means that the
sequencing information and log location will be incorrect. In this case, the
sybdumptran utility automatically tries to determine the location of the active log, and
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the sequencing must be overridden when the transaction log is loaded using the dump
tran with override=sequence command.

The long parameter option displays when you use —-—help, SO you can use either -m
filename Or --metadata-file=filename.

-g —generates a compact metadata file from a database or transaction log dump. Specify
the name of the output file using the ~o output file option. You can use the -g
option only with the -m and -o options.

If the most recent database or transaction log dump is unavailable, or when you use -g to
generate a metadata file, you can use an older database or transaction log dump as the
information source for providing the layout of the database if it was identical at the time the
dump was performed, to compare with the metadata file you just generated. The dump
from which it is generated, however, should be the most recent.

The —g option to generate metadata is useful when the last database or transaction log
dump is located on an entirely different system. The created metadata file is a subset of the
database dump or transaction log dump from which it was created, containing only the
information needed by sybdumptran. Because it is smaller, it is easier to copy to the
system on which you are creating the transaction log.

-d database_name —is the name of the database used to locate and add entries to the
dump history file.

-h dump history file name—used in combination with the —d option, adds an
entry to the dump history file for the transaction log dump generated by sybdumptran.
When you use -h dump_ history file name, sybdumptran tries to locate the
most recent dump that was taken, and uses this as its source of the metadata, obviating the
need for the —m option.

The entry is generated for the database named by the -d option. No entry is added in the
dump history file if this database has no existing entries.

Note: You cannot use —h withthe -m file name option.
-f first _page num-—allows you to specify the first log page.

The sybdumptran -m option uses the metadata file to locate the first page of the log within
the log devices. If the metadata file is not the most recent transaction log or database dump,
then the first page of the log is incorrect, and sybdumptran automatically tries to locate the
first page of the log. If this fails, and sybdumptran exits and reports that it cannot locate the
first log page, use the - £ option to manually specify the first log page.

sybdumptran --help —displays this long parameter format:

Usage: sybdumptran <option list>
Valid options:

-d, --databasename=database name - name of database in dump
history

-h, --dump history file=filename - dump history file name

-f, --first-log-page=page number - to overwrite the first

page from meta data
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-g, ——generatemetadata - create compact meta
data file from dump

-H, --help=[{0|1]|2|3}[,display width]] - print this help
message, and exit

-m, --metadatafile=filename - meta data file used
to locate devices

-0, --outputfile=filename - name of output file

-V, --sbssav - print a short version
string, and exit

-T, --trace=number - for debugging

-v, —--version - print version message,
and exit

Examples

* sybdumptran Example— Start with a database dump (/dumps/db . dmp), and two
transaction logs (/dumps/db. trnl and /dumps/db.trn2).

Use the last transaction log dump as a metadata file (-m for sybdumptran):

> sybdumptran -o /dumps/db.trn sdt -m /dumps/db.trn2
Opening output-file '/dumps/db.trn sdt'.
Opening metadata-file '/dumps/db.trn2'.
Opening log devices used by database:
Opening device "db logl", path "/sdcl eng/devices/db.logl".
Opening device "db log2", path "/sdcl eng/devices/db.log2".
Building run-lists using first log page=10888.
Finished building run-lists, number of log pages=7, first log
page=10888,
last log page=10894.
Dumping log pages to output file "/dumps/db.trn sdt".
Finished dumping 7 log pages.
Sybdumptran completed without errors.

Load the database dump, the two transaction log dumps, and the dump generated by

sybdumptran:

1> load database db from '/dumps/db.dmp'
2> go

1> load tran db from '/dumps/db.trnl'

2> go

1> load tran db from '/dumps/db.trn2'

2> go

1> load tran db from '/dumps/db.trn sdt'
2> go

1> online database db

2> go

When you do not use the most recent dump as metadata file, the dump generated by
sybdumptran contain the wrong sequence date. This example uses /dumps/db.trnl
as the metadata file:

> sybdumptran -o /dumps/db.trn sdt -m /dumps/db.trnl
Opening output-file '/dumps/db.trn sdt'.

Opening metadata-file '/dumps/db.trnl'.

Opening log devices used by database:
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Opening device "db logl", path "/sdcl eng/devices/db.logl".
Opening device "db log2", path "/sdcl eng/devices/db.log2".
Building run-lists using first log page=10253.
Found new first log page=10888.
Restarting the building of run-lists.
Building run-lists using first log page=10888.
Finished building run-lists, number of log pages=7, first log
page=10888,
last log page=10894.
Dumping log pages to output file "/dumps/db.trn sdt".
Finished dumping 7 log pages.
Sybdumptran completed without errors.

1> load database db from '/dumps/db.dmp'
2> go

1> load tran db from '/dumps/db.trnl'

2> go

1> load tran db from '/dumps/db.trn2'

2> go

1> load tran db from '/dumps/db.trn sdt'
2> go

Backup Server session id is: 69. Use this value when executing the
'sp_volchanged'

system stored procedure after

Msg 4305, Level 16, State 1:

Server 'marslinuxl asecarina smp', Line 1:

Specified file 'dump device' is out of sequence. Current time
stamp is Nov 30 2012

1:59:59:423AM while dump was from Nov 30 2012 1:59:59:296AM.

To be able to load this dump, use the override option:

1> load tran db from '/dumps/db.trn sdt'

2> with override = sequence

3> go

Backup Server session id is: 83. Use this value when executing the
'sp _volchanged'

system stored procedure after fulfilling any volume change request
from the

Backup Server.

Backup Server: 6.28.1.1: Dumpfile name 'db1233501C1lF

' section number 1 mounted on disk file '/dumps/db.trn sdt'’
Backup Server: 4.58.1.1: Database db: 22 kilobytes LOADED.

1> online database db
2> go
Started estimating recovery log boundaries for database 'db'.

Enable the dump history file:

1> sp configure 'dump history filename', 1, '/dumps/dump hist'
2> go

1> sp configure 'enable dump history', 1

2> go
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Dump database is then added to the history file:
1> dump database db to '/dumps/db.dmp'

2> go
Permissions

Any user who has read permissions on the log devices of the database, and write permission to
the output file can use sybdumptran.

Usage for sybdumptran
There are additional considerations when using sybdumptran.

During a load sequence of a database dump and one or more transaction log dumps, SAP ASE
verifies that the transaction log dump is loaded in sequence based on a sequence number stored
in the dump header.

If you do not use the most recent dump as a metadata file for a transaction log dump generated
by sybdumptran, the sequence number will be incorrect, causing the load of this transaction
log dump to fail. The load transaction option with override=sequence ignores this error and
allows the load of an out-of-sequence transaction log dump.

If the sequence number sybdumptran created for the dump does not match the new sequence
number of the previous dump, restore the database using the load tran command with the with
override=sequence option. You cannot use this option when loading transaction dumps
created by SAP ASE, but only when loading transaction logs created with sybdumptran.

Warning!

* When using the override=sequence option, make sure the transaction log to be loaded is
indeed the next in the sequence. Since the sequence number is there to protect the
sequence, overriding it means the task must be performed correctly. Loading a transaction
log out of sequence can corrupt the database (for example, if an earlier dump transaction is
omitted during the load, so that the load sequence would need to be repeated, this time, in
the correct order).

» If a partially logged operation (such as select into without the enable full logging for
select into database option) was done between the last transaction log that was dumped
normally, and the transaction log that is created by sybdumptran, then a sequence error
will not be reported during the load of the latter, even when using the most recent
transaction log dump as a metadata file. Normally, a partially logged operation
deliberately breaks the sequence to make sure that a subsequent dump transaction does not
take place.

In such a case, do not load the dump from sybdumptran. sybdumptran dumps the
transaction log, irrespective of whether partially logged operations have taken place or not,
because the utility does not have access to the metadata information held within the
database. If the sequencing is overridden when the transaction log is loaded, the load may
fail, or worse, the database may become corrupted.
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If you make use of partially logged operations and you are unsure whether such an
operation took place before the sybdumptran operation, make sure to run database
consistency checks after the transaction log created by sybdumptran, has been loaded.

In this example, when you omit the -m metadata file option and specify the dump history file,
sybdumptran locates the metadata file in the dump history file:

> sybdumptran -o /dumps/db.trn sdt -h /dumps/dump hist -d db
Opening output-file '/dumps/db.trn sdt'.
Opening dump-history-file '/dumps/dump hist'.
Option 'metadata-file' is not supplied, using last dump '/dumps/
db.trnl' from dump history file.
Opening metadata-file '/dumps/db.trnl'.
Opening log devices used by database:
Opening device "db logl", path "/sdcl eng/devices/db.logl".
Opening device "db log2", path "/sdcl eng/devices/db.log2".
Building run-lists using first log page=10894.
Finished building run-lists, number of log pages=1l, first log
page=10894, last log page=10894.
Dumping log pages to output file "/dumps/db.trn sdt".
Finished dumping 1 log pages.
Sybdumptran completed without errors.

sybmigrate

sybmigrate allows you to convert an SAP ASE server from one page size to another page size,
and to migrate between platforms.

The utility is located in:

* (UNIX platforms) $SYBASE/$SYBASE ASE/bin/
* (Windows) $SYBASE%\%SYBASE ASE%\bin\sybmigrate.bat, as
sybmigrate.bat.

War ning! sybmigrate assumes that the source and target SAP ASE servers will not have any
activity during the migration. If objects are created, modified, or deleted during the migration
process (setup, migrate, and validate), SAP cannot guarantee migration integrity.

Syntax
sybmigrate [-v ] [-h ] [-f ]
[-D1 | 2] 3| 4]
[-I interfaces file ]
[-J client charset ]
[-1 log file ]
[-m setup | migrate | validate | report ]
[-r input resource file ]
[-rn status | space est | repl | diff | password ]
[-T trace flags ]
[-t output template resource file ]
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[-Tase trace flags ]
[-z language ]

Parameters

-D 1 | 2 | 3 | 4-setsthedebug level for sybmigrate. The default debug level is
2.

-f —overrides the locking session.

If sybmigrate exited a session inappropriately, use -£ to override the source and target
database binding that is created so that only one session of sybmigrate can run on a source
and target database path.

-h —prints the help information and syntax usage and exits.
-I—identifiesaspecific interfaces filetofind server names. Ifnointerfacesfile
location is designated, sybmigrate uses:

e (UNIX) $SYBASE/interfaces
e (Windows) $SYBASE$\ini\sgl.ini

Note: You can override sybmigrate, and use the interfaces file by providing the -1
argument if the LDAP entry is defined in:

* (UNIX) $SYBASE/$SSYBASE 0OCS/config/libtcl.cfg
* (Windows) $SYBASE$\$SYBASE 0CS%\ini\libtcl.cfg

-J —specifies the character set to be used for the SAP ASE connection.

-1 —indicates a user-defined log file where the output of the migration process is stored. If
-1 is not used, the logs are stored in $SYBASE/$SYBASE ASE/init/logs or the
working directory.

-m — designates the types of operations that are performed:

* setup —to set up the repository and migration working database, and to migrate the
server-wide data.

* migrate —to perform data and object migration.

e validate —to validate the migrated objects.

* report-—torunany of the five reports. The reports can be run in the GUI and resource
file mode. The available reports are:
e status - the migrate object status report gives information about objects that

have been migrated. To run this report, issue:

sybmigrate -r resource file -m report -rn
status

* space_est —use the target database space estimation report to verify that you
have sufficient resources allocated to your target database. In the resource file
mode, issue the following command to run the space est report:
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sybmigrate -r resource file -m report -rn
space_est

repl — use the replication report to check any explicitly replicated objects that

have been migrated, determine the type of replication system, and to produce SQL

commands for users to execute on the target SAP ASE server and the Replication

Server. To run the repl report, issue:

sybmigrate -r resource file -m report -rn repl

di f £ —checks the objects between the source and target databases. Users can run

the report on individual objects, or the entire database, except for server and

database information or metadata. You can runthe di £ £ report at any time. You do
not need to run a setup session to run the di £ £ report. The source and target
database name do not need to be the same when running the di £ £ report.

The dif £ report provides the following information for the following object

types:

« Server information — compares the master database system catalogs row count
between the source and target SAP ASE server. This task is similar to the
validation session.

< Database information — compares the user database system catalogs row count
between the source and target SAP ASE server. This task is similar to the
validation session.

« DDL objects —the report displays whether the objects exist on the source or the
target SAP ASE servers. If the objects exists in both databases, that object does
not appear in the report.

» User table data — compares the row count of the user tables in the source and
target SAP ASE server. If the table only exists in the source or target databases,
the table does not appear in the report.

password — creates a file for the changed passwords.

-r —specifies that the resource file mode is to be used in the migration process. If the input
resource file is not specified by using the -r parameter, sybmigrate operates in GUI

mode.

If you use the —r parameter, then you also need to use the —m argument to specify the type
of operation to perform: setup, migrate, validate, or report. You can run the
entire migration process in the resource file mode, or you can choose to run only parts of in
this fashion.

-rn —indicates what type of report to generate. If -rn is not specified, all five reports are

run.

-T —sets these command line trace flags:

DUMP_ SQL —specifies that every query issued by sybmigrate is output to the log file.
NO_SORTED_DATA —overrides the default, which specifies that tables with clustered

indexes are copied to the target server in order, and the clustered index is recreated
usingthe with sorted data option.
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* LEAVE PTBL ON_ERROR - specifies that proxy tables are not deleted on failure.

* SKIP CONFIG CHECK - specifies that configuration compatibility checks are not
to be performed.

* SKIP PARTITION CHECK -—specifies that partition compatibility checks are notto
be performed.

* DUMP_DDL - specifies that DDL commands are to be output to the log file.

e DUMP DEPEND OBJECT - specifies that when the
auto_select dependent objects option is used, sybmigrate outputs a list
of objects added as dependents.

* ONE_WORK_THREAD - specifies that one work thread is to be used, overriding the
current setting for schema creation threads.

*+ ALLOW DATA AND INDEX - overrides default behavior, in which indexes are
created after all tables are created. Indexes are created as resources become available.

e -t —directs sybmigrate to generate an output template resource file, to be used for
subsequent migrations in the resource file mode.

-t requires that you start sybmigrate using the —-r argument specifying the login
information. This argument also requires —m to specify what type of resource file is to be
generated.

Note: You can use -t only in the resource file mode.
* -Tase —runs SAP ASE trace flags (turned on using dbcc traceon) for all SAP ASE
connections opened by sybmigrate. Specify the trace flags in a comma-separated list.
* —v —prints the version string and exits.
» -z —specifies the language to be used for the SAP ASE connection.

Examples
e Example1— Runs the status report:

sybmigrate -r resource file -m report -rn status

» Example2— Runs the space est report in the resource file mode:
sybmigrate -r resource file -m report -rn space est

» Example3—Runs the repl report, issue:

sybmigrate -r resource file -m report -rn repl

Usage
« You can use the sybmigrate utility to migrate an encrypted database just as you would a
normal database. When you do, make sure:

« The master database in the target server has the same database encryption key as the
one used for the database you are migrating
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« You configure the target database as an encrypted database that uses the same database
encryption key as the database you are migrating.

For security purposes, set file permissions at the highest level (preferably 600) for both the
sybmigrate resource file and the file that contains the login and password information you
are using for migrating logins from the source to the target server.

Make sure the allow resource 1limits configuration parameter is setto O before
running sybmigrate.

You cannot migrate server data if metadata already exists on the target SAP ASE server.
If sybmigrate exited a session inappropriately, use - £ to override the source and target
database binding that is created so that only one session of sybmigrate can run on a source
and target database path.

If you use the —r parameter, then you also need to use the —m argument to specify the type
of operation to perform: setup, migrate, validate, or report. Run the entire
migration process in the resource file mode, or run only parts in this fashion.

Use -t only in the resource file mode. -t requires that you start sybmigrate using the -r
argument specifying the login information. This argument also requires —m to specify
what type of resource file is to be generated.

You may specify the size and location of a work database on your target server.

SAP does not support SAP ASE version 12.5.1. SAP recommends that you upgrade from
12.5.1to 12.5.4, then from 12.5.4 to 15.5 and later versions. To make the 12.5.1 server
visible to the 12.5.4 or later server, use:

sp_addserver 'servername', local

Restart SAP ASE to recognize the 12.5.1 server.

You can override sybmigrate, and use the interfaces file by providing the -
argument if the LDAP entry is defined in:

* UNIX-$SYBASE/SSYBASE OCS/config/libtcl.cfg

e Windows - $SYBASE%\$SYBASE 0CS%\ini\libtcl.cfg

sybmigrate automatically migrates predicated privileges when:

« ddlgen is called to generate the scheme definitions, including grants, denies, and
revokes

» Data is migrated using CIS and proxy tables.

Permissions

You must be a Sybase system administrator or log in with the sa_role to use sybmigrate.

If you want any user other than the SA to use sybmigrate, setthe cis rpc handling
configuration parameter to “1”.

See also

Chapter 10, Using sybmigrate to Migrate Data on page 305
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sybrestore

sybrestore allows you to restore an SAP ASE database to the time of failure from the most
current full database backup dump files.

Syntax
Parameters for interactive mode:
sybrestore [-v ] [-h ]
[-S server name | host name:port number]

[-t [point in time of restore]]
-d dump directory]

-1 interfaces file ]

-J character set ]

-P password ]

-U username]

-z language |

-R Restore from master database corruption ]

-s list system databases except master database ]
-o Log output]

Parameters for noninteractive mode:

sybrestore [-v ] [-h ]
-S server name | host name:port number
-U username
[-P password]
-D database name
[-d dump directory]
[-I interfaces file]
[-o Log output]

Parameters

* -h —prints the help information and syntax usage and exits.
* -D database_name — specifies the source database name.
* -d dump_directory —specifies the dump directory for dumping the last log.

* -I interfaces_file—identifiesaspecific interfaces file in which to look for
server names. If you do not specify this parameter, sybrestore uses:

e (UNIX) $SYBASE/interfaces
e (Windows) $SYBASE$\ini\sgl.ini

* -J character_set —specifies the character set to be used for the SAP ASE
connection.

* -P password — specifies your SAP ASE password. If you do not specify the —p
parameter, sybrestore prompts for a password.
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-S server name | host_name:port number] —specifies the name of the
source SAP ASE server. sybrestore looks for this name in the interfaces file.

host_name:port_number specifies the machine name and the port number.

-t point_in_time —restores the specified database to a point in time.

-U username — specifies a case-sensitive login name.

-v — prints the version string and exits.

-z language — specifies the language to be used for the SAP ASE connection.

Examples

command line mode — Invokes the command line interactive Restore Database menu.
Use single-key entries to navigate through the menu options to specify options for
restoring a database:

sybrestore -Usa -P -SlinuxData

sybrestore -Usa -P -SlinuxData

<<<<L<L<====User Database Restore Menu ====>>>>>>>>
c : Complete Database Restore
p : Database Point-In-Time Restore

To invoke the interactive command line Restore Database menu and execute the SQL
statements for restoring the database to a point in time:

sybrestore -Usa -P -SaseServerl -t

Noninter active mode— Invokes sybrestore in noninteractive mode using SAP ASE 15.7
ESD #2 and later. Executes the SQL statements for restoring the database and exits:

sybrestore -Usa -P -SaseServerl -Ddba db

Usage
Verify settings before using sybrestore.

SAP ASE server and Backup Server are running for both the target and source.

The master database is available.

The log segment of the source database is available for dumping and then loading back the
most recent transaction logs that have not been dumped.

Either history files or external dump files are available.

Permissions

To use sybrestore, you must be logged in with the sa_role, or as the database owner.

See also

Chapter 11, Using sybrestore to Restore Databases on page 341
Chapter 2, Utility Commands Reference on page 5
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sybtsmpasswd

Records or changes the user password and creates the Tivoli Storage Manager (TSM)
encrypted password file, TSM. PWD, on the TSM client machine. The location of the file is the
directory specified by the PASSWORDDIR configuration parameter in the TSM configuration
file.

Note: sybtsmpasswd is supported when the IBM Tivoli Storage Manager is licensed at your
site.

Syntax
sybtsmpasswd

Examples

* Example 1 —sybtsmpasswd prompts for password information.

sybtsmpasswd
Enter your current password:
Enter your new password:

Enter your new password again:

Your new password has been accepted and updated.

Usage

Execute sybtsmpasswd when you record or change the user password. Make sure the same
user name and password are present in the TsM. PWD file on the TSM client node.

Permissions

Only the operating system “root” user can execute sybtsmpasswd.

See also
e Chapter 2, Utility Commands Reference on page 5

updatease

The updatease utility reinstalls scripts and updates system stored procedures and messages
after a minor upgrade.

The updatease executable file is located in:
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* (UNIX) $SYBASE/SYBASE ASE/bin/
e (Windows) $SYBASE%\%SYBASE ASE%\bin\

Syntax

updatease
-Sserver name
-PASE password
[-D data directory]

The syntax for SAP ASE Cluster Edition:

updatease -FSCC connection
-PSCC password
[-D data directory]
-Ccluster name
-linstance
-AASE instance password

Parameters

* -Sserver_name—(nonclustered SAP ASE only) specifies the SAP ASE server you are
updating.

* -PASE_ password — (nonclustered SAP ASE only) is the SAP ASE "sa" password. If
you do not specify this, updatease obtains the information from the
SYBASE_ASE_SA_PWD environment variable or at the prompt.

* -Ddata_directory—(optional) specifies the working directory when it differs from
the default installation directory for the SAP ASE server. Use this option when you specify
at the time that you install SAP ASE, that another user could configure the server. If you do
not use —D, the SAP ASE server uses $SYBASE as the default.

* -FSCC_connection—(SAP ASE Cluster Edition only) specifies the SAP® Control
Center agent that you use to access the cluster. The value must be in the form
"hostname.port_number".

* -PSCC_password— (SAP ASE Cluster Edition only) specifies the SCC "uafadmin”
password. If you do not specify this, updatease obtains the information from the
UAFADMIN_PWD environment variable.

* -Ccluster_name —(SAP ASE Cluster Edition only) specifies the name of the SAP
ASE cluster.

* -iinstance—(SAP ASE Cluster Edition only) specifies the SAP ASE instance you are
updating.

* -AASE instance_password— (SAP ASE Cluster Edition only) specifies the SAP
ASE "sa" password.
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Usage

When you perform a minor upgrade/update from SAP ASE version 15.0 and higher, you need
to update the system stored procedures and messages from the earlier version of SAP ASE, as
well as reinstall the scripts in the following directory:

¢ (UNIX) $SYBASE/ASE-15 0/scripts/
* (Windows) $SYBASE$\ASE-15 O\scripts\

Note: Inanonclustered SAP ASE, when you perform the minor upgrade using the SAP ASE
installer, the installer runs updatease in the background; you need not perform any additional
steps.

Permissions

You must be an SAP ASE system administrator, or log in with the sa_role to use
updatease.

See also
e Chapter 2, Utility Commands Reference on page 5
 Installation or Configuration Ulilities on page 1

xpserver

Starts XP Server manually.

Syntax

Xpserver -S XP Server

xpserver
-SXP Server
[-Tinterfaces file]
-ppriority]
-sstack size]

[
[
[-ul
[-v]
[-x]

Parameters

* -S XP_Server —specifies the name of the XP Server to start. The format of the XP
server name is SQLSERVERNAME_XP, where SQLSERVERNAME is the name of the
SAP ASE server to which the XP Server is dedicated. For example, the XP Server for an
SAP ASE server named SMOKE would be named SMOKE_XP. The XP Server name
must be in uppercase.
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-1 interfaces_file —specifies the name and location of the directory containing
the interfaces file (sgl . in1i) that the SAP ASE server searches when connecting to XP
Server. If you do not specify — I, xpserver uses the ini subdirectory of the $SYBASES
release directory.

-p priority—specifies the priority of the Open Server process. Values between 0
(lowest) and 15 (highest) are valid. Overrides the esp execution priority
configuration parameter. The default is 8.

-s stack_size —specifies (in bytes) the stack size of the process used to execute an
extended stored procedure (ESP). Overrides the esp execution stacksize
configuration parameter if it is set. The default is 34816 bytes.

—-u —specifies that the functions be automatically unloaded from XP Server memory after
the ESP request terminates. Overridesthe esp unload dl11 configuration parameter if
it is set. The default is not to unload the function.

-v — prints the version number and copyright message for XP Server and then exits.

-x — specifies that the client security context be used to execute operating system
commands using the system ESP, xp_cmdshell. Overrides the xp_cmdshell context
configuration parameter if it is set. The default is to use the security context of the
operating system account of the SAP ASE session.

Usage

When you run xpserver in root, xpserver automatically enables secure access on the
machine as if you set the xp_cmdshell context configuration parameter to 1, thereby
preventing users from accessing the SAP ASE server unless they are also valid users on the
machine.

XP Server is normally started automatically by the SAP ASE server. Use the manual
command to start XP Server only when instructed to do so in an “XP Server Failed to Start”
error message.

There can be only one XP Server per SAP ASE server. An SAP ASE server running ESPs
communicates with a single XP Server, and the ESPs execute synchronously.

The —p parameter affects the priority used by the Open Server scheduler. If -p issetto a
high number, the scheduler can run XP Server before running the other threads in its run
queue. If -p issetto a low number, the scheduler can run XP Server only when there are no
other Open Server threads in its run queue. This parameter is unrelated to the application
queue priorities within SAP ASE, which are set by sp_bindexeclass.

See the discussion of multithread programming in the Open Server Server Library/C
Reference Manual.

If automatic unloading of ESP functions is not set by the —u parameter or by the esp
unload dl11 configuration parameter, unload them at runtime using sp_freedll.

Unlike an SAP ASE server and Backup Server, XP Server does not have a runserver file.

When configuring an XP Server, the directory service entry name must end with “_XP”” in
upper case, such as “abcdef_XP” or “ABCDEF_XP.”
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See also:
»  Reference Manual: Procedures—sp_configure, sp_freedll, xp_cmdshell extended stored
procedure

Permissions

No special permissions are required to run xpserver.

See also
e Chapter 2, Utility Commands Reference on page 5
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from SAP ASE

This chapter discusses the bcp bulk copy utility, which provides a convenient, high-speed
method for transferring data between a database table or view and an operating system file.

bcp can read or write files in a wide variety of formats. When copying in from a file, bcp
inserts data into an existing database table; when copying out to a file, bcp overwrites any
previous contents of the file.

Versions earlier than 15.0.3 did not allow you to run fast bcp on tables with nonclustered
indexes or triggers. Cluster Edition version 15.0.3 and later removes this restriction.

See also

e bcpon page 14

Methods for Moving Data

There are two methods to move data to and from your SAP ASE databases.

* bcp as a standalone program from the operating system.
* Client-Library, which calls bulk-library routines. See the Open Client and Open Server
Common Libraries Reference Manual.

Import and Export Data with bcp
Transact-SQL commands cannot transfer data in bulk. For this reason, use bcp for any large
transfers.

Uses for bep include:

» Importing data that was previously associated with another program, such as the records
from another database management system. This is the most common use for bcp.

Before using bcp, create a file of the records you want to import. The general steps are:
1. Put the data to transfer into an operating system file.
2. Run bcp from the operating system command line.

¢ Moving tables between SAP ASE servers or between an SAP ASE server and other data
sources that can produce an operating-system file.

« Copying out data from a view.

Note: You cannot use bep to copy in data to a view.
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« Transferring data for use with other programs, for example, with a spreadsheet program.
The general steps to transfer data are:
1. Use bcp to move the data from the SAP ASE server into an operating-system file from
which the other program imports the data.
2. When you finish using your data with the other program, copy it into an operating-
system file, then use bcp to copy it into the SAP ASE server.

The SAP ASE server can accept data in any character or binary format, as long as the data file
describes either the length of the fields or the ferminators, the characters that separate
columns.

The structures in the tables involved in the transfer need not be identical, because when
bcp:

* Imports from a file, it appends data to an existing database table.
« Exports to afile, it overwrites the previous contents of the file.

When the transfer is complete, bep informs you of the:

« Number of rows of data successfully copied

* Number of rows (if any) that it could not copy

» Total time the copy took

« Average amount of time, in milliseconds, that it took to copy one row
* Number of rows copied per second.

If bep runs successfully, you see a return status of 0. The return status generally reflects errors
from the operating system level and correspond to the ones listed in the errno.h file in
the /usr/include/sys/ directory.

See also
e bcpon page 14

bcp Modes

bcp in works in one of three modes.

» Slow bcp - logs each row insert that it makes, used for tables that have one or more
indexes.

» Fast bep — logs only page allocations, copying data into tables without indexes or at the
fastest speed possible. Use fast bcp on tables with nonclustered indexes.

« Fully logged fast bcp — provides a full log for each row. Allows you to use fast bcp on
indexed and replicated tables.

Although fast bcp might enhance performance, slow bcp gives you greater data
recoverability. Fully-logged fast bcp provides a combination of both.
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To determine the bcp mode that is best for your copying task, consider:

« Size of the table into which you are copying data

« Amount of data that you are copying in

e Number of indexes on the table

e Whether the table is replicated

« Amount of spare database device space that you have for re-creating indexes

The modes bcp uses depending on index type:

Table Properties bcp Mode for bulk- bcp Mode for bulk-
copy on, With Logging | copy on Without Log-
ging
Clustered index Slow mode Slow mode
Replicated table with indexes or trig- | Fast mode Slow mode

gers, but no clustered index

Nonclustered index and no triggers | Fast mode Slow mode
Triggers, and no indexes Fast mode Fast mode
Nonclustered index with triggers Fast mode Fast mode
No indexes, no triggers, and no rep- | Fast mode Fast mode
lication

See also

e Before You Transferon page 172

bcp Requirements

Before using bcp, provide it with basic data information and prepare both the data for transfer
and the command to access the data.

To transfer data successfully to and from the SAP ASE server, supply:

» Name of the database and table or view
* Name of the operating system file
 Direction of the transfer (in or out)

You may also use becp to modify the storage type, storage length, and terminator for each
column.
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bcp Permissions

You need an SAP ASE account and the appropriate permissions on the database tables or
views, as well as the operating system files to use in the transfer to use bcp.

To copy:

« Data into a table — have insert and select permission on the table.
« Atable to an operating system file — have select permission on:

e The table to copy

¢ sysobjects

e syscolumns

¢ sysindexes

Before You Transfer

Prepare the command and the data for transfer before using bcp in.

To use either fast or fast-logged bcp, set select into/bulkcopy/plisort to true. For example, to
turn on this option for the pubs2 database, enter:

sp_dboption pubs2, "select into/bulkcopy/pllsort", true
To use fast bcp, remove indexes on the target table.
In addition:

e If you are running Open Client version 11.1 or later and are using an external Sybase
configuration file, enable bcp by adding:
[BCP]

» Setthe SSYBASE environment variable to the location of the current version of SAP ASE
before using bcp.

» Touse aprevious version of bep, set the CS_BEHAVIOR property in the [bcp] section of
the ocs.cfg file:
[bep]
CS BEHAVIOR = CS_BEHAVIOR_IOO

If youdo notset CS BEHAVIORto CS_BEHAVIOR_100, use functionality for bcp 11.1
and later.

See also
e bep Modes on page 170
e Fast, Fast-logged, and Slow bcp on page 174
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Copy Data to Partitions Using bcp

Use bep to copy data from a table to an operating system file. Specify a table name and one or
more partitions as the source.

You can copy data to a single file for all partitions, or a single file for each partition.

If you do not specify a destination file name, the SAP ASE server creates file names based on
the partition names.

These examples show how to copy of data from bigtable, which is partitioned three ways
—ptnl, ptn2, and ptn3—to various operating system files:

e Copiesthedatainbigtableto filel:
bcp mydb. .bigtable out filel
e Copies the data from ptnl, ptn2,and ptn3to file2:
bcp mydb. .bigtable partition ptnl, ptn2, ptn3 out file2
« Copies the data from ptn1 and ptn2 to data files ptnl.dat and ptn2.dat:

bcp mydb. .bigtable partition ptnl, ptn2 out ptnl.dat,
ptn2.dat

» Copies the data from ptnl and ptn2 to ptnl.dat and ptn2.dat:
bcp mydb. .bigtable partition ptnl, ptn2 out

See also
e bcpon page 14

Improve bcp Performance

There are three ways to improve the performance of bcp.
Use:

« Fast-logged bcp

 Partitioned tables — several bcp sessions with a partitioned table can dramatically reduce
the time required to copy the data. However, such performance improvements are more
noticeable in fast and fast-logged bcp than in slow bcp.

e bcp in parallel to increase performance dramatically — parallel bulk copy can provide
balanced data distribution across partitions.

Note: bcp does not fire any trigger that exists on the target table.

See also
» Using Parallel Bulk Copy to Copy Data into a Specific Partition on page 181
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Fast, Fast-logged, and Slow bcp
Whether to use fast, fast-logged, or slow bcp depends on your situation.

The existence of indexes on tables can affect transfer speed, depending on certain attributes.
Unless you explicitly specify fast-logged bcp on tables with indexes, bcp automatically uses
slow mode, which logs data inserts in the transaction log. These logged inserts can cause the
transaction log to become very large.

To control this data excess and ensure that the database is fully recoverable in the event of a
failure, back up the log with dump transaction.

By default, the select into/bulkcopy/plisort option is false (disabled) in newly created
databases. When this option is disabled, bcp automatically uses slow mode. Fast and fast-
logged bep both require that select into/bulkcopy/plisort option is set to true. To change the
default setting for future databases, turn this option on in the mode1 database.

Note: You need not set the select into/bulkcopy/plisort option to true to copy out data from, or
to copy in data to a table that has indexes. Slow bcp always copies tables with indexes and logs
all inserts.

The differences between fast, fast-logged, and slow bcp are:

e Fast bep:
Lock Scheme Index Type select into Recovery
APL Non-unique nonclustered On No
DOL Non-unique nonclustered On No
DOL Non-unique clustered On No

« Fast-logged bcp (in SAP ASE 15.7 ESD #2):

Lock Scheme Index Type select into Recovery
APL Non-unique nonclustered On Yes
DOL Non-unique nonclustered On Yes
DOL Non-unique clustered On Yes
* Slow bcp:
Lock Scheme Index Type select into/bulkcopy Recovery
APL Unique On/off Yes
DOL Unique On/off Yes
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Lock Scheme Index Type select into/bulkcopy Recovery
APL Non-unique Off Yes
DOL Non-unique Off Yes

While the select into/bulkcopy/pllsort option is on, you cannot dump the transaction log.
Issuing dump transaction produces an error message instructing you to use dump database
instead.

Warning! Be certain that you dump your database before you turn off the select into/
bulkcopy/plisort flag. If you have inserted unlogged data into your database, and you then
perform a dump transaction before performing a dump database, you will not be able to
recover your data.

SAP ASE prohibits dump transaction after running fast bcp. Instead, use dump database.
Because slow bcp is a minimally logged operation, the SAP ASE server allows you to issue
dump transaction after running slow bcp whether select into/bulkcopy/plisort is set to true
or false in the database.

See also
» Before You Transferon page 172

Slow bcp
In certain situations, use slow bcp.

Use slow bcp when:

* sp_dboption 'select into/bulkcopy/plisort' is off.

» sp_dboption 'select into/bulkcopy/plisort’ is on, but the table uses the allpages locking
scheme and has a clustered index.

» sp_dboption 'select into/bulkcopy/plisort’ is on, but the table has a unique nonclustered
index.
If the option ignore_dup_key option is enabled on the unique index, performing fast bcp
can put the table and index in an inconsistent state if rows with duplicate keys are inserted.
To avoid the inconsistency, the SAP ASE server performs slow bcp.

« Ifthe table has nonclustered indexes or triggers, and the table is marked for replication or
the database is used as a warm standby.
Because fast bcp does not log inserts, if the SAP ASE server uses fast bcp, the rows bep
copies cannot be recovered on the replication site if there is a problem. The SAP ASE
server uses slow bcp in these situations to maintain compatibility with applications that
were written to use the old behavior.
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Fast bcp
Adaptive Server uses fast bep in certain situations.

The SAP ASE server uses fast bcp when (in all cases sp_dboption 'select into/bulkcopy/
plisort' is enabled and the table does not have a unique clustered index):

« You do not explicitly specify fast-logged bcp.

« The table has a non-unique, nonclustered index. The SAP ASE server logs the index
updates and the page allocations only. It does not log inserts into the table.

» A table has triggers. However, bcp does not fire any triggers in the target table.

» A table has datarows or datapage locking scheme with a unique clustered index.

If the table includes nonclustered indexes or triggers, but sp_dboption 'select into/bulkcopy/
plisort’ is not enabled, the SAP ASE server uses slow bcp.

Fast bcp runs more slowly while a dump database is taking place.

Fast bcp logs only the page allocations. For copying data in, bep is fastest if your database
table has no indexes.

If you use fast bep to make data inserts, which fast bcp does not log, you cannot back up
(dump) the transaction log to a device. The changes are not in the log, and a restore cannot
recover nonexistent backup data. The requested backup (dump transaction) produces an error
message that instructs you to use dump database instead. This restriction remains in force
until a dump database successfully completes. For more information about dump database
and dump transaction, see the System Administration Guide, and the Reference Manual.

bcp optimization is performed by the SAP ASE server and does not require that you use Open
Client version 15.0 or later.

Fast-logged bcp
Use fast-logged bcp on any table the includes indexes and triggers (bcp does not fire any
triggers in the target table). Fast-logged bcp logs inserts to tables.

Use the set logbulkcopy {on | off } command to configure fast-logged bcp for the session. You
may include the set logbulkcopy {on | off } with the -—initstring 'Transact-
SQL command' parameter, which sends Transact-SQL commands to the SAP ASE server
before transferring the data. For example, this enables logging when you transfer the
titles.txt dataintothe pubs2..titles table

bcp pubs2..titles in titles.txt --initstring 'set logbulkcopy on'

Copying Tables with Indexes
The bep utility is optimized to load data into tables that do not have indexes associated with
them.

bep loads data into tables without indexes at the fastest possible speed. Fast-logged bep logs
any data changes to the table.
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When you copy data into a table that has one or more indexes, depending on the index type and
the locking scheme, you can use fast bcp. This includes indexes that are implicitly created
using the unique integrity constraint of a create table statement. However, bcp does not
enforce the other integrity constraints defined for a table.

Note: The log can grow very large during slow bcp because bep logs inserts into a table that
has indexes. After the bulk copy completes, back up your database with dump database, then
truncate the log with dump transaction after the bulk copy completes and after you have
backed up your database with dump database.

The performance penalty for copying data into a table that has indexes in place can be severe.
If you are copying in a very large number of rows, it may be faster to drop all the indexes
beforehand with drop index (or alter table, for indexes created as a unique constraint); set the
database option; copy the data into the table; re-create the indexes; and then dump the
database. Remember to allocate disk space for the construction of indexes: about 2.2 times the
amount of space needed for the data.

Locking Scheme and Fast bcp
Regardless of the locking scheme, any table without indexes can utilize fast bcp.

For:

« APL tables —the index must be nonunique and nonclustered to enable fast bcp.

« DOL tables - the index need only be nonunique for fast bcp. It can be either clustered or
nonclustered.

To access fast bcp, set sp_dboption 'select into/bulkcopy/pllisort to true in the database.

SAP recommends that you enable dboption "trunc log on chkpt" before using bcp. This
ensures that the log will be truncated with each checkpoint. The SAP ASE server issues a
checkpoint with each batch completion. To implement more checkpoints, run bep -b
batchsize.

Space Requirements for Copying
If you are copying a very large number of rows, you must have 1.2 times the amount of space
needed for the data and enough space for the server to reconstruct a clustered index.

If space is

« Available — use drop index to drop all the indexes beforehand.

* Notavailable —if you do not have enough space for the server to sort the data and build the
index or indexes, use slow bcp.

Summary of Steps for Fast and Fast-logged bcp
The various steps available for fast and fast-logged bcp can be performed by various users.
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Table 2. Steps for Copying in Data Using Fast and Fast-logged bcp

Step

Who can do it

Use sp_dboption to set select into/bulkcopy/
plisort to true.

System administrator or database owner

Have enough space to re-create any indexes on the
table.

Drop the indexes on the table.

Table owner

Have insert permission on the table.

Granted by the table owner

Perform the copy with bcp.

Any user with insert permission

Re-create the indexes.

Table owner

Reset sp_dboption, if required.

System administrator or database owner

Use dump database to back up the newly inserted
data.

System administrator, operator, or database
owner

Run stored procedures or queries to determine
whether any of the newly loaded data violates rules.

Table owner or stored procedure owner

Bulk Copying Data into Partitioned Tables

In certain circumstances, you can improve bep performance dramatically by executing several

bcp sessions with a partitioned table.

Partitioned tables improve insert performance by reducing lock contention and by distributing
1/0 over multiple devices. bcp performance with partitioned tables is improved primarily

because of this distributed 1/0.

When you execute a bcp session on a partitioned table, consider:

« A partitioned table improves performance when you are bulk copying in to the table.

« The performance of slow bcp does not improve as much with partitioned tables. Instead,
drop all indexes and use fast or fast-logged bcp.

» Network traffic can quickly become a bottleneck when multiple bcp sessions are being
executed. If possible, use a local connection to the SAP ASE server to avoid this

bottleneck.

When copying data into a partitioned table, you can:

« Copy the data randomly without regard to the partition to which data is copied. For
example, to copy data from filel tobigtable, enter:

bcp mydb. .bigtable in filel

To copy data from £ilel, file2,and file3 to bigtable, enter:
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bcp mydb. .bigtable in filel, file2, file3
« Copy the data into a specific partition For example, to copy data from filel to ptnl,
file2toptn2,and £ile3 to ptn3, enter:

bcp mydb. .bigtable partition ptnl, ptn2, ptn3 in filel, file2,
file3

To copy data from £ilel to the first partition of bigtable, enter:
bcp mydb. .bigtable:1 in filel

If the table has a clustered index, bep runs in slow mode and allows the index to control the
placement of rows.

See also
e Chapter 2, Utility Commands Reference on page 5

Copying Data Randomly Into Partitions
You can copy data randomly into partitioned tables when using multiple bcp sessions.

1. Configure the table with as many partitions and physical devices as you require for your
system.
For more information, see the Performance and Tuning Guide.

2. Make sure that the SAP ASE server is configured with enough locks to support multiple
bep sessions. For information on configuring locks, see the System Administration
Guide.

3. Remove the indexes on the table and enable fast or fast-logged bcp.

Note: If you use slow bcp, performance may improve significantly after you remove the
indexes.

4. Divide the bcp input file into as many files of equal size as the number of planned
simultaneous bcp sessions.

You also can use the -F first_row and -L last_row options to specify the start and end of each
“input file.”
5. Execute the bcp sessions with separate files in parallel on the local SAP ASE machine.

For example, on UNIX platforms, execute different sessions in different shell windows or
start individual bcp sessions in the background.

See also
e Using Parallel Bulk Copy to Copy Data into a Specific Partition on page 181
e Fast, Fast-logged, and Slow bcp on page 174
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Monitoring bcp Sessions with dbcc checktable and sp helpsegment

If you do not specify which partition the bcp sessions should use, the SAP ASE server
randomly assigns the multiple bcp sessions to the table’s available partitions.

If this random assignment occurs, be sure to monitor the partitions to ensure that the process
has evenly distributed the inserts by using either of the following:

» dbcc checktable — to periodically to check the total page counts for each partition

* sp_helpsegment or sp_helpartition — to perform a similar check, but without locking the
database objects

For more information about dbcc checktable, see the System Administration Guide. For more
information about sp_helpsegment and sp_helpartition, see the Reference Manual.

For more information about table partitions, see the Performance and Tuning Guide.
Reducing Logging by Increasing Page Allocations

If you are using fast or fast-logged bcp, consider that each bep in batch requires the page
manager to allocate one or more extents. Each such allocation generates a single log record.

Use the number of pre-allocated extents configuration parameter to specify how many
extents the SAP ASE server is to allocate through the page manager:

* Valid values for the number of pre-allocated extents configuration parameter are from 1
to 32; the default value is 2.

e The number of pre-allocated extents parameter is dynamic, not static. For this reason,
you need not restart the SAP ASE server after you change its value.

« An object may be allocated more pages than actually needed, so the value of number of
pre-allocated extents should be low if you are using bcp for small batches. If you are using
bep for large batches, increase the value of number of pre-allocated extents to reduce the
amount of overhead required to allocate pages and to reduce the number of log records.

The SAP ASE server may allocate more pages than are actually needed, so keep the value
small when space is limited. These pages are deallocated at the end of the batch.

In SAP ASE version 15.5 and later, the maximum values of preallocated extents has been
increased increased from 31 to 32.

Using a value of 32 for the number of pre-allocated extents parameter has a special
significance for configuration, and impacts the space allocations the SAP ASE server
performs internally. If you set the number of preallocated extents to 32, the SAP ASE server
attempts to reserve an entire allocation unit of extents for utility operations that use a large-
scale allocation scheme of space reservation, such as bcp in and select into.

Using the maximum number of preallocated extents can greatly improve the performance of
these utilities, particularly when you run them in parallel. Using a value of 32 greatly increases
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the likelihood that each engine running the utility can work independently on its own
allocation unit without interference from other engines.

For more information, see Setting Configuration Parameters in the System Administration
Guide: Volume 1.

Using Parallel Bulk Copy to Copy Data into a Specific Partition
Use parallel bulk copy to copy data in parallel to a specific partition. Parallel bulk copy
substantially increases performance during bcp sessions because it can split large bulk copy
jobs into multiple sessions and run the sessions concurrently.

To use parallel bulk copy:

* The destination table must be partitioned. Use:
* sp_helpartition — to see the number of partitions on the table.
e alter table ... partition — to partition the table, if the table is not already partitioned.
* The destination table should not contain indexes because:
« If the table has a clustered index, this index determines the physical placement of the
data, causing the partition specification in the bcp command to be ignored.
« Ifany indexes exist, bcp automatically uses its slow bulk copy instead of its fast bulk
copy mode.
« Ifnonclustered indexes exist on the tables, parallel bulk copy is likely to lead to deadlocks
on index pages.
« Each partition should reside on a separate physical disk for the best performance.
« Before you copy data into your database, partition the table destined to contain the data.
» Parallel bulk copy can copy in to a table from multiple operating system files.
« For all types of partitioned tables, use:
bcp tablename partition partition name in file name
« For round-robin partitioned tables only, use:

bcp tablename partition number in file name

Figure 1: Copying data into a round-robin partitioned table using parallel bulk

copy
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See the Transact-SQL Users Guide for information about partitioning a table.

Note: When using parallel bulk copy to copy data out, you cannot specify a partition number.
You can, however, specify a partition name.

bcp in and Locks
When you copy in to atable using bcp—particularly when you copy in to a table using parallel
bcp—the copy process acquires an exclusive lock.

» An exclusive intent lock on the table
» An exclusive page lock on each data page or data row
« An exclusive lock on index pages, if any indexes exist

If you are copying in very large tables—especially if you are using simultaneous copies into a
partitioned table—this can involve a very large number of locks.

To avoid running out of locks, increase the number of locks.

« To estimate the number of locks needed, use:
# of simultaneous batches * (rows per batch / (2016/row length))
« To see the row length for a table, use:

1> select maxlen
2> from sysindexes
3> where id = object id("tablename") and (indid = 0 or indid = 1)

See the System Administration Guide for more information about setting the number of
locks.

» Usethe-bbatchsize flag to copy smaller batches; the default batch size is 1000 rows. The
smallest batch size bcp can process is 1; the largest is 2147483647L.

* Run fewer batches concurrently.

Parallel Bulk Copy Methods
There are various methods to copy in data using parallel bulk copy.

 Start multiple bep sessions in the background, and:
» Specify the password at the command line.
» Use native mode, character mode, or a format file.
You can start bcp as many times as the table is partitioned.
» Create and use a format file:
Start bep in interactive mode.
Answer the prompts.
Create a format file that stores your responses.
Put the process in the background when the copy begins.

Issue the next bcp command, and specify the format file created with the first bcp
command.

g rwbdhe
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 Start bep sessions in multiple windows.

» Specify a partition to file mapping in a single bcp in command.
The client can execute independent bcp in sessions in parallel. The user can alternately
specify the --maxconn option to control the maximum number of parallel connections that
the bcp client can open to the server.

Alternatively, specify the --maxconn option to control the maximum number of parallel
connections that the bcp client can open to the server. To ensure parallel execution on UNIX
platforms, use the bcp_r variant.

Parallel Bulk Copy Syntax
Use this syntax for parallel bulk copy, when using several simultaneous sessions.

bcp table name|:partition number | partrition name] in file name
-Pmypassword

» table_ name—is the name of the table into which you are copying the data.

* partition_name — is the name of the partition into which you are copying.

» file_name—is the host file that contains the data.

e mypassword — is your password.

Alternatively, you can execute parallel bulk copy using a multithreaded version of bcp:

e (UNIX) Perform this using the bcp_r command:

bcp r database name..table name partition partition numberl
[, partition number2 ...] in file namel [,file name2 ....]
-Ul[username] -P[password] -S[servername]

« (Windows) The standard bcp command is capable of paralled execution:

bcp database name..table name partition partition numberl
[, partition number2 ...] in file namel [,file name2 ....]
-Ulusername] -P[password] -S|[servername]

Using Parallel Bulk Copy on Round-robin Partitioned Tables
Copy sorted data in parallel into a specific partition.

» Specify the partition by appending a colon (:) plus the partition number to the table name.
For example:

publishers:10

Note: The partition you specify must exist before you issue the bcp command.
« Split the sorted data into separate files, or delineate the “files” by specifying the first row
(-F first_row) and the last row (-L last_row) of the host file.

* Note the number of partitions in the table, as this number limits the number of parallel bulk
copy sessions that you can start.
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For example, if a table has four partitions, and you start five parallel bulk copy jobs, only
the first four jobs can run in parallel; the fifth job does not start until one of the first four
jobs finish.

bcp copies each file or set of line numbers to a separate partition. For example, to use parallel
bulk copy to copy in sorted data to mydb . .bigtable from four files into four partitions,
enter:

bcp mydb..bigtable:
bcp mydb. .bigtable:

bcp mydb. .bigtable:
bcp mydb. .bigtable:

in filel -Pmypassword -c
in file2 -Pmypassword -c
in file3 -Pmypassword -c
in file4 -Pmypassword -c

S w N
2 22 22

Parallel Bulk Copy and IDENTITY Columns
When you use parallel bulk copy, IDENTITY columns can cause a bottleneck.

As bep reads in the data, the utility both generates the values of the IDENTITY column and
updates the IDENTITY column’s maximum value for each row. This extra work may
adversely affect the performance improvement that you expected to receive from using
parallel bulk copy. To avoid this bottleneck, explicitly specify the IDENTITY starting point
for each session.

Specifying the Starting Point from the Command Line
Use -g id start value tospecify an IDENTITY starting point for a session in the
command line.

The —g parameter instructs the SAP ASE server to generate a sequence of IDENTITY column
values for the bcp session without checking and updating the maximum value of the table’s
IDENTITY column for each row. Instead of checking, the SAP ASE server updates the
maximum value at the end of each batch.

Warning! When specifying overlapping identity value ranges, be cautious about
inadvertently creating duplicate identity values.

To specify a starting IDENTITY value, enter:
bcp [-gid start value]

For example, to copy in four files, each of which has 100 rows, enter:

bcp mydb..bigtable in filel -gl00
bcp mydb. .bigtable in file2 -g200
bcp mydb. .bigtable in file3 -g300
bcp mydb. .bigtable in filed4 -g400

Using the —g parameter does not guarantee that the IDENTITY column values are unique. To
ensure uniqueness:

« Know how many rows are in the input files and what the highest existing value is. Use this
information to set the starting values with the —g parameter and generate ranges that do not
overlap.
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In the example above, if any file contains more than 100 rows, the identity values overlap
into the next 100 rows of data, creating duplicate identity values.

« Verify that no one else is inserting data that can produce conflicting IDENTITY values.

Retaining Sort Order
If you copy sorted data into the table without explicitly specifying the IDENTITY starting
point, bcp might not generate the IDENTITY column values in sorted order.

Parallel bulk copy reads the information into all the partitions simultaneously and updates the
values of the IDENTITY column as it reads in the data.

A bcp statement with no explicit starting point would produce IDENTITY column numbers
similar to those shown as follows:

Partition 1 Partition 2 Partition 3 Partition 4
I cohmrm

The table has a maximum IDENTITY column number of 119, but the order is no longer
meaningful.

To enforce unique IDENTITY column values in the SAP ASE server, run bcp with either the
-g Or -E parameter.

Specifying the Value of a Table’s IDENTITY Column
By default, when you bulk copy data into a table withan IDENTITY column, bep assigns each
row a temporary IDENTITY column value of 0.

This is effective only when copying data into a table. bcp reads the value of the ID column
from the data file, but does not send it to the server. Instead, as bcp inserts each row into the
table, the server assigns the row a unique, sequential, IDENTITY column value, beginning
with the value 1.

If you specify the -E flag when copying data into a table, bcp reads the value from the data file
and sends it to the server which inserts the value into the table. If the number of rows inserted
exceeds the maximum possible IDENTITY column value, the SAP ASE server returns an
error.

The -E parameter has no effect when you are bulk copying data out. the SAP ASE server copies
the ID column to the data file, unless you use the -N parameter.

You cannot use the -E and -g flags together.
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Bulk Copying Encrypted Data

bep transfers encrypted data in and out of databases in either plain text or cipher text form. By
default, bcp copies plain text data, data is automatically:

« Encrypted by the SAP ASE server before insertion when executing bcp in. Slow bep is
used. The user must have insert and select permission on all columns.

» Decrypted by the SAP ASE server when executing bcp out. select permission is required
on all columns; in addition, decrypt permission is required on the encrypted columns.

This example copies the customer table out as plain text data in native machine format:

bcp uksales.dbo.customer out uk customers -n -Uroy -Proyl23

If the data to be copied out as plain text is encrypted by a key that uses an explicit password,
supply that password to bep using the --c password or --colpasswd options.

For example, if the salary column in the employee table is encrypted by a key that is
protected by an explicit password, copy out only the salary data as plain text by providing
bcp with the password, such as:

bcp hr.dbo.employee out -c -Upjones -PX15tgol --
colpasswd hr.dbo.employee.salary '4mIneIsonly'

Alternatively, if you know the name of the key that encrypts the salary column, use:

bcp hr.dbo.employee out -c -Upjones -PX15tgol --
keypasswd keydb.dbo.hr key '4mIneIsonly'

bcp uses the password to issue a set encryption passwd command before selecting the data.
Use the --keypasswd and --colpasswd options in a similar way on the bcp command line
when copying the data back in.

Use the -C option for bep to copy the data as cipher text. When copying cipher text, you may
copy data out and in across different operating systems. If you are copying character data as
cipher text, both platforms must support the same character set.

The -C option for bcp allows administrators to run bep when they lack decrypt permission on
the data. When you use the -C option:

« Datais assumed to be in cipher text format during execution of bcp in, and the SAP ASE
server performs no encryption.
Use the -C option only if the file being copied into the SAP ASE server was created using
the -C option on bcp out. The cipher text must have been copied from a column with
exactly the same column attributes and encrypted by the same key as the column into
which the data is being copied. Fast bcp is used. The user must have insert and select
permission on the table.

186

Adaptive Server Enterprise



CHAPTER 3: Using bcp to Transfer Data to and from SAP ASE

bcp in -C bypasses the domain rule and check constraint for encrypted columns if either
exist on an encrypted column because, in this situation, the SAP ASE server uses fast bep.
Domain rules and check constraints do not affect bcp out -C.

If an access rule exists on an encrypted column, using bcp out -C results in a 2929 error.
Access rules do not affect bep in -C.

Data is copied out of the SAP ASE server without decryption on bcp out. The cipher text
data is in hexadecimal format. The user must have select permission on all columns. For
copying cipher text, decrypt is not required on the encrypted columns.

Encrypted char or varchar dataretains the character set used by the SAP ASE server at
the time of encryption. If the data is copied in cipher text format to another server, the
character set used on the target server must match that of the encrypted data copied from
the source. The character set associated with the data on the source server when it was
encrypted is not stored with the encrypted data and is not known or converted on the target
server.

You can also perform bcp without the -C option to avoid the character set issue.

You cannot use the -J option (for character set conversion) with the -C option.

This example copies the customer table:

bcp uksales.dbo.customer out uk customers -C -c -Uroy -Proyl23

The cc__cardcolumnis copied out as human-readable cipher text. Other columns are copied
in character format. User “roy” is not required to have decrypt permission on customer
cc card.

When copying data as cipher text, ensure that the same keys are available in the database when
the data is copied back in. If necessary, use the ddigen utility to move keys from one database
to another.

bcp Options

The information in this section clarifies some of the more complex options of the bep syntax.

See also

bcp on page 14

Using the Default Formats

bep provides two command line options that create files with frequently used default formats.
These options provide the easiest way to copy data in and out from a SAP ASE server.

The -n option uses “native” (operating system) formats.

The -c option uses “character” (char datatype) for all columns. This datatype supplies
tabs between fields on a row and a newline terminator, such as a carriage return, at the end
of each row.
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When you use the native or character options, bcp operates noninteractively and only asks you
for your SAP ASE password.

Native Format
The -n option creates files using native (operating system-specific) formats.

Native formats usually create a more compact operating system file. For example, this
command copies the publishers table to the file called pub_out, using native data
format:

bcp pubs2..publishers out pub out -n

The contents of pub_out are:

0736"MNew Age Books”FBoston”BMAQO877"PBinnet & Hardley”™Jd
Washington”BDC1389"TAlgodata Infosystems”HBerkeley”BCA

bep prefixed each field, except the pub_id, whichisa char (4) datatype, with an ASCII
character equal to the data length in the field. For example, “New Age Books” is 13 characters
long, and *M (Ctrl+m) is ASCII 13.

All the table data stored in pub_out is in the form of human-readable char or varchar
data. In a table with numeric data, bcp writes the information to the file in the operating
system’s data representation format, which may not be human-readable.

bcp can copy data out to a file either as its native (database) datatype or as any datatype for

which implicit conversion is supported for the datatype in question. bcp copies user-defined

datatypes as their base datatype or as any datatype for which implicit conversion is supported.

For more information on datatype conversions, see dbconvert inthe Open Client DB-Library/
C Reference Manual or the Adaptive Server Enterprise Reference Manual.

The bcep utility does not support copying data in native format from different operating
systems; for example, copying from Windows to UNIX. Use the -c flag if you need to use bcp
to copy files from one operating system to another.

Warning! Do not use row terminator (-t) or field terminator (-r) parameters with bcp in
native format. Results are unpredictable and data may be corrupted.

Character Format
Character format (-c) uses the char datatype for all columns. It inserts tabs between fields in
each row and a newline terminator at the end of each row.

For example, this command copies out the data from the publishers table in character
format to the file pub out:

bcp pubs2..publishers out pub out -c

0736 New Age Books Boston MA
0877 Binnet & Hardley Washington DC
1389 Algodata Infosystems Berkeley CA
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Change Terminators from the Command Line

Terminators are the characters that separate data fields (field terminators). The row terminator
is the field terminator of the last field in the table or file.

Use the -tfield_terminator and -rrow_terminator command line options with the character
format option (-c) to change the terminators from the command line.

This example uses the comma (, ) as the field terminator, and returns (\r) as the row terminator.

e In UNIX platforms:
bcp pubs2..publishers out pub out -c -t , -r \\r

If necessary, “escape” the backslash for your operating system command shell.
e In Windows:
bcp pubs2..publishers out pub out -c -t , -r \r

This bcp command line produces the following information:

0736,New Age Books,Boston,MA
0877,Binnet & Hardley,Washington,DC
1389,Algodata Infosystems,Berkeley,CA

Note: You can use the -t and -r options to change the default terminators without including the
character option (-c).

Change the Defaults in Interactive bcp

If you do not specify native (-n) or character (-c) format, bcp prompts you interactively

The prompts are for:

« The file storage type

e The prefix length

» The terminator for each column of data to be copied

» Afield length for fields that are to be stored as char or binary

The default values for these prompts produce the same results as using the native format, and
provide a simple means for copying data out of a database for reloading into the SAP ASE
server later.

If you are copying data to or from the SAP ASE server for use with other programs, base your
answers to the prompts on the format required by the other software.

These four prompts provide an extremely flexible system that allows you either to read a file
from other software or to create a file that requires little or no editing to conform to many other
data formats.
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Respond to bcp Prompts

Unless you supplied bcp with the -P parameter, it prompts you for your password when you
copy data in or out using the -n (native format) or -c (character format) parameters.

If you do not supply either the -n, —c or -f formatfile parameter, bcp prompts you for
information for each field in the table or view.

Each prompt displays a default value, in brackets, which you can accept by pressing
Return. The prompts include:

» The file storage type, which can be character or any valid SAP ASE datatype

« The prefix length, which is an integer indicating the length in bytes of the following
data

e The storage length of the data in the file for non-NULL fields

» The field terminator, which can be any character string

* (Windows) Scale and precision for numeric and decimal datatypes

The row terminator is the field terminator of the last field in the table, view, or file.

The bracketed defaults represent reasonable values for the datatypes of the field in
question. For the most efficient use of space when copying out to a file:

» Use the default prompts

e Copy all data in the datatypes defined by their table

« Use prefixes as indicated

« Do not use terminators

» Accept the default lengths

The bep prompts, defaults, and the possible alternate user responses are:

Table 3. Defaults and User Responses for bcp Prompts

Prompt Default Provided Possible User Response

File Storage | Use database storage type for most fields | char to create or read a human-

Type except: readable file; any SAP ASE datatype
e charforvarchar where implicit conversion is suppor-
* binaryforvarbinary ted.

Prefix « 0O for fields defined with char data- | O if no prefix is desired; otherwise,

Length type (not storage type) and all fixed- | defaults are recommended.

length datatypes

e 1 for most other datatypes

e 2forbinaryand varbinary
saved as char

e 4for text and image
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Prompt Default Provided Possible User Response
Storage e Forchar and varchar, use de- | Default values, or greater, are recom-
Length fined length. mended.

e Forbinaryandvarbinary
saved as char, use double the de-
fined length.

» Forall other datatypes, use maximum
length needed to avoid truncation or
data overflow.

Field or Row | None Up to 30 characters, or one of the fol-
Terminator lowing:
« \t-tab

¢ \n-newline
» \r -carriage return
e\ 0 -null terminator
e\ —backslash

bcp can copy data out to a file either as its native (database) datatype, or as any datatype for
which implicit conversion is supported. bcp copies user-defined datatypes as their base
datatype or as any datatype for which implicit conversion is supported. See dbconvert in
the Open Client DB-Library/C Reference Manual.

Note: Be careful when you copy data from different versions of SAP ASE, because not all
versions support the same datatypes.

A prefix length is a 1-byte, 2-byte, or 4-byte integer that represents the length of each data
value in bytes. It immediately precedes the data value in the host file.

Be sure that fields defined in the database as char, nchar, and binary are always
padded with spaces (null bytes for binary) to the full length defined in the database.
timestamp data is treated as binary (8).

Ifdatain varchar andvarbinary fields is longer than the length you specify for copy
out, bep silently truncates the data in the file at the specified length.

A field terminator string can be up to 30 characters long. The most common terminators
are a tab (entered as “\ t” and used for all columns except the last one), and a newline
(entered as “\n” and used for the last field in a row). Other terminators are: “\ 0” (the null
terminator), “\” (backslash), and “\ r” (Return). When choosing a terminator, be sure that
its pattern does not appear in any of your character data. For example, if you use tab
terminators with a string that contains a tab, bcp cannot identify which tab represents the
end of the string. bcp always looks for the first possible terminator, in this case, it will find
the wrong one.

When a terminator or prefix is present, it affects the actual length of data transferred. If the
length of an entry being copied out to a file is smaller than the storage length, it is followed
immediately by the terminator, or the prefix for the next field. The entry is not padded to
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the full storage length (char, nchar, and binary data is returned from the SAP ASE
server already padded to the full length).

When copying in from a file, data is transferred until either the number of bytes indicated
in the “Length” prompt has been copied, or the terminator is encountered. Once a number
of bytes equal to the specified length has been transferred, the rest of the data is flushed
until the terminator is encountered. When no terminator is used, the table storage length is
strictly observed.

These tables show the interaction of prefix lengths, terminators, and field length on the
information in the file. “P” indicates the prefix in the stored table; “T” indicates the
terminator; and dashes, “--”, show appended spaces. “...” indicates that the pattern repeats
for each field. The field length is 8 for each column, and “string” represents the 6-character
field each time.

Table 4. SAP ASE char data

Prefix length 0 Prefix length 1, 2, or 4
No terminator string--string-- Pstring--Pstring--
Terminator string--Tstring--T Pstring--TPstring--T

Table 5. Other datatypes converted to char storage

Prefix length 0 Prefix length 1, 2 or 4
No terminator string--string-- PstringPstring
Terminator stringTstringT PstringTPstringT

The file storage type and length of a column do not have to be the same as the type and
length of the column in the database table. However, if types and formats copied in are
incompatible with the structure of the database table, the copy fails.

File storage length generally indicates the maximum amount of data to be transferred for
the column, excluding terminators and prefixes.

When copying data into a table, bcp observes any defaults defined for columns and user-
defined datatypes. However, bcp ignores rules to load data at the fastest possible speed.
Because bcp considers any data column that can contain null values to be variable length,
use either a length prefix or terminator to denote the length of each data row.

Data written to a host file in its native format preserves all of its precision. datetime and
float values preserve all of their precision even when they are converted to character
format. The SAP ASE server stores money values to a precision of one ten-thousandth of a
monetary unit. However, when money values are converted to character format, their
character format values are recorded only to the nearest two places.

Before copying data in character format from a file into a database table, check the
datatype entry rules in the Datatypesin Reference Manual: Building Blocks. Character
data that is copied into the database with bcp must conform to those rules. Dates in the
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undelimited (yy)yymmddformat may result in overflow errors if the year is not specified
first.

« When you send host data files to sites that use terminals different from your own, inform
them of the datafile charset that you used to create the files.

File Storage Type
The file storage type prompt offers you choices about how to store the data in the file.

Copy data into a file as:

« Its database table type,
e A character string, or

« Any datatype for which implicit conversion is supported.

Note: bcp copies user-defined datatypes as their base types.

Table 6. File storage datatypes for bcp

Table Datatype Storage Type
char, varchar c[har]
text T[ext]
int i[nt]
smallint s[mallint]
tinyint tlinyint]
float f[loat]
money m[oney]
bit b[it]
datetime d[atetime]
binary, varbinary, timestamp X
image I[mage]
smalldatetime D

real r
smallmoney M
numeric n
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Table Datatype Storage Type

decimal e

The table shows the default storage type for each SAP ASE datatype and the abbreviations that
are acceptable to bcp.

» For the most compact storage, use the default value.

» For character files, use char.

e Thedate storage type isthe SAP ASE internal storage format of datet ime, notthe host
operating system format of the date.

e timestamp dataistreated asbinary (8).

The brackets [ ] in the table indicate that you can use the initial character or the beginning
characters of the word. For example, for “bit” use “b,” “bi,” or “bit.”

To display this list while using bcp interactively, type a question mark (?) in response to the
prompt Enter the file storage type.

The values that appear in the prompts are the defaults. Your response determines how the data
is stored in the output file; you need not indicate the column’s type in the database table.

bep fails if you enter a type that is neither implicitly convertible or char. For example, you
may not be able to use smallint for int data (you may get overflow errors), but you can
use int for smallint.

When storing noncharacter datatypes as their database types, bcp writes the data to the file in
the SAP ASE server’s internal data representation format for the host operating system, rather
than in human-readable form.

Before copying data that is in character format from a file into a database table, check the
datatype entry rules in the Reference Manual: Building Blocks. Character data copied into the
database with bcp must conform to those rules. If you do not specify the year first, dates in the
undelimited (yy)yymmadd format may result in overflow errors.

When you send host data files to sites that use terminals different from your own, inform them
of the datafile charset that you used to create the files.

Prefix Length

By default, bcp precedes each field that has a variable storage length with a string of one or
more bytes indicating the length of the field, which enables the most compact file storage.

The default values in the prompts indicate the most efficient prefix length. For:

» Fixed-length fields — the prefix length should be 0.
« Fields of 255 bytes or less — the default prefix length is 1.
e text or image datatypes — the default prefix length is 4
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e binaryandvarbinary datatypes being converted to char storage types —the default
prefix length is 2, since each byte of table data requires 2 bytes of file storage.

* binary,varbinary, and image data — use even numbers for the prefix and length.
This maintains consistency with the SAP ASE server, which stores data as an even number
of hexadecimal digits.

* Any data column that permits null values — use a prefix length, other than 0, or a terminator
to denote the length of each row’s data. bcp considers such columns, including columns
with integer datatypes that might ordinarily be considered fixed-length columns, to be of
variable length.

« Data with no prefix before its column — use a prefix length of 0.

A prefix length is a 1-, 2-, or 4-byte integer that represents the length of each data value in
bytes, and it immediately precedes the data value in the host file.

Unless you supply a terminator, bcp pads each stored field with spaces to the full length
specified at the next prompt, “length.”

Because prefix lengths consist of native format integers, the resulting host file contains
nonprintable characters, which could prevent you from printing the host file or from
transmitting it through a communications program that cannot handle non-human-readable
characters.

Field length

In almost all cases, use the bcp default value for the storage length while copying data out.

Note: The terms “length” and “storage length” in this discussion refer to the operating system
file, not to SAP ASE field lengths.

If you are creating:

« Afiletoreload into the SAP ASE server — the default prefixes and length keep the storage
space needed to a minimum.

* Ahuman-readable file —the default length prevents the truncation of data or the creation of
overflow errors that cause bcp to fail.

Be familiar with the data to transfer, since you can change the default length by supplying
another value. If you are copying character data in from other software, examine the source file
carefully before choosing length values.

Note: If the storage type is noncharacter, bcp stores the data in the operating system’s native
data representation and does not prompt for a length.

When bcp converts noncharacter data to character storage, it suggests a default field length
large enough to store the data without truncating datet ime data or causing an overflow of
numeric data.

» Thedefault lengths are the number of bytes needed to display the longest value for the SAP
ASE datatype.
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Table 7. Default Field Lengths for Noncharacter to Character Datatypes

Datatype Default Size
int 12 bytes
smallint 6 bytes
tinyint 3 bytes
float 25 bytes
money 24 bytes
bit 1 byte
datetime 26 bytes
smalldatetime 26 bytes
real 25 bytes
smallmoney 24 bytes

If you specify a field length that is too short for numeric data when copying data out, bcp

prints an overflow message and does not copy the data.

The default length forbinary and varbinary fields is twice the length defined for the

column, since each byte of the field requires 2 bytes of file storage.

If you accept the default storage length, the actual amount of storage space allocated

depends on whether you specify a prefix length and terminators. If you specify a prefix

length of:

e 1,2,0r4-bcp usesastorage space of the actual length of the data, plus the length of the
prefix, plus any terminators.

« 0 and no terminator — bcp allocates the maximum amount of space shown in the
prompt, which is the maximum space that may be needed for the datatype in question.
bcp treats the field as if it were fixed length to determine where one field ends and the
next begins.

For example, if the field is defined as varchar (30), bcp uses 30 bytes for each
value, even if some of the values are only 1 character long.

Fields defined in the database as char, nchar, and binary, and those that do not

permit null values, are always padded with spaces (null bytes for binary) to the full length

defined in the database. t imestamp data is treated as binary (8).

If data in the varchar and varbinary fields is longer than the length specified for

copy out, bep silently truncates the data in the file at the specified length.

bep does not know how large any one data value will be before copying all the data, so it

always pads char datatypes to their full specified length.
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The file storage type and length of a column need not be the same as the type and length of
the column in the database table. The coy fails if the types and formats copied in are
incompatible with the structure of the database table.

File storage length generally indicates the maximum amount of transferable data for the
column, excluding terminators and/or prefixes.

When copying data into a table, bcp observes any defaults defined for columns and user-
defined datatypes, but ignores rules in order to load data at the fastest possible speed.
bcp considers any data column that can contain a null value to be variable length, so use
either a length prefix or a terminator to denote the length of each row of data.

The file storage type and length of a column need not be the same as the type and length of
the column in the database table. (If types and formats copied in are incompatible with the
structure of the database table, the copy fails.)

Field and Row Terminators

Use a terminator to mark the end of a column or row, separating one from the next. The default
is no terminator.

Field terminators separate table columns.
A row terminator is a field terminator for the last field in the row of the table or file.

Terminators are very useful for dealing with character data because you can choose human-
readable terminators. The bcp character option, which uses tabs between each column with a
newline terminator at the end of each row, is an example of using terminators that enhance the
readability of a data file.

Supply your own terminators when you prepare data for use with other programs, and you
want to use bcp to prepare tabular data. The available terminators are:

Tabs, indicated by \ t

New lines, indicated by \n

Carriage returns, indicated by \r

Backslash, indicated by \

Null terminators (no visible terminator), indicated by \ 0

Any printable character, for example, *, A, t, |

Strings of up to 10 printable characters, including some or all of the terminators listed

Note: Control characters (ASCII 0-25) cannot be printed.

Choose Terminators

Choose terminators with patterns that do not appear in any of the data.

For example, using a tab terminator with a string of data that also contains a tab creates
ambiguity: which tab represents the end of the string? bcp always looks for the first possible
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terminator, which in this case would be incorrect, since the first tab it would encounter would
be part of the data string.

Data in native format can also conflict with terminators. If the values of these integers are not
strictly limited in a column containing a 4-byte integer in native format, it is impossible to
choose a terminator that is guaranteed not to appear inside the data. Use bcp’s native format
option for data in native format.

Note: “No terminator” differs from a “null terminator,” which is an invisible—but real—
character.

A field terminator string can be up to 30 characters long. The most common terminators
are a tab (entered as \ t and used for all columns except the last one), and a newline
(entered as \n and used for the last field in a row). Other terminators are: \ 0 (the null
terminator), \ (backslash), and \ r (Return). When choosing a terminator, its pattern
cannot appear in any of your character data, since bcp always looks for the first possible
terminator.

For example, if you used tab terminators with a string that contained a tab, bcp cannot
identify which tab represents the end of the string. bcp always looks for the first possible
terminator, so, in this example it would find the wrong one.

A terminator or prefix affects the actual length of data transferred:

When a terminator or prefix is present, it affects the length of data transferred. If the length
of an entry being copied out to a file is less than the storage length, it is immediately
followed by the terminator or the prefix for the next field. The entry is not padded to the full
storage length (char, nchar, and binary data is returned from the SAP ASE server
already padded to the full length).

When bep is copying in from a file, data is transferred until either the number of bytes
indicated in the “Length” prompt has been copied or the terminator is encountered. Once
the number of bytes equal to the specified length has been transferred, the rest of the data is
flushed until the terminator is encountered. When no terminator is used, the table storage
length is strictly observed.

Fields stored as char (except char, nchar, and binary fields) instead of their
database datatypes take less file storage space with the default length and prefix or a
terminator. bcp can use either aterminator or a prefix to determine the most efficient use of
storage space. bcp suggests the maximum amount of storage space required for each field
as the default. For char or varchar data, bcp accepts any length.

The following two tables show the interaction of prefix lengths, terminators, and field
length on the information in the file. “P” indicates the prefix in the stored table; “T”
indicates the terminator; and dashes, (--) show appended spaces. An ellipsis (...) indicates
that the pattern repeats for each field. The field length is 8 bytes for each column; “string”
represents the 6-character field each time.
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Table 8. SAP ASE char Data

Prefix length =0 Prefix length-1, 2, or 4
No terminator string--string--... Pstring--Pstring--...
Terminator string--Tstring--T... Pstring--TPstring--T...

Table 9. Other Datatypes Converted to char Storage

Prefix length =0 Prefix length-1, 2, or 4
No terminator string--string--... PstringPstring...
Terminator stringTstringT... PstringTPstringT...

Format Files

After gathering information about each field in the table, bcp asks if you want to save the
information to a format file and prompts for the file name.

Using a format file created for the data to be copied with bcp allows you to copy data in or out
noninteractively without being prompted by bcp for information, since the format file
supplies the information that bcp needs. Use this newly created format file at any other time to
copy the data back into the SAP ASE server or to copy data out from the table.

The figure illustrates the format of the bcp format files. It shows the pub1i shers table from
the pubs2 database, with all the host file columns in character format, with no prefix, and
using the default data length, a newline terminator at the end of the final column of a row, and
tabs as terminators for all other columns.

Figure 2: bcp format file

TOS

Server
lenel Prrefis: column
| length Termingor name
v | ;
Hurmnber 10.0
m - i Y Y
calumns 1 SYECHAR 0 4 Ve 1 pub_id
2 SYECHALR 0 20 LT 2 pub_name
3 SYECHAR 0 20 W 3 city
4 SYECHALR 0 2 Yn' 4 state

Host file 1 ? ?
column -[
arder Host file Host file Server

datztype data calurn
length order

Using this format file example, the names of the various elements of a bcp format file are:
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The Tabular Data Stream (TDS) version is always the first line of the file. It specifies the
version of TDS that you are using, not the SAP ASE version, and appears is a literal string
without quotation marks. In the figure, the version is 10.0.

The second line of a bep format file is the number of columns, which refers to the number
of records in the format file, not including lines 1 and 2. Each column in the host table has

one line.

One line for each column follows the first and second lines in the database table. Each line
consists of elements that are usually separated by tabs, except for the host file datatype and
the prefix length which are usually separated by a space. These elements are:

Elements

Description

Host file column order

The host file column order is the sequential number of the field in the host
data file, which begins numbering at 1.

Host file datatype

The host file datatype refers to the storage format of the field in the host
data file, not the datatype of the database table column. See the next table
for the list of host file datatypes and their storage formats.

Data written to a host file in its native format preserves all of its precision.
datetimeand f1oat values preserve all of their precision, even when
they are converted to character format. The SAP ASE server stores mon -
ey values to a precision of one ten-thousandth of a monetary unit. How-
ever, when money values are converted to character format, their char-

acter format values are recorded only to the nearest two places.

See System and User-Defined Datatypes in the Reference Manual: Build-
ing Blocks for descriptions and appropriate uses of SAP ASE datatypes.

Prefix length

Prefix length indicates the number of bytes in the field length prefix. The
prefix length is a 0-, 1-, 2-, or 4-byte unsigned integer value embedded in
the host data file that specifies the actual length of data contained in the
field. Some fields may have a length prefix while others do not.

The allowable prefix length values in bytes, and their ranges are:

» 0. Range: No prefix

+ 1. Range: 28-1; 0-255

+ 2. Range: 216-1; 0-65535

» 4. Range: 232 -1; 0-4,294,967,295
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Elements

Description

Host file data length

Host file data length refers to the maximum number of bytes to copy for the
field.

To decide how much data to copy in or out, bcp uses one of:
e The maximum field length

* The prefix length, if any
e The field terminator string, if any

If more than one method of field length specification is given, bcp chooses
the one that copies the least amount of data.

Terminator

The terminator can be up to 30 bytes of characters enclosed in quotation
marks (" "). The terminator designates the end of data for the host data file
field.

Server column order

The server column order represents the colid (column ID) of the sy -
scolumns column into which the host data file column is to be loaded.
Together with the host file column order, this element maps host data file
fields to the database table columns.

Server column name

The server column name is the name of the database table column into
which this field is to be loaded.

Column precision

The column precision is the precision of the database table column into
which this field is to be loaded. This element is present only if the storage
formatis numericordecimal

Column scale The column scale is the scale of the database table column into which this
field is to be loaded. This element is present only if the storage format is
numericordecimal.

Table 10. Host File Datatype Storage Formats

SYBCHAR char, chavarchar (ASCIl), nchar

nvarchar

SYBTEXT text

SYBBINARY binary, timestamp, unichar, uni-

varchar, varbinary

SYBIMAGE image

SYBINT1 tinyint

SYBINT2 smallint

SYBINT4 int
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SYBINTS8 bigint

SYBFLTS8 float

SYBREAL real

SYBBIT bit

SYBNUMERIC numeric
SYBDECIMAL decimal
SYBMONEY money

SYBMONEY4 smallmoney
SYBDATETIME datetime
SYBDATETIME4 smalldatetime
SYBDATE date

SYBTIME time

SYBUINTS unsigned bigint
SYBUINT4 unsigned int
SYBUINTZ2 unsigned smallint
SYBUNITEXT unitext

SYBFLTS8 double

Examples of Copying Out Data Interactively

By changing the default values of the prompts to bcp, you can prepare data for use with other
software.

To create a human-readable file, respond to the bcp prompts:

File storage type, enter 0.

Prefix length, enter 0.

Field length, accept the default.

Terminator — the field terminator you enter depends on the software that you plan to use.

« Choose between delimited fields or fixed-length fields. Always use \n, the newline
terminator, to terminate the last field.

For fixed-length fields, do not use a terminator. Each field has a fixed length, with
spaces to pad the fields. Adjacent fields, where the data completely fills the first field
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create tabular output, use the tab character (\ t).

Copy Out Data with Field Lengths

seem to run together, since there are no field separators on each line of output. See the
example below.

For comma-delimited output, use a comma (, ) as the terminator for each field. To

This example uses fixed-length fields to create output in the personal computer format called
SDF (system data format). This format can be easily read or produced by other software.

bcp pubs2..sales out sal out

The results as stored in the sal out file are:

5023
5023
5023
5023
5023
5023
5023
5023
5023
5023
5023
6380
6380
6380
7066
7066
7066
7067
7067
7131
7131
7131
7896
7896
8042
8042
8042
8042
8042
8042

AB-123-DEF-425-173
AB-872-DEF-732-27Z1
AX-532-FED-452-27Z7
BS-345-DSE-860-1F2
GH-542-NAD-713-9F9
NF-123-ADS-642-9G3
XS-135-DER-432-8J2
ZA-000-ASD-324-4D1
ZD-123-DFG-752-9G8
ZS-645-CAT-415-1B2
27Z-999-2727Z-999-0A0
234518

342157

356921

BA27618

BA52498

BA71224

NB-1.142

NB-3.142

Asoapl32

Asoap432

Fsoap867

124152

234518

12-F-9

13-E-7

13-J-9

55-v-7

91-A-7

91-v-7

Oct
Nov
Dec
Dec
Mar
Jul
Mar
Jul
Mar
Mar
Mar
Sep
Dec
Feb
Oct
Oct
Aug
Jan
Jun
Nov
Dec
Sep
Aug
Feb
Jul
May
Jan
Mar
Mar
Mar

The contents of the sal fmt format file are:

10.0

3

1 SYBCHAR 04 "" 1 stor id
2 SYBCHAR 020 "" 2 ord num
3 SYBCHAR 026 "" 3 date

Comma-delimited, Newline-delimited with Format File

In this example, bcp copies data interactively from the publishers table to afile:

31 1985 12:00AM
6 1985 12:00AM
1 1990 12:00AM

12
15
18
21
27
21
21
21
30
13
17
12
27

1986
1987
1987
1991
1988
1991
1991
1991
1987
1985
1991
1985
1987

12:
12:
12:

12

12

12

00AM
00AM
00AM

:00AM
12:
12:
12:

00AM
00AM
00AM

:00AM
12:
12:
12:

00AM
00AM
00AM

:00AM
12:

00AM

5 1988 12:00AM
2 1987 12:00AM
13 1990 12:00AM
16 1986 12:00AM
20 1990 12:00AM
8 1987 12:00AM

14
14
13
23
13
20
20
20

1986
1991
1986
1989
1988
1991
1991
1991

12

12

:00AM
12:
12:
12:

00AM
00AM
00AM

:00AM
12:
12:
12:

00AM
00AM
00AM
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bcp pubs2..publishers out pub out

The results as stored in the pub_out file are:

0736,New Age Books,Boston,MA
0877,Binnet & Hardley,Washington,DC
1389,Algodata Infosystems,Berkeley,CA

The contents of the pub_fmt format file are:

10.0

4

1 SYBCHAR 0 4 W, W 1 pub id

2 SYBCHAR O 40 ", " 2 pub name
3 SYBCHAR O 20 "," 3 city

4 SYBCHAR 0 2 "\n" 4 state

This example creates:

* Anoutput file with commas between all fields in a row and a newline terminator at the end
of each row

» Aformatfile (pub_fmt) that you can use later to copy the same or similar data back into
the SAP ASE server

Tab-delimited with Format File

This example creates tab-delimited output from the table pubs2. .publishers inthe
pub_out file:

bcp pubs2..publishers out pub out

The results as stored in the pub_out file are:

0736 New Age Books Boston MA
0877 Binnet & Hardley Washington DC
1389 Algodata Infosystems Berkeley CA

The contents of the pub_fmt format file are:

10.0

4

1 SYBCHAR 04 "\t" 1 pub id
2 SYBCHAR 040 "\t" 2 pub_ name
3 SYBCHAR 020 "\t" 3 city

4 SYBCHAR 02 "\n" 4 state
See also

e Format Files on page 199
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Examples of Copying In Data Interactively

To copy in data successfully to a table from a file, know what the terminators in the file are or
what the field lengths are and specify them when you use bcp.

The following examples show how to copy data in, either with fixed field lengths or with
delimiters, using bcp with or without a format file.

Copy In Data with Field Lengths
In this example, bcp copies data from the salesneuw file into the pubs2. . sales table.

Inthe salesnew file are three fields: the first is 4 characters long, the second is 20, and the
third is 26 characters long. Each row ends with a newline terminator (\n):

5023ZS-731-AAB-780-2B9 May 24 1993 12:00:00:000AM
5023XC-362-CFB-387-3%Z5 May 24 1993 12:00:00:000AM
6380837206 May 24 1993 12:00:00:000AM
6380838441 May 24 1993 12:00:00:000AM

Use the following command to copy in the data interactively from salesnew:

bcp pubs2..sales in salesnew

The system responds to the bcp command:

Password:

Enter the file storage type of field stor id [char]:

Enter prefix-length of field stor id ([0]:

Enter length of field stor id [4]:

Enter field terminator [none]:

Enter the file storage type of field ord num [char]:

Enter prefix-length of field ord num [1]: O

Enter length of field ord num [20]:

Enter field terminator [none]:

Enter the file storage type of field date [datetime]: char
Enter prefix-length of field date [1]: O

Enter length of field date [26]:

Enter field terminator [nonel: \n

Do you want to save this format information in a file? [Y/n] y
Host filename [bcp.fmt]: salesin_ fmt

Starting copy...

4 rows copied.

Clock Time (ms.): total = 1 Avg = 0 (116000.00 rows per sec.)

When you log in to the SAP ASE server and access sales, you see the following data from
salesnew appended to the table:

select * from sales

stor _id ord num date
5023 AB-123-DEF-425-173 Oct 31 1985 12:00AM
5023 AB-872-DEF-732-271 Nov 6 1985 12:00AM
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5023 AX-532-FED-452-277 Dec 1 1990 12:00AM
5023 BS-345-DSE-860-1F2 Dec 12 1986 12:00AM
5023 GH-542-NAD-713-9F9 Mar 15 1987 12:00AM
5023 NF-123-ADS-642-9G3 Jul 18 1987 12:00AM
5023 XS-135-DER-432-8J2 Mar 21 1991 12:00AM
5023 ZA-000-ASD-324-4D1 Jul 27 1988 12:00AM
5023 ZD-123-DFG-752-9G8 Mar 21 1991 12:00AM
5023 ZS-645-CAT-415-1B2 Mar 21 1991 12:00AM
5023 Z27Z-999-2727Z-999-0A0 Mar 21 1991 12:00AM
6380 234518 Sep 30 1987 12:00AM
6380 342157 Dec 13 1985 12:00AM
6380 356921 Feb 17 1991 12:00AM
7066 BA27618 Oct 12 1985 12:00AM
7066 BA52498 Oct 27 1987 12:00AM
7066 BA71224 Aug 5 1988 12:00AM
7067 NB-1.142 Jan 2 1987 12:00AM
7067 NB-3.142 Jun 13 1990 12:00AM
7131 Asoapl32 Nov 16 1986 12:00AM
7131 Asoap432 Dec 20 1990 12:00AM
7131 Fsoap867 Sep 8 1987 12:00AM
7896 124152 Aug 14 1986 12:00AM
7896 234518 Feb 14 1991 12:00AM
8042 12-F-9 Jul 13 1986 12:00AM
8042 13-E-7 May 23 1989 12:00AM
8042 13-J-9 Jan 13 1988 12:00AM
8042 55-v-7 Mar 20 1991 12:00AM
8042 91-A-7 Mar 20 1991 12:00AM
8042 91-v-7 Mar 20 1991 12:00AM

(34 rows affected)

Since there is a unique clustered index on the stor idand ord num columns of sales,
the new rows were sorted in order.

A conflict or violation can affect the copy process:

» Had there been any violations of the unique index on the columns in the data being copied
from the file, bcp would have discarded the entire batch in which the violating row was
encountered.

A batch size of 1 evaluates each row individually, but loads more slowly and creates a
separate data page for each row during a fast or fast-logged bcp session.

 If the types copied in are incompatible with the database types, the entire copy fails.

Copy In Data with Delimiters

In this example, bcp copies data from the file newpubs into the table
pubs2..publishers. Inthe newpubs file, each field in a row ends with a tab character
(\t) and each row ends with a newline terminator (\n):

1111 Stone Age Books Boston MA
2222 Harley & Davidson Washington DC
3333 Infodata Algosystems Berkeley CA

Since newpubs contains all character data, use the character command-line flag and specify
the terminators with command line options:
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* In UNIX platforms:

bcp pubs2..publishers in newpubs -c -t\\t -r\\n
e In Windows:

bcp pubs2..publishers in newpubs -c -t\t -r\n

Copy In Data with a Format File

To copy data back into the SAP ASE server using the saved pub fmt format file, run:
bcp pubs2..publishers in pub out -fpub fmt

Use the pub_ fmt file to copy any data with the same format into the SAP ASE server. If you
have a similar data file with different delimiters, change the delimiters in the format file.

Similarly, edit the format file to reflect any changes to the field lengths, as long as all fields
have the same length. For example, the moresales file contains:

804213-L-9 Jan 21 1993 12:00AM

804255-N-8 Mar 12 1993 12:00AM

804291-T-4 Mar 23 1993 12:00AM
804291-W-9 Mar 23 1993 12:00AM

Edit the sal fmt format file to read:

10.0

3

1 SYBCHAR 0 4 "™ 1 Stor_id
2 SYBCHAR O 7 "" 2 ord num
3 SYBCHAR 0 21 "\n" 3 date
Then enter:

e For UNIX platforms:
bcp pubs2..sales in moresales -fsal fmt
e For Windows:

bcp pubs2..sales in moresale -fsal fmt

The system responds:

Starting copy...

4 rows copied.

Clock Time (ms.): total = 1 Avg = 0 (116000.00 rows
per sec.)

bcp and Alternate Languages

The SAP ASE server stores data using its default character set, which is configured during
installation. If your terminal does not support that default character set, it may send confusing
characters to bcp when you respond to prompts either by typing or by using host file scripts.

Omitting all character-set options causes bcp to use the character set that was named as the
default for the platform. This default can cause communications problems:
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« The default is not necessarily the same character set that was configured for the SAP ASE
Server.
« The default may not necessarily be the character set that the client is using.

For more information about character sets and the associated flags, see Configuring Client/
Server Character Set Conversions in the System Administration Guide.

Support for Initialization Strings

The bep utility supports sending Transact-SQL commands, such as set replication off, to the
SAP ASE server before data is transferred.

Although you may use any Transact-SQL command as an initialization string for bcp, reset
possible permanent changes to the server configuration after running bcp. For example, reset
changes in a separate isql session.

bcp and Row-Level Access Rules

If the SAP ASE server is enabled for row-level access, and you bulk-copy-out data, bcp copies
out only the rows of data to which you have access. To copy out the entire table, first drop the
access rules, then bep out. Reinstate the access rules after you are done, if applicable.

If you bulk-copy-in data to a table that has access rules enabled, the SAP ASE server may issue
“uniqueness violation” errors. For example, if you load data from a bcp data file that was
generated before the access rules were created on the table, and the bcp data file contains rows
that were previously inserted into the table, you may receive this type of error.

If this happens, the table may look to the user like it does not include the rows that failed the
bcp insert because of the uniqueness violation, but the user does not have access to the
“missing” rows because of the access rules.

To copy in the entire table, drop the access rules, load the data, address any errors, then
reinstate the access rules.

Copy In and Batch Files

Batching applies only to bulk copying in; it has no effect when copying out. By default, the
SAP ASE server copies all the rows in batches of 1000 lines. To specify a different batch size,
use the command-line option (-b).

bcp copies each batch in a single transaction. If the SAP ASE server rejects any row in the
batch, the entire transaction is rolled back. By default, bcp copies all rows in a single batch;
use the -b parameter to change the default batch size. The SAP ASE server considers each
batch a single bcp operation, writes each batch to a separate data page, and continues to the
next batch, regardless of whether the previous transaction succeeded.
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When data is being copied in, it can be rejected by either the SAP ASE server or bcp.

The SAP ASE server treats each batch as a separate transaction. If the server rejects any
row in the batch, it rolls back the entire transaction.

When bcp rejects a batch, it then continues to the next batch. Only fatal errors roll back the
transaction.

The SAP ASE server generates error messages on a batch-by-batch basis, instead of row-
by-row, and rejects each batch in which it finds an error. Error messages appear on your
terminal and in the error file.

Improve Recoverability

Ensure better recoverability with these actions.

Break large input files into smaller units.

For example, if you use bep with a batch size of 100,000 rows to bulk copy in 300,000
rows, and a fatal error occurs after row 200,000, bcp would have successfully copied in the
first two batches—200,000 rows—to the SAP ASE server. If you had not used batching,
bcp would not have been able to copy in any rows to the SAP ASE server.

Set the trunc log on chkpt to true (on).

The log entry for the transaction is available for truncation after the batch completes. If you
copy into a database that has the trunc log on chkpt database option set on (true), the next
automatic checkpoint removes the log entries for completed batches. This log cleaning
breaks up large bep operations and keeps the log from filling.

Set -b batch_size to 10.

The batch size parameter set to 10 causes bcp to reject the batch of 10 rows, including the
defective row. The error log from this setting allows you to identify exactly which row
failed.

A batch size of 1 is the smallest that bcp processes.

Note: bep creates 1 data page per batch, and setting b batch_size to 10 creates data pages
with 10 rows on each page. If you set -b batch sizetol, the setting creates data
pages with 1 row on each page. This setting causes the data to load slowly and takes up
storage space.

Batches and Partitioned Tables

When you bulk copy data into a partitioned table without specifying a partition number, the
SAP ASE server randomly assigns each batch to an available partition. Copying rows in a
single batch places all those rows in a single partition, which can lead to load imbalance in the
partitioned table.

To help keep partitioned tables balanced, use a small batch size when bulk copying data or
specify the partition ID during the bcp session. For information about partitioning tables, see
the Performance and Tuning Guide.
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Copy Out and Text and Image Data

When you copy out text or image data, the SAP ASE server, by default, copies only the first
32K of data in a text or image field.

The -T text_or_image_size parameter allows you to specify a different value. For example, if
the text field to copy out contains up to 40K of data, use the following command to copy out
all 40K:

bcp pubs2..publishers out -T40960

Note: Ifa text or image field is larger than the given value or the default, bcp does not copy
out the remaining data.

Specify a Network Packet Size

To improve the performance of large bulk copy operations, you may want to use larger
network packet sizes than the defaults. The -A size option specifies the network packet size to
use for the bcp session that you are beginning.

The value of size must be:

» Between the values of the default network packet size and max network packet size
configuration parameters, and
e A multiple of 512.

Note: The new packet size remains in effect for the current bcp session only.

For example, this command specifies that the SAP ASE server send 40K of text or image
data using a packet size of 4096 bytes for the bcp session:
bcp pubs2..authors out -A 4096 -T40960

Copy In and Error Files

When you specify the -e error_file option with copy in, bep stores the rows that it cannot copy
in to Adaptive Server in the specified error file.
» The error file stores a line that:
 Indicates which row failed and the error that occurred, and
» Is an exact copy of the row in the host file.
« If the file name specified after —e already exists, bcp overwrites the existing file.
» If bcp does not encounter any errors, it does not create the file.

bcp in detects two types of errors:
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< Data conversion errors
 Errors in building the row — for example, attempts to insert a NULL into columns that do
not accept null values or to use invalid data formats, such as a 3-byte integer

The copy in process displays error messages on your monitor.

Thisexample loads the newpubs file into the pub1 i shers database, storing any error rows
in the pub_err file:

bcp pubs2..publishers in newpubs -epub err
When working with error files generated by copy in, note:

* bcp stores rows in an error file only when the bep program itself detects the error.

* bcp continues to copy rows until bcp encounters the maximum number of error rows, at
which point bcp stops the copy.

* bcp sends rows to the SAP ASE server in batches, so bcp cannot save copies of rows that
are rejected by the SAP ASE server, for example, a duplicate row for a table that has a
unique index.

« The SAP ASE server generates error messages on a batch-by-batch basis, instead of row-
by-row, and rejects the entire batch if it finds an error.

« Itis not considered an error for the SAP ASE server to reject duplicate rows if either
allow_dup_row or ignore_dup_key was set when a table’s index was created. The copy
proceeds normally, but the duplicate rows are neither stored in the table nor in the bcp error
file.

Copy Out and Error Files

During the copy out process, as with copy in, bcp overwrites any file of the same name and
does not create an error file if no errors occurred.

There are two situations that cause rows to be logged in the error file during a copy out:

* A data conversion error in one of the row’s columns
e An |/O error in writing to the host file

When working with error files generated by copy out, note that:

* bcp logs rows in the error file in the default character format.
« All datavalues print as characters with tabs between the columns and a newline terminator
at the end of each row.
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Data Integrity for Defaults, Rules, and Triggers

To ensure integrity, bcp handles data to copy depending upon its element.

Element Description
Type
Defaults When copying data into a table, bcp observes any defaults defined for the columns and
and data- | datatypes. That s, if there is a null field in the data in a file, bcp loads the default value
types instead of the null value during the copy.
For example, here are two rows in a file to be loaded into authors:
409-56-7008,Bennet, David, 415 658-9932,622 Pine
St.,Berkeley,CA,USA,94705213-46-8915,Green,Marjorie,, 309
63rd St.
#411,0akland,CA,USA, 94618
Commas separate the fields; a newline terminator separates the rows. There is no phone
number for Marjorie Green. Because the phone columnofthe authors tablehasa
default of “unknown,” the rows in the loaded table look like this:
409-56-7008 Bennet David 415 658-9932 622 Pine St.
Berkeley CA USA 94705
213-46-8915 Green Marjorie unknown 309 63rd St.
#411
Oakland CA USA 94618
Rulesand | bcp, to enable its maximum speed for loading data, does not fire rules and triggers.
triggers To find any rows that violate rules and triggers, copy the data into the table and run
queries or stored procedures that test the rule or trigger conditions.

How bcp Differs from Other Utilities

The bep utility, which copies entire tables or portions of a single table, is distinct from the
other utilities that move data from one place to another.

The following list names these other utilities and their commands, and describes how best to
use them to move data.
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Commands

Usage

dump database, load
database, dump
transaction, and load
transaction

Use the SQL commands dump database, load database, dump transaction,
and load transaction for backup purposes only. Unlike bcp, the dump com-
mands create a physical image of the entire database.

Use load database or load transaction to read data backed up with dump
database or dump transaction.

For information on using the SQL dump and load commands, see the System
Administration Guide and the Reference Manual.

insert, update, and
delete

Use the data modification commands insert, update, and delete, respective-
ly, to add new rows to, change existing rows in, or remove rows from a table
or view.

¢ Use the insert command with a select statement to move data between
tables.

» Use the select statement with an into clause to create a new table, based
on:

» the columns named in the select statement,
» the tables named in the from clause, and
» data in the rows named in the where clause.

For details on adding, changing, and deleting data, see insert, update,
and delete in the Reference Manual.

Utility Guide

213



CHAPTER 3: Using bcp to Transfer Data to and from SAP ASE

214 Adaptive Server Enterprise



CHAPTER 4 Using dataserver Build Servers

dataserver is the executable form of the SAP ASE program.

SAP ASE does not use the buildmaster binary to build the master device. Instead, Sybase has
incorporated the buildmaster functionality in the dataserver binary. This chapter discusses
how to use dataserver to build your server.

Note: The dataserver binary in Windows is called sqlsrvr.exe. If you are using the Windows
platform, substitute all reference to dataserver in this chapter with sqlsrvr.

The dataserver command allows you to create master devices and databases with logical
pages of size 2K, 4K, 8K, or 16K. Larger logical pages allow you to create larger rows, which
can improve your performance because the SAP ASE server accesses more data each time it
reads a page. For example, a 16K page can hold eight times the amount of data as a 2K page, an
8K page holds four times as much data as a 2K page, and so on, for all the sizes for logical
pages.

The logical page size is a server-wide setting; you cannot have databases with varying size
logical pages within the same server. All tables are appropriately sized so that the row size
does not exceed the current page size of the server. That is, rows cannot span multiple pages.

See also
e dataserveron page 35
* sglsrvron page 127

Building a New Master Device

You can create a new master device using the dataserver utility.

The master device is built using the build mode in dataserver. After the master device is built,
the server shuts down. You must then manually start the server in the start mode. After this
you can start, stop, and restart the SAP ASE server whenever necessary without having to
rebuild the master device

Note: When you are building a master device you should allow an additional 8K for the config
block.

The SAP ASE server uses:

» Logical page size — these are the pages that the database objects are built with. A databases
and any of its related objects must use the same logical page size. Logical page sizes come
in sizes of 2K, 4K, 8K, and 16K.
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* Virtual page size — this is the physical page allocation at the disk level, and is always done
in 2K pages. All disk 1/0 is done in multiples of virtual page size.

« Memory page size —the memory allocated and managed within the SAP ASE server. The
memory page size is always in units of 2K pages.

To create a new master device with dataserver, use:
dataserver -ddevice name
b [master device size [k|K|m|M|g|G]
[_

z logical page size [k|K]
-h

where:

-d device_name — is the full path name of the device for the master database. The master
database device must be writable by the user who starts the SAP ASE server. The default
master database device name is d_master.

-b — indicates that dataserver is in build mode and creating a new master device, and indicates
the size of the master device. If you do not provide a unit specifier (k, m, g) for the size of the
device, dataserver assumes a size in virtual pages. The size of a virtual page is always 2K. For
example:

* -b 51204 -specifies a device of 51,204 virtual pages (100.0078125MB).
e -b 100M - specifies a device of 100MB

-z — specifies the logical page size, which is always 2K, 4K, 8K, or 16K. This parameter is
optional during the build phase and is ignored during the start mode. If you do not include the
-z parameter during the build mode, the master device is built with 2K logical pages.

-h — prints the syntax for the dataserver command.

See also
 gataserveron page 35

Environments When Using dataserver

When you start an SAP ASE server with dataserver, it derives its running environment from
these places.

e The configuration file you specify in -c configuration_file
» The default configuration file, servername.cfy, if you did not specify the -c parameter
« Default values if you did not specify either -c configuration_file or servername.cfy

See Setting Configuration Parameters in the System Administration Guide.
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Specifying Device and Logical Page Sizes When Building a New SAP
ASE Server
Create a new SAP ASE server by issuing dataserver using the -b and -z options.

For example, to:

« Build a100MB master device using the default logical page size (2K) and start the server:
dataserver -d /var/sybase/masterdb.dat -b100M -sMASTER2K

» Build a 100MB master device with a logical page size of size 4K:
dataserver -d /var/sybase/masterdb.dat -b100M -z4K -sMASTER4K

» Build a master device of 102,400 virtual pages of size 2K, create databases using a logical
page size of 8K, and boot the server:
dataserver -d /var/sybase/masterdb.dat -b102400 -z8K -sMASTER8K

If the total requested space (102,400 x 2K = 200 MB) is insufficient to build all the required
system databases using the specified logical page size, then an error message is reported, and
the process fails.

Example

The following is a sample output of dataserver building a 200MB device with a 2K logical
page size, called personnel2k:

dataserver -d /var/sybase/personnel2k.dat -b200M -z2k -sPERSONNEL2K

dataserver uses a default configuration file if you do not specify one:

00:00000:00000:2001/04/16 10:24:31.73 kernel Warning: Using default
file

'/var/sybase/PERSONNEL2K.cfg' since a configuration file was not
specified.

Specify a configuration file name in the RUNSERVER file to avoid
this

message.

To specify your own configuration file, use the dataserver —c parameter. See Chapter 11,
“Setting Configuration Parameters” in the System Administration Guide for more
information.

SAP ASE treats all installations as an upgrade, regardless of whether you have an existing
version of SAP ASE or not. For this reason, you see the following output when running
dataserver:

00:00000:00001:2001/04/16 10:24:32.63 server Database 'master'
appears to

be at an older revision than the present installation; SQL Server
will assess

it, and upgrade it as required.

00:00000:00001:2001/04/16 10:24:32.66 server Database 'master':
beginning
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upgrade step [ID 1]: Initialize disk and create empty allocation
units
on master device.

00:00000:00001:2001/04/16 10:24:34.74 server Database 'master':
beginning

upgrade step [ID 2]: Bootstrap basic system catalogs in
database.

dataserver continues creating the master database, including all of its tables such as
systypes, sysobjects and sysusages:

00:00000:00001:2001/04/16 10:24:35.21 server Database 'master':
beginning upgrade step [ID 3]: creating index (table systypes,
index ncsystypes)

00:00000:00001:2001/04/16 10:24:35.36 server Database 'master':
beginning

upgrade step [ID 4]: creating index (table sysobjects, index
ncsysobjects)

00:00000:00001:2001/04/16 10:24:35.44 server Database 'master':
beginning
upgrade step [ID 20]: creating table (table sysusages)

[...]
When dataserver has created the master database, it creates the model database:
[...]

00:00000:00001:2001/04/16 10:24:43.14 server Database 'model'
appears to

be at an older revision than the present installation; SQL Server
will assess

it, and upgrade it as required.

00:00000:00001:2001/04/16 10:24:43.14 server Database 'model':
beginning

upgrade step [ID 1]: Initialize disk and create empty allocation
units

on master device.

00:00000:00001:2001/04/16 10:24:43.83 server Database 'model':
beginning
upgrade step [ID 2]: Bootstrap basic system catalogs in database.

00:00000:00001:2001/04/16 10:24:43.89 server Database 'model':
beginning

upgrade step [ID 3]: creating index (table systypes, index
ncsystypes)

00:00000:00001:2001/04/16 10:24:43.91 server Database 'model':
beginning

upgrade step [ID 4]: creating index (table sysobjects, index
ncsysobjects)
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[oool

When dataserver has created the mode1 database, it creates the tempdb and
sybsystemdb databases:

[oool

00:00000:00001:2001/04/16 10:24:45.23 server CREATE DATABASE:
allocating
1024 logical pages (2.0 megabytes) on disk 'master'.

00:00000:00001:2001/04/16 10:24:46.79 server Database sybsystemdb
successfully created.

[...]
dataserver is successful when the server changes the default sort order and shuts down:
[...]

00:00000:00001:2001/04/16 10:24:47.23 server Now loading SQL
Server's new
default sort order and character set

[...]
00:00000:00001:2001/04/16 10:24:47.31 server Default Sort Order
successfully changed.

00:00000:00001:2001/04/16 10:24:47.37 server SQL Server shutdown
after
verifying System Indexes.

00:00000:00001:2001/04/16 10:24:47.37 kernel ueshutdown: exiting

Error Messages

If dataserver is unsuccessful, you cannot start the server on that master device, and you see the
following error message:

00:00000:00001:2001/04/16 19:02:39.53 kernel Use license file
/var/sybase/SYSAM-1 0/licenses/license.dat.

00:00000:00001:2001/04/16 19:02:39.54 kernel The master device's
configuration area appears to be corrupt. The server needs this data
to boot,

and so cannot continue. The server will shut down.

If you run dataserver with a user-specified configuration file that includes options that make it
impossible to allocate a shared segment and start up a server, dataserver fails with an error
message, and you cannot boot the server on that master device:

00:00000:00001:2001/04/16 19:04:01.11 kernel Use license file
/var/sybase/SYSAM-1 0/licenses/license.dat.
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00:00000:00000:2001/02/09 19:04:01.25 kernel Using config area from
primary
master device.

00:00000:00001:2001/04/16 19:04:01.36 server The value of the 'max
total memory' parameter (33792) defined in the configuration file is

not high

enough to set the other parameter values specified in the
configuration file.

'max total memory' should be greater than the logical memory '34343'.

Starting an Existing a SAP ASE Server
To start an existing SAP ASE server, issue dataserver without the -b and -z options:

dataserver -d /sybase/masterdb.dat

Upgrading to a Server With Larger Page Sizes
SAP ASE earlier than version 12.5 used 2K logical page sizes. You cannot change an
installation’s page size by upgrading. That is, if your current SAP ASE uses 2K logical pages,
you can upgrade only to an SAP ASE server that uses 2K logical pages.

However, you can migrate databases with 2K logical pages from earlier versions of SAP ASE.

See also
e Chapter 10, Using sybmigrate to Migrate Data on page 305

Viewing the Current Server Limits
To display information about the SAP ASE server’s limits:

« Run dbcc serverlimits, which includes the size of your server’s logical page size in its
output. For example, enter:
dbcc serverlimits

« Search for the string “logical page size” in the error log.

* Runselectusing the @@maxpagesize global variable, which displays the server’s logical
page size:

select @@maxpage size
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dscp is a utility program that you use to view and edit server entries in the interfaces file.

Note: dscp is not available for Windows.

e To start dscp, enter:
$SYBASE/$SYBASE OCS/bin/dscp

The dscp prompt, >>, appears.
» To view the dscp help screen, enter one of the following commands:
help

h

?

See also
e dscpon page 69

Starting dscp

If you plan to add or modify entries, you must log in to the directory services, with the
necessary privileges, before you start dscp.

To start dscp, enter:
$SYBASE/$SYBASE OCS/bin/dscp

The dscp prompt, >>, appears. The commands you can use are:

Command Description

open [DSNAME] Opens a session with the specified directory service or interfaces.

dscp — to open a session with interfaces, specify “InterfacesDriver” as

DSNAME.
Sess Lists all open sessions.
[switch] SESS Makes session number SESS the current session.
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Command Description

close [SESS] Closes a session identified by the SESSnumber. If you do not specify SESS,
closes the current session.

list [all] Lists the server entries for the current session.
To list the names of the entries, use the list command. To list the attributes for
each entry, use the list all command.

read SERVER- Prints the contents of server entry SERVERNAME to the screen.

NAME

add SERVERNAME

Adds server entry SERVERNAME in the current session.

dscp prompts you for information about SERVERNAME. Press Return to
accept the default value, which is shown in brackets [ ].

adtr SERVER- Adds an attribute to the server entry SERVERNAME in the current session.
NAME

mod SERVER- Modifies server entry SERVERNAME in the current session.

NAME

dscp prompts you for information about SERVERNAME. Press Return to
accept the default value, which is shown in brackets [ ].

del SERVERNAME

Deletes server entry SERVERNAME in the current session.

delete-all

Deletes all server entries in the current session.

copy NAME1 to
{NAME2 | SESS|
SESSNAME2}

Copies server entry MAMED in the current session to:

< Server entry NAME2 in the current session
e Session SESS
« Server entry NAME2 in session SESS

copyall to SESS

Copies all server entries in the current session to session SESS.

config Prints configuration information related to your Sybase environment to the
screen.

exit, quit Exits dscp.

help, ?, h Displays the help screen.
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Working with Server Entries
Use dscp to add or modify server entries.

Note: When you add or modify a server entry, dscp automatically creates or modifies both
master and query lines. The master line and the query line of an interfaces file entry contain
identical information.

After you open a session, you can add or modify server entries associated with that session.

Each server entry is made up of a set of attributes. When you add or modify a server entry, dscp
prompts you for information about each attribute.

Table 11. Server attributes

Attributes | Type of value | Default value and valid | Can be edited when
values adding or modifying a
server entry

Adding Modifying

Server Object | Integer 110 No No
\ersion

Server Name | Character string | N/A N/A No
Server Service | Character string | SQL SERVER Yes No
Server Status | Integer 4 No No

Valid values are:

1. Active
2. Stopped
3. Failed

4. Unknown

Transport Character string | tcp. Valid valuesare: decnet, spx, | Yes Yes
Type tep, tli, spx, tli tcp

Note: SAP ASE does not sup-
portthe TLI interface in threaded

mode.
Transport Ad- | Character string | None. Valid values are character | Yes Yes
dress strings recognized by the speci-

fied transport type
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Attributes | Type of value | Default value and valid | Can be edited when
values adding or modifying a
server entry

Adding Modifying

Security Character string | None Yes Yes

Mechanism —— . .
Note: You can Valid values are character strings

add up to 20 se- | associated with object identifiers
curity mecha- defined in the user’s objec-
nism strings for | tid.dat.

each server entry

See also

* Adding a Server Entry on page 224

»  Modifying or Deleting a Server Entry on page 225
»  EXiting dscp on page 228

Adding and Modifying Server Entries
After you open a session, you can add or modify server entries associated with that session.

Adding a Server Entry
After you open a session, you can add server entries associated with that session.

1. Enter:

add servername

You are now in add mode. You can continue to add server entries, but you cannot execute
any other dscp commands until you exit this mode. While in add mode, dscp prompts you
for information about servername.

2. Either:

» Enter a value for each attribute, or

e Press Return to accept the default value, which is shown in brackets [ ]
For example, dscp prompts for this information when you enter:

add myserver

Service: [SQL Server]

Transport Type: [tcp] tcp

Transport Address: victory 8001

Security Mechanism []:

A server entry can have up to 20 transport type/address combinations associated with it.
3. When you are done adding a server enter, exit add mode:
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#done

See also

«  Working with Server Entries on page 223

e Copy Server Entries on page 226

» Lijst and Viiew Contents of Server Entries on page 227
» Delete Server Entries on page 227

Modifying or Deleting a Server Entry
After you open a session, you can modify or delete server entries associated with that session.

You cannot use dscp to modify the Version, Service, and Status entriesinthe interfaces
file.

1. Enter:

mod servername

You are now in modify mode. You can continue to modify server entries, but you cannot
execute any other dscp commands until you exit this mode. In modify mode, dscp
prompts you for information about servername.

2. Either:

« Enter a value for each attribute, or
* Press Return to accept the default value, which is shown in brackets [ ]

For example, dscp prompts for the following information when you enter:
mod myserver

Version: [1]

Service: [SQL Server] Open Server

Status: [4]

Address:

Transport Type: [tcp]

Transport Address: [victory 1824] victory 1826
Transport Type: [tcp]

Transport Address: [victory 1828]

Transport Type: []

Security Mechanism []:

a) To delete an address:

#del
3. When you are done modifying a server enter, exit modify mode:

#done

See also
o Working with Server Entries on page 223
e Copy Server Entries on page 226
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» List and Viiew Contents of Server Entries on page 227
e Delete Server Entries on page 227

Copy Server Entries

dscp allows you to copy server entries within a session and between two sessions.

When you are copying a server entry, you can:

Options

Descriptions

Create server entry to a
new name in the current
session

A server entry to a new name in the current session by entering:

copy namel to name2

For example, dscp creates a new entry, “my_server,” that is identical to
“myserver” when you enter:

copy myserver to my server

You can then modify the new entry and leave the original intact.

Copy aserver entry with-
out changing the name

Copy a server entry without changing the name. Enter:

copy namel to sess

For example, dscp copies the “myserver” entry in the current session to
session 2 when you enter:

copy myserver to 2

Copy a server entry and
rename it.

Enter:

copy namel to sess namel

For example, dscp copies the “myserver” entry in the current session to
session 2 and renames it “my_server” when you enter:

copy myserver to 2 my server

Copy all entries in the
current session to a dif-
ferent session.

Enter:

copyall sess

For example, dscp copies all entries in the current session to session 2
when you enter:

copyall 2

See also

* Adding a Server Entry on page 224
»  Modifying or Deleting a Server Entry on page 225
»  Exiting dscp on page 228
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List and View Contents of Server Entries
You can list names and attributes associated with a session.

Option Description
List names of server entries Enter:

list
List the attributes of server entries Enter:

list all
View the contents of a server entry Enter:

read servername

For example:

read myserver

DIT base for object: interfaces
Distinguish name: myserver
Server Version: 1

Server Name: myserver

Server Service: SQL Server
Server Status: 4 (Unknown)
Server Address:

Transport Type: tcp
Transport Addr: victory 1824
Transport Type: tcp
Transport Addr: victory 1828

See also

* Adding a Server Entry on page 224

»  Modifying or Deleting a Server Entry on page 225
e EXiting dscp on page 228

Delete Server Entries
You can delete one entry or all entries associated with a session.

Option Description

Delete entries associated with a session | gnter:

del servername

For example, dscp deletes the entry for “myserver” when
you enter:

del myserver
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Option Description

Delete all entries associated with a session | gnter:
delete-all

See also

» Adding a Server Entry on page 224

»  Modifying or Deleting a Server Entry on page 225
e EXiting dscp on page 228

Exiting dscp

Enter this command to exit dscp.
To exit dscp, enter either of the following:

° exit
e quit
See also

»  Working with Server Entries on page 223

e Copy Server Entries on page 226

e Listand View Contents of Server Entries on page 227
» Delete Server Entries on page 227
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Server Entries

dsedit is a graphical utility that lets you view and edit server entries in the interfaces file
(sgl.ini in Windows).

Note: (UNIX) If your system does not have X-Windows, use dscp to configure server entries
in the interfaces file.

See also
e Chapter 5, Using dscp to View and Edit Server Entries on page 221
* dsediton page 71

Add, View, and Edit Server Entries

Once you are in an open session, you can add, modify, rename, and delete server entries
associated with that session, as well as copy server entries within a session and between
sessions.

Each server entry is made up of a set of attributes.

Table 12. Server attributes

Attribute | Type of Description De-

name value fault
value

Server Ver- | Integer Version level of the server object definition. Sybase pro- | 150

sion vides this attribute to identify future changes to the object

definition.

Server Character Server name. N/A

Name string

Server Serv- | Character A description of the service provided by the server. This | The

ice string value can be any meaningful description. SAP
ASE
server
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Attribute | Type of Description De-
name value fault
value

Server Sta- | Integer The operating status of the server. Values are: 4
tus

e Active

e Stopped

e Failed

¢ Unknown

Security Character Object identifier strings (OID) that specify the security N/A
Mechanism | string mechanisms supported by the server. This attribute is op-
tional. If it is omitted, Open Server allows clients to connect
with any security mechanism for which Open Server has a
corresponding security driver.

Server Ad- | Character One or more addresses for the server. N/A

dress string The format of the address varies by protocol, and some

protocols allow more than one format. The options are:

¢ TCP/IP - two formats:
e computer name,port number
e [p-address,portnumber
* Named Pipe — pipe name: “\pipe” is a required prefix to
all pipe names. Server pipes can be only local.
* Local -\pipe\sgl\query
* Remote—\\computer name\pipe
\sgl\query
e IPX/SPX - three formats:
e server name
e net number, node number, socket number
e server name, socket number
« DECnet - four formats:
e area number.node number,object name
e area number.node number,object number
e node name,object name
e node name,object number

Using dsedit in UNIX

The dsedit utility allows you to view and edit server entries in the interfaces file using a GUI.

The server entries associated with the session appear in the Server box. Click a server entry to
select it.
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Note: If your system does not have X-Windows, use dscp to configure server entries in the
interfaces file.

See also

o Starting dsedit in UNIX on page 231

»  Open an Editing Session in UN/X on page 231

* Adding a New Server Entry in UNIX on page 232

o Viewing or Modifying a Server Entry in UN/X on page 232

e Copying a Server Entry to Another Interfaces File in UNIX on page 233
e Copying Server Entries Within the Current Session on page 234

« Copying Server Entries Between Sessions on page 234

Starting dsedit in UNIX
Before starting dsedit, verify that you have write permission on the interfaces file.

Prerequisites

If you are running dsedit from a remote machine, verify that the DISPLAY environment
variable is set so the dsedit screens display on your machine instead of on the remote machine
by logging in to the remote machine and entering:

setenv DISPLAY your machine name:0.0

Task
Enter:

SSYBASE/bin/dsedit
The Select a Directory Service window appears, letting you open editing sessions for the

interfaces file. The full path name of the default interfaces file is shown in the Interfaces File to
Edit box, and the full path name of the configuration file is shown below it.

See also
e Using dsedit in UNIX on page 230

Open an Editing Session in UNIX
You can edit both the default interfaces file as well as other interfaces files to edit.

1. In dsedit, select Sybase Interfaces File.
2. To open:

* The default interfaces file for editing, click OK.
« Afile other than the default interfaces file, edit the displayed file name, then click
OK.
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The Directory Service Session window appears.

See also
e Using dsedit in UNIX on page 230

Modify Server Entries in UNIX

The server entries associated with the session appear in the Server box. Click a server entry to
select it.

Click Close Session to apply your edits to the interfaces file. Clicking this button also closes
the interfaces session window.

See also
» Open an Editing Session in Windows on page 236

Adding a New Server Entry in UNIX
Use dsedit to add a server entry.

1. Click Add new server entry.
2. Specify the name and network addresses for a new server entry.

See also
e Using dsedit in UNIX on page 230

Viewing or Modifying a Server Entry in UNIX
Use dsedit to modify a server entry.

1. Click Modify server entry.
2. Modify the attributes.

See also
e Using dsedit in UNIX on page 230

Add or Edit Network Transport Addresses
You can view, edit, or create the transport addresses at which a server accepts client
connections in the Network Transport Editor window.

This window displays the name of the server entry for the address and allows you to configure:

« Transport type — specifies the protocol and interface for the address.

e Address information — different address components are required depending on the
transport type.
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TCP/IP_Addresses

The address information for a TCP/IP entry consists of a host name (or IP address) and a port
number (entered as a decimal number). For tli tcp-formatted interfaces entries, the host’s IP
address and the port number are converted to the 16-byte hexadecimal representation required
for tli tcp-formatted interfaces entries.

Note: Adaptive Server does not support the TLI interface in threaded mode.

In interfaces entries, use tli tcp for:

e All pre-10.0 clients on platforms that use tli-formatted interfaces entries

» Adaptive Server or Replication Server version 11.0.x or earlier on platforms that use tli-
formatted interfaces entries

Use tcp for other clients and servers.
To indicate a TCP/IP address, choose tcp or tli tcp from the Transport Type menu.
SPX/IPX Addresses

SPX/IPX addresses allow Adaptive Server to listen for connections from client applications
running on a Novell network.

To indicate an SPX/IPX address, choose tli spx or spx from the Transport Type menu.

Address Description
Information

Host address An eight digit hexadecimal value representing the IP address of the computer on
which the server runs. Each component of the dot-separated decimal IP address
format maps to one byte in the hex address format. For example, if your host’s IP
address is 128.15.15.14, enter “800FOFOE” as the SPX/IPX host address value.

Port number The port number, expressed as a four-digit hexadecimal number.

Endpoint The path for the device file that points to the SPX device driver. Defaults to /
dev/mspx on Solaris and /dev/nspx on any other platform. If necessary,
adjust the path so that it is correct for the machine on which the server runs. The
default path is based on the platform on which you are running dsedit.

Copying a Server Entry to Another Interfaces File in UNIX
Use dsedit to copy a server entry into another interfaces file.

1. Select the entries to copy.
» Click once to copy a single entry.

« Copy a range of consecutive entries by clicking the first entry in the range, then
pressing and holding Shift key, and clicking the last entry in the range.
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2.
3.
4,

» Select multiple, nonconsecutive entries by pressing and holding down the Ctrl key
while you click each entry.

Click Copy server entry.
Select the Sybase interfaces file from the list.
Edit the file name, then click OK.

See also

Using dsedit in UNIX on page 230

Copying Server Entries Within the Current Session

Use dsedit to copy server entries within the curent session.

1
2.
3.

Select one or more servers to copy. To select multiple entries, use the Shift key.
Click Copy from below the menu bar, or choose Edit > Copy.

Click Paste from below the menu bar, or choose Edit > Paste. dsedit appends the copied
server entries with a version number of _ 7. To rename copied server entries, select Server
Object > Rename.

See also

Using dsedit in UNIX on page 230
Renaming a Server Entry on page 238

Copying Server Entries Between Sessions

Use dsedit to copy server entries between sessions.

1

4,
5.

Open a session with the directory service or sql.ini file you want the entries copied
to.

To open a session, choose File > Open Directory Service.

Select one or more servers to copy. To select multiple entries, use the Shift key.

Click Copy from below the menu bar, or choose Edit > Copy.

To cut the server entries, click Cut below the menu bar, or choose Edit > Cut.
Activate the session where you want to paste the server entries.
Click Paste below the menu bar, or choose Edit > Paste.

You can rename the copied server entries using Server Object > Rename.

See also

Using dsedit in UNIX on page 230
Switching Between Sessions in Windows on page 237
Opening Additional Sessions in Windows on page 237
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Renaming a Server Entry on page 238

Using dsedit in Windows

The dsedit utility allows you to view and edit server entries in the interfaces file using a GUI.
In Windows, dsedit creates and modifies network connection information in the interfaces

f

ile.

The server entries associated with the session appear in the Server box. Click a server entry to
select it.

See also
Opening a Session in Windows on page 236

Opening Additional Sessions in Windows on page 237

Switching Between Sessions in Windows on page 237

Adding a Server Entry on page 237

Modifying a Server Attribute on page 238

Renaming a Server Entry on page 238

Deleting a Server Entry on page 238

Copying Server Entries Within the Current Session in Windows on page 239
Copying Server Entries Between Sessions in Windows on page 239

Starting dsedit in Windows

Start dsedit from the command prompt, the Windows Explorer, or the Sybase for Windows

program group.

Method Description
Command Enter:
prompt dsedit

Specify these command-line arguments:

« -ddsname - specifies which directory service to connect to. dsnameis the
local name of the directory service, as listed inthe 1ibtcl . cfgfile. If you
do not specify —ddsname, dsedit presents a list of directory service options in
the first dialog box.

* —lpath-specifies the path to the Libtcl.cfyg file, if other than SYB-
ASE home\INI. Use thisonly if youwanttousea 1ibtcl.cfq file
other than the one located in SYBASE home\ INI.

Windows Ex- | Double-click DSEDIT.exe inthe $SYBASE%\bin\ directory.
plorer
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Method Description
Windows Choose Start > Sybase for Windows > dsedit.
Start menu

See also

» Opening a Session in Windows on page 236

»  Opening Additional Sessions in Windows on page 237

»  Switching Between Sessions in Windows on page 237

» Adding a Server Entry on page 237

»  Modifying a Server Attribute on page 238

e Renaming a Server Entry on page 238

» Deleting a Server Entry on page 238

e Copying Server Entries Within the Current Session in Windows on page 239
e Copying Server Entries Between Sessions in Windows on page 239

Open an Editing Session in Windows

The Select Directory Service dialog box allows you to open a session with a directory service.
Open a session with:

* Any directory service that has a driver listed inthe Libtcl.cfqg file

e The sqgl.ini file

Opening a Session in Windows
There are two methods to open a session in Windows.
Choose a method:

« Double-click the local name of the directory service you want to connect to, as listed in the
DS Name box

 Click the local name of the directory service you want to connect to, as listed in the DS
Name box, and click OK.
dsedit uses the SYBASE environment variable to locate the 1ibtcl.cfg file. If the
SYBASE environment variable is not set correctly, dsedit cannot locate the
libtcl.cfqgfile.

The session number and local name of the directory service appear in the header bar.
See also

e Using dsedit in Windows on page 235
» Starting dsedit in Windows on page 235
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Opening Additional Sessions in Windows
dsedit allows you to have multiple sessions open at one time.

1. Select File> Open Directory Service.

2. Double-click the local name of the directory service to which to connect. Alternatively,
select the directory service and click OK.

Opening multiple sessions allows you to copy entries between directory services.

See also
e Using dsedit in Windows on page 235
 Starting dsedit in Windows on page 235

Switching Between Sessions in Windows

If you have multiple sessions open simultaeously, you must activate a session before you can
work in it.

Perform either:

 Clicking in the session window
» Choosing the session from the Windows menu

The dsedit title bar shows which session is active.

See also
e Using dsedit in Windows on page 235
o Slarting dsedit in Windows on page 235

Modify Server Entries in Windows

The server entries associated with the session appear in the Server box. Click a server entry to
select it.

Adding a Server Entry
Use dsedit to add a server entry.

1. Choose Server Object > Add.
2. Either:

¢ (UNIX) Specify the name and network addresses for a new server entry.
* (Windows) Enter a server name, then click OK.

The server entry appears in the Server box. To specify an address for the server, you must
modify the entry.
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See also
e Using dsedit in Windows on page 235
o Starting dsedit in Windows on page 235

Modifying a Server Attribute
Use dsedit to modify a server entry.

Modify any attribute of a server entry.

1. Select a server.

2. (Windows) Choose Server Object > Modify Attribute.

{UNIX) Click Modify server entry.

3. Select the attribute to modify. A dialog box appears that shows the current value of the

attribute.

4. Enter or select the new attribute value, then click OK.

See also
e Using dsedit in Windows on page 235
o Slarting dsedit in Windows on page 235

Renaming a Server Entry

Use dsedit to rename a server entry.

1. Select a server.
2. Choose Server Object > Rename.

3. Enter a new server name, then click OK.

See also
e Using dsedit in Windows on page 235
» Starting dsedit in Windows on page 235

Deleting a Server Entry

Use dsedit to delete a server entry.

1. Select a server.
2. Choose Server Object > Delete.

See also
e Using dsedit in Windows on page 235
» Starting dsedit in Windows on page 235
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Copying Server Entries Within the Current Session in Windows

Use dsedit to copy server entries within the current session.

1. Click one or more server entries in the Server box. Use the Shift key to select multiple
entries.

2. Click Copy below the menu bar, or choose Edit > Copy.

3. Click Pastebelow the menu bar, or choose Edit > Paste. dsedit appends the copied server
entries with a version number of 7. You can rename the copied server entries using Server
Object > Rename.

See also

Renaming a Server Entry on page 238
Using dsedit in Windows on page 235
Starting dsedit in Windows on page 235

Copying Server Entries Between Sessions in Windows

Use dsedit to copy server entries between sessions.

1

5.
6.

Open asession with the directory service or sql . ini file that you want the entries copied
to.

To open a session, choose File > Open Directory Service.

Click one or more server entries in the Server box of the session that you want the entries
copied from. Use the Shift key to select multiple entries.

To copy the server entries, click Copy below the menu bar, or choose Edit > Copy.

To cut the server entries, click Cut below the menu bar, or choose Edit > Cut.
Activate the session where you want to paste the server entries.
Click Paste below the menu bar, or choose Edit > Paste.

You can rename the copied server entries using the Rename command in the Server Object
menu.

See also

Opening Additional Sessions in Windows on page 237
Renaming a Server Entry on page 238

Using dsedit in Windows on page 235

Starting dsedit in Windows on page 235
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Troubleshooting dsedit

Identify and correct common dsedit problems.

Problem Solution

The dsedit utility does | Check for the following:

not start . . . .
e The SYBASE environment variable is not set or points to the wrong

directory.

*  (UNIX platforms) X-Windows is not configured correctly. If you are
running dsedit on a remote host, make sure that X-Windows clients on
the remote host can connect to the X-Windows server on your own
machine. See your X-Windows documentation for more troubleshoot-
ing information. If X-Windows is not available, use dscp instead of
dsedit.

Error message: “Unable | (UNIX platforms) dsedit might not work if the display machine is set up to
to open X display” reject X-Windows connections from remote hosts. If this is the problem,
you see a message similar to the following:

Unable to open X display. Check the value of your
SDISPLAY variable. If it is set correctly, use

the

'xhost +' command on the display machine to au-
thorize

use of the X display. If no X display is availa-
ble, run

dscp instead of dsedit.
This error may be caused by either of the following situations:

* The value for the DISPLAY environment variable is not entered cor-
rectly or is not set.

Solution : Enter the DISPLAY environment variable correctly.

* You are not authorized to open windows on the machine to which
DISPLAY refers.

Solution : Run the command ‘xhost +* on the display machine.

Cannot add, modify, or | Check for permissions problems with the interfaces file. To edit interfaces
delete server entries entries, you must have write permission on both the interfaces file and the
Sybase installation directory.
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isgl is a command line interactive SQL parser to the SAP ASE server.

If youare running Open Client version 11.1 or later and are using an external SAP ASE-related
configuration file, add the following in your configuration file to enable isql:
[isqgl]

See also
e jsgl/on page 78

Starting isql

Perform these steps to start isql.

1. Enter this command at the operating-system prompt:
isqgl
2. When the prompt appears, enter your password.

The password does not appear on the screen as you type. The isgl prompt appears:
1>

You can now issue Transact-SQL commands.

Stopping isql

To stop isql, enter one of these commands on a line by itself.
Enter:

quit
exit

Using Transact-SQL in isql

isgl sends Transact-SQL commands to the SAP ASE server, formatting the results and
printing them to standard output.

There is no maximum size for an isql statement. For more information about using Transact-
SQL, see the Transact-SQL User’s Guide.
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Note: To use Transact-SQL directly from the operating system with the isql utility program,
you must have an account, or login, on the SAP ASE server.

To execute a Transact-SQL command, type the default command terminator “go” on a new
line.

For example:

isqgl
Password:

1> use pubs2

2> go

1> select *

2> from authors

3> where city = "Oakland"
4> go

Formatting isql Output

The width for isgl output is adjusted according to the character-set expansion or the character
width, and displays a output column of the maximum possible bytes.

For example, for the UTF8 character set, each character may use at most 4 bytes, so the output
column width is the character number multiplied by 4. However, the output column width can
not be larger than the column defined value, and the column width is calculated using this
formula:

Min(character_number X max_character_width, column_defined width)

For example, if a column co11 is defined as varchar (10), then left (coll, 2)
returns a width of eight, or four bytes per character. A value of 1eft (coll,5) returnsa
width or 10, and cannot be larger than the defined length, even though, according to the
formula, 5 X 4 = 20).

The options that change the format of isql output are:

* -h headers — the number of rows to print between column headings. The default is 1.
* -scolseparator — changes the column separator character. The default is single space.
* -wcolumnwidth — changes the line width. The default is 80 characters.

e -e — Includes each command issued to isqgl in the output

e -n-—Removes numbering and prompt symbols

In this example, the query’s results are placed in a file called output:

isgl -Uuser name -Ppassword -Sserver -e -n -0 output
use pubs2

go

select *

from authors

where city = "Oakland"
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To view the contents of output, enter:

e (Windows) type output
¢ (UNIX) cat output

select *

from authors

where city = "Oakland"

au_id au_lname au_fname phone
city state country postalcode

213-46-8915
Oakland
274-80-9391
Oakland
724-08-9931
Oakland
724-80-9391
Oakland
756-30-7391
Oakland

Green Marjorie 415
CA USA 94618

Straight Dick 415
CA USA 94609

Stringer Dirk 415
CA USA 94609

MacFeather Stearns 415
CA USA 94612

Karsen Livia 415
CA USA 94609

986-7020

834-2919

843-2991

354-7128

534-9219

address

309 63rd St. #411
5420 College Av.
5420 Telegraph Av.
44 Upland Hts.

5720 McAuley St.

Note: The output file does not include the command terminator.

Correcting isqgl Input

You can correct input when you make an error when typing a Transact-SQL command.

You can:

» Press Ctrl-c or type the word “reset” on a line by itself —this clears the query buffer and
returns the isgl prompt.
« Type the name of your text editor on a line by itself — this opens a text file where you can
edit the query. When you write and save the file, you are returned to isql and the corrected
query appears. Type “go” to execute it.

set Options that Affect Output

A number of set options affect Transact-SQL output.

Option

Description

char_convert

Turns character-set conversion off and on between the SAP ASE server and a
client; also starts a conversion between the server character set and a different
client character set. The default is off.
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Option

Description

fipsflagger

Warns when any Transact-SQL extensions to entry-level SQL92 are used.This
option does not disable the SQL extensions. Processing completes when you
issue the non-ANSI SQL command. The default is off.

flushmessage

Sends messages as they are generated. The default is off.

language Sets the language for system messages. The default is us_english.

nocount Turns off report of number of rows affected. The default is off.

noexec Compiles each query but does not execute it; often used with showplan. The
default is off.

parseonly Checks the syntax of queries and returns error messages without compiling or
executing the queries. The default is off.

showplan Generates a description of the processing plan for a query; does not print results

when used inside a stored procedure or trigger. The default is off.

statistics io, sta-
tistics time

Displays performance statistics after each execution. The default is off.

statistics sub-
querycache

Displays the number of cache hits, misses, and rows in the subquery cache for
each subquery. The default is off.

textsize

Controls the number of bytes of text or image data returned. The default is
32K.

For more information, see set in the Reference Manual

Changing the Command Terminator

If you include the command terminator argument (-c), you can choose your own terminator
symbol; go is the default value for this option. Always enter the command terminator without
blanks or tabs in front of it.

For example, to use a period as the command terminator, invoke isql:

isgl -c.

A sample isql session with this command terminator looks like:

1> select name from sysusers
2>
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leslie
(3 rows affected)
Using the isql command terminator option with scripts requires advance planning:

*  When the SAP ASE server supplies scripts, such as installmaster, use “go”. Do not
change the command terminator for any session that uses these scripts.

* Your own scripts may already have “go” in them. Remember to update your scripts to
include the terminator you plan to use.

Performance Statistics Interaction with Command
Terminator Values

isgl provides a performance statistics option (-p).

For example, this syntax returns the following statistics:

isgl -p

1> select * from sysobjects

2> go

Execution Time (ms.): 1000 Clock Time (ms.): 1000
1 xact:

This means that a single transaction took 100 milliseconds. The clock time value reflects the
entire transaction, which starts when Client-Library™ builds the query and ends when Client-
Library returns the information from the SAP ASE server.

You can gather performance statistics based on the execution of one or more transactions. To
gather statistics on more than one transaction, specify a number after the command terminator.

For example, the following command instructs the SAP ASE server to execute three select *
transactions and report the performance statistics:

isgl -p

1> select * from sysobjects

2> go 3

Execution Time (ms.): 1000 Clock Time (ms.): 1000
Execution Time (ms.): 1000 Clock Time (ms.): 2000
Execution Time (ms.): 1000 Clock Time (ms.): 1000
Execution Time (ms.): 1000 Clock Time (ms.): 4000
3xact:
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Input and Output Files

You can specify input and output files on the command line with the -i and -o options.

isgl does not provide formatting options for the output. However, you can use the -n option to
eliminate the isql prompts and other tools to reformat the output.

If you use the -e option, isgl echoes the input to output. The resulting output file contains both
the queries and their results.

UNIX command line redirection

The UNIX redirection symbols, “ <” and “>”, provide a similar mechanism to the -i and -o
options.

For example:
isgl -Usa < input > output

You can direct isql to take input from the terminal, as shown in this example:

isqgql -Usa -Ppassword -Sserver name << EOF > output use pubs2
go
select * from table

go

EOF

“<<EOF” instructs isql to take input from the terminal up to the string “EOF.” You can replace
“EOF” with any character string. Similarly, the following example signals the end of input
with Ctrl-d:

isgl -Usa << > output
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Interactive SQL is the GUI-based isql utility, and allows you to execute SQL statements, build
scripts, and display database data to the server..

You can use Interactive SQL to:

« Browse the information in a database.
« Test SQL statements that you plan to include in an application.
« Load data into a database and carrying out administrative tasks.

In addition, Interactive SQL can run command files or script files. For example, you can build
repeatable scripts to run against a database and then use Interactive SQL to execute these
scripts as batches.

Starting Interactive SQL

The menu item Open Interactive SQL opens a connection to a server. However, when you
select the menu item for a server, Interactive SQL opens a connection to the default database
for that server. When you select a specific database from the Open Interactive SQL menu,
Interactive SQL opens to the selected database.

How you start Interactive SQL from the command line depends on your operating system.

If you start Interactive SQL independently, the Connect dialog appears, which lets you
connect to a database just as you would in SQL Central.

*  (UNIX) You need not install Interactive SQL under $SYBASE, as $SYBASE does not
even need to exist for themto start. Instead, Interactive SQL is installed under $SYBROOT,
an environment variable set by the installer. Go to $SYBROOT and enter:

dbisgl
(Windows) Change to the $SYBROOT directory and enter:

dbisgl.bat
* In the Connection dialog, enter the information to connect to a database in the Connect
dialog box and click OK.

To open a new Interactive SQL window:

1. Choose Window > New Window. The Connect dialog appears.
2. Inthe Connect dialog, enter connection options, and click OK to connect.
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The connection information (including the database name, your user ID, and the database
server) appears on the title bar above the SQL Statements pane.

You can also connect to or disconnect from a database with the Connect and Disconnect
commands in the SQL menu, or by executing a connect or disconnect statement in the
SQL Statements pane.

The Main Interactive SQL Window

The Interactive SQL window includes four panes.

The window title displays the connection name. For SAP ASE, the connection name is either
the server name (determined by the server’s interfaces file entry) or the host name and port
number the user enters at the time of connection. The panes are:

Panes Description

SQL State- | Provides a place for you to type SQL statements.
ment

Results Displays the results of commands that you execute. For example, if you use SQL
statements to search for specific data in the database, the Results tab in this pane
displays the columns and rows that match the search criteria. If the information exceeds
the size of the pane, scroll bars automatically appear. You can edit the result set on the
Results tab.

M essages Displays messages from the database server.

Plan Displays the query optimizer’s execution plan for a SQL statement.

See also
* Plan Dialog Tab on page 248

Plan Dialog Tab

The Plan tab displays a GUI representation of an execution engine’s plan for the currently
running SQL text, and helps you understand the performance and statistic characteristics of
the currently running query.

Note: The Plan tab only appears if you connect to SAP ASE version 15.0 and later.

The top half of the Plan tab shows the logical flow of the operators used in the plan in a tree-
based, hierarchal structure, with each operator a separate node of the tree. The cost of each
operator is based on the cost model used by the query processor. Each operator node in the tree
is costed relative to other nodes, which makes it easier to identify operators based on their
costs.
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Each node includes tooltip text (text that appears when you move your mouse over the node)
that provides details about each operator, so you do not have to select the nodes to compare
details between operators.

Plan Tab Description
Information
Details Shows the details of the operator statistics as:
* Node Statistics table — shown for all the operators, and includes statistics like
row count, logical 1/0, and physical 1/0.
e Subtree Statistics table — the aggregate sum of all the operators below, and are
shown for the non-leaf operators, and include statistics on row count, logical
1/0, and physical 1/0.
XML Shows the result set as XML output.
Text Shows the text version of the query plan (the same as the output of showplan).
Advanced Includes:

Abstract query plan — shows the abstract query plan used by the query.
Resource utilization — describes the resources used by the plan, including
number of threads and the auxiliary session descriptors (SDESs; every table
scan requires one session descriptor to track the scan).

Cost — lists costs associated with the plan, including logical 1/0, Physical 1/0,
and CPU usage.

Optimizer Metrics — lists the query-plan statistics, including query run time,
run time for the first plan, number of plans evaluated, number of plans that
were valid, and amount of procedure cache used.

Optimizer Statistics — lists the last time you ran update statistics on the table,
any missing histogram steps, and the density of the steps.

The Interactive SQL Toolbar

The Interactive SQL toolbar appears at the top of the Interactive SQL window.

Use the buttons on this toolbar to:

» Recall the executed SQL statement immediately before your current position in the history

list.

* View a list of up to 50 previously executed SQL statements.
« Recall the executed SQL statement immediately after your current position in the history

list.
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« Execute the SQL statement that appears in the SQL Statements pane.
 Interrupt the execution of the current SQL statement.

Open Multiple Windows

You can open multiple Interactive SQL windows. Each window corresponds to a separate

connection.

You can connect simultaneously to two (or more) databases on different servers, or you can
open concurrent connections to a single database.

Keyboard Shortcuts

Interactive SQL provides keyboard shortcuts.

Function Description

Alt-F4 Exits Interactive SQL.

Alt-LEFT AR- | Displays the previous SQL statement in the history list.

ROW

Alt-RIGHT Displays the next SQL statement in the history list

ARROW

Ctrl-C Copies the selected rows and column headings to the clipboard.

Ctrl-End Moves to the bottom of the current pane.

Ctrl-F6 Cycles through the open Interactive SQL windows.

Ctrl-H Displays the history of your executed SQL statements during the current session.

Ctrl-Home Moves to the top of the current pane.

CtrI-N Clears the contents of the Interactive SQL window.

Ctrl-Q Displays the Query Editor, which helps you build SQL queries. When you have
finished building your query, click OK to export it back into the SQL Statements
pane.

Ctrl-S Saves the contents of the SQL Statements pane.

Shift-F5 Refreshes the plan without executing the statement in the SQL Statements pane.
This allows you to see the plan for a statement without altering table data.

Esc Clears the SQL Statements pane.
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Function Description

F2 Allows you to edit the selected row in the result set. You can use the Tab key to
move from column to column within the row.

F5 Executes all text in the SQL Statements pane. You can also perform this operation
by clicking the Execute SQL Statement button on the toolbar.

F7 Displays the Lookup Table Name dialog. In this dialog, you can find and select a
table and then press Enter to insert the table name into the SQL Statements pane at
the cursor position. Or, with a table selected in the list, press F7 again to display the
columns in that table. You can then select a column and press Enter to insert the
column name into the SQL Statements pane at the cursor position.

F8 Displays the Lookup Procedure Name dialog. In this dialog, you can find and select
aprocedure, then press Enter to insert the procedure name into the SQL Statements
pane at the cursor position.

F9 Executes the selected text in the SQL Statements pane. If no text is selected, all of
the statements are executed.

Page Down Moves down in the current pane.

Page Up Moves up in the current pane.

Display Data Using Interactive SQL

Interactive SQL allows you to browse the information in databases.

You can display database information using the select statement in Interactive SQL. Once you
enter the statement, click the Execute SQL Statement button on the toolbar.

After you execute the statement, the result set appears in the Results pane. You can use the
scroll bars to see areas of the table that are outside your current view of the pane.

For example, to list all the columns and rows of the authors table:
1. Start Interactive SQL and connect to the pubs2 database.
2. Enter this in the SQL Statements pane:
select * from authors
3. On the toolbar, click the Execute SQL Statement button
You can add, delete, and update rows within the result set.

Edit Table Values in Interactive SQL

Once you execute a query in Interactive SQL, you can edit the result set to modify the
database. You can also select rows from the result set and copy them for use in other
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applications. Interactive SQL supports editing, inserting, and deleting rows. These actions
have the same result as executing update, insert, and delete statements.

Before you can copy, edit, insert, or delete rows, you must execute a query in Interactive SQL
that returns a result set on the Results tab in the Results pane. When you edit the result set
directly, Interactive SQL creates and executes a SQL statement that makes your change to the
database table.

To edit a row or value in the result set, you must have the proper permissions on the table or
column you want to modify values from. For example, to delete a row, you must have delete
permission for the table the row belongs to.

Editing the result set may fail if you:

e Attempt to edit a row or column you do not have permission on.

« Select columns from a table with a primary key, but do not select all of the primary key
columns.

« Attemptto edit the result set of ajoin (for example, there is data from more than one table in
the result set).

» Enteran invalid value (for example, a string in a numeric column or a NULL in a column
that does not allow NULLS).

When editing fails, an Interactive SQL error message appears explaining the error, and the
database table values remain unchanged.

Once you make changes to table values, you must enter a commit statement to make the
changes permanent. To undo your changes, you must execute a rollback statement.

Copying Rows from the Interactive SQL Result Set

You can copy rows directly from the result set in Interactive SQL and then paste them into
other applications. Copying rows also copies the column headings. Copied data is comma-
delimited, which allows other applications, such as Microsoft Excel, to format the copied data
correctly. By default, copied data is in ASCII format, and all strings are enclosed in single
quotes. You can select only consecutive rows in the result set.

1. Choose a method to select the rows you want to copy:
« Press and hold the Shift key while clicking the rows.
e Press and hold the Shift key while using the Up or Down arrow.

2. Right-click the result set and select Copy. You can also copy the selected rows by pressing
Ctrl-C.

The selected rows, including their column headings, are copied to the clipboard. You can
paste them into other applications by selecting Edit > Paste or by pressing Ctrl-V.

Editing Rows from the Interactive SQL Result Set

The Edit command allows you to change individual values within a row. You can change any
or all of the values within existing rows in database tables. You must have update permission

252 Adaptive Server Enterprise



CHAPTER 8: Using Interactive SQL in Graphics Mode

on the columns being modified. When you edit the result set, you can make changes to the
values in only one row at a time.

1. Select the row to edit and choose an edit method:

» Right-click the result set and choose Edit from the menu.
* PressF2.

A blinking cursor appears in the first value in the row.

2. Press Tab to move the cursor from column to column across the row. You can also edit a
value by clicking the value in the selected row.

3. Enter the new value.

You cannot enter invalid datatypes into a column. For example, you cannot enter a
string datatype into a column that is configured for the int datatype.

4. Execute a commit statement to make your changes to the table permanent.

Inserting Rows into the Database from the Interactive SQL Result Set

The Insert command adds a new blank row to the database table. Use the Tab key to move
between columns in the result set to add values to the row. When you add values to the table,
characters are stored in the same case as they are entered.

You must have insert permission on the table to add new rows. See insert in Reference
Manual: Commands.

1. Right-click the result set and choose Add from the menu.

A new blank row appears in the result set with a blinking cursor in the first value in the
rOW.

Press Tab to move the cursor from column to column across the row. You can also insert a
value by clicking on the appropriate field in the selected row.

2. Enter the new value.

You cannot enter invalid datatypes into a column. For example, you cannot enter a
string into a column that accepts the int datatype.

3. Execute a commit statement to make your changes to the table permanent.

Deleting Rows from the Database Using Interactive SQL
The Delete command removes the selected rows from a database table.

You must have delete permission on the table to delete rows.

1. Choose a method to select the rows you want to delete:
* Press and hold the Shift key while clicking the rows.
e Press and hold the Shift key while using the Up or Down arrow.
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Delete nonconsecutive rows individually.

2. Right-click the result set and choose Delete. You can also delete the selected rows by
pressing the Delete key.

3. Execute a commit statement to make your changes to the table permanent.

SQL Statements in Interactive SQL

You can enter all SQL statements as commands in the top pane of the Interactive SQL window.
When you are finished typing, execute the statement to run it.

Execute a SQL statement by either:

« Press the Execute SQL Statement button, or
» Selecting Fb5.

To clear the SQL Statements pane:

e Choose Edit > Clear SQL, or
e Press Escape.

If you are running a long-running query, Interactive SQL displays a splash screen that
describes some diagnostic tips.

Canceling an Interactive SQL Command

Use the Interrupt button on the Interactive SQL toolbar to cancel a command.

A Stop operation stops current processing and prompts for the next command. If a command
file was being processed, you are prompted for an action to take (Stop Command File,
Continue, or Exit I nteractive SQL ). You can control these actions with the Interactive SQL
ON_ERROR option.When an interruption is detected, one of three different errors is reported,
depending on when the interruption is detected. If the interruption is detected:

« When Interactive SQL is processing the request (as opposed to the database server), this
message appears, and Interactive SQL stops processing immediately and the current
database transaction is not updated:

ISQL command terminated by user

« By the database server while processing a data manipulation command (select, insert,
delete, or update), this message appears, and the effects of the current command are left
unfinished but the rest of the transaction is left intact:

Statement interrupted by user.

« While the database server is processing a data definition command (create object, drop
object, alter object, and so on.), this message appears:
Terminated by user -- transaction rolled back

Since data definition commands all perform a commit automatically before the command
starts, rollback simply cancels the current command.
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This message also occurs when the database server is running in bulk operations mode
executing acommand that modifies the database (insert, update, and delete). In this case,
rollback cancels not only the current command, but everything that has been done since the
last commit. In some cases, it may take a considerable amount of time for the database
server to perform the automatic rollback.

Combining Multiple Statements

Interactive SQL allows you to enter multiple statements at the same time. End each statement
with the Transact-SQL command, go.

Enter multiple statements in the SQL Statements pane separated by go:

update titles
set price = 21.95
where pub id = "1389"

go
update titles

set price = price + 2.05
where pub id = "0736"

go
update titles

set price = price+2.0
where pub id = "0877"

go

You then execute all three statements by clicking Execute SQL Statement on the toolbar (or
by pressing F9). After execution, the commands remain in the SQL Statements pane. To clear
this pane, press the Esc key.

You can roll back your changes by entering rollback and executing the statement.

Looking Up Tables, Columns, and Procedures
Use Tools > L ookup Table Name and Tools > L ookup Procedure Name to look up the
names of tables, columns, or procedures stored in the current database and insert them at your
cursor position.

Prerequisites
Install jConnect for JDBC in order to use these Interactive SQL tools.

Task

Enter the first characters of a table, column, or procedure in the Lookup Table Name and
Lookup Procedure Name dialogs. This list narrows to display only those items that start with
the text you entered.

You can use the standard SQL wildcard character % to mean “match anything”. Clear the
search area to display all items.
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Looking Up Description

Table names 1.
2.

Choose Tools > L ookup Table Name.

Select the table and click OK to insert the table name into the SQL
Statements pane.

Column names

AW

Choose Tools > L ookup Table Name.
Find and select the table containing the column.
Click Show Columns.

Select the column and click OK to insert the column name into the
SQL Statements pane.

=

Procedure
names 2

Choose Tools > L ookup Procedure Name.

Find and select the procedure.

Click OK to insert the procedure name into the SQL Statements
pane.

Recall Commands

When you execute acommand, Interactive SQL automatically saves it in a history list that lasts
for the duration of your current session. Interactive SQL maintains a record of as many as 50 of
the most recent commands.

Choose one of these commands:

Recall Command
Options

Description

View the
commands list

To view the entire list of commands in the Command History
dialog:

* Press Ctrl-H, or

» Select the book icon in the toolbar.

Recall a command
from a list

The most recent commands appear at the bottom of the list. To
recall acommand, highlight itand click OK. It appears in the SQL
Statements pane.

Recall a command

To recall commands without the Command History dialog:

» Use the arrows in the toolbar to scroll back and forward
through your commands, or

* Press Alt-RIGHT ARROW and Alt-LEFT ARROW.

Save the
commands

Save commands in text files for use in a subsequent Interactive
SQL session.
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Logging Commands

With the Interactive SQL logging feature, you can record commands as you execute them.
Interactive SQL continues to record until you stop the logging process, or until you end the
current session. The recorded commands are stored in a log file.

Start or stop logging:

Command | Description

Start You can use either:
logging « The GUI option:
1. Choose SQL > Start Logging.
2. In the Save dialog, specify a location and name for the log file.
3. Click Save when finished
» Enter the command, where c:\file name.sql isthe path, name,
and extension of the log file:
start logging "c:\file name.sql"

A log file must have the . sg1 extension. Include the single quotation
marks if the path contains embedded spaces.

Once you start logging, all commands that you try to execute are logged,
including ones that do not execute properly.

Stop You can use either:
logging « The GUI option by choosing SQL > Stop L ogging.
» Enter the command:

stop logging

Note: The commands start logging and stop logging are not Transact-SQL commands, and
are not supported by SAP ASE outside the Interactive SQL dialog box.

Configure Interactive SQL

You can configure Interactive SQL in the Options dialog, which provides settings for
commands, appearance, import/export features, and messages.

After you make your selections, choose OK or M ake Per manent. Interactive SQL starts the
configuration you select when you click M ake Per manent..

Set each option by either using the GUI, or the set option statement.

To access the Options dialog, choose Tools > Options.
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General Dialog Box

In the General dialog box, select when to commit transactions, how Interactive SQL acts when
an error occurs, and whether to make a copy of scripts or commands into a log.

Components

Description

Commit

Lets you select when transactions are committed. You can commit transactions:

e Automatically after each statement is executed, or
«  Only when you exit your Interactive SQL session

You can also commit manually by entering an explicit commit command when-
ever appropriate. The default behavior is that transactions are committed when
you exit Interactive SQL.

Command files

Determines how Interactive SQL acts when an error occurs:

« Continue — Interactive SQL displays the error message in the Results pane
but does not exit. Correct the problem, then reissue the command.

« Exit- Interactive SQL exits when an error occurs.

« Notify and Continue — Interactive SQL displays the error message in adialog
box and describes the error but does not exit

* Notify and Exit — Interactive SQL displays the error message in a dialog box,
describes the error, and exits.

* Notify and stop — Interactive SQL displays the error message and describes
the error.

e Prompt - the default setting. Interactive SQL displays a message box asking
if you want to continue.

« Stop — Interactive SQL displays the error message in the Results pane. Cor-
rect, then reissue the command.

Echo Command

When you enable logging, this option causes SQL statements executed from

FilestoLog script files (or command files) to be copied to the log along with the SQL state-
ments entered interactively. If you disable this option, only SQL statements
entered interactively are copied to the log when you start logging.

Folders Determines in which directory the browser should start looking for files. Select

either Last folder used or Current folder.
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The Results dialog box has multiple components that let you configure how your results from
Interactive SQL appear.

Component

Description

Display Null Values

Lets you specify how you want nulls to appear in the table columns when you
browse data. The default setting is (NULL).

Maximum Number
of Rowsto Display

Lmits the number of rows that appear. The default setting is 500.

Truncation Length

Limits the number of characters that appear in each column in the Results pane
in Interactive SQL. The default setting is 30.

Show Multiple Re-
sult Sets

Enables or disables the display of multiple result sets. For example, you can
use this feature when you create a procedure containing multiple select state-
ments. If you enable this option, you can see each result set on a separate tab in
the Results pane when you call the procedure.

If you are using the jConnect driver, choosing to display multiple result sets
requires Interactive SQL to wait for an entire result set to be retrieved before
any rows appear. This may result in longer waits for large result sets. This
option is off by default.

Show Row Number

Check if you want the row numbers displayed in the result set.

Automatically Re-
fetch Result

Enables or disables the ability of Interactive SQL to automatically regenerate
the most recent result set after you execute an insert, update, or delete state-
ment. For example, if you are updating a table with the Results tab in the
Results pane displaying the rows about to be affected, this option causes
Interactive SQL to automatically refresh the Results tab to reflect the executed
changes. This option is on by default.

Console Mode

Select how you want the result sets displayed in the console; only the last result
sets, all result sets, or no result sets.

Font

Select which font you want to use for the result set.
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Import/Export Dialog Box

The Import/Export dialog box allows you to configure import and export settings in

Interactive SQL.

Component

Description

Default export
format

Select the default file format for exporting. This format is automatically selected
in the Files of Type field in the Save dialog, but you can still choose other formats.
The defaultis also used when Interactive SQL interprets an output statement if no
format is specified. The default setting is ASCII.

Default import
format

Select the default file format for importing. This format is automatically selected
in the Files of Type field in the Open dialog, but you can still choose other
formats. The default is also used when Interactive SQL interprets an input state-
ment if no format is specified. The default setting is ASCII.

ASCII options

Specify the default symbols that are used for the field separator, quote string,
escape character, and the default encoding datatype when you import or export
data in the ASCII format. The default settings are the comma (,) for the field
separator, an apostrophe (i) for the quote string, and a backslash (\) for the escape
character.

By default, Interactive SQL uses the default datatype of the server.

Messages Dialog Tab

The Messages dialog box allows you to configure specify message settings in Interactive

SQL.

Component

Description

M easureexecutiontime | Enables or disables the ability of Interactive SQL to measure the time it
for SQL statements takes for a statement to execute. When this option is enabled (which is the

default), the time appears in the Messages pane.

espane

Show separate M - | Lets you specify where information from the database server appears. By

default, messages appear on the Messages tab in the Results pane. If you
select this option, database server information appears in a separate Mes-
sages pane in the Interactive SQL window.

in M essages pane

Default number of lines| Lets you specify the initial height (in lines) of the Messages pane. The

default is 7 lines.
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Editor Dialog Box

The Editor dialog box allows you to configure edit settings in Interactive SQL.

Component

Description

Editor

Select your scrollbar style preference: vertical, horizontal, or both.

Tabs

Determines how tabs are used in your SQL text:

Tab size — enter the number of spaces you want each tab to comprise.

Indent size — enter the number of spaces for each indent.

Tab radio buttons —select | nsert spacesto convert tabs to spaces when you indent

SQL text. Select Keep tabsto retain tabs as spaces when you indent SQL text.

Auto indent — Select:

* None- if you do not want to automatically indent SQL text

e Default - to use the default tab and indent settings

e Smart-ifyouwant Interactive SQL to automatically indent SQL text. Select
Indent open braceto indent open braces or Indent closing brace to indent the
closing braces. Interactive SQL displays how these decisions affect the text in
the window below the buttons.

Format

Determines the look of your SQL text:

Text Highlighting — select the type of text you want to highlight from the list
(keywords, comments, strings, and so on).

Foreground — select the foreground color of the text.
Background — select the color of the text’s background field.

Style

Font size — select the size font.
Caret color — determines the color of the caret.
Reset All - returns all styles to original selections.

Print

Customizes your printed jobs:

Header — enter the header text.
Footer — enter the footer text.
Font size — select the font size.
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Query Editor Dialog Box

The Query Editor dialog box allows you to configure the query editor settings in Interactive
SQL.

Component Description

Fully qualify tableand | Select this to have Interactive SQL prefix table names with the owner (for
column names example, dbo . authors) and prefix column names with the owner
and table names (for example, dbo.titles.price).

Quote names Select this to automatically put quotes around table and columns names to
avoid conflicts with reserved words.

Get list of tableson Select this to automatically get a list of tables in the database when the
startup query editor is started.

Processing Command Files

This section describes how to process files consisting of a set of commands.

Saving SQL Statements to a File

In Interactive SQL, the output for each command remains in the Results pane until the next
command is executed. To keep arecord of your data, you can save the output of each statement
to a separate file.

If statementl and statement2 are two select statements, then you can save them them to
filel and £ile2, respectively:

Statementl; OUTPUT TO filel

go

statement2; OUTPUT TO file2

go

For example, this command saves the result of a query:

select * from titles
go
output to "C:\My Documents\Employees.txt"

Executing Command Files
There are three ways to execute command files.

« Use the Interactive SQL read command to execute command files. this statement executes
the file temp.sql:

read temp.SQL
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» Load a command file into the SQL Statements pane and execute it directly from there.
You load command files back into the SQL Statements pane by choosing File > Open.
Enter transfer.sqgl when prompted for the file name.

The SQL Statements pane in Interactive SQL has a limit of 500 lines. For command files
larger than this, use a generic editor capable of handling large files and use the read
command to import itinto Interactive SQL, which has no limit on the number of lines it can
read.

« Supply a command file as a command-line argument for Interactive SQL.

Saving, Loading, and Running Command Files

Save the commands in the SQL Statements pane so they are available for future Interactive
SQL sessions.

The files in which you save them, called command files and commonly referred to as scripts,
are text files containing SQL statements. You can use any editor to create command files, and
include comment lines along with the SQL statements to be executed. When you begin a new
session, you can load the contents of acommand file into the SQL Statements pane, or you can
run the contents immediately.

Action Description

Save the commands 1
from the SQL State-
ments pane to a file

. Choose File > Save.

2. Inthe Save dialog, specify a location, name, and format for the file. Click
Save when finished.

Load commands from 1
a file into the SQL
Statements pane

. Choose File > Open.
2. Inthe Open dialog, find and select the file. Click Open when finished.
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Action Description

Run a command file 1. Choose File> Run Script.
immediately . . . .

2. The Run Script menu item is the equivalent of a read statement. For
example, in the SQL Statements pane, you can also run a command file
by typing the following, where c: \filename. sql is the path,
name, and extension of the file. Single quotation marks (as shown) are
required only if the path contains spaces:

READ "c:\filename.sqgl"
3. Inthe Open dialog, find and select the file. Click Open when finished.

The Run Script menu item is the equivalent of a READ statement. For
example, in the SQL Statements pane, you can also run a command file by
typing the following, where c:lfilename.sqglis the path, name, and extension
of the file. Single quotation marks (as shown) are required only if the path
contains spaces:

READ 'c:\filename.sqgl'

The SQL Escape Syntax in Interactive SQL

Interactive SQL supports JDBC escape syntax, which allows you to call stored procedures
from Interactive SQL regardless of the database management system you are using.

The general form for the escape syntax is:

{{ keyword parameters }}

You must use double braces. This doubling is specific to Interactive SQL. There must not be a
space between successive braces: " { {" isacceptable,but™ { {"isnot. Aswell, you cannot use
newline characters in the statement. You cannot use the escape syntax in stored procedures
because they are not executed by Interactive SQL.

You can use the escape syntax to access a library of functions implemented by the JDBC
driver, including number, string, time, date, and system functions.

For example, to obtain the name of the current user in a database management system-neutral
way, type:

select {{ fn user() }}

The functions that are available depend on the JDBC driver that you are using. The numeric
functions that are supported by jConnect are:

abs cos log10 sign

acos cot pi sin
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asin degrees power sqrt
atan exp radians tan
atan2 floor rand

ceiling log round

The string functions that are supported by jConnect are:

ascii difference repeat space
char Icase right substring
concat length soundex ucase

The system functions that are supported by jConnect are:

database ifnull user convert

The datetime functions that are supported by jConnect are:

curdate dayofweek monthname timestampadd
curtime hour now timestampdiff
dayname minute quarter year
dayofmonth month second

A statement using the escape syntax should work in Adaptive Server Anywhere, SAP ASE,
Oracle, SQL Server, or another database management system that you are connected to from
Interactive SQL. For example, to obtain database properties with the sa_db_info procedure
using SQL escape syntax, type this in the SQL Statements pane in Interactive SQL:
((CANN sa db info(1)))

Interactive SQL Commands

Interactive SQL includes a set of commands that are entered in the top pane of the Interactive
SQL display. These commands are intended only for Interactive SQL and are not sent to the
SAP ASE server for execution.

The commands available for Interactive SQL are:

Command Description
clear Clears the Interactive SQL panes.
configure Opens the Interactive SQL Options dialog.
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Command Description

connect Establishes a connection to a database.

disconnect Drops the current connection to a database.

exit Leaves Interactive SQL.

input Imports data into a database table from an external file or from the keyboard.
output Imports data into a database table from an external file or from the keyboard.
parameters Specifies parameters to an Interactive SQL command file.

read Reads Interactive SQL statements from a file.

set connection

Changes the current database connection to another server.

set option

Use this statement to change the values of Interactive SQL options.

start logging

Use this statement to start logging executed SQL statements to a log file.

stop logging

Use this statement to stop logging of SQL statements in the current session.

system

Use this statement to launch an executable file from within Interactive SQL.

See “Using DBISQL Commands” in the Reference Manual: Commandas.
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Commands Reference

Some interactive commands are active before you connect to a cluster, while others are active
only after you connect to a cluster.

The sybcluster command prompt includes the current cluster and the default instance when
these values have been set.

Prompt When sybcluster is:
> Not connected to a cluster.
cluster_name> Connected to a cluster.

cluster_name instance_name> Connected to a cluster and a default instance has been set.

See also
e sybclusteron page 141

Commands Active Before Connecting to a Cluster

These commands are active before you connect to a cluster, and are not available after you
connect to a cluster.

Command Description

connect Connects to an existing cluster.

create cluster | Creates a new cluster.

deploy plugin | Deploys the configuration information for a single instance of the cluster to the
Unified Agent.

exit Exits sybcluster.
help Lists the currently available sybcluster interactive commands.
quit Exits sybcluster.

show agents Displays information about available UAF agents.

upgrade server | Updates SAP ASE to SAP ASE Cluster Edition.
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Commands Active After Connecting to a Cluster

These commands are active only after you connect to a cluster:

Command

Description

add backupserver

Configures one or more new Backup Servers on nodes in the cluster not
currently configured for Backup Server.

add instance

Adds one new instance to the cluster.

create backupserver

Create Backup Server.

create xpserver

Creates an XP Server.

diagnose { cluster | in-
stance }

Performs a set of checks to ensure the cluster or instance is working
properly.

disconnect

Loses all connections to the current cluster and returns the cluster to the
unconnected state.

drop backupserver

Drops the Backup Server.

drop cluster

Removes each instance from the cluster and deletes the cluster definition
from the cluster configuration file.

drop xpserver

Drops the XP Server.

drop instance

Removes an instance from the cluster.

exit Exits sybcluster.

help Lists the currently available sybcluster interactive commands.

localize Displays current values for default language, charset, and sort order.
Allows you to change the default values and add or remove languages.

quit Exits sybcluster.

set backupserver

Changes the listening port number for Backup Server on one or more
nodes.

set cluster

Sets properties for the cluster.

set instance

Sets properties for the instance.

set xpserver

Changes the listening port number for XP Server on one or more nodes.

show backupserver con-
fig

Displays the names of the nodes on which Backup Server is configured
and the associated listening port number.
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Command

Description

show cluster

Displays configuration, log, and status values for the cluster.

show instance

Displays information about an instance.

show membership mode

Displays the cluster’s current membership mode, which specifies wheth-
er or not the cluster supports Veritas Cluster Server integration.

show session

Displays current agent and discovery information.

show xpserver config

Displays the names of the instances and nodes on which XP Server is
configured and the associated listening port number.

shutdown cluster

Shuts down the cluster by executing a Transact-SQL shutdown com-
mand for each instance in the cluster.

shutdown instance

Shuts down the instance by executing a Transact-SQL shutdown com-
mand.

start cluster

Starts all instances in the cluster.

start instance

Starts an instance in the cluster.

use

Sets the default instance.

add backupserver

Configures Backup Server for nodes not already configured for Backup Server.

Syntax

add backupserver

Examples

* Add Backup Server — Adds a Backup Server to “mycluster” on nodes “blade3” and

“blade4.”

add backupserver

Finding nodes for which Backup Server is not configured...

Do you want to configure Backup Server for node "blade3"? [Y]
Please enter the Backup Server port number for node "blade3": 5001
Do you want to configure Backup Server for node "bladed"? [Y]
Please enter the Backup Server port number for node "bladed":
50011

Usage

You can configure Backup Server for one or more nodes in the cluster.
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add backupserver lets you add additional nodes when configuring for single Backup Servers.
You cannot use this command to add multiple Backup Servers.

add instance

Adds one new instance to the cluster.

You can add an instance interactively, with sybcluster prompting for necessary configuration
information, or through an input file. add instance also creates a local system temporary
database for the new instance. add instance prompts vary depending on whether
configuration for the cluster is shared or private.

Syntax

add instance instance name [file “input file”]

Parameters

* instance name— is the name of the instance.

» file“input_file” —specifies a file name that contains the configuration information for
adding an instance.

Usage

e add instance creates a local system temporary database for the new instance. Before
executing add instance, make sure that a device with sufficient space for the local system
database exists.

» The input file for add instance has the same format as the cluster input file. However, the
add instance input file may limit the instance definitions to the new instance in the node
section.

e add instance may prompt for this information:

« Instance name, if you did not enter an instance name in the command statement.
* Node hosting the instance

« Port number of the UAF agent on the node

e Query port number

e Primary and secondary address of the node

e Primary and secondary port specification

« If you have configured single Backup Servers for the cluster, add instance asks whether
Backup Server is already configured for the new instance node. If no, add instance asks if
Backup Server should be configured. If yes, it prompts for the Backup Server port for the
node.

If you have configured multiple Backup Servers for the cluster, add instance prompts
for:
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« Name of the Backup Server

« Backup Server log file path

» Backup Server port for the new instance

add instance also prompts for XP Server port number information for the new instance.
« Ifthe installation mode is private, add instance prompts for additional information for the

new instance:

* S$SYBASE home directory.

« Environment shell script path.

*  SAP ASE home directory.

« Server configuration file path.

 Interfaces file path, if LDAP is not configured.

connect

Connects to an existing cluster.

Syntax
connect [ to cluster name ]
[ login login name]
password [password]]

[

[ agent “agent spec [, agent spec [,...]]" ]

[ discovery “ discovery spec [, discovery spec [, ...]]1" ]
Parameters

* cluster_name—is the name of the cluster to which you are connecting.

* login login_name — is the management agent login for the Sybase Common Security
Infrastructure in the Unified Agent framework.

The default user name after installation is “uafadmin” with no password; this is the Simple
Login Module in the Agent configuration. You can configure the user name and password
to use several different mechanisms for authentication and authorization, including
operating system logins.

* password password — is the management agent password for the Sybase Common
Security Infrastructure in the Unified Agent framework.

The default user name after installation is “uafadmin” with no password; this is the Simple
Login Module in the Agent configuration. You can configure the user name and password
to use several different mechanisms for authentication and authorization, including
operating system logins.

* agent agent_spec —is the agent specification that identifies the nodes in the cluster
running a Unified Agent, and the port number that sybcluster uses to connect to the
Unified Agent.
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The format is node_name:port_number[, node_name:port_number ][,...]. The default
port number is 9999. This is the preferred method for connecting to a cluster.
discovery discovery spec —is the discovery method used to identify the agents
responsible for the requested cluster.

The format is method[(method_specification)][, ( method_specification )[,...]]. See the
description for sybcluster-d discovery_list for more information about discovery methods.

Examples

Example1—Connects to “mycluster,” when “mycluster” is the default cluster specified in
the sybcluster command statement:

connect

Example 2 — Connects to “mycluster” using the agent specification and default port
numbers:

connect to mycluster agent "bladel,blade2,blade3"

Usage

A direct connection is one in which the user identifies the cluster nodes and, optionally, the
port numbers for the UAF agents. Sample agent specifications are:

myhost — identifies the host node and assumes the default listening port of 9999.
myhost.mydomain.com — includes the host domain name.
myhost:9999 — identifies the host node and listening port number.

create backupserver

Creates a Backup Server for the cluster, or, if the cluster is configured for multiple Backup
Servers, creates a Backup Server for each instance in the cluster.

Syntax

create backupserver

Examples

Create Backup Server cluster — Creates the Backup Server “mycluster_BS” for
“mycluster”:

create backupserver

Do you want to create multiple Backup Servers? [Y] N

Enter the Backup Server name: [mycluster BS]

Enter the Backup Server log file path: [$SYBASE/ASE-15 0/
install/mycluster BS.log]

Do you want to create a Backup Server for node "bladel"? [Y]
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Enter the Backup Server port number for node "bladel":
The Backup Server "mycluster BS" was successfully defined.

* Create multiple Backup Servers— Creates multiple Backup Servers for “mycluster”
running on “asel” on “bladel” and “ase2” on “blade2”:

create backupserver

Do you want to create multiple Backup Servers? [Y] Y

The "dump/load" commands would be routed to appropriate Backup
Server based on following policies:

1. Dedicated - Each instance associated with exactly one Backup
Server.

2. Round Robin - Choose the Backup Server with least number of
requests in round robin fashion starting from global cluster level
counter.

Enter the number corresponding to the policy to be used: [1] 1

Enter the Backup Server name for instance asel: [asel BS]

Enter Backup Server log file path: [/remote/var/sybase/install/
asel BS log]

Enter the Backup Server port for node "bladel": 23001

Enter the Backup Server name for instance ase2: [ase2 BS]

Enter Backup Server log file path: [/remote/var/sybase/install/
ase2 BS log]

Enter the Backup Server port for node "blade2": 23002

Backup Servers successfully defined.

Usage

create backupserver prompts for the Backup Server listening port on each node. It copies
other necessary configuration information from the cluster configuration file. create
backupserver:

» Creates directory service entries for Backup Server on each node.

« Creates the Backup Server configuration and log files, and the RUN_backup_server script.
* Adds the Backup Server name to the cluster’s sysservers table.

e Enables Backup Server HA.

create cluster
Creates an SAP ASE shared-disk cluster.

Enter the necessary configuration information interactively, as responses to a series of
prompts, or use an input file.

Syntax

create cluster [cluster name ]
[ login login name ]
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password password ]

agent “agent spec[, agent spec[, ...]]1" ]

discovery “ discovery spec[, discovery spec[, ...]1" ]
file “input file” ]

Parameters

cluster_name —is the name of the cluster.

login login_name — is the management agent login for the Sybase Common Security
Infrastructure in the Unified Agent framework. The default user name after installation is
“uafadmin” with no password; this is the simple login module in the agent configuration.
You can configure the user name and password to use several different mechanisms for
authentication and authorization, including operating system logins.

password password — is the management agent password for the Sybase Common
Security Infrastructure in the Unified Agent framework. The default user name after
installation is “uafadmin” with no password; this is the Simple Login Module in the Agent
configuration. You can configure the user name and password to use several different
mechanisms for authentication and authorization, including operating system logins.
agent agent_spec — is the agent specification that identifies the nodes in the cluster
running a Unified Agent, and the port number that sybcluster uses to connect to the
Unified Agent.

The format is node_name:port_number [, node_name:port_number ][,...]. The default
port number is “9999.”

discovery discovery_spec — is the discovery method used to identify the agents
responsible for the requested cluster.

The format is method[(method_specification)] [, (method_specification)],...]]. See the
description for sybcluster -d discovery_list.

file“input_file” —is the operating system input file for creating the cluster.

Examples

Create a cluster with sybcluter prompts— Creates a new cluster called “mycluster”;
sybcluster prompts you for the information necessary to create the cluster:

create cluster mycluster

Create a cluster using a configuration file— Creates a new cluster called “myclusterl”
using configuration information supplied in the myclusterl.xml file:

create cluster myclusterl file myclusterl.xml

Usage
When you create a cluster, sybcluster prompts for:

Cluster name, if one has not been provided.
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* Number of instances.

 Installation mode for the cluster (private or shared).

» Complete path to the master, quorum, PCl, systemdb, sybsysprocs, and temporary
database devices.

» Path to the interfaces file, if LDAP is not configured and this is a shared install.

e (Optional) Trace flags.

« Complete path to the dataserver configuration file, if this is a shared install.

« Primary and secondary interconnection protocols.

« Instance host name, port number, private address, log file location, and start-up arguments.
If this is a private installation, sybcluster also prompts for the $SYBASE installation

directory, SAP ASE home directory, dataserver configuration file location, and interfaces
file location (if LDAP is not configured).

If sybcluster detects the Veritas Cluster Server (VCS) on the system, sybcluster asks if it
should check whether device is managed by VCS.

After you create and confirm the cluster, create cluster prompts for an I/O fencing check,
which checks whether or not each device has 1/0 fencing capability (see the Installation Guide
for a description of 1/O fencing).

create xpserver

Creates an XP Server for each instance in the cluster.

Syntax

create xpserver

Examples
* Createan XP Server —Creates an XP Server for each instance in “mycluster”:

Create xpserver

Enter the XP Server port number for instance "asel":
Enter the XP Server port number for instance "ase2":
Enter the XP Server port number for instance "ase3":
The XP Server was successfully defined for each instance.

Usage

create xpserver prompts for the XP Server listening port for each node in the cluster. Other
information necessary to create the XP Server is read from the cluster configuration file.
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deploy plugin

Adds the configuration information for a single instance of the cluster to the Unified Agent.

You can use deploy plugin to configure the Unified Agent to manage a cluster if you created
the cluster without using the SAP® Control Centeror sybcluster utility, or if you need to re-
create the Unified Agent configuration for a cluster. The configuration of a cluster instance is
performed by deploying a Unified Agent plug-in.

Syntax
deploy plugin
[ login login name ]
[ password password ]
[ agent agent spec ]
[ discovery discovery spec ]

Parameters

* login login_name — is the management agent login for the Sybase Common Security
Infrastructure in the Unified Agent framework.

The default user name after installation is “uafadmin” with no password; this is the Simple
Login Module in the Agent configuration. You can configure the user name and password
to use several different mechanisms for authentication and authorization, including
operating system logins.

* password password — is the management agent password for the Sybase Common
Security Infrastructure in the Unified Agent framework.

The default user name after installation is “uafadmin” with no password; this is the Simple
Login Module in the Agent configuration. You can configure the user name and password
to use several different mechanisms for authentication and authorization, including
operating system logins.

* agent agent_spec —is the agent specification that identifies the nodes in the cluster
running a Unified Agent, and the port number that sybcluster uses to connect to the
Unified Agent.

The format is “node_name:port_number [, node_name:port_number] [,...]]”. The
default port number is “9999”.

» discovery discovery spec —is the discovery method used to identify the agents
responsible for the requested cluster.

The format is “method[(method_specification)] [, (method_specification)l,...]]”. See the
description for sybcluster-d discovery_list for more information about discovery methods.
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Examples

Deploy plug-in using UAF agent — Deploys the plug-in using the UAF agent on host
“system1501™:
deploy plugin agent systeml501

sybcluster prompts for the cluster name, cluster node number, installation mode, full path
to the quorum device, the environment shell script path, and the SAP ASE home directory.

Deploy plug-in using discovery — Deploys the plug-in using discovery to identify the
agent:
deploy plugin discovery udp

Usage
After you execute deploy plugin, sybcluster prompts you for:

Path to the quorum device.

Path to the Sybase home directory.

Installation mode (private or shared) — the default is shared.

Location of your Sybase environment script — this must be a shell script that can be loaded
using the “.file_name” syntax, such as “sh” or “bash.” An example is SYBASE. sh.
Location of your SAP ASE software directory — the default is

<sybase home directory>/ASE-15_0.When entering the location of the SAP
ASE software directory, include the full path. Do not use $SYBASE.

The dataserver login and password are configured using the login command, which updates
all Adaptive Server plug-ins managing the cluster.

diagnose cluster

Performs a set of checks to ensure that the cluster is working correctly.

Syntax

diagnose cluster

Examples

Example 1 — Checks that “mycluster” is working correctly:
diagnose cluster

Cluster name.........oeeeeeenn. mycluster
Maximum instances.............. 4

Cluster node count............. 1
Instances defined.............. 4

Is cluster locked.............. Yes

JDBC connection available...... 1 asel Yes
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JDBC connection available...... 2 ase2 Yes

JDBC connection available...... 3 ase3 Yes

JDBC connection available...... 4 ased Yes

Instance Public Network........ 1 asel on bladel (10.22.79.39)
Reachable: Yes

Instance Public Network........ 2 ase?2 on bladel (10.22.79.39)
Reachable: Yes

Instance Public Network........ 3 ase3 on bladel (10.22.79.39)
Reachable: Yes

Instance Public Network........ 4 ased4 on bladel (10.22.79.39)
Reachable: Yes

Has private Primary network.... No

Has private Secondary network.. No
Network ports required/instance 20

Minimum port allowed........... 1025

Maximum port allowed............ 65535

Current port strategy........... Public primary and secondary
unique.

...The ports are sequenced primary followed by the next instance
primary.

...When the primaries are are completed the secondary ports follow
the same

pattern.

Recommended port strategy....... Public primary and secondary
unique.

...The ports are sequenced primary followed by the next instance
primary.

...When the primaries are are completed the secondary ports follow
the same
pattern.

Usage
diagnose cluster checks that:

A Unified Agent is running on each instance in the cluster.

The number of instances in the cluster does not exceed the value set for maximum number
of instances.

The quorum file exists.

All instances are defined in the interfaces file and that port numbers do not conflict.
The primary and secondary protocol specifications do not overlap.

Each of the $SYBASE directories are shared.
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diagnose instance

Performs a set of checks to ensure that the instance is configured correctly.

Syntax
diagnose instance [instance name]
Parameters

* instance_name—isthe name of an instance. sybcluster uses the default value if you do not
specify an instance name.

Examples

« Example 1 -Displays and verifies configuration information for “asel” on “mycluster”:
diagnose instance asel

Cluster name .. ... L. mycluster
Instance id .......ciiiiene... 1
Instance name ........oiiinn. asel
Node name .......coeueeeeeeeennn bladel
QUEery Port ...ttt 7101
JDBC connection available .... Yes
Instance Public Network ....... 1 asel on bladel (10.33.108.139)
Reachable:..... Yes
Minimum port allowed.......... 1025
Maximum port allowed .......... 65535
Instance port range ........... 1 Primary asel 17100 to 17115 (16)
Okay
Instance port range ........... 1 Secondary asel 17165 to 17180
(16) Okay
Usage

Use diagnose cluster to ensure the cluster is configured correctly.

See also
e diagnose clusteron page 277
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disconnect

Closes all connections to the current cluster and returns sybcluster to an unconnected state.

Syntax

disconnect

Usage
Use connect to reconnect to an existing cluster.

See also
e connecton page 271

drop backupserver

Drops Backup Server from a node or from the cluster. If the cluster is configured for multiple
Backup Servers, drops all Backup Servers.

Syntax

drop backupserver

Examples

* Drop asingle Backup Server —
drop backupserver

Do you want to drop the Backup Server from:

1. Selected nodes

2. Cluster
Enter choice: 1
Do you want to drop Backup Server from node "bladel"? [N] vy
Do you want to drop Backup Server from node "blade2"? [N]
The Backup Server has been dropped from selected nodes.

* Drop the Backup Server from the cluster —
drop backupserver

Do you want to drop the Backup Server from:
1. Selected nodes
2. Cluster
Enter choice: 2
Are you sure you want to drop Backup Server mycluster BS from
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cluster mycluster? (Y or N): [N] vy
The Backup Server has been dropped.

* Drop all multiple Backup Servers—Drops all of the multiple Backup Servers that were
configured for the cluster:

drop backupserver

Multiple Backup Server are defined for the cluster. This command
will drop all of them.

Are you sure you want to continue? (Y/N): [N] y

The Backup Server has been dropped.

Usage
Use drop backupserver to drop a Backup Server from the cluster.

drop cluster

Removes each instance from a cluster and then removes the cluster definition from the cluster
configuration file.

The drop cluster command also removes regular files associated with the cluster and the
cluster agent plug-ins that manage the cluster. The cluster must be down to use drop
cluster.

Syntax

drop cluster

Examples
* Drop all instances—Drops all instances from the current cluster and deletes the cluster:

drop cluster

Usage

» sybcluster prompts for confirmation before dropping the cluster.

» Dueto certain file-system locking, the UAF plug-ins may not be deleted after you use drop
cluster. Verify that the SSYBASE UA/nodes/*/plugins/<cluster name>
directory has been deleted. If the directory still exists, delete it.

e drop cluster:

« Removes cluster and instance entries from the interfaces file, configuration files, and
specified data devices.

« Marks the quorum device as unused.

» Shuts down and removes the cluster’s UAF agent plug-ins.
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drop instance

Removes an instance from the cluster configuration file and updates the Unified Agent
Framework (UAF) and discovery services.

drop instance also notifies the cluster that an instance is to be dropped, and removes the
instance and interfaces file entries.

Syntax

drop instance [instance name]

Parameters

* instance name —identifies an instance in a cluster. If an instance name is not specified,
sybcluster uses the default specified in the sybcluster command line.

Examples
* Remove an instance — Removes the “ase3” instance from the current cluster:

drop instance ase3

Usage

» Before you use drop instance:
» Start at least one instance in the cluster other than the instance you plan to drop.
e Shut down the instance you plan to drop.

« Manually remove instance-specific information. drop instance automatically
removes the local system temporary database.

» sybcluster prompts for confirmation before removing the instance.
* You cannot drop the last instance in the cluster. You must use drop cluster.

drop instance:

« Removes references to the instance in the interfaces file, the instance entry in the quorum
device, and notifies the cluster that the instance has been dropped.

* Removes entries for multiple and single Backup Servers if they were configured for the
instance you are dropping.

» Drops XP Server and single or multiple Backup Servers if they have been configured for
that instance.

See also
* drop clusteron page 281
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drop xpserver

Drops the XP Server for each instance in the cluster.

Syntax

drop xpserver

Examples
* Drop XP Server —Drops the XP Servers for “mycluster”:

drop xpserver

Are you sure you want to drop the XP Servers from cluster
mycluster"? {Y or N): [N] y
The XP Servers have been dropped for all instances.

Usage
Use drop xpserver to drop an XP Server from the cluster.

Exits the sybcluster utility.

Syntax

exit

Usage
exit and quit both exit the sybcluster utility.

If some agents have been shut down while connected to sybcluster, the SAP ASE server may

display error messages describing the connections. You can ignore these messages.

See also
e quiton page 285
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help

Lists the currently available sybcluster interactive commands.

Syntax
help

Usage

The list of currently available interactive commands changes depending on whether or not
sybcluster is connected to a cluster.

localize

Displays the current values for default language, charset, and sort order. Allows modification
of default values, and addition or removal of languages.

Syntax

localize

Examples

» Digplay default localization avlues— Displays default localization values, and then
prompts for changes. The default language changes to Chinese, the default charset to
eucgb, and the default sort order to bin_eucgb:

localize

Current default locale properties are:

Default Language - portuguese

Default Charset - mac

Default SortOrder - Binary ordering, for use with the Macintosh
charcter

set (mac) .

Options for default Language are:
spanish

portuguese

german

us_english

thai

french

japanese

chinese

. korean

10. polish

Enter the number representing the language to be set as defaults:

O oW Joy Ul WwWN -
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[2] 8

Options for default charsets are:

1. gbl18030

2. eucgb

3. uttfs8

Enter the number representing the charset to be set as default:
[1] 2

Options for sort orders are:

1. Binary ordering, for the EUC GB2312-80 character set (eucgb).
Enter the number representing the sort order to be set as default

[1]

Do you want to install any language? [Y] n

Do you want to remove any language? [N ]

The cluster mycluster was successfully localized with default
language

chinese, charset eucgb, sortorder bin eucgb

Usage

» The current default localization value displays after each prompt. To accept the current
value, enter a carriage return instead of a number.

» The options for default languages include all languages present in $SYBASE ASE. If the
selected default language is not configured, use localize to configure it or remove it.

« To ensure that new values are consistent for all instances in the cluster, restart the cluster
after changing localization values.

quit
Exits the sybcluster utility.

Syntax
quit

Usage
exit and quit both exit the sybcluster utility.

See also
e exiton page 283
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set backupserver

Changes the listening port number for Backup Server on specified nodes in a cluster.

Syntax

set backupserver

Examples

Changethelistening port number for Backup Server — Changes the listening port
number for Backup Server on “bladel” of “mycluster”:

set backupserver

Backup Server is configured on the following nodes:

1. bladel: 3001

2. blade2: 3002

3. blade3: 3003
Do you want to change the Backup Server port on any node? {Y}
Enter the number representing the node whose port you want to
change: 1
Enter the Backup Server port number for node "bladel":4001
Backup Server was successfully modified as per new properties.

Changethelistening port number for one or more Backup Servers—When
“mycluster” has been configured for multiple Backup Servers, changes the listening port
number for one or more Backup Servers:

set backupserver

Multiple Backup Servers are configured for the cluster. Their
configuration is as follows:
Backup Server Policy: Dedicated
1. Backup Server name: asel BS

Configured for bladel:23001

Log file location: /remote/sybase/ASE-15 0/install/asel BS.log
2. Backup Server name: ase2 BS

Configured for blade2:23002

Log file location: /remote/sybase/ASE-15 0/install/ase2 BS.log
3. Backup Server name: ase3 BS

Configured for blade3:23003

Log file location: /remote/sybase/ASE-15 0/install/ase3 BS.log

Do you want to edit any Backup Server (y/n)? [Y]

Enter the number representing the Backup Server you want to edit:
[1]

Enter the new port for Backup Server "asel BS":24001

Do you want to edit any more Backup Servers? [N]

Backup Server "asel BS" successfully updated.
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Usage

When you set a new listening port number, the SAP ASE server first checks to see if that port
number is already in use.

set cluster

Changes configuration values for the cluster.

The cluster must be down to execute all set cluster commands except set cluster login.

Syntax

set cluster {
maxinst max num instances |
traceflags trace flag[, trace flagl[,...]] |
{ primary | secondary } protocol udp |
login login name [password password ] }

Parameters

* maxinst max_instances—specifies the maximum number of instances that can run in the
cluster.

» traceflagstrace flag[, trace flag[,...] —specifies trace flags to be set when the cluster
starts.

* login login_name [password password] — specifies a user name and password that the
Unified Agent uses to log in to the cluster and perform shutdown and certain other tasks.

Note: You can only use set cluster login to change the login or password that the Unified
Agent uses to log in to the cluster. To change the login or password sybcluster uses to log
in to the Unified Agent, use the Agent Management Console SQL Central plug-in.

» {primary | secondary } protocol udp —sets the protocol for the private network for the
primary or secondary interface.

Examples

e Changethe maximum number of instances— Changes the maximum number of
instances to 4 for “mycluster”:

set cluster maxinst 4

* Add atraceflag — Adds the trace flag 15506:
set cluster traceflags 15506

* Changethe password — Changes the password for the “sa” user name:

set cluster login sa password abcde
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Usage
To check that the cluster is down, enter show cluster status.

Permissions

The login for login login_name [password password] must have sa_role. By default, the
Unified Agent uses the “sa” login with no password. To change this password, use set cluster
login.

See also
» set cluster on page 287
» show cluster on page 292

set instance

Sets properties of the instance. The instance must be down.

Syntax

set instance instance name
{logpath path |
startargs values |

{primary | secondary} port port range |
{primary | secondary} address ip address}
Parameters

» logpath logfile path — specifies the path for the instance log file.
e instance_name — specifies an instance.
e startargsstartup_args—specifies arguments for starting the instance.

e {primary | secondary } addressip_address —specifies the primary or secondary IP
address for the instance.

* {primary |secondary} port port_range—specifies the primary or secondary port range
for the instance. The format for port_rangeis start_num end_num.

Examples

* Changetheport range— Changes the port range for the primary interface listening port:
set instance primary port 7777

Usage
To check that the instance is down, enter show cluster status.
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See also
e show clusteron page 292

set xpserver port

Changes the listening port number for XP Server on specified nodes of the cluster.

Syntax

set xXpserver port

Examples

* Example1—Changes the listening port for the XP Server for instance “asel” on “bladel”
of “mycluster” without changing the listening ports for “ase2” and “ase3":

set xpserver port

Enter the XP Server port number for instance "asel" [3002]: 4002

Enter the XP Server port number for instance "ase2" [3002]: <CR>

Enter the XP Server port number for instance "ase3" [3002]: <CR>
Usage

You can change the XP Server listening port number on one or more instances.

show agents

Displays information about available UAF agents.

Syntax

show agents
login login name ]
password password |

agent “agent spec[, agent specl[,...]]" ]
discovery “discovery spec|, discovery spec[,...]]1" ]
Parameters

* login login_name — is the management agent login for the Sybase Common Security
Infrastructure in the Unified Agent framework.

The default user name after installation is “uafadmin” with no password; this is the Simple
Login Module in the Agent configuration. You can configure the user name and password
to use several different mechanisms for authentication and authorization, including
operating system logins.
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password password — is the management agent password for the Sybase Common
Security Infrastructure in the Unified Agent framework.

The default user name after installation is “uafadmin” with no password; this is the Simple
Login Module in the Agent configuration. You can configure the user name and password
to use several different mechanisms for authentication and authorization, including
operating system logins.

agent agent_spec — is the agent specification that identifies the nodes in the cluster
running a Unified Agent, and the port number that sybcluster uses to connect to the
Unified Agent.

The format is “node_name:port_number [, node_name:port_number ][,...]]". The
default port number is “9999.”

discovery discovery_spec — is the discovery method used to identify the agents
responsible for the requested cluster.

The format is “method[(method_specification)] [, ( method_specification ) [,...]]”. See
the description for sybcluster -d discovery_list for more information about discovery
methods.

Examples

Display UAF agent information —
show agents

Agent Information: service:jmx:rmi:///jndi/rmi://bladel:9985/
agent

Node Name: bladel

Agent Port: 9985

Agent Version: 2.5.0

Agent Build: 977

OS Name: Linux

OS Version: 2.6.9-42 .ELsmp

OS Architecture: amdo64
Agent Service Info:

Agent Service (Agent) Build: 977 Status: running
BootstrapService (BootstrapService) Build: <unavailable> Status:
running

Configuration Service (ConfigService) Build: 977 Status:
running

Deployment Service (DeploymentService) Build:

<unavailable> Status: running

Environment Service (EnvironmentDiscoveryService) Build:

977 Status: running

File Transfer Service (FileTransferService) Build: 977 Status:
running

Plugin Registration Service (PluginRegisterService) Build:
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977 Status: running

RMI Service (RMIService) Build: 977 Status: running

Remote Shell Service (RemoteShellService) Build: 977 Status:
running Security

Service (SecurityService) Build: 977 Status: running Self
Discovery Service

(SelfDiscoveryService) Build: 977 Status: running Service
Registration Service

(ServiceRegistrationService) Build: 977 Status: running Session
Service

(SessionService) Build: 977 Status: running Sybase Home Service
(SybaseHomeService)

Build: 14 Status: running

Agent Plugin Info:

ASE Cluster Agent Plugin (com.sybase.ase.cluster) Version: 15.1.0
Build: 85 Instance:
1 Status: running

Cluster Name: marion

Env Shell: /jobl/miso/betaR1/SYBASE.sh Shell Type: sh

Sybase Home: /jobl/miso/betaRl

ASE Home: /jobl/miso/betaR1/ASE-15 0

ASE Version: Adaptive Server Enterprise/15.0.1/EBF 14721
Cluster

Edition/B/x86 64/Enterprise Linux/asecluster3/2360/64-bit/FBO/Fri
Jul 20 10:04:16

2007
ASE Login: sa
Update Time: 60 seconds
Last Update: 2007-09-28 22:09:02 -0700
Usage

show agents is active before you connect to a cluster.

show backupserver config

Displays the nodes on which Backup Server is configured, the associated listening port
numbers, and the Backup Server policy.

Syntax

show backupserver config

Examples

» Display configuration infor mation — Displays configuration information for
“mycluster,” which has been configured for multiple Backup Servers.

show backupserver config

Multiple Backup Servers are configured for cluster. Their
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configuration is

as follows:

Backup Server policy: Dedicated

1. Backup Server for asel: asel BS
Configured on (host:port) - bladel:23001

2. Backup Server for ase2: ase2 BS
Configured on (host:port) - blade2:23002

3. Backup Server for ase3: ase3 BS
Configured on (host:port) - blade3:23003

Usage

» Use the show backupserver config command to display Backup Server configuration
information.

« If you are configuring multiple Backup Servers, show backupserver config includes the
Backup Server policy.

show cluster

Displays configuration, log, and status information about the cluster.

Syntax

show cluster

config

template

log

[errors]
minseverity severity level]
startdate [date string]]
enddate [date string]]
last number of lines]
status

[
[
[
[

Parameters

» status—displays status information for the cluster. Values are:

* Up
* Down

¢ Undefined
* Invalid

e Start

* Init

* Quiesce

* log—displays logs from all instances in the cluster.
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» errors[ minseverity severity_level ] —display log file entries for errors. (Optional) Limits
displayed error entries to a severity level and above.

Note: Error severities_levelis an attribute of SAP ASE error messages, not sybcluster
messages.

« startdate[date string] —display log file entries that occur on and after the date specified.
The format for date_string is: mm:dd:yy.

If you do not specify a startdate or enddate date_string, the default is the current date
(today).

* enddate[ date string] —display log file entries that occur on or before the date specified.

e last num_lines— limits the number of lines displayed, counting backward from the last
line in the log files.

» config—displays configuration information for the cluster:

e Maximum number of instances
« Installation mode: shared or private
e Primary and secondary protocols
e Trace flags set
« Location and name of the quorum device
o LDAP information, if LDAP is configured
» Location and name of the master device
* template—displays formatted configuration information for the cluster.

Examples

» Display current information — Displays current configuration and other information
about the default cluster:

show cluster status

Id Name Node State Heartbeat
1 asel bladel Up Yes
2 ase?2 blade2 Up Yes
3 ase3 blade3 Down No

» Display configuration information for a cluster configured for shared installation
mode— Displays configuration information—including LDAP, if it is configured—for the
default cluster configured for shared installation mode:

show cluster config

**Cluster configuration for "mycluster" **
Installation Mode shared
Interfaces Path "/work2/sybase/ASE-15 0/"
Trace Flags:
15556
Maximum Instances "4"
Quorum "/dev/raw/rawlO1l"
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Master Device
"/dev/raw/rawl02"

logfile asel /work2/sybase/ASE-15 0/install/
asel.log

run_parameters asel null

logfile ase2 /work2/sybase/ASE-15 0/install/
ase2.log

run parameters ase2 null

Primary Interconnect "udp"

Server[l]lasel tigger.sybase.com 26016 26031
Server|[2]ase2 christopher.sybase.com 26032 26047

Secondary Interconnect "udp"

Server[l]asel tigger.sybase.com 26081 26096
Server[2]ase2 christopher.sybase.com 26097 26112

Display configuration information for a cluster configured for private installation
mode — Displays configuration information for the default cluster configured for private
installation mode:

show cluster config

**Cluster configuration for "localcluster" **

Installation Mode "private"

Trace Flags:

There are no trace flags

Maximum Instances "4"

Quorum "/dev/raw/rawlO1l"

Master Device "/dev/raw/rawl02"

logfile asel /remote/work2/sybase/ASE-15 0/install/asel.log
run parameters asel null

logfile ase2 /work2/sybase/ASE-15 0/install/ase2.log

run parameters ase2 null

Primary Interconnect "udp"

Server[l]lasel tigger.sybase.com 26016 26031
Server[2]ase?2 christopher.sybase.com 26032 26047

Secondary Interconnect "udp"

Server[l]asel tigger.sybase.com 26081 26096
Server[2]ase2 christopher.sybase.com 26097 26112

LDAP server bladel 2250

show cluster status displays the results of a show instance command on each instance in the

See also
show instance on page 295
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show instance

Displays information about an instance.

Syntax
show instance [instance name ] ({
config |
status |
log
[ [ errors ] minseverity severity level ]
[ startdate [ date string ]]
[enddate [ date string 1]
[ last num lines ] ] }
Parameters

* instance_name— specifies a unique name for an instance in the cluster.
* status—displays status information for the instance. Values are:

e Up
* Down

¢ Undefined
* Invalid

e Start

e Init

* Quiesce

* log —displays the instance log.

* erors[ minseverity severity level ] —displays log file entries for errors. (Optional)
Limits displayed error entries to a severity level and above.

Note: Error severities levelis an attribute of SAP ASE error messages, not sybcluster
messages.

+ dtartdate[ date string] —displays log file entries that occur on and after the date
specified. The format for date_string is: mm:dd:yy.

If a startdate Or enddate date_string is not specified, date_string defaults to the current
day.

* enddate[ date_string] —displays log file entries that occur on or before the date specified.
The format is: mm:dd:yy.

* last num_lines— Limits the number of lines displayed, counting backwards from the last
line in the log file.
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Examples

» Display information about “asel” —
show instance asel status

* Display configuration information for “asel” —
show instance asel config

Instance: asel at blade6:25001

Private Primary Network
Address: bladel
Port Range: 2541 - 2556
Sybase home: /sybase/sybase sdc
ASE home: /sybase/sybase_sdc/ASE-15_0
Config file: /sybase/sybase sdc/asel.cfg

Private Secondary Network
Address: bladel
Port Range: 2557 - 2572

Log Path: /bladel/sybase/
ASE-15 0/install/mycluster asel.log

Usage
* show instance status displays one of seven different states for the named instance:
¢ Down
e Init
* Invalid
* Quiesce
e Start
* Undefined
. Up

* show instance config includes this information when the installation mode is private:
e The $SYBASE path
e The ASE path
» The server configuration file path
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show membership mode

Displays the cluster’s current membership mode. Membership mode specifies whether or not
Veritas Cluster Integration is supported on the current cluster.

Syntax

show membership mode

Usage
Values for show membership mode are:

* vecs — VCS is supported for the current cluster.
« native — VCS is not supported for the current cluster.

If the cluster is running in VCS membership mode, make sure you shut down or start up
servers and the cluster using VCS shut-down and start-up mechanisms.

show session

Displays current discovery and agent information.

Syntax

show session

Examples
» Display agent statusinformation —

show session

Session information

Sybase sybcluster Command Line Utility/15.0.1/CE GA 2/S/3jdkl.4.2/
sybclustermain/129/Mon Aug 13 09:59:51 PDT 2007Connected Cluster:
myclusterDefault Cluster:

Default Instance:

Agent Specifications:
[1]: oddjob:7171

Discovery Specifications:
Agent Connections: 1

Connection[1l] URL: rmi://oddjob:7171 Node
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Name:

oddjobl
Agent Port: 7171
Agent Version: 2.5.0
Agent Build: 980
OS Name: Linux
0S Version: 2.6.9-42 . ELsmp

OS Architecture: amdo64

Agent Service Info:

Agent Service (Agent) Build:980 Status:running

BootstrapService (BootstrapService) Build:
<unavailable> Status: running

Configuration Service (ConfigService) Build:
980 Status: running

Deployment Service (DeploymentService) Build:
19 Status: running

Environment Service (EnvironmentDiscoveryService)
Build: 980 Status: running

File Transfer Service (FileTransferService)
Build: 980 Status: running

Plugin Registration Service
(PluginRegisterService) Build:980 Status:
running

RMI Service (RMIService) Build: 980 Status:
running

Remote Shell Service (RemoteShellService) Build:
980 Status: running

Security Service (SecurityService) Build: 980
Status: running

Self Discovery Service (SelfDiscoveryService)
Build: 980 Status: running

Service Registration Service
(ServiceRegistrationService) Build: 980
Status: running

Session Service (SessionService) Build: 980
Status: running

Sybase Home Service (SybaseHomeService) Build:
14 Status: running

Agent Plugin Info:

ASE Cluster Agent Plugin(com.sybase.ase.cluster)
Version: 15.0.1 Build: 129 Instance: 1
Status: running

Cluster Name: mycluster

Env Shell: /oddjobl/work2/
sybase sybclustermain mycluster vu/SYBASE.sh
Shell Type: sh

Sybase Home: /oddjobl/
work2/sybase sybclustermain mycluster vu

ASE Home: /oddjobl/work2/
sybase sybclustermain mycluster vu/ASE-15 0

ASE Version: Adaptive Server Enterprise/
15.0.1/EBF 14721 Cluster Edition/B/x86 64/
Enterprise Linux/asecluster3/2381/64-bit/
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FBO/Mon Nov 12 07:44:23 2007
ASE Login: sa
Update time: 300 seconds
Last Update: 2007-11-13 15:27:39 -0800

Usage
Use the sybcluster show session command to view information about the current cluster.

show xpserver

Displays the XP Server name and listening port number, node name, and instance name
configured on each node.

Syntax

show xpserver

Examples

* Display XP Server configuration infor mation —Displays the XP Server name, listening
port number, node name, and instance name:

show xpserver config

**XP Server configuration for the cluster**

XPServer Name Port Host Node

asel XP 4010 bladel asel

ase2 XP 4011 blade2 ase2

ase3 XP 4012 blade3 ase3
Usage

Use the sybcluster show xpserver command to view information about XP Server.

shutdown cluster

Shuts down the cluster by executing a Transact-SQL shutdown command for each instance in
the cluster’s instance list, in the order specified in the cluster configuration file.

Syntax

shutdown cluster [nowait]
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Parameters

* nowait —shuts down the cluster immediately, without waiting for transactions or
statements currently executing to conclude. By default, sybcluster waits for all
transactions and statements to execute before shutting down the cluster.

Examples

e Shut down thecurrent cluster —
shutdown cluster

INFO -

INFO - 01:00:00000:00117:2007/06/02 00:23:53.56 kernel
ueshutdown: exiting

INFO - 01:00:00000:00117:2007/06/02 00:23:53.56 kernel SySAM:
Checked in

license for 1 ASE CORE (2007.1031/31-0ct-2007/1293 6876 8FE7
E217) .

Usage
sybcluster prompts for confirmation before shutting down the cluster.

If the cluster is managed by VCS, shutdown cluster fails. You must use VCS shut-down
mechanisms to shut down the cluster.

shutdown instance

Shuts down the instance by executing a Transact-SQL shutdown command.

Syntax

shutdown instance [instance name] [nowait]

Parameters

* instance_name— is the unique name of an instance in the cluster.

* nowait —shuts down the instance immediately, without waiting for currently executing
transactions or statements to finish.

Examples

¢ Shut down an instance — Shuts down the instance “asel,” after waiting for currently
executing transactions or statements to finish:
shutdown instance asel

INFO - 01:00:00000:00113:2007/06/02 00:31:24/14 kernel shutdown
server asel
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INFO - 01:00:00000:00113:2007/06/02 00:31:24/14 Server SHUTDOWN by

request.

INFO - 01:00:00000:00113:2007/06/02 00:31:24/14 ASE is terminating

this process

INFO - 01:00:00000:00113:2007/06/02 00:31:24/14

cluster server.

INFO - 01:00:00000:00113:2007/06/02 00:31:24/14
coordinator to be shutdown, newcoo is 0.

INFO - 01:00:00000:00113:2007/06/02
server cluster.

INFO - 01:00:00000:00113:2007/06/02
cipcnode down(): Node 1 down event.
INFO - 01:00:00000:00113:2007/06/02
shutdown by request.

INFO - 01:00:00000:00113:2007/06/02
ueshutdown: exiting

INFO - 01:00:00000:00113:2007/06/02

00:

00:

00:

00:

00:

Checked in license for 1 ASE CORE (2007

8FE7 E 217).

Usage

Shutting down the last instance in a cluster also shuts down the cluster.
sybcluster prompts for confirmation before shutting down the instance.
If the cluster is managed by VCS, shutdown instance fails. You must use VCS shut-down

mechanisms to shut down the instance.

start cluster

31:24/14
31:24/14
31:24/14
31:24/14

31:24/14

shut down local
kernel

kernel Single
kernel

server ASE
kernel

kernel SySAM:

.1031.31-0ct-2007/1293 6876

Starts all instances in the cluster.

Syntax

start cluster

Examples

Start the current cluster —
start cluster

INFO - [cluster boot log]

INFO - 02:00:00000:00002:2007/06/02 00:21:53.56

(ID=1) .

server 'asel'

INFO - 02:00:00000:00002:2007/06/02 00:21:53.56 server Master

device
size:

80 megabytes, or 40960 virtual pages.
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Usage
Connect to the cluster before starting it.

start instance

Starts an instance.

Syntax

start instance [instance name] [unlock]

Parameters
* instance_name— specifies a unique name for an instance in the cluster.

If you do not enter a cluster name, sybcluster uses the instance specified in the sybcluster
command line or specified with the use command.

* unlock —removes the lock from a cluster that was terminated unexpectedly. The cluster
must be down before using unlock.

Warning! Do not use the unlock parameter unless you have verified that all instances in
the cluster are shut down.

Usage
The instance must be down to use start instance unlock.

upgrade server

Upgrades a nonclustered SAP ASE server to the SAP ASE Cluster Edition, and creates a
cluster with a single instance.

You can perform the upgrade by answering prompts at the command line or via an input file.

See the SAP ASE Cluster Edition installation guide for your platform for upgrade
information.

Syntax

upgrade server server name

[ login login name ]
password password |
agent agent spec ]
discovery discovery spec ]
file input file name ]
checkonly ]
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Parameters

e server_name— is the name of the non-clustered SAP ASE server.
* login login_name — is the management agent login for the Sybase Common Security
Infrastructure in the Unified Agent framework.

The default user name after installation is “uafadmin” with no password; this is the Simple
Login Module in the Agent configuration. You can configure the user name and password
to use several different mechanisms for authentication and authorization, including
operating system logins.

* password password — is the management agent password for the Sybase Common
Security Infrastructure in the Unified Agent framework.

The default user name after installation is “uafadmin” with no password; this is the Simple
Login Module in the Agent configuration. You can configure the user name and password
to use several different mechanisms for authentication and authorization, including
operating system logins.

* agent agent_spec— isthe agent specification that identifies the node in the cluster running
a Unified Agent, and the port number that sybcluster uses to connect the Unified Agent.

When upgrading a non-clustered SAP ASE server, there is only one node. The format for
agent_specis “node_name:port_number”. The default port number is “9999.”

» discovery discovery spec — is the discovery method used to identify the agents
responsible for the requested cluster.

The format is “method[(method_specification)] ”. See the description for sybcluster -d
discovery_list for more information about discovery methods.

« filefile_name—is the input file containing values required for upgrading the server.

¢ checkonly — performs a check run of the non-clustered SAP ASE server to determine its
readiness for upgrade.

Examples

e Upgrade“myserver” tothe Cluster Edition —
upgrade server

Enter the name of the cluster: new cluster

Enter the existing Sybase installation directory for server
myserver:

Enter the name of the subdirectory containing the ASE installation
for server myserver:

Enter the name of the subdirectory containing the OCS installation
for server myserver:

Enter the name of an sa login on server exit: [sa]
Enter a password:
Cluster new cluster - Enter the maximum number of instances: [4]

Verifying the supplied agent specifications...
1>tigger 9999 2.5.0 Linux
Enter the number representing the cluster node 1 [1]
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Will this cluster be configured using private SYBASE
installations? (Y/N)

The information required to upgrade a server or create a cluster are the same.

Usage
upgrade server prompts for these values:

» The Sybase installation directory of the non-clustered SAP ASE server.
e The release home directory of the non-clustered SAP ASE server.

« The Open Client home directory of the non-clustered SAP ASE server.
» The installation mode, private or shared.

« If sybcluster detects a VCS subsystem, asks if you want to include VVCS integration with
the cluster.

« If you have not configured LDAP, the path to the interfaces file.
* The name of the first instance in the cluster.
» Other values as required to create a cluster.

The checkonly option does not perform any upgrade steps, but instead check the server’s
readiness for upgrade. Resolve the error conditions checkonly finds before performing the
upgrade.

See also

» create clusteron page 273

use

Specifies the default instance.

Syntax

use instance_name

Usage
use overrides the instance name specified in the sybcluster command line.

304 Adaptive Server Enterprise



CHAPTER 10  Using sybmigrate to Migrate
Data

sybmigrate is the migration tool used to migrate data from one server to another.

By default, sybmigrate migrates encrypted columns in ciphertext format. This avoids the
overhead of decrypting data at the source and encrypting at the target. In some cases,
sybmigrate chooses the reencrypt method of migration, decrypting data at the source and
encrypting at the target.

Note: When migrating from one SAP ASE to another more recent version of SAP ASE, you
must specify the size and location of a work database on the target server.

The sybmigrate utility:

« Aids users in changing the page sizes of their database applications.
« Provides a manageable and smooth migration process.

« Allows customers to take advantage of the variable page size feature for existing databases
with user data, thus realizing the full benefit of SAP ASE versions 12.5 and later.

What sybmigrate Does

During the set-up portion of the migration process, sybmigrate migrates following server data
to the target SAP ASE server:

¢ Remote servers
* Logins

« Login attributes
« Server roles

e Login roles

« Role attributes

e Users
» Alternate users
* Roles

e Permissions

< Remote logins

« External login attributes
e Timer

« Resource limits
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Replication attributes

Display level attributes

User messages in the master database
Java classes in the master database
JAR files in the master database
Proxy objects

During the migration portion of the migration process, sybmigrate migrates following
database-specific data to the target database:

Defaults

User-defined datatypes
Rules

User tables

User table data

Views

Triggers

Indexes

Stored procedures
Extended stored procedures
Users

Logins

Roles

Remote servers

Database data

e Users
« Alternate users
¢ Roles

e Role attributes
e Permissions
e User messages
e Java classes
* JARfiles
Defaults

Rules
User-defined types
Tables

Indexes
Referential constraints
Views
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Stored procedures
Triggers

What sybmigrate Does Not Do

The sybmigrate utility does not perform all tasks. Migrate these items manually.

Migrate/downgrade databases from a higher version level. For example, you cannot use
sybmigrate to downgrade SAP ASE version 15.7 to an earlier version, such as 15.5.

Table-level lock promotion attributes

User-defined thresholds

Abstract plan definitions maintained in sysqueryplans
All system databases except the mode 1 database

Any required database options like cache binding, recovery order, and the associated log
1/0 size as specified by sp_logiosize

Proxy databases

Engine groups

Engine bindings

Execution classes

Cache configurations

Auditing tables and auditing configuration

Server-wide row-lock promotion settings

Access rules

Note: Drop access rules before beginning data migration; they can prevent the Database
Owner from accessing all rows in a table, which prevents complete data migration.
Compiled objects with hidden SQL text

User-defined segments

Constraints are migrated but when they are bound by name to user-defined message
numbers, the bindings must be re-created manually

Settings for objects such as ascinserts, indextrips, camtrips, datatrips,
and sortbufsize created using dbcc tune

Device definitions

SQLJ functions

Proxy tables for external files

Audit options and audit events

Server configuration

Database suspect threshold

Recovery orders
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Before You Begin

sybmigrate requires JRE 1.4, jConnect™ for JDBC™ 6.0, ddigen components, and
Component Integration Services in the source SAP ASE server.

sybmigrate is installed as part of the SAP ASE software. For information about how to install
SAP ASE, see the installation guide for your platform.

Because sybmigrate requires a server-to-server connection, two SAP ASE servers must be
running. Make sure that you have the appropriate licenses.

Before you begin the migration process, create databases, devices, and segments on the target
SAP ASE server. Server and cache configurations must also be already installed on the target
SAP ASE server.

Use ddlgen to extract the corresponding scripts from the source SAP ASE server, and modify
them as needed before applying them to the target SAP ASE server.

See also
e ddlgenon page 42

Permissions

The System Administrator login is needed for the setup portion of the migration process. For
the remainder of the process, the login must have “sa_role” and “sso_role” privileges to run
sybmigrate.

Changing Target Login Accounts

Once you have migrated between different platforms, login passwords are not compatible.
However, sybmigrate allows you to change the password on target SAP ASE server login
accounts during the setup session of the migration process in either of two ways.

» Let sybmigrate generate a password on the target server. sybmigrate outputs a list of
passwords used during migration after the process is complete.

« Supply a password file that contains user name and password pairs. sybmigrate sets these
passwords on the target server. Thereafter, the System Administrator must run
sp_password to create a new password for each login not included in the password file.

Note: After the migration process is complete, the System Administrator must change
passwords manually on the target SAP ASE server. The System Administrator must issue
sp_password for new login and for each login not reset during the migration process.

In addition to the changing password options, sybmigrate also allows you to lock and unlock
target SAP ASE server accounts. This option is provided so that the System Administrator can
block a user from logging into the target SAP ASE server during the migration process.
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Platforms
sybmigrate works on both UNIX and Windows platforms.

» For UNIX, the executable file is located in $SYBASE/$SYBASE ASE/bin/
sybmigrate.

» For Windows, the executable file is located in $SYBASE$\$SYBASE ASE%$\bin
\sybmigrate.bat.

Environment Settings

These environment variables must be set correctly. With the exception of
SYBMIGRATE_MEMORY, these environment variables are defined inthe SYBASE . cshor
SYBASE. sh files that are created during the installation process.

Environment Description

Variable

SYBASE Defines the location of the Sybase release path.

SYBASE_ASE Defines the location of the SAP ASE component directory.
SYBASE_JRE Defines the location of the Java runtime environment. This is generally set to

$SYBASE/shared/jre-1 4 inthe SAP ASE release area. This en-
vironment variable overrides JAVA_HOME. SYBASE_JRE defaults to
SSYBASE/shared/jrel42 (UNIX)and $SYBASES\Shared
\Sun\jrel42 (Windows).

SYBMI- Specifies the amount of memory to be used when invoking the Java virtual
GRATE_MEMORY | machine (JVM). This environment variable should be specified with a num-
ber, which refers to the amount of memory in megabytes. If SYBMI-
GRATE_MEMORY is not set, JVM uses the default memory setting of
512MB.

Migrating Proxy Tables

sybmigrate supports the migration of proxy tables. If you are planning to migrate proxy
tables, you should do the following before you begin migration.

» Make sure that the remote servers involved in proxy table defintions is present in the target
server interface file.

» Inorder to verify the DDL execution time, the remote server has to be accessible when the
migration is performed.
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Migration process

The goal of sybmigrate is to provide a means to migrate all objects and user data that exist on
the source Adaptive Server. However, when migration takes place, there is some server-wide
data that needs to be migrated before any user data or user objects can be migrated to
individual databases.

The hierarchy of objects dictates the order in which objects are re-created. Generally, server-
wide objects from the master database are created first. Independent objects like default
languages and character are migrated to the target server before data from individual
databases.

Overview of the Migration Process

The migration procedure consists of configuring the source and target SAP ASE servers,
setting up the migration paths, migrating objects, and validating the migrated objects.

The setup session establishes the migration paths from the source database to the target
database. The setup creates the repository database and the work databases, and registers the
option to migrate the server data. The setup session can only be executed by an “sa” login.

The migrate session is used to migrate objects and data from the source database to the target
database.

The validate session validates the migrated objects. Validation ensures the integrity of data
and objects that have been successfully migrated from the source database to the target
database.

sybmigrate does not migrate an archive database if an entire installation is being migrated.

sybmigrate migrates an archive database only if the archive database is specifically selected
for migration. When you migrate an archive database to a target server, sybmigrate
automatically creates a traditional database—rather than an archive database—on the target
server.

Pre-migration Considerations

You must have the source SAP ASE server and the target SAP ASE server running
concurrently when you migrate data from one to the other.

sybmigrate assumes that the target SAP ASE server has been installed and configured prior to
data migration. Use srvbuild or syconfig to create a new SAP ASE server with the required
logical page size.

Keep the following items in mind prior to migration, when you are creating the target SAP
ASE server and configuring the source SAP ASE server:
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« sybmigrate requires allow resource limits to be set to 0.

« If metadata already exists on the target server, you cannot migrate server data.

« When you create a new SAP ASE server with a different logical page size into which you
want to migrate data, you must adequately adjust the size of the database on the target SAP
ASE server to accommaodate the inbound data. If you are migrating data to an SAP ASE
server with a larger logical page size, this is especially important.

Use the space estimation report, space_est, to determine how much space is available on
your target database.

» To speed the migration process, you can run multiple sessions of sybmigrate within the
same server. However, running more than one session of sybmigrate on the same source
and target database path is not allowed.

< You must manually create segments on the target database before migrating tables and
indexes.

« The datatransfer rate for sybmigrate is configured through CIS bulk insert array size. The
default configuration for CIS bulk insert array size is 50 rows. This means that as many as
50 rows of data are buffered by CIS before being transferred to the target SAP ASE server.
To increase throughput, increase the configuration of CIS bulk insert array size to a larger
value.

However, increasing CIS bulk insert array size causes the source SAP ASE server to use
memory from the operating system for local buffers. This can lead to excessive
consumption of operating system memory.

SAP recommends that if you do choose to increase the CIS bulk insert array size default
value, you do so modestly. See the CIS documentation for more information.

e ClIShbulkinsertarray size has no effect on data throughput if the table being transferred has
a text, image, or Java ADT column. When a table has a text, image, or Java
ADT column init, all data is migrated one row at a time, for the duration of the migration of
that particular table. Also, no array buffering takes place.

« Asthe data migration is being done using CIS bulk transfer, the value for the configuration
parameter CIS packet size on the source SAP ASE server can affect the speed of the data
transfer. The recommended value for CIS packet size on the source SAP ASE server is the
logical page size (2K, 4K, 8K, or 16K) of the target SAP ASE server.

* max packet size allowed on the target SAP ASE server should match the value of CIS
packet size on the source SAP ASE server.

For more information on max packet size allowed, see the Systern Administration
Guide.

« To maximize the performance of sybmigrate, increase the additional network memory
configuration parameter on the target SAP ASE server to a value larger than the default.
For more information on additional network memory, see the System Administration
Guide.

« All the above considerations affect the max memory configuration parameter. Before
migrating your data, make sure that max memory is set to a sufficiently large value.

» There are three types of data that are migrated: server data, database data, and user objects.
To migrate metadata (the server and database data), the target SAP ASE server must be

Utility Guide 311



CHAPTER 10: Using sybmigrate to Migrate Data

newly installed so that the migrated metadata does not conflict with any residual data from
previous usage.

If you are migrating only user objects, you can use a previously used SAP ASE server. For
user data however, the target tables must be empty.

Before migrating data, create the databases into which you want to migrate data on the
target SAP ASE server. The databases should have the same name that they have on the
source SAP ASE server.

To enable conversion of character sets that do not have an internal SAP ASE conversion
routine, configure the target SAP ASE server with enable unicode conversions set to 1.
Determine the size of the named caches and buffer pools on the target SAP ASE server.
sybmigrate does not migrate cache configurations. You can use the information that is
generated by ddigen and apply it to the target SAP ASE server, or you can choose to
configure larger amounts of memory, in light of the larger page size being used.
However, sybmigrate migrates cache bindings, therefore if the required cache is not in the
target SAP ASE server, warnings are generated in the migration log.

Before running sybmigrate, you must install the desired languages on the target SAP ASE
server. The default language should be the same on the source and the target SAP ASE
server.

If there are user messages on the source SAP ASE server that are not installed on the target
SAP ASE server, sybmigrate aborts user message migration and reports an error.

If you are migrating Java columns, you must enable Java on the source and target SAP ASE
server prior to migration. Enter:

sp_configure 'enable java', 1

To complete the migration, the source and target SAP ASE servers must have different
local server names. Set the local server name, and then restart the servers for the change to
take effect.

To migrate an SAP ASE server using single-byte character sets to an SAP ASE server
using multibyte character sets (utf8):

1. Use sybmigrate to migrate to a server using the same, single-byte character set.

2. Change the character set to multibyte after migration is complete.

sybcluster cannot migrate data directly from an SAP ASE server using single-byte
character sets to an SAP ASE server using multibyte character sets.

See also

sybmigrate on page 156

Configuration and Tuning for Higher Performance

Depending upon your server resources, you can configure sybmigrate and the SAP ASE
server for optimal performance.

Copy threads and create index threads are used to migrate tables and re-create indexes. When
you are configuring sybmigrate during setup mode, the values of COPY_THREADS and
INDEX_THREADS can increase the speed at which sybmigrate copies and migrates data.
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The number of copy threads controls the number of tables for which data migration is done
simultaneously. One copy thread is assigned to each table. When the thread has successfully
completed one task, it moves on to another. Depending upon the size of your database and the
resources for your SAP ASE server, you can increase the number of copy threads used during
the migration process to improve performance.

Note: When you are migrating a large number of objects in parallel, check the value of
SYBMIGRATE_MEMORY to verify that there is sufficient memory allocated to
sybmigrate.

Index threads control the number of threads used to re-create indexes on the target SAP ASE
tables. One thread per table is used to re-create the indexes. Once the indexes have been re-
created on a table, the thread proceeds to the next successfully migrated table. Any threads

without a task exits. The number of create index threads is expected to be substantially smaller
than the number of copy threads.

If you configure INDEX_THREADS to a large number, be sure that the target SAP ASE
server is also configured with a large number of sort buffers. The use of index threads takes up
space in the target database, so make sure that the target database is configured with adequate
space for the designated number of index threads. Also, you must configure the target database
with extra space if you are going to be re-creating clustered indexes.

Configuration Considerations for SAP ASE
There are several configuration parameters on both the source and target SAP ASE server that
affect the performance of the migration process.

Configuration parameters that affect the source SAP ASE server:

Parameter Description

cis packet size Should be equal to max page size of the target SAP ASE server.

number of user Should be high enough to accommodate the migration of multiple tables simul-
connections taneously according to the value of COPY_THREADS and IN-
DEX_THREADS.

max parallel de- | Should be set to a value that is larger than the largest number of partitions in a
gree single table. Data migration is done in parallel, and if max parallel degree is not
set to a value large enough to accommodate the partitioned tables, the tables do
not migrate.

number of worker | Data migration for partitioned tables requires one worker thread per partition.
processes Therefore, if fpartitioned tables with p partitions each are migrating simultane-
ously, configure a total of #multiplied by pworker threads on the source SAP
ASE server.
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Parameter

Description

cis bulk insert
batch size

Controls the number of rows after which the data transfer transaction is com-
mitted. The default value is 0. Using the default value is the safest way to ensure
data integrity while migrating data, but it can result in a large number of page and
row locks on the source SAP ASE server. To reduce the number of locks, increase
this value. If you increase the value of cis bulk insert batch size, only a partial
data migration completes if an error occurs during the process. In this situation,
manually truncate the target table and restart sybmigrate.

cis bulk insert ar-
ray size

Controls the number of rows that are copied in bulk at one time. The default is 50
rows per batch. For faster data migration, increase this value. If the table contains
text or image columns, the data is transferred one row at atime, regardless of
the value for cis bulk insert array size.

The following configuration parameters on the target SAP ASE server affect the performance

of sybmigrate:

Parameter

Description

max network pack-
et size

Should be set to a value that is at least equal to max page size.

number of user
connections

Should be set to accommodate the migration of multiple tables in parallel and
partitioned tables. For parallel data transfer for partitioned tables, worker pro-
cesses are required on the source SAP ASE server, but user connections are
required on the target SAP ASE server. If you are migrating partitioned tables,
set the number of user connections on the target SAP ASE server to the same
value as number of worker processes on the source SAP ASE server.

number of sort
buffers

The default value of 500 is sufficient during the migration process. You can
increase this value when sybmigrate rebuilds the indexes, especially if you are
migrating indexes on partitioned tables.

Possible Errors to Avoid

Before beginning the data migration process, sybmigrate checks for the following error
conditions. If any of these conditions are detected, the migration procedure is aborted.

« A target table with existing data — any attempt to migrate data to a table that already
contains data results in the failure of sybmigrate.

« A target table with existing indexes — the presence of indexes on a target table causes
sybmigrate to operate in slow bcp. Manually drop all indexes before you begin the data

migration.

« Unmatching numbers of partitions on the source and target tables — if the number of
partitions on the source and target table do not match, the attempt to migrate data fails.
sybmigrate only migrates data; it does not redistribute it across partitions.
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Auto-select Dependent Objects for Migration
When you use the auto-select feature, sybmigrate selects dependent objects for migration.

We recommend that you use the auto-select feature for a successful migration because it
checks for the existence of dependent objects, and automatically migrates them to the target
SAP ASE server.

Migrating an Archive Database
sybmigrate does not migrate an archive database if an entire installation is being migrated.

sybmigrate migrates an archive database only if the archive database is specifically selected
for migration. When you migrate an archive database to a target server, sybmigrate
automatically creates a traditional database—rather than an archive database—on the target
server.

Upgrading an SAP ASE Server with an Archive Database

You cannot upgrade an archive database. If you load a database dump from an older version of
SAP ASE onto an archive database hosted on a newer version of SAP ASE, the database is not
internally upgraded when you execute online database.

If you upgrade an SAP ASE server containing an archive database, all the databases except the
archive databases are upgraded. The archive database remains on the older version of SAP
ASE server.

SAP recommends you reload the archive database with a dump generated from an already
upgraded database.

For more information about upgrading SAP ASE, see the installation guide for your platform.
Downgrading an SAP ASE Server with an Archive Database

When you are downgrading to a version of SAP ASE that does not support archive databases,
be aware of the following:

* If you must downgrade an SAP ASE server containing an archive database to a version of
SAP ASE that does not support archive databases, SAP recommends you drop the archive
database before you downgrade.

To eliminate the new sysaltusages table, drop the scratch database before you
perform the downgrade procedure. sysaltuages does not cause any problems if the
scratch database is not dropped.

« Backup Server versions 15.0 ESD #2 and later writes a format for compression (with
compression = compression_level) so that the dump can be loaded into an archive
database. Therefore, if you must load a compressed dump onto a version of SAP ASE that
does not support archive databases access, use the same version of Backup Server that
created the compressed dump to load the compressed database dump. An earlier version of
Backup Server does not support the new format of the compressed database dump.
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When you are downgrading without compression, you need not worry about Backup
Server at all.

GUI Mode

You can use either the GUI or the resource file mode for the migration process. You can also
elect to run parts of the migration process in GUI mode, and parts of it in resource file mode.

When you run sybmigrate, there are three phases of the migration process that you must
follow: setup, migrate, and validate.

See also

» Setting Up Source Databases for Migration on page 316
*  Begin the Migration on page 319

» \Validating the Migration on page 321

Setting Up Source Databases for Migration
Before migrating data, indicate your source and target SAP ASE servers and register the paths
between the source and target databases they contain.

To do this, start sybmigrate with the -m setup command line option, or by selecting “Setup
source databases for migration” when you are prompted in the Session Type window.

1. The Connect to ASE window allows you to designate the source and the target SAP ASE
servers for your migration process.

* Choose from the drop-down menu in the Server fields. The menus provide a list of SAP
ASE servers that are located in the default interfaces file (SSYBASE/
interfaces on UNIX or $SYBASE%\ini\sqgl.ini on Windows) or in the
interfaces file that you specify with the —I command line argument.

If you are not using the interfaces file, you cannot use the —I command line
argument; you must specify the source and the target SAP ASE servers in the Aost. port
format.

« During the setup phase, you must be logged in to the servers as a System Administrator.
Enter “sa” into the Login field, enter your password, and select Connect.

Note: You can run only one session of sybmigrate at a time. Therefore, if there is another
user running sybmigrate on the same source and target SAP ASE servers, you see the error
message “Setup session lock: Either previous setup exit abnormal or there is another setup
session running. Do you want to override?” You can override the session lock because it is
possible that the previous session may have crashed or quit prematurely.

Before proceeding with the setup and migration process, verify that there are no other
users running sybmigrate. If there is more than one user running sybmigrate
simultaneously, Sybase cannot guarantee data integrity.
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2. The Session Type window prompts you to select the type of operation you want to perform.
Choose from:

« Setup source databases for migration

* Migrate database objects and data

« Validate the migrated objects and data

« Reports — when you select Reports, a Reports type window displays. You can choose
from status, space_est, repl, diff, or password. When you select either the space
estimation or the replication report, a Report Paths Window prompts you to select the
database paths on which to run the reports.
The Password, Status, and Replications reports are disabled if the setup session has not
been completed between the source and target SAP ASE servers.

If you started sybmigrate with the —m option specifying setup, migrate, validate, or
reports you do not see this window.

3. Use the Setup wizard to prepare databases for migration. The Setup wizard displays
several windows:

» Choose Database window
This window prompts you to select the source and target databases located within your
source and target SAP ASE servers, so that sybmigrate knows where to put the data
from the source SAP ASE server in the target SAP ASE server.

Note: The source and target databases must have identical names.

The Source Database drop-down list has a list of the databases in your source SAP ASE
server.
The Target Database drop-down list has a list of the databases available in the target
SAP ASE server. sybmigrate requires that you create the databases in the target SAP
ASE server before beginning the migration process.
The migration path is a selected source and target database pair.

» Configure DDL threads
Choose the number of threads to be used to create database objects on the target server
for the specified migration path.

« Configure copy threads
Chose the number of threads to be used to copy data from the source to the target for the
migration path. Make sure you use sufficient numbers of threads for systems with
multiple engines.

» Configure index threads
Chose the number of threads to be used to create indexes on the target server for the
specified migration path. Make sure you use sufficient numbers of threads for systems
with multiple engines.
You control the number of threads used for parallel table transfer. When several tables
are transferred concurrently, each table requires a one-server-to-one-server CIS
connection.
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Suppose the data migration is performed on unpartitioned tables (each table contains a
single partition). When you migrate such tables, a single server-to-server connection is
established, which uses a single user connection on the source SAP ASE server and a
single user connection on the target SAP ASE server.

If the data migration is performed on 7+way partitioned tables, the data transfer is
performed in parallel with an 7-way degree of parallelism. This requires 77 worker
processes on the source server and 2/ user connections on the target server.

For example, suppose you have 10 n#way partitioned tables to migrate. You use four
threads in sybmigrate, and configure the source SAP ASE server to have at least four
worker processes and eight user connections. You must configure the target SAP ASE
server to have at least eight user connections.

Note: The value you assign to each property in the setup session becomes the default
value. You can temporarily override default values in the migrate or validate session. Limit
these values to the resources available to the SAP ASE server.

Configuring the work database

sybmigrate requires at least one work database during the migration process. The
Database size field provides a default value in megabytes. The default value is based on
the number of copy and create index threads specified in a previous window. The
default is the minimum value; you can increase but not decrease it.

The Device field lets you indicate the device on which to create the work database.

Note: When migrating from a source SAP ASE version 12.0 through 12.5.0,

sybmigrate also requires a work database on the target server. The wizard prompts for

the same information for the target work database.

Current paths

Review the migration paths you have selected. Right-click a migration path to display

edit and delete options.

You can add paths by selecting Add Migration Path. To add paths later on, rerun

sybmigate in Setup mode.

Configure repository

sybmigrate creates a repository database on the source server to track the migration of

all migration paths. The default database size is a minimum; you can increase but not

decrease it.

Migration of server-wide data

You can choose whether or not to migrate information in system catalogs, such as login

information. The options are:

* Yes —server-wide data is migrated at the end of the Setup phase.

* No-server-wide data is not migrated. You can return to this window and choose to
migrate data at any time—as long as database migration has not yet begun.

* Undecided — allows you to return and choose another migration option later on.
However, you cannot begin the Migration phase until you have chosen Yes or No.
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Undecided is useful when you want to set up the migration process, but plan to
migrate data at a later date.
If the target server already has been configured for logins or other server-wide
information, sybmigrate defaults this option to No.
The Options button provides advanced options for handling login accounts. The
options let you specify:
*  Whether or not to lock login accounts after migration
* How to handle login passwords when migrating across platforms
* No change — use when migrating to the same platform (default)
* Generate random passwords
« Assign passwords from a list in a file
e Summary
Displays a summary of options chosen. Click Finish to perform the chosen setup tasks.

4. The Setup Progress window displays the progress of the setup phase.

During this time, sybmigrate is creating the repository database, installing the database
schema, creating a working database for each selected path, and migrating the server data
based on your selection, in that order. If you are running sybmigrate in setup mode a

subsequent time, it is creating new paths for data migration. If you do not want to create
new paths, there is no reason to run sybmigrate through the setup mode more than once.

You can to view the progress in the log by clicking Show Log. The completion of the setup
process is indicated when the Current Task window displays DONE, and when the log
shows SETUP_COMPLETE. Click Close to exit the log and the Setup Progress window.

5. You return to the Connect to ASE window. Select Quit to exit sybmigrate. To begin the
migration phase of the data migration process, exit sybmigrate and restart it in the migrate
mode.

See also
e GUI Mode on page 316

Begin the Migration
After you have completed setup, you are ready to begin migrating.

Restart sybmigrate with the -m migrate command line option, or choose the migrate
database objects and data option from the GUI window.

1. Inthe Connectto ASE window, select the source and target SAP ASE servers to which you
want to connect.

2. Ifyou have not started sybmigrate with the -m migrate command line argument, select
the session type in the Session Type window.

3. The Object Selection window allows you to choose what types of database data you want
to migrate.
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In the Object Selection window, you can set the Copy thread, create index thread, and work
thread parameters from the Setting menu bar.

In the Object Selection window, you can also request that sybmigrate Auto-Select
Dependent Objects on your selected objects by right clicking the object tree node.

When you expand the database data folder, there is a file for each path that you created
during setup. Each file allows you to select the data you want to migrate for that particular
database. You can choose from the following:

¢ Database Data

Note: If you choose to migrate database data, you must migrate all of it. If you deselect
parts of the database data, you see an error message asking you whether or not you want
to migrate database data.

If you do not migrate the server data during setup, the Database Data selection is
disabled.

e Defaults

e Rules

» User-defined Datatypes
e Tables

e Indexes

« Referential Constraints
e Views

« Stored Procedures

o Triggers

The Status field for these objects indicates whether or not the data has successfully
migrated. “Success” indicates that the data has already migrated. “Initial” means that the
migration has not yet begun. If you find an error in the data that has been migrated, you can
reset the Status field to Initial so that the data migrates again. The validation process acts
only on those objects that have been migrated successfully, so to begin the validation
process without all of the data having successfully migrated, reset the Status field to
Success. “Work in Progress” means that the object was selected for migration, but that the
migration was not attempted because there was some error causing sybmigrate to exit
abnormally.

You can see whether or not the server data has been selected to be migrated, but this is for
informational purposes only since the server data has already been migrated at this pointin
the migration process.

When you have selected the data that you want to migrate, click Migrate.

See also
*  GUI Modeon page 316
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Validating the Migration

The validation phase is the same as the migrate phase.

The windows ask you to indicate the same information, but rather than selecting data for
migration, you are selecting data for validation.

You can validate only those objects that have successfully been migrated.

See also
*  GUI Modeon page 316

Migration and Validation Progress

sybmigrate keeps you informed of the migration and validation progress on the Migration/
validation screen. It shows migration progress, messages reported, and a summary count of
objects pending, failed, and succeeded for each task type.

You can select Cancel at any time, which starts a graceful shutdown of the execution progress.

Resource File Mode
Make these changes to the resource file mode:

e data_copy_thread, create_index_thread, and work_thread attributes are recognized in
the setup, migration, and validate sessions of sybmigrate. In the setup session, these
values are recorded in the repository database, and used as default values during the
migrate and validate sessions. During the migrate and validate sessions, you can override
the default values by specifying a new value.

* lock_accountisanew login account management feature. lock_account tells sybmigrate
to lock or unlock all accounts on the target SAP ASE server after copying the login
information. Valid values are “Yes” and “No”, with “Yes” instructing sybmigrate to lock
the target SAP ASE server accounts. To activate lock_account, you must set
migrate_server_data to “Yes” in the setup session.

If the lock_account attribute is not set, nothing is done to target login accounts.

* login_password_file has been added to support changing the passwords on the target SAP
ASE server. In the setup session, login_password_file takes the input password file or the
value “<generate>". “<generate>" is a special key used to tell sybmigrate to generate the
passwords instead of reading them from the password file. If this attribute is not set in the
resource file during the setup session, there is no change to the target SAP ASE server
login passwords. To activate login_password_file, you must set migrate_server_data to
“Yes” in the setup session.

« The password file must be in plain text. The content of this file consists of two columns: the
login name column and the password string column. The separator between the columns
are tabs and or spaces. Any lines beginning with “#” are comments.

e auto_select_dependent_objects is a new value that is available during the migrate and
validate sessions. This attribute tells sybmigrate to automatically select the dependent
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objects for migration and validation. The valid values for this attribute are either “Yes” or
“No”; “No” is the default.

» If source_ase, source_ase_login, source_ase_password, target_ase,
target_ase_login, and target_ase_password attributes are not in the resource file,
sybmigrate prompts the user for these attributes.

» In the database section of the resource file, if you do not specify any objects or SQL, all
objects and types are selected.

For example, in the following resource file all object types (default, rule, table, and so on)
are migrated from pubs?2 and pubs3 databases:

[server}

source ase=tho:5002

source ase login=sa

source_ ase password=

target ase=tho:6002
target ase login=sa
target ase password=

[database]
source database name=pubs2
target database name=pubs2

[database]

source database name=pubs3

target database name=pubs3
Resource file mode is a non-interactive mode. The resource file contains all the information
required for migration. You can use the resource file mode if you do not have GUI support or if
you need to run batch files.

If you do not specify any object type attributes to migrate in the resource file, sybmigrate
migrates the entire database.

If you do not specify the source or target SAP ASE server login or password in the resource
file, sybmigrate prompts the user for this information.

Following is the format for the resource file to run sybmigrate in noninteractive mode. To
create a resource file, type all the values into a file:

#

# This is a sample Migration Tool resource file.

# This resource file will migrate objects in pubs2,
# pubs3, and foo databases.

#

FHEFHE A A A A A A R R A
# Server wide information
G i
[server]

# "<host name>:<port number>" or just server name.
source ase=tho:5002

source ase login=sa

source ase password=
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# "<host name>:<port number>" or just server name.
target ase=tho:6002

target ase login=sa

target ase password=

# Repository database setup attributes. This is
required with "setup" mode.

# Repository database size in MB.

repository database size=7

# Device used to create the "sybmigrate" database.
repository device=master

# Migrate server wide data - logins, roles, remote servers, etc...
# valid only with "setup" mode, default is yes
migrate server data=yes

# Tell sybmigrate to lock or unlock all login accounts on the

# target Adaptive Server. Valid values are "yes" and "no":

# "yes" to lock and "no" to unlock. This is only valid if

# "migrate server data" is set to "yes" and run in "setup" mode.

# If this attribute is not specified, target Adaptive Server login
# accounts are not change.
lock account=no

# Change target Adaptive Server login passwords. This is only valid
# 1f "migrate server data" is set to "yes" and run in "setup" mode.
# If this attribute is not specified, target Adaptive Server login
# accounts are not change.

# The valid values are "<generate>" and password file.

# "<generate>" instructs sybmigrate to use random passwords.

# Password file instructs sybmigrate to use the passwords from

# this file.

# The content of the password file consists of two columns:

# the login name column and the password string column.

# The separator between the columns are tabs and or spaces.

login password file=<generate>

E R
# Database information

E
#

# Migrate the "pubs2" database objects

#

[database]

# Specify the source target database to migrate.
source database name=pubs2

target database name=pubs2

# Migrate database data, valid only if "migrate server data"
# was set to "yes" in "setup" mode. This is default to yes.
migrate database data=yes

# Work database setup attributes. This is required with "setup"
mode.
# Work database size in MB.
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work database size=5
# Device used to create the work database.
work database device=master

# Number of threads use to do user table data copy
data copy thread=5

# Number of thread use to create indexes.
create index thread=1

# Number of thread use to do ddl migration/validation
work thread=10

# Automatically select the depedent objects for migration and
# validation. Valid values are "yes" or "no".
auto select dependent objects=yes

# Migrate objects

These attributes specify the list of DDL object to
migrate or validate. User can directly specify the
list of DDL object or ask Migration tool to query the
list. Directly specifying the list has the higher
precedence. The SQL command will ignore if the list
is given.

Note:

* The SQL command for the "* list from sqgl" attributes
must return column <object name> or columns <user
name> and <object name>

* Index type must also specify the table name. For
example, "<table>.<index name>" for

"index create list" attribute or columns <table>,
<index name> for "index create list from sqgl"
attribute.

* Value "<ALL OBJECTS>" can be used on any of the
attributes to specify all objects for the type.

* If none of these attributes are given, all objects
and data are migrated.

H= S S S S S S S S SR S SR S S S SH Sk S SR S S S S S

user defined type create list=
id
dbo.tid

default create list from sqgl=
select user name (uid), name from sysobjects
where type = 'D'

rule create list=
pub idrule, title idrule

table create list=
publishers

titles

dbo.authors
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dbo.titleauthor
dbo.roysched
stores
dbo.sales
dbo.salesdetail
dbo.discounts
dbo.au pix
blurbs

table migrate list=

dbo.publishers titles dbo.authors dbo.titleauthor
dbo.roysched

stores dbo.sales dbo.salesdetail dbo.discounts au pix
dbo.blurbs

index create list=
dbo.authors.auidind
dbo.authors.aunmind
publishers.pubind
roysched.titleidind
sales.salesind
salesdetail.titleidind
salesdetail.salesdetailind
titleauthor.taind
titleauthor.auidind
titleauthor.titleidind
titles.titleidind
titles.titleind

trigger create list=
deltitle
totalsales trig

store procedure create list from sql=
select name from sysobjects where type = 'P'

view create list from sql=<ALL OBJECTS>

referential constraint create list from sgql=<ALL OBJECTS>
logical key create list from sql=<ALL OBJECTS>
A R R

#

# Migrate the "pubs3" database objects
#

[database]

source database name=pubs3

target database name=pubs3

# Migrate database data - user, etc.
migrate database data=yes

# These two attributes valid only with "setup" mode
work database size=5
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work database device=master

# Number of threads use to do user table data copy
data copy thread=5

# Number of thread use to create indexes.
create index thread=1

# Number of thread use to do ddl migration/validation
work thread=10

# Migrate objects
user defined type create list=<ALL OBJECTS>

default create list=<ALL OBJECTS>
rule create list=<ALL OBJECTS>

table create list=
dbo.authors
publishers
dbo.titles
dbo.roysched
stores

dbo.sales
dbo.store employees
salesdetail
dbo.titleauthor
dbo.discounts
blurbs

table migrate list from sql=<ALL OBJECTS>

index create list=<ALL OBJECTS>

trigger create list=<ALL OBJECTS>

store procedure create list=<ALL OBJECTS>

view create list=<ALL OBJECTS>

referential constraint create list from sgl=<ALL OBJECTS>
logical key create list from sql=<ALL OBJECTS>
A R R

#

# Migrate all the "foo" database objects with default settings.

#

[database]

source database name=foo
target database name=foo

# Migrate database data - user, etc.
migrate database data=yes
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# These two attributes valid only with "setup" mode
work database size=5
work database device=master

# Number of threads use to do user table data copy
data copy thread=5

# Number of thread use to create indexes.
create index thread=1

# Number of thread use to do ddl migration/validation
work thread=10

Using sybmigrate with Encrypted Columns

For databases with encrypted columns, sybmigrate migrates the following.

1. The system encryption password — if you specify not to migrate the system encryption
password, sybmigrate migrates the encrypted columns using the reencrypt method
instead of migrating the ciphertext directly.

2. Encrypted columns in cipher text format by default — this avoids the overhead of
decrypting data at the source and reencrypting it at the target. In some cases, however,
sybmigrate chooses the reencrypt method of migration, which does decrypt data at the
source and reencrypts it at the target.

3. The encryption keys — you may select the keys to migrate. sybmigrate automatically
selects keys in the current database used to encrypt columns in the same database. If you
have selected migration of the system encryption password, sybmigrate migrates the
encryption keys using their actual values. The key values from the sysencryptkeys
system table have been encrypted using the system encryption password and these are the
values that are migrated. If you have not migrated the system encryption password,
sybmigrate migrates the keys by name, to avoid migrating keys that will not decrypt
correctly at the target. Migrating the key by name causes the key at the target to be created
with a different key value from the key at the source.

4. The data— by default, the data is transferred in its ciphertext form. Ciphertext data can be
migrated to a different operating system. Character data requires that the target server uses
the same character set as the source.

sybmigrate works on a database as a unit of work. If your database on the source server has
data encrypted by a key in another database, migrate the key’s database first.

sybmigrate chooses to reencrypt migrated data when:

« Any keys in the current database are specifically not selected for migration, or already
exist in the target server. There is no guarantee that the keys at the target are identical to the
keys are the source, so the migrating data must be reencrypted.
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e The system password was not selected for migration. When the system password at the
target differs from that at the source, the keys cannot be migrated by value. In turn, the data
cannot be migrated as ciphertext.

e The user uses the following flag:
sybmigrate -T 'ALWZ—\YS_REENCRYPT '

Reencrypting data can slow performance. A message to this effect is written to the migration
log file when you perform migration with reencryption mode.

To migrate encrypted columns, you must have both sa_role and sso_role enabled.

Post-migration Activities

These are additional activities you perform after migration.

Activity Description

Migratesche- | sybmigrate supports the migration of only the objects listed elsewhere in this
ma obj ects, document. Manually migrate other schema objects and configuration information
configuration | to ensure the target SAP ASE server is fully functional.

information

Statisticsfrom

Statistics for indexes are automatically re-created when you rebuild the indexes.

non-index col- | However, sybmigrate does not re-create statistics from non-index columns. Any

umns user-defined step values for index statistics are not retained during migration. To
obtain target-server-side statistics similar to the source-server-side statistics, use
optdiag to identify the tables with non-index columns that include statistics. Once
you have determined which non-index columns include statistics, update the sta-
tistics manually.

M essages Any message requiring user attention preceded by the word “attention” and logged
in the migration log.

Statusreport Run the object migrations status report to verify that all objects have been migra-
ted.

Clean up When you no longer need to perform additional sessions (such as to validate or to

source and tar- | report), clean up the source and target SAP ASE servers. On the source SAP ASE

get servers server and target SAP ASE servers:

« Drop the temporary working databases mt pdb $%.
» Drop the repository database sybmigratedb.
e Drop all remote servers mtrs$%.
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Migrate Databases in the Replication Server Domain

The Replication Server domain includes one or more of these types of databases.

e Primary databases
* Replicate databases
* Replication Server System Databases (RSSDs)

Note: The RSSD stores Replication Server system tables; in addition, it can also be a primary
or a replicate database.

You can migrate any of these databases, but the process requires additional steps to ensure
success.

Preparing for Migration
Make sure that replication from or into each database is complete before initiating migration.

This means that:

» For a primary database — all changes have been applied to all subscribing databases
» Forareplicate database — all changes to which the database subscribes have been applied

Note: All transactions in the Replication Server inbound and outbound queues must be
applied. After migration, there is no way to restore data left in the SAP ASE transaction log.

1. Log in to the Replication Server and suspend log transfer. Enter:
suspend log transfer from server.database

2. Log into the SAP ASE server, and shut down the RepAgent. Enter:

use database
sp_stop rep agent database

3. Suspend all DSI connections to the replicate database. Log in to the Replication Server and
enter:

suspend connection to server.database
4. Put the Replication Server in hibernation mode. Enter:
sysadmin hibernate on, replication server
Before starting the migration process, sybmigrate records replication information in its log.

The information needed to restore the replication information during the postmigration steps
can be retrieved from this log.

See also
Postmigration Procedures on page 330
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Postmigration Procedures

After migration, restore the replication information in the database. These steps can be
generated by the repl report.

If the page size changes between the source and target, amend the system tables.

Replication Server identifies all connections by server name.database _name. After
migration, you must change the name of the target server (the server you are migrating to) to
that of the source server (the server you are migrating from).

See also

*  Amending System Tables When the Logical Page Size Changes on page 331
e Restoring Primary Databases on page 330

» Restoring the RSSD on page 331

Restoring Primary Databases
Follow this procedure for all primary databases, including the RSSD, if it is a primary
database.

If the page size changes during the migration, you must also alter the rs _lastcommit and
rs_threads system tables.

1. If the original primary database had warm standby on, restore the standby status. Enter:

sp_reptostandby database name, status

sybmigrate saves the standby status in the migration log of the source database.
2. Increase the generation ID by 1. Enter:

dbcc settrunc ("ltm", "gen id", gen 1id)

You can view the current generation 1D in the migration log of the source database.
3. Reset the secondary truncation point:

dbcc settrunc ("1ltm", "valid")
4. Zero the Replication Server locator value for this database. Enter:

rs zeroltm server, database name

5. Ifthis database is an active connection in a warm standby configuration, rematerialize the
standby database by dumping the primary and loading the dumps into the standby. See the
Replication Server documentation for instructions.

6. Start the RepAgent on the primary database. Enter:
sp_start rep agent database name
7. Log into the Replication Server and restart log transfer:

resume log transfer from server.database
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See also

* Amending System Tables When the Logical Page Size Changes on page 331
»  Postmigration Procedures on page 330

» Restoring Replicate Databases on page 332

Restoring the RSSD
Follow this procedure to restore the RSSD.

1. If the RSSD is a primary database, restore the primary databases.
If the page size changes, make sure you alter the rs lastcommit and rs_threads
system tables as instructed.

2. Turn off hibernation for the Repliction Server. Log in to Replication Server and enter:

sysadmin hiberate off replication server

See also

» Restoring Primary Databases on page 330

e Postmigration Procedures on page 330

e Restoring Replicate Databases on page 332

Amending System Tables When the Logical Page Size Changes
Follow this procedure for all databases in which the page size has changed.

If the logical page size changes during migration, you must alter the rs_lastcommit and
rs_threads system tables to account for the change.

1. Alterthe rs lastcommit table. Enter:

declare @pad8 size integer
declare @alter cmd varchar (200)

select @pad8 size = (Q@maxpagesize / 2)
- (select sum(A.length) from
syscolumns A, sysobjects B

where A.id = B.id

and B.name = 'rs lastcommit')

+ (select A.length from

syscolumns A, sysobjects B

where A.id = B.id

and B.name = 'rs lastcommit'

and A.name = 'pad8')

select @alter cmd = "alter table rs lastcommit "

+ "modify pad8 char ("

+ convert (varchar (100), @pad8 size)
+ 'l) n

execute (Qalter cmd)

go
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2. Alterthe rs_threads table. Enter:

declare @pad4 size integer
declare R@alter cmd varchar (200)

select @pad4 size = (Q@maxpagesize / 2)
- (select sum(A.length) from
syscolumns A, sysobjects B

where A.id = B.id

and B.name = 'rs threads')

+ (select A.length from

syscolumns A, sysobjects B

where A.id = B.id

and B.name = 'rs threads'

and A.name = 'pad4')

select @alter cmd = "alter table rs_threads "

+ "modify padZ char ("

+ convert (varchar (100), @pad4 size)
+ 'l) n

execute (Qalter cmd)

go

See also
Postmigration Procedures on page 330
e Restoring Replicate Databases on page 332

Restoring Replicate Databases
If the page size does not change during migration, there are no postmigration steps necessary
for replicate databases.

If the page size does change, amend the system tables. .

See also

*  Amending System Tables When the Logical Page Size Changes on page 331
»  Restoring Primary Databases on page 330

» Restoring the RSSD on page 331

Logs
In the migration tool log, information about replicated objects is preceded by this banner:

=== Replication Information for Database 'pdbl' ===

This is a sample log file for a primary database named pdb1:
sp_repostandby 'pdbl' is NONE.

If the standby status for the database is not NONE, use the standby status as described in the
post-migration steps above.

sp_config rep agent 'pdbl'
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sp_config_rep_agent requests the current RepAgent configuration. The migration tool
automatically restores RepAgent configuration, and you can use this log to verify the

RepAgent configuration.

Parameter name Default Config Value Run value
priority 5 5 5
fade timeout 30 30 30
scan timeout 15 15 15
retry timeout 60 60 60

rs username n/a rsl user rsl user
trace flags 0 8194 8194
batch 1tl true true true
rs servername n/a rsl rsl
send buffer size 2k 2k 2k
trace log file n/a n/a n/a
connect database n/a pdbl pdbl
connect dataserver n/a pdsl pdsl
can batch size 1000 1000 1000
security mechanism n/a n/a n/a
msg integrity false false false
unified login false false falses
kip 1ltl errors false false false
msg origin check false false false
short 1tl keywords false false false
msg confidentiality false false false
data limits filter mode stop stop stop
msg replay detection false false false
mutual authentication false false false
send structured ogids false false false
send warm standby xacts false false false
msg out-of-sequence check false false false
skip unsupported features false false false
send maint xacts to replicate false false false

(28 rows affected)

This is a list of explicitly replicated tables. sybmigrate automatically restores the replication
status for explicitly replicated tables, and you can use this part of the log to verify the
replication status of explicitly replicated tables.

sp_setreptable

Name Repdef Mode
tl owner off
t2 owner on

(2 rows affected)

This is a list of explicitly replicated stored procedures. The migration tool automatically
restores the replication status for explicitly replicated stored procedures, and you can use this
part of the log to verify the replication status of explicitly replicated stored procedures.

Sp_setrepproc

Name Type Log Mode
pl function log sproc
P2 function log current
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r3 table
p4 table
(4 rows affected)

log_sproc
log current

This is information about the secondary truncation page. You will need the
generation_id column during the post-migration steps.

dbcc gettrunc

secondary trunc page secondary trunc state

dbrepstat generation i

d
database id database name 1tl version
621 1 167 0
6 pdbl 400

(1 row affected)

This appears to be a replicated primary database.

Make sure the post processing steps for a replicated primary
database are performed. Please consult the manuals for

the steps that need to be performed.

This is an example log entry if your database is a replicate database.

This appears to be a replicate database.
If the pagesize is greater than 2K, make sure the
post processing steps for a replicate database

are performed. Please consult the manuals for the

steps that need to be performed.

This is an example log entry for an RSSD database.

This appears to be a replication system database

Make sure the post processing steps for a replication system
database are performed. Please consult the manuals for

the steps that need to be performed

All three logs can be present for a database, since a database can list the three categories.

Migrating Databases That Support Wide Data

SAP ASE version 12.5 and later can generate data wider than what Replication Server version
12.1and earlier can handle. If RepAgent passes wide data to Replication Server 12.1 or earlier,

Replication Server threads may shut down.

RepAgent communicates with Replication Server using Log Transfer Language (LTL). When
the RepAgent connects to Replication Server, it returns an LTL version.

Table 13. Replication Server and LTL versions

Replication Server version LTL version
12.1 and earlier <400
12.5 and later >= 400
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If Replication Server returns an LTL version less than 400, RepAgent uses the setting of the
data limits filter mode option to determine how to treat wide data.

You can set the data limits filter mode option using sp_config_rep_agent. Values for data
limits filter mode are:

« stop — RepAgent shuts down when it encounters data too wide for Replication Server to
process (the default when the LTL version is less than 400).

» skip — RepAgent ignores data too wide for Replication Server to process, and logs an
informational message.

* truncate — RepAgent truncates wide data so that Replication Server can process it. If the
table or stored procedures has more than 250 columns or parameters, only the first 250
columns or parameters are sent. If the column or parameter is wider than 255 bytes, only
the first 255 bytes are sent.

« off—RepAgent sends wide data to the Replication Server; Replication Server threads may
shut down.

This table shows column and width limits for Replication Server 12.1 and earlier and
Replication Server 12.5 and later:

Table 14. Replication Server column number and width limits

Property Replication Server 12.1 | Replication Server 12.5
and earlier and later

Column count 250 65535

Column width 255 65535

Limitations

When migrating server data, sybmigrate requires that the target SAP ASE server catalog
contain only default data. Default data on Windows machines is different from UNIX
machines. This causes problems when migrating from UNIX to Windows machines.

To successfully migrate from a UNIX machine to a Windows machine, delete the XP Server
name and the mon_user login on the target Windows machine.

Stopping High Availability

Data migration is not supported while you are in high availability. You must stop high
availability before beginning database migration.

1. Decouple primary and secondary SAP ASE servers.

2. Migrate primary source SAP ASE server and secondary source SAP ASE server data to the
primary target SAP ASE server and secondary target SAP ASE server separately.
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3. Configure the target SAP ASE server for high availability.

Warning! The primary and the secondary SAP ASE servers must be configured to the
same logical page size to run high availability.

Other Limitations

These are additional limitations for migration.

sybmigrate does not do any special processing for a DTM/XA environment. The status of
open transactions and outstanding prepared transactions should be given consideration. If
any special handling is required, you must do it manually.

There is no reliable way for sybmigrate to determine the dependency of various objects.
sybmigrate does not attempt to create an order in which objects are migrated based on
their dependencies on other objects. Views can be dependent upon other views, and they
will not be re-created if the view on which they are dependent has not yet been migrated.
The migration of stored procedures and triggers may not be successful if the data on which
they depend has not yet been migrated. Cross-database dependencies mean that you need
to coordinate the migration of related objects. If dependencies are within the selected set,
sybmigrate takes care of those dependencies. However, if dependencies exist outside the
selected set, you may need to run sybmigrate through migration more than one time. For
this reason, you may need to perform some partial retries to successfully complete the data
migration.

SAP ASE versions 12.5.3 and later allow you to specify the size and location of a work
database on your target server. When migrating a database or server from a source server
with SAP ASE versions 12.0 and later but earlier than 12.5.0.1, you must specify the size
and location of a work database on the target server.

The name of the source and the target databases must be the same. SQL schema generated
by ddigen may have objects that must be qualified with the source SAP ASE server name.
sybmigrate does not support any kind of auditing for migration activities.

When renaming any of the compiled objects (procs, views, rules, defaults) the object name
in syscomments is not updated.

During the migration, the ddigen query the object from syscomments with the old

name in the text. This old name in the text causes problems for sybmigrate during the DDL
migration.
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Troubleshooting and Error Messages

This section discusses common errors and how to address them, as well as different error
messages and their meaning.

Table 15. Migration-related errors and their descriptions

Issue

Description

Objects fail to migrate

Objects often fail to migrate on the first attempt. sybmigrate automatically
retries all failed migration attempts. However, if you choose to migrate an
object that is dependent upon another object that is not migrated, the
migration fails.

To prevent failed migration of objects, examine the dependencies of ob-
jects that you select for migration. For example, you cannot migrate a
trigger if the table on which the trigger is defined is not also migrated.
Similarly, views can be created on other views or tables, and if these objects
are not migrated, the migration of the view fails.

Beginning database mi-
gration

When you are in the setup phase of the migration process, you are asked to
decide whether or not you want to migrate server data. You must select
from yes, no, or undecided.

“Undecided” provides you with the flexibility of setting up the migration
process, but being able to return to the process at a later date that is more
convenient for migration. If you select Undecided, you cannot begin the

database migration until you indicate whether you want to migrate server
data.

If you indicate that you do not want to migrate server data during setup, you
cannot migrate database data during migration. You can override this lim-
itation in GUI mode.

“Connection refused”
and “Unable to obtain
connection to the serv-
er”

There are two possible reasons why you may encounter these error mes-
sages.

» If either the source or the target SAP ASE server is not running, syb-
migrate cannot establish a connection.

e The number of user connections configuration parameter must be
configured to provide sufficient resources on both the source and target
SAP ASE servers.

Target server cannot be
reached from source
server

The interfaces file is used to start the source SAP ASE server. Verify that it
has an entry that identifies the target SAP ASE server.

Verify that your login can access the target SAP ASE server from the
source SAP ASE server.
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Issue

Description

If sybmigrate hangs
during migration

If sybmigrate hangs during the migration process, check the sybmi -
gratelogin $SYBASE/SSYBASE ASE/init/logs forany
errors or exceptions.

Also, check your SAP ASE server logs. If the SAP ASE server logs run out
of space on the database, increase the database size, and install the
sp_threasholdaction stored procedure to do dump tran when the log is
full.

Merging two databases

To merge two databases on the source SAP ASE server into one database
on the target SAP ASE server, use the following procedure.

» Set up and migrate the first database.

»  After migrating the first database, rename the target database so that it
has the same name as the second source database.

» Set up and migrate the second database.

Note: You cannot migrate the database data for the second database be-
cause the users, roles and other database data already exist on the target
database. You can still migrate user data.

Post-migration failure
cleanup

If sybmigrate fails unexpectedly, rerun sybmigrate on the areas that failed.
If it fails again with no more progress, clean up the source and target SAP
ASE servers, and begin migration again. There are actions that you must
perform on both the source and target SAP ASE server.

On the source SAP ASE server:
» Drop the temporary working databases mt pdb $%.

» Drop the repository database sybmigratedb.
» Drop all remote servers mtrs$%.

On the target SAP ASE server:

» If server data was migrated, rebuild the target SAP ASE server with
srvbuild or syconfig.
* Re-create the target databases.

Remigrating one data-
base

To remigrate a specific database:

1. Start sybmigrate.

2. In the Setup Paths window, during the setup session, right-click the
migration path you want to redo.

3. Select Delete Migration Path on the pop-up menu.

4. Clean up or remove the migrated data and objects on the target data-
base, or drop and re-create the target database.

5. Restart sybmigrate and run it from setup mode.
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Issue

Description

Re-creating an individu-
al object

To re-create an individual object:

1. Inthe target SAP ASE server, drop the object you want to re-create.

2. Startsybmigrate in the migration session, and go to the Migrate Object
Selection window. Highlight the object you want to create and right-
click.

3. From the pop-up menu, select Reset Object to Initial status.
4. Complete the migration process.

Connection fail

If you receive a connection fail error message even though the source and
target SAP ASE servers are running, you may be using the wrong character
set. When you are using sybmigrate, you must use the default character
set. Run sybmigrate with the —J charsetoption, to change the character set
you are using.

“Insufficient memory in
JVM shared class”

If you see the following error in the server log, it indicates that you must
reconfigure the size of shared class heap configuration parameter to a
larger value.

01:00000:00036:2002/01/28 14:17:05.63 server Java
VM

Host: Memory allocation request failed because
of

insufficient memory in Jvm Shared Class.

“There is not enough
memory in the proce-
dure cache”

If you see the error message there is not enough memory
in the procedure cache duringthe migration of indexes, use
sp_configure procedure cache size to increase the procedure cache.

java.lang related error

If you receive java.lang.NoClassDefFoundError:com/
sybase/jdbcx/SybDriver when you are connecting to an SAP
ASE server, check to make sure you have jConnect 6.0 installed in your
$SYBASE directory (SSYBASE/jConnect-6_0).
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Databases

Use sybrestore to restore an SAP ASE database to the time of failure from the most current
full database backup dump files.

sybrestore can be used to restore a database:

« from the most current backup in the dump history.

« from the server integrated with Tivoli Storage Manager (TSM).

 to the same server or to a different target server.

« to different database name, or to a re-created new database on the same server.
» to a new database on a different target server.

e from cumulative dump.

« from a master database corruption.

sybrestore offers two modes—interactive and noninteractive—and is supported on both
Windows and UNIX platforms.

sybrestore also allows applying database attributes via sp_dboption when a database is re-
created and restored from the dump file.

Noninteractive Mode
To use noninteractive mode:

* Use SAP ASE 15.7 ESD #2 and later.

« Thetargetand source servers must be the same server and the target database to be restored
must be the same database as the source.

* You cannot use external dump files.

» Specify the server name, a user name, and the database name. If you do not provide a
password, you are prompted to do so when you invoke sybrestore.

» (Optional) Specify a dump directory and an interfaces file.

Interactive Mode
In interactive mode, you can specify:

» To restore a master database.

« Adifferent target server than the source server. If the target database you specify does not
exist, a new database is automatically created.
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Whether the last transaction is dumped from the source server and loaded on to the target
server. If your data device fails and the database is inaccessible, the dump transaction does
not truncate the log.

Whether to drop and re-create the database.

Whether to use the current dump history files or external dump files.
The location for the dump transaction.

Whether to bring the database online immediately after the restore.

A point in time, within the range of time during which the database is backed up in the
dump history files, from which to restore the database.

To reinitialize and re-create the database devices of an offline database for which the
devices are offline. Then restore the re-created database.

To log output to a file.

Before You Begin

Perform these tasks before using sybrestore.

To restore a user database, you must be a user with sa_role privilege. To work on an offline
database that has offline or inactivated devices, you must be a user with mon_role and
sa_role.

To restore a master database, you must provide a restoremaster . cfg configuration
file, resource files for building the SAP ASE server and the Backup Server, and dump
history files.

Make sure these environment variables are set correctly:

e SYBASE -- the location of the current version of SAP ASE.

* SYBASE ASE --the location of the SAP ASE component directory.

* SAP JRET7 -- the location of SAP JRE 1.7.

e SYBASE JREG6 and SYBASE JRE7 -- the location of JRE 1.6 and JRE 1.7
respective_ly. B

Note: In SAP ASE 16.0, SYBASE_JRE6 and SYBASE_JRE7 are superseded by
SAP_JRE7.
Adaptive Server and Backup Server must be running for both the target and source servers.
The master database must be available.
The source database must be connected to the server in a recovered or unrecovered state.

The log segment of the source database must be available for dumping and then loading
back the last transaction logs that have not been dumped.

Dump history files or external dump files must be available.

sybrestore is installed as part of the SAP ASE software. For more information, see the
installation guide for your platform. The executable file is located in:

$SYBASE/ASE-15 0/bin/
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sybrestore Checks

sybrestore performs checks in both interactive and noninteractive mode.

* A check is performed to determine the version of SAP ASE. In version 15.7 ESD #2,
enhancements called dump configurations were introduced in the dump and load
commands. sybrestore supports dump configurations in version 15.7 ESD #2 and later. If
you are using SAP ASE 15.7 ESD #1 or earlier, you must use external dump files

« Another check determines whether Backup Server is running. The session is terminated if
it is not.

« The dumped database and target database are checked for geometry compatibility, which
verifies that the database dump can be loaded successfully into the target database.

« Afinal check determines whether dump history files exist for the database. If there is no
such file, sybrestore prompts you to provide external dump files.

See also
o Compatibility Geometry Check on page 343

Compatibility Geometry Check

A geometry compatibility check verifies whether a database dump can be loaded successfully
into the target database.

Checks are performed both interactive and noninteractive modes. The rules that verify this
compatibility are:

« The size and the order of the data and log fragments must match. If two or more
consecutive fragments are of the same type (data or log), the sizes for these consecutive
fragments are combined together by the restore utility before a comparison is done
between the dumped database and the target database.

« The size of all fragments before the last fragment for the target database must match
exactly with the size of the dumped database. The last fragment of the target database can
be bigger than the database that is dumped. There may be extra fragments in the target
database after matching all fragments in the dumped database.

sybrestore Syntax

Start the restore utility by entering sybrestore along with a login and server name (or host
name and port number). Providing the database name invokes noninteractive mode.

If you do not provide a password, you are prompted to enter one when you execute the
command. If the connection to the server fails, an error message is raised. By default, the
SSYBASE/interfaces fileisused. If you specify an interfacesfile, that file is used instead
of SSYBASE/interfaces.
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The parameters for interactive mode are:

sybrestore
-S server name | host name:port number
-U username
-P password ]
t [point in time of restore]]
I interfaces file ]
J character set ]
R Restore from master database corruption ]
-d dump directory ]
s list system databases except master database ]
v version |
z language ]
o Log output]

The parameters for noninteractive mode are:

sybrestore
-S server name | host name:port number
-U username
[-P password]
-D database name
[-d dump directory]
[-I interfaces file]
[-o Log output]

See also
» Sybrestore on page 161

Restoring a Database in Noninteractive Mode

In SAP ASE 15.7 ESD #2 and later, use sybrestore in noninteractive mode to restore a
database to the time of failure from the most current dump history files.

In noninteractive mode, the dump history files must be available.
The current full database dump files are used, along with either:

« A series of transaction log dumps, if dump transaction is used, or,

e The most recent cumulative dump, if cumulative dump is used. Cumulative dump is
supported only in SAP ASE versions later than 15.7 ESD #3.

Start sybrestore with the user name, password, server name, and database name options. For

example:

sybrestore -Usa -P -SaseServerl -Ddba db

You see the Restore Database wizard, which shows a preview of the SQL to be executed for
restoring the database, along with any progress or error messages.
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Optionally, you can specify an interfaces file, and a directory for dumping the last transaction
log. If you specify a directory for dumping the last transaction log in the sybrestore command,
it overrides the default location of the dump directory.

A geometry check, which verifies that the database dump can be loaded successfully into the
target database is performed. If dump files do not exist or the geometry check fails, the session
is terminated.

See also
e Compatibility Geometry Check on page 343

Restoring a Database in Interactive Mode

The interactive command line interface allows single-key entry, plus the Enter key to navigate
through each menu.

The sybrestore utility menu is hierarchical and allows you to start at different levels in the
menu depending on the type of database restore.

Top Level Menu

Restore Databasze
[

¥ ¥
Uzer Databaze Restore Master Databaze Restore
[
¥ ¥
Cotmplete Database Databaze Point-In-Time o . '
Restore Restore & Edit Rezource Files

Edit Reszource Tool
Configuration File

Y

Restore Master Databaze

You can navigate down through the levels of the menu and back to the level from which you
started. For example, if you start the utility at the top level, you can navigation down and back
up to the top menu. However, if you start the utility at a lower level, such as the Complete
Database Restore menu, you can only navigate back to that same start level. The Restore
Database wizard provides prompts based on the given parameters and the level of at which you
start the utility.

This example starts the utility at the top level of the sybrestore menu shows the prompts
provided to navigate to a lower menu level:
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sybrestore
<<<<<<====Restore Database Menu ====>>>>>>>

u : User Database Restore
m : Master Database Restore

u

Provide information of the source server for
restoring user database.
Server (servername or hostname:port#) :

myData0053177a:5000

Login username:

sa

Login password:

myPassword
<<<<LLLL<<==== User Database Restore Menu ====>>>>>>>>>>
c : Complete Database Restore

p : Database Point-In-Time Restore

In this example, you see the menu shown below when you start sybrestore with the minimal
options of user name, password, and server name:

sybrestore -Usa -P -SaseServerl

<<L<L<<==== Complete Database Restore Menu ====>>>>>>>

Select Database
Target Server
Recreate Database
Use External Dump
Check Geometry
Dump Directory
Online Database
Preview

Go

QT O QQ0dR n

This example illustrates how the menu is affected if you include the point-in-time parameter in
the sybrestore command:

sybrestore -Usa -P -SaseServerl -t

<<<L<<==== Database Point-In-Time Restore Menu ====>>>>>>>

Select Database
Target Server
Recreate Database
Point-In-Time
Check Geometry
Online Database
Preview

Go

QT O QKK d®n
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This example illustrates starting the utility to restore a master database:
sybrestore -R

<<<<<L<====Master Database Restore Menu ====>>>>>>>

e : Edit Resource Files
c : Edit Restore Tool Configuration File
r : Restore Master Database

Interactive Menu Options
Menu options for the interactive sybrestore utility.

Note: After every successful action such as Go, sybrestore will proceed through the menu
system. Any action that raises an error or exception causes the utility to quit.

Table 16. Special Meaning Keys

Option Description

q From the menu level, quit the restore utility ses-
sion.

Ctrlc Abort the restore utility session.

Space bar To move back to the previous menu step.

? To display the restore utility help.

Table 17. Options for the Complete Database Restore Menu and Database
Point-In-Time Restore Menu

Menu Option | Input

s: Select Database | Select the database to be restored.

t: Target Server Select the target server if it is not same as source server. Provide the target server
information:

e Server name or host name and port number.

e User name.

» Password.

« A mapping directory that maps the mount point of the dump files in the
source server to the mount point of the dump files in the target server.

» Specify whether the target database has the same name as the source da-
tabase.

r: Recreate Data- When the input is yes, the database is dropped and re-created using specified
base devices and device sizes, and log devices and log sizes.
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Menu Option

Input

e: Use External

Whether you want to restore the database from dump history files. When the

Dump input is no, provide the external backup files to restore the database:
e The archive directory for the dump database file location and the dump
database file name, including respective stripe names.
e The dump transaction log file location and multiple dump transaction log
file names, including respective stripes names.
Using the external dump option overrides using dump history files.
i: Point-In-Time Select the point in time to restore the database.

c: Check Geometry

When the input is yes, you see the comparison between the data size and log size
of the device fragments of the dumped database, and the corresponding data
size and log size of the device fragments of the target database.

This option is provided when dump history files exist and external dump files
are not being used to restore the database.

d: Dump Directory

When yes, you can change whether to dump the last transaction of the source
database, and change the dump directory for dumping the last transaction.

0: Online Database

When yes, the database is brought online after restoring the database.

p: Preview Shows the SQL statements that will be executed.

Go Use “Go” to run all the menus options without having to select menus indi-
vidually. “Go” runs all menu options in sequence and then exits. If a menu item
has already been executed, for example, if you have already selected a database,
you are not prompted again to select a database.

Table 18. Restore Database Menu
Menu Option Input
u : User Database Restore Directs you to the User Database Restore menu.
You can choose to go to the Complete Database
Restore or Database Point-In-Time Restore wiz-
ard.
m : Master Database Restore Directs you to the Master Database Restore wiz-
ard. The interactive wizard provides option se-
lections and prompts to restore master database.
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Table 19. User Database Restore Menu

Menu Option Input

c : Complete Database Restore Directs you to the Complete Database Restore
wizard. The interactive wizard provides option
selections and prompts to restore a user database.

p : Database Point-In-Time Restore Directs you to the Database Point-In-Time Re-
store wizard. The interactive wizard provides op-
tion selections and prompts to restore a user da-
tabase to a point in time.

Table 20. Master Database Restore Menu

Menu Option Input

e : Edit Resource Files Directs you to the Edit Resources Files wizard.
The resource files are used by the restore utility
to build an SAP ASE server.

c : Edit Restore Tool Configuration File Directs you to the Edit Restore Tool Configu-
ration File wizard. The configuration file con-
tains information about the resource files used
to build the SAP ASE server and Backup Server,
the SAP ASE configuration file, and the dump
history file. On the UNIX platform, there is ad-
ditional resource file for the XP server and a
resource file for the sqglloc utility which is used
to set the language, character set, and sort order.

m : Restore Master Database Directs you to the Restore Master Database
wizard. The interactive wizard provides option
selections and prompts to restore master data-
base.

Logging sybrestore Output
Log output of a database restore to a file.

Use the sybrestore —o option to log output of a database restore to a file.
For example:

sybrestore -Usa -P -SaseServerl -DmyDataBase -o logData
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Providing a Mapping Directory

When using the interactive command line to restore a database, you can provide one or more
mapping directories.

If the mounted directory of the target server backup files is the same as the source server,
provide an empty mapping directory by leaving the prompt blank.

If the mounted directory of the target server backup files is not the same as the source
server, provide a mapping directory in this form:

/pathl>>/path?2

Do not use cyclic path entries, as they cannot be resolved. For example:

Mapping Results in
/pathl>>/path?2 /pathl>>/pathl
/path2>>/pathl

/pathl>>/path?2 /pathl>>/pathb
/path2>>/path3 /path2>>/pathb
/path3>>/pathb /path3>>/pathb

Restoring a Database to a Point In Time

Follow these steps to restore a database to a specific point in time.

1

In the command window, start sybrestore.

sybrestore -Usa -P —-SserverName -t

Once the Restore Database wizard starts, you see the Restore Database menu.

<<<<<L<====Restore Database Menu ====>>>>>>>
s : Select Database

t : Target Server

r : Recreate Database
i : Point-In-Time

c : Check Geometry

o : Online Database

p : Preview

g : Go

Enter:

g

You see a list of available source databases.

Select a database by entering the number associated with the database or the name of the
database.
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You must provide the password for dump files that are password protected.
4. Specify whether the target server to be restored is the same as the source server.
If the target server is not the same as the source server, you are prompted to specify a target

server by providing the server name (or hostname:port number), login, and password. You
can then provide a mapping directory.

5. Specify whether the name of the target database is the same as the source database.

If the target database name is not the same as the source database name, select a target
database.

If the target database does not exist, a database is created, and you must specify devices and
devices sizes and log devices and log sizes.

6. Specify whether to drop and re-create the database.
When re-creating the database, you are prompted to specify devices and devices sizes, and
log devices and log sizes.

7. The dates and times of the dumped database are given.
First, specify the range of time from which to restore the database. You then see the low and
high time ranges. Specify a point in time that falls within the available range.

8. A geometry check is performed. If dump files do not exist or the geometry check fails, the
session is terminated.

9. Specify whether to bring the database online after the restore.

You see a preview of the SQL to be executed for restoring the database.
10. Specify whether you want to execute the SQL.

You see any progress or error messages.

See also

*  Providing a Mapping Directory on page 350

o Compatibility Geometry Check on page 343

»  Example of Restoring a Database to a Point In Time on page 351

Example of Restoring a Database to a Point In Time
Provided is an example of restoring a database to a point-in-time based on the dump database
dates and times.

Table 21. Example of dump history

Date Dump time Type of dump
Aug 14 11:04 AM database dump
12:20 PM transaction dump
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Date Dump time Type of dump
2:20 PM transaction dump
7:00 PM transaction dump
Aug 17 9:00 AM transaction dump
9:00 AM transaction dump
2:16 PM transaction dump
Aug 23 10:27 AM database dump
2:00 PM transaction dump
9:30 PM transaction dump
Sep 28 8:00 AM transaction dump
9:00 AM transaction dump
12:14 PM transaction dump

sybrestore prompts you to select a range of time based on the database dump history.

For example, based on the information in the above table, you see:

1 : [Aug 23 2012 10:27:45:206AM, Sep 28 2012 12:14:50:063PM]

2 : [Aug 14 2012 11:04:58:330AM, Aug 17 2012 2:16:17:206PM]

You can select atime range by entering the list number. For example, enter 2 for the time range
[Aug 14 2012 11:04:58:330AM, Aug 17 2012 2:16:17:206PM].

Next, enter a time that falls between Aug 14 2012 11:04:58:330AM and Aug 17 2012
2:16:17:206PM. For example, enter:

Aug 16 2012 10:00 A.M

Restoring User and System Databases

Follow these steps to restore user and system databases, with the exception of the master
database.

1. Start sybrestore:

« To restore a user database, enter:
sybrestore -Usa -P -ShostName:portNumber

« To restore both user and system databases, enter:
sybrestore -Usa -P -ShostName:portNumber -s

You see the Complete Database Restore menu.

<<<<<L<====Complete Database Restore Menu ====>>>>>>>

s : Select Database
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: Target Server

: Recreate Database
: Use External Dump
: Check Geometry

: Dump Directory

: Online Database

: Preview

: Go

2. To proceed through the menu, enter:

QT O QN DdHR

g

You see a list of available source databases.

3. Select a database by entering the number associated with the database or the name of the
database.

You must provide the password for dump files that are password protected.
4. Specify whether the target server to be restored is the same as the source server.

If the target server is not the same as the source server, you are prompted to specify a target
server by providing the server name (or hostname:port number), login, and password. You
can then provide a mapping directory.

5. Specify whether the name of the target database is the same as the source database:

 If the target database name is not the same as the source database name, select a target
database.

« Ifthetarget database does not exist, a database is created, and you must specify devices
and devices sizes and log devices and log sizes.

« Ifthe database is offline and its devices do not exist, you are prompted to reinitialize the
database devices.

6. Specify whether to drop and re-create the database.

When re-creating the database, you are prompted to specify devices and devices sizes, and
log devices and log sizes.

7. If you choose to restore the database from dump history files, specify whether to use the
current dump files or external dump files.

If you are using external backup files to restore the database:

« Specify the archive directory for the dump database file location and the dump
database file name, including respective stripe names.

» Specify the dump transaction log file location and multiple dump transaction log file
names, including respective stripes names.

Note: Provide the transaction log files in the same time sequence as they were dumped.

If you have selected dump history files, a geometry check verifies that the database dump
can be loaded successfully into the target database.
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In SAP ASE versions 15.7 ESD #2 and earlier, specify external dump files; no geometry
check is performed.

8. Specify whether to dump the last transaction of the source database, provided that:
» The status of the database is not "for load," or "offline."
e The database passes the tran_dumpable_status check.

9. Use the archive directory as the location of the dump directory, or specify a different
location for dumping the transaction.

10. Specify whether to bring the database online after the restore.

You see a preview of the SQL statements to be executed for restoring the database.
11. Specify whether to execute the SQL.

You see any progress or error messages.

See also
*  Providing a Mapping Directory on page 350
o Compatibility Geometry Check on page 343

Master Database Restore

Restore an SAP ASE master database in the event of a master database corruption.
These functions are performed when restoring a master database.

* The SAP ASE server is rebuilt with srvbuildres on UNIX/Linux or sybatch on Windows.

« The Backup Server is created using srvbuildres on UNIXLinux platform or sybatch on
Windows.

« OnUNIX/Linux, the language, character setand sort order are configured using sqgllocres.
On Windows, this is done during the rebuild of the server.

» The SAP ASE configuration file and dump history file are restored.

e The master database is loaded from dump files.

« Optionally, you can interactively load other databases after loading the master database.

« If the master database backup is not current or the backing up is missing database devices
or a database, you can initiate the disk reinit and disk refit option.

Prerequisites for Restoring a Master Database
To restore the server from master database corruption, resource file, configuration files, dump
files, and devices must be available.

Note: For recovery purpose, it is advised to not create user database on the master device.

Prerequisites

* File systems for the SAP ASE server are available.
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e Current dump of the master, system databases, and user databases are available.

» Resource files for building the SAP ASE server and the Backup server are defined.

« Device layouts for the master and system databases are specified in the resource files.

« Database sizes for the master and system databases are specified in the resource files.

* SAP ASE configuration file is available.

e Dump history file is available

* Restore utility restoremaster.cfg configuration file must exist in $SYBASE/
$SYBASE ASE.

When restoring the master database, the master database is loaded back from the dump files of
the master database. All databases that use the master devices are listed after loading the
master database from the dump. You have the option to restore any of these user databases and
system databases that are listed.

You must provide information in the sybrestore utility restoremaster.cfg
configuration file. The configuration file contains information about the resource files for
building the SAP ASE server and Backup Server. It also contains information about the saved
SAP ASE configuration file and the dump history file. If the resource files are not available,
you can create them by running Edit Resource Files from the sybrestore utility.

The resource files for building an SAP ASE server differ for UNIX/Linux platform and the
Windows platform. The utility provides options to construct the resource file and to edit the
sybrestore configuration file.

Configuration and Resource Files

When restoring a master database, the restore utility uses the information saved in the master
database restore utility SSYBASE/$SYBASE ASE/restoremaster.cfg
configuration file.

Inturn, the restoremaster. cfg configuration file relies on this information to restore
the master database:

 resource file to build the server

 resource file to create the backup server

» resource file to create the XP server (not used for Windows platforms)

« resource file to create languages, character sets and sort order (not used for Windows
platforms)

* SAP ASE configuration file

e dump history file

This is an example of restore utility configuration file and the required input files:

Note: The file names shown are simplified; they can be prefixed with a full path followed by
the file name. If a path is not prefixed in the file name, it assumes that the path is $SYBASE /
$SYBASE ASE.

# Resource files

Utility Guide 355



CHAPTER 11: Using sybrestore to Restore Databases

srv_resource file=gpamd7.rs
bsrv_resource file=gpamd7.bk.rs
xpsrv_resource file=

sglloc resource file=gpamd7.sglloc.rs
# ______________________

# Adaptive Server configuration file and dumphist file

ﬁriginaliconfigifilequamd7srv.cfg.sav

original dumphist file=dumphist.bak

If the restoremaster. cfg file does not exist, you can create the file by starting
sybrestore, selecting Master Database Restore, then selecting Edit Restore Tool
Configuration File. A sample configuration file is located in the $SYBASE/
$SYBASE ASE/sample/server directory.

If the resource files do not exist, you can create new files from a locally running server or
sample resource files. You can also edit existing resource files. To create or edit resource files,
start sybrestore, select Master Database Restore, then select Edit Resource Files.

When initiating Edit Resour ce Files, these options are available:

File Availability sybrestore Options

The configuration file sybrestore defaults to the resource files indicated in the existing config-
and resource files are uration file. You are prompted to confirm the name and location of re-
available. source file that are to be used. The sybrestore utility will also prompt you
to confirm the values in the existing resource files.

A configuration file does | A new configuration file is created that references the specified resource
not exists. files.

The resource files and You are prompted to name a locally running SAP ASE server. Resource
configuration file do not | files are then constructed based on the values of the locally running server.
exist. If you do not name a locally running server, resource files are created
based on the sample resource files. You are also prompted to confirm or
change the values taken from the sample resource files. A configuration
file is created which references the new resource files.

Creating or Editing the Restore Utility Configuration File

The configuration file contains information about the resource files used to build the SAP ASE
server and Backup Server. It also contains information about the saved SAP ASE
configuration file and the dump history file.

If the restore tool configuration file restoremaster.cfg does not exists in the
$SYBASE/$SYBASE ASE directory, the file will be created. A sample copy of the restore
utility configuration file is located in the $SYBASE/$SYBASE ASE/sample/server
directory.

1. Inthe command window, start sybrestore without specifying parameters.

Once the Restore Database wizard starts, you see the Master Restore Database Menu.
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<<<<L<L<====Master Restore Database Menu ====>>>>>>>
u : Restore User Database
m : Restore Master Database

2. Enter:

m

You see the Edit Restore Tool Configuration File wizard.

3. For UNIX/Linux, you are prompted for the names of these resource files: SAP ASE server,
Backup Server, sglloc (language, character sets and sort order), and the XP server. For
Windows, you are prompted for the names of these resource files: SAP ASE server and the
Backup Server. The available actions are:

A configuration file exists and the resource | Confirm the resource file
files are listed within the configuration file. | names.

A configuration file does not exists. A new configuration file is
created.

A configuration file and resource files exist | Provide names of the resource
but they are not listed within the files.
configuration file.

Note: If the resource files do not exist, you have the option to construct resource files from
an existing locally running SAP ASE server.

4. Confirm the SAP ASE configuration file name or specify a different configuration file.
5. Confirm the dump history file name or specify a different dump history file.
6. Confirm the updates to the restore tool configuration file.

Creating or Editing Resource Files
Resource files are used by the restore utility to build an SAP ASE server.

1. Inthe command window, start sybrestore without specifying parameters.

Once the Restore Database wizard starts, you see the Master Restore Database Menu.
<<<<L<L<====Master Restore Database Menu ====>>>>>>>

u : Restore User Database
m : Restore Master Database

2. Enter:

m

You see:

<<<<L<L<====Master Restore Database Menu ====>>>>>>>

e : Edit Resource Files
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c : Edit Restore Tool Configuration File
r : Restore Master Database

3. Enter:

e

You see the Edit Resources Files wizard.
4. Enter the names of the resource files for your platform.

For the UNIX/Linux platform:

* The SAP ASE server
* sqlloc (language, character sets and sort order)
o XP server (optional)

For Windows platform:

¢ The SAP ASE server
« Backup Server

If you editing existing resource files, you are prompted to confirm the names of the files.
When editing the resource files, the restore utility modifies only the rows specific to
restoring the database.

If you do not have resource files available, you are prompted to either:

< Create the resource files from a locally running an SAP ASE server by connecting to
the server and collecting default data.

You must provide server connection information such as the server name or
hostname:port#, the login name and password. After connecting to the server,
sybrestore displays the default data enclosed in square-brackets, such as:

Select network protocol

1 : TCP TCP/IP Net-Library driver

2 : NAMEPIPE Named Pipes Net-Libray driver
3 : SPX SPX/IPX Net-Library driver

4 : DECNET DecNET Net-Library driver
Provide a number (1 to 4) ->[1]

Provide its network port number:[5000]
Select ASE application type

1 : MIXED

2 : OLTP

3 : DSS

Provide a number (1 to 3) ->[1]

» Create the resource files from the sample resource files located here:
*  Windows platform: $SYBASE/ASE-15_ 0/sample/server/
e Unix and Linux platform: SSYBASE/ASE-15 0/init/
sample resource files/ -

You are prompted to confirm or change the default values taken from the sample
resource files.

If the restoremaster.cfg does not exist, one will be created for you.
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5. Provide the name of the SAP ASE server.
6. Provide the system administrator login name and password.

The system administer password specified is a temporary password that is visible in the
resource files. This password should only be used to restore the master database. Once the
master database is restored, you will be prompted for the secure sa password associated
with the master database.

7. Provide the following information for the network configuration:
a) Network protocol and network port number.
b) SAP ASE application type.
C) Server page size.
d) Language set, character set, and sort order.
8. Specify whether to optimize the SAP ASE configuration.
9. Provide the following information for device names, location, and sizes:
a) Master device name, location, and size.
b) sybsystemprocs name, location, and size.
€) sybsystemdb name, location, and size.
d) Temporary database name, location, and size.
10. Specify the name and location for the SAP ASE error log.

11. Specify whether to enable PCI in the SAP ASE server. If yes, provide the name, location,
and size of the device.

12. Provide the name and network port number of the Backup Server.

13. Specify whether to configure an XP Server. If yes, prove the name and network port
number.

14. Specify the name and location of the SAP ASE configuration file, and the dump history
file.

15. Confirm the update to the resource files and the restore utility configuration file.

Resource File Examples

Specific rows are modified by the restore utility when creating or editing resource files.
Rows that are modified are shown in bold.

Resource file for the SAP ASE server on Windows platform

#

# --- This file was generated by Sybase Installer ---
#

sybinit.boot_ directory: C:\Sybase.carina
sybinit.release_directory: C:\Sybase.carina
sglsrv.do add server: yes
sqlsrv.network_hostname list: OAKN00531664A
sqlsrv.network port list: 5000
sqlsrv.network protocol list: tep
sglsrv.notes:

sglsrv.connect retry delay time: 5
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sglsrv.
sglsrv.

#

sqlsrv.
sqglsrv.
sqlsrv.
sqlsrv.
sqlsrv.

#
4 -
#

sqlsrv.master_device physical name:

connect retry count:
new config:

server_name:
sa_password:
sa_login:
application_type:
server_page_size:

Set up master ----

5
yes

OAKN00531664A

Sybase4dme
sa

MIXED

4k

C:\Sybase.carina\data\master.dat

sqlsrv.master_device_ size: 73
sqlsrv.master_db_size: 26

sglsrv.disk mirror name:

#

# --- Set up sybsystemprocs ----

#

sglsrv.do create sybsystemprocs device: yes
sqlsrv.sybsystemprocs dev1ce_phy51cal name:

C:\Sybase.carina\data\sysprocs.dat
sqlsrv.sybsystemprocs_device_size: 172
sqlsrv.sybsystemprocs_db_size: 172
sglsrv.sybsystemprocs device logical name: sysprocsdev
#

# --— Set up sybsystemdb ----

#

sglsrv.do create sybsystemdb: yes
sglsrv. do create _sybsystemdb db device: yes
sqlsrv.sybsystemdb_db_dev1ce_phys1cal_pame:

C:\Sybase.carina\data\sybsysdb.dat
sqlsrv.sybsystemdb db dev1ce_phy51cal size: 6
sqlsrv.sybsystemdb db size: 6
sglsrv.sybsystemdb db device _logical name: systemdbdev
sqlsrv. tempdb dev1ce_phy51cal name:

C:\Sybase.carina\data\tempdbdev.dat
sqlsrv.tempdb device size: 100
sqlsrv. tempdb _database_size: 100
#
sglsrv.errorlog:

C:\Sybase.carina\ASE-15 0\install\OAKN00531664A.1log
sqlsrv.sort_order: bin_cp850
sqlsrv.default_characterset: cp850
sqlsrv.default_ language: us_english
#
sglsrv.preupgrade succeeded: no
sglsrv.network name alias list:
sglsrv.resword conflict: 0
sglsrv.resword done: no
sglsrv.do upgrade: no
sqglsrv.characterset_install list: cp850
sglsrv.characterset remove list:
sqlsrv.language_install list: us_english
sglsrv.language remove list:
sglsrv.shared memory directory:
sglsrv.addl cmdline parameters:
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sglsrv.eventlog: yes
sglsrv.atr name shutdown required: yes
sglsrv.atr name ginstall: no
#

sglsrv.do change ase service account: no

sglsrv.ase service account name:
sglsrv.ase service account password:

#
sybinit.charset: cp850
sybinit.language: us_english

sybinit.resource file:
sybinit.log file:

sybinit.product: sglsrv

#

sqlsrv.default_backup_server: OAKN00531664A BS
#

sqlsrv.xpserver network protocol list: tcp
sqlsrv.xpserver_ network hostname list: OAKN00531664A
sqlsrv.xpserver network port list: 5002

#

sglsrv.do change xp service account: no

sqlsrv.xp service account name:

sglsrv.xp service account password:

#

sqlsrv.do_configure pci: yes

sqlsrv.sybpcidb device_physical name:
C:\Sybase.carina\data\sybpcidbdev_data.dat

sqlsrv.sybpcidb _device_size: 48
sqlsrv.sybpcidb_database_size: 48

#

sqlsrv.do_optimize_config: yes
sqlsrv.avail physical memory: 2816
sqglsrv.avail cpu num: 3

Resource file for Backup server on Windows platform

#

# -—— This is a "sybatch.exe" sample resource file. ---
#

# This sample resource file will configure a new
# Backup Server "SYBASE BS".

#

sybinit.boot_directory: C:\Sybase.carina
sybinit.release_directory: C:\Sybase.carina
sybinit.product: bsrv
sqlsrv.server_ name: OAKN00531664A
sqlsrv.sa_ login: sa

sqlsrv.sa password: Sybasedme
bsrv.do add backup server: yes

bsrv.server name: OAKN00531664A BS

bsrv.errorlog:
C:\Sybase.carina\ASE-15 0\install\OAKN00531664A BS.log

bsrv.network port list: 5001
bsrv.network hostname_ list: OAKNO00531664A
bsrv.network protocol list: tcp
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bsrv.character_set:
bsrv.language:
bsrv.network name alias list:
bsrv.notes:

bsrv.connect retry delay time: 5
bsrv.connect retry count: 5
bsrv.addl cmdline parameters:

cp850
us_english

Resource file for the SAP ASE server on UNIX/Linux:

sybinit.release_directory:

USE_DEFAULT

sybinit.product: sglsrv
sqlsrv.server_ name: gpamd7srv
sqlsrv.sa password: dbasql
sglsrv.new config: yes
sglsrv.do_add server: yes
sqlsrv.network protocol list: tcp
sqlsrv.network_hostname list: gpamd?7
sqlsrv.network port _ list: 6008
sqlsrv.application_type: MIXED
sqlsrv.server page_size: 4K
sglsrv.force buildmaster: no

sqlsrv.master _device_physical name:

/gpamd7_eng2/hlam/asel57esd3/data/master.dat

sqlsrv.master_device_size:
sqlsrv.master_ database size:
sglsrv.errorlog: USE | DEFAULT

60M
26M

sglsrv.do upgrade: no
sqlsrv.sybsystemprocs_device_physical name:
/qpamd7_en92/hlam/asel57esd3/data/sysprocs.dat
sqlsrv.sybsystemprocs_device_size: USE_DEFAULT
sqlsrv.sybsystemprocs_: database size: USE DEFAULT
sqlsrv.sybsystemdb dev1ce_phy51cal name:
/qpamd7_en92/hlam/asel57esd3/data/systemdb.dat

sqlsrv.sybsystemdb device_size:
sqlsrv.sybsystemdb database size:
sqlsrv. tempdb dev1ce_phy51cal name:

USE_DEFAULT
USE_DEFAULT

/gpamd7_eng2/hlam/asel57esd3/data/tempdb.dat

sqlsrv.tempdb device size:
sqlsrv. tempdb ¢ database size:
sqlsrv.default_backup_: server:

USE_DEFAULT
USE_DEFAULT
SYB BACKUP

#sglsrv.addl cmdline parameters:

#PUT ANY ADDITIONAL COMMAND LINE PARAMETERS HERE
sqlsrv.do_configure pci: no
sqlsrv.sybpcidb device_physical name:

PUT_THE_ PATH OF YOUR_SYBPCIDB DATA DEVICE HERE
sqlsrv. sybpc1db device size: USE_DEFAULT
sqlsrv.sybpcidb database size: USE_DEFAULT
# If sglsrv.do optimize conflg is set to yes,
#both sglsrv.avail physical memory and
#sglsrv.avail cpu num need to be set.
sqlsrv.do_optimize_config: no
sqlsrv.avail_ physical memory:

PUT_THE AVAILABLE PHYSICAL MEMORY FOR ASE IN OPTIMIZATION

362 Adaptive Server Enterprise



CHAPTER 11: Using sybrestore to Restore Databases

sglsrv.avail cpu num:

PUT_THE AVAILABLE NUMBER CPU FOR ASE_IN OPTIMIZATION

Resource file for Backup server on UNIX/Linux platform

sybinit.release_directory:
sybinit.product:
bsrv.server name:

bsrv.new config:
bsrv.do add backup server:
bsrv.do upgrade:
bsrv.network protocol list:
bsrv.network hostname list:
bsrv.network_port_llst
bsrv.language:
bsrv.character_set:
bsrv.tape config file:
bsrv.errorlog:
sqlsrv.related sqlsrvr:
sqlsrv.sa_login:

sqlsrv.sa password:
#bsrv.addl cmdline parameters:

PUT_ANY ADDITIONAL COMMAND LINE

USE_DEFAULT
bsrv

SYB BACKUP
yes

yes

no

tep

gpamd7

6010
USE_DEFAULT
USE_DEFAULT
USE_DEFAULT
USE_DEFAULT
gpamd7srv
sa

dbasql

PARAMETERS HERE

Resource file for sqglloc utility on UNIX/Linux platform

sybinit.release_directory:
sqlsrv.server name:
sqlsrv.sa_ login:

sqlsrv.sa password:
sqlsrv.default_language:
sqlsrv.language_install list:
sglsrv.language remove Tist:
sqlsrv.default_ characterset:

USE DEFAULT

PUT_YOUR_SERVER_NAME_HERE

sa

USE_DEFAULT
USE_DEFAULT
USE DEFAULT
USE_DEFAULT

sqlsrv.characterset install list: USE DEFAULT

sglsrv.characterset remove Tist:
sqglsrv.sort_order:

USE_DEFAULT
USE_DEFAULT

Resource file for XP server on UNIX/Linux platform

sybinit.release_directory:
sybinit.product:
Xp.server name:
xp.new_config:
xp.do add xXp server:
xp.do upgrade:
xp.network protocol list:
xp.network hostname list:
Xp.network port_. list:
sqglsrv.related sqlsrvr:
sqlsrv.sa_login: sa
sqlsrv.sa password:

USE_DEFAULT
XpP

PUT YOUR SERVER NAME HERE

yes
yes
no
tcp
PUT_YOUR HOSTNAME HERE

PUT YOUR PORT_] NUMBER HERE
PUT_YOUR_ADAPTIVE_SERVER_NAME_ﬁERE

USE_DEFAULT
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Restoring a Master Database

The interactive Restore Master Database wizard provides option selections and prompts to
restore master database.

Prerequisites
See Prerequisites for Restoring a Master Database on page 354

Task
When restoring a master database, these options are available:

Rebuild a new server on anew machine and restore the master database by loading it froma
dump file.

Rebuild aserver in your current SAP ASE installation on the same machine and restore the
master database by loading from a dump file.

Restore the master database of your currently running server on the same machine without
rebuilding the server.

Do a disk reinit and disk refit of your current SAP ASE server. You can do disk reinit and
disk refit when the list of database devices, including user databases, indicate that some
database devices have not been updated after loading the master database. A rebuild of the
SAP ASE server is not required.

In the command window, start sybrestore without specifying parameters.
You see:
<<<<<L<==== Restore Database Menu ====>>>>>>>

u : Restore Master Database
m : Restore Master Database

Enter:
m

You see:
<<<<L<<====Master Restore Database Menu ====>>>>>>>
e : Edit Resource Files

c : Edit Restore Tool Configuration File
r : Restore Master Database

Enter:
r

You see the Restore Master Database wizard.

You are prompted to confirm the name and location of the SAP ASE installation directory.
The utility defaults to the same machine on which the utility is running. The
restoremaster.cfg located in this directory is used to determine the resource files,
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SAP ASE configuration file, and dump history file that will be used to restore the master
database.

5. Provide the system administrator login name and password. The sa login name and
password must match those saved in the master database dump file.

The sybrestore ulitity automatically detects password protected master database dumps.
You are only prompted for a password if the master database dump is password protected.

6. (Optional) To rebuild the SAP ASE server, enter y at the prompt.
The SAP ASE server and Backup Server are rebuilt using sybatch on Windows or
srvbuildres on UNIX/Linux. For UNIX/Linux, sqgllocres is executed to install languages,
character sets and the configuration of the sort order.

7. (Optional) If rebuilding the server, you are prompted to confirm the removal of system
database devices files that are listed in the resource file.

You are not prompted when using raw disk files. Providing an answer of no to dropping any
of the system devices will exist the wizard.

8. Enter y when prompted to reload the master database.
The SAP ASE server is shut down and the SAP ASE configuration file and dump history
file is copied to the new SAP ASE instance. The SAP ASE server is re-started in master
recover mode.
The size of master database defined in the resource file must be greater than or equal to the
size of the master database of the dump file. After comparing the size of the master
databases, the master database is loaded from the latest dump and the SAP ASE server is
shut down and re-started in normal mode.

9. The wizard automatically opens the Complete Database Restore Menu. You can restore
one or more user databases and system databases with the exception of the master
database.

« Enter s to continue and restore user and system databases. Available source databases
are displayed. Enter the number associated with the databases you want to restore.
Enter g when finished selecting databases.

« Enter g to quit out of the Complete Database Restore Menu.

10. (Optional) You are prompted as to whether you want to do a disk reinit and disk refit to
recover an missing database device and databases.

If yes, the server is shut down and re-started in master recovery mode. For each device you

must provide the:

» Device name

e Physical name

» Device size

» Device option: dsync, directio, or none

When finished, enter n at the prompt, "Do you have additional device to reinit?" You are

returned to the Master Database Restore Menu.
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